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Trademarks and Credits

MatchWare, MatchWare Mediator, MatchWare OpenMind and MatchWare ScreenCorder are trademarks or
registered trademarks of MatchWare A/S.

Microsoft, Microsoft Office, Microsoft Word, Microsoft PowerPoint, Microsoft Project, Microsoft Outlook,
Microsoft FrontPage, Microsoft Windows, Windows Media Player, Windows Explorer and Internet Explorer are
trademarks or registered trademarks of Microsoft Corporation.

Netscape is a registered trademark of the Netscape Corporation.
Firefox is a registered trademark of the Mozilla Foundation.
Flash is a trademark of Adobe Systems Inc. (formerly Macromedia, Inc.).

Other brand or product names are trademarks or registered trademarks of their respective holders.

MatchWare License Agreement

This program is copyrighted © 2002-2007 by MatchWare A/S. All rights reserved.

MatchWare and MatchWare Mediator are trademarks or registered trademarks of MatchWare A/S. Other brand
or product names are trademarks or registered trademarks of their respective holders.

Information given in this documentation can be changed and represents no obligation on MatchWare, its
Publishers or Agents. This documentation is copyrighted © 2002-2007 by MatchWare A/S. All rights reserved.
This documentation is not to be copied, photocopied, reproduced, translated or transferred to an electronic media
or machine sensible form without a written authorization from MatchWare or its Publishers.

IMPORTANT You should read the following MatchWare License Agreement (EULA) carefully. If you install,
copy, download, or use this software product you agree to be bound by the terms of this agreement. If you do not
agree with the conditions, you are not entitled to install and use the software, and should immediately return the
software package and all other material in this package along with proof of payment, to the authorized dealer
from whom you obtained it for a full refund of the price you paid. Do not make any illegal copies.

MatchWare License Agreement
USE

This is a legal agreement between you, the end user, and MatchWare A/S ("MatchWare"). The enclosed software
program ("Software") is licensed, not sold, to you by MatchWare for use under the term of this license.

You (an entity or a person) may use one (1) copy of the Software. This Software may be freely moved from one
computer or location to another, so long as there is no possibility of it being used by more than one person at a
time. You may make one (1) backup copy of the Software.

A Terminal Server is a computer allowing other Client computers to run applications on the Terminal Server
such as but not limited to a Microsoft Terminal Server and a Citrix Server. If the Software is installed on a
Terminal Server you need a license for each Client computer that can run the Software.

You may add users by paying for a separate license for each user you wish to add. When installing the Software
on a server which allows multiple, concurrent users to access and run the Software, you must license (purchase)
additional licenses for each computer.

When using Remote Desktop technologies you may access and use the Software provided that only the primary
user of the device hosting the remote desktop session accesses and uses the Software with a remote access
device. You are not permitted to use the Software on both the device hosting the remote desktop session and the
access device at the same time.

You may not rent, lease, loan or license this Software or any copy.

You may not reverse-engineer, disassemble, decompile, modify or create derivative work of this Software.



EDUCATIONAL LICENSES
Commercial use of Educational Licenses of this Software is prohibited.

You agree to not use an Educational License to engage in commercial activities including, without limitation, the
following activities:

o offering for sale any products or services;
e soliciting for advertisers or sponsors;
e conducting raffles or contests that require any type of entry fee;

e displaying a sponsorship banner of any kind, including those that are generated by banner or link exchange
services; and

o displaying banners for services that provide cash or cash-equivalent prizes to users in exchange for
hyperlinks to their web sites.

Some educational multi-user licenses offer home use rights for teachers (and students). Any additional CDs
purchased to facilitate such home use may not be installed or used on the respective educational institution
premises, buildings or campus.

TRANSFER OF THE SOFTWARE

You may transfer all of your rights to use the Software to another person, provided that you transfer to that
person the entire software package, CD-ROM's, documentation, and this statement, and transfer or destroy all
copies in any form. Once you transfer the Software you no longer have any rights to use it. Only the person to
whom the Software is transferred may use it in accordance with the copyright law, international treaty and this
statement.

If you have purchased an upgrade version of the Software, it constitutes a single product with the MatchWare
Software that you upgraded. For instance, the upgrade and the Software that you upgraded cannot both be
available for use by two different persons at the same time and cannot be transferred separately.

COPYRIGHT

All intellectual property rights in the Software and user documentation are owned by MatchWare A/S or its
suppliers and are protected by United Kingdom copyright laws, other applicable copyright laws and international
treaty provisions. MatchWare A/S retains all rights not expressly granted.

CLIPART

This Software may contain clipart ("Clipart™) such as images, sounds, video clips etc. All intellectual copyright
for the Clipart is owned by MatchWare A/S or licensed by MatchWare A/S.

MatchWare grants you a non-exclusive, non-sublicensable right to use the Clipart in presentations or web sites
created with this Software, including in runtime versions of the Software. There is no royalty due for such use to
MatchWare. The Clipart may not be sublicensed or made available to any person or entity that does not have a
legal license of this Software.

RUNTIME VERSIONS

In some MatchWare products (including this Software) you have the opportunity to make runtime versions or
web sites of your applications. Your runtime versions or web sites and the distribution of them are subject to all
of the following conditions:

e You may not remove or alter any MatchWare copyright, trademark, or any other proprietary rights.

e You may not use MatchWare's or any of its suppliers' names, logos, or trademarks to market your runtime
version. You may state that your runtime version was made using this MatchWare product.

e You will remain solely responsible to anyone receiving your runtime versions or web site for support,
service, upgrades, or technical assistance. The recipients will have no right to contact MatchWare for such
services or assistance.

¢ You will indemnify and hold MatchWare, its related companies and its suppliers harmless from and against
any claims or liabilities arising out of the distribution of your runtime versions.
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LIMITED WARRANTY

MatchWare warrants the physical media and physical documentation provided by MatchWare to be free of
defects in materials and workmanship for a period of ninety (90) days from the original purchase date.
MatchWare will replace defective media or user documentation at no charge, provided you return the item within
the warranty period. If MatchWare is unable to replace defective media or user documentation, MatchWare will
refund the amount you paid for the Software. These are your sole remedies for any breach of warranty.

LIMITATION OF LIABILITY

The entire and exclusive liability and remedy for breach of this limited warranty shall be limited to replacement
of defective media or documentation and shall not include or extend to any claim for or right to recover any
other damages, including but not limited to, loss of profit, data, or use of the Software or special, incidental or
consequential damages, or other similar claims, even if MatchWare has been advised of the possibility of such
damages. MatchWare makes no representation or warranty that the software or documentation are "error free" or
meet any of the user's particular standards, requirements, or needs. In no event shall MatchWare's liability
exceed the amount paid by you for the Software. To the extent that applicable law does not allow the exclusion
or limitation of implied warranties or limitation of liability for incidental or consequential damages the above
limitation or exclusion may not apply to you.

U.S. GOVERNMENT RESTRICTED RIGHTS

This Software and documentation are provided with RESTRICTED RIGHTS. The Software and documentation
are developed at private expense and no part of them is in the public domain. Use, duplication, or disclosure by
the Government is subject to restrictions as set forth in subparagraph c(1) and (2) of the Commercial Computer
Software Restricted Rights clause at FAR 52.277-19 or subparagraph c(1) (ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.227 - 7013. Manufacturer is MatchWare A/S, Vestergade 48F,
8000 Arhus C, Denmark.

GENERAL

This agreement is governed by English law and any dispute connected with this agreement and/or the Software is
subject to the exclusive jurisdiction of the English courts. The export of this product is governed by U.S and UK
export regulations.



Introduction

Welcome

First of all, thank you for choosing Mediator.

Mediator 9 is our most powerful, user-friendly version to date. All features previously reserved for Mediator Exp
have now been integrated into Mediator 9, vastly expanding its capabilities. Our latest upgrade includes a brand
new Windows 2007 interface, text object, enhanced HTML editing, SCORM compliance, Unicode and much
more.

This documentation, provided both as PDF manual and online help, will give you an overview of the
functionality and possibilities of Mediator:

e The Quick Start will show you the basic principles of Mediator and teach you how to use its most important
functions in a few short steps.

e The User Guide section describes all the main operations you can perform in Mediator, from setting up your
project, to designing it, testing it and exporting it.

e The Reference section gives you a complete definition of each object, event and action and lists all the
system variables and functions available.

e The Appendixes contain various lists: shortcuts, object properties, methods to be used in script and so on.

Getting started

Before you start designing your own projects, you are advised to follow the "Quick Start".

You should then go through the "Setting up your project” section, paying particular attention to the topic
"Planning your project".

You might also find it useful to study the examples provided with Mediator. Each example consists of basic
pages aimed at novice users or newcomers to Mediator, as well as advanced pages demonstrating the extent of
the possibilities offered by the feature in question. A comprehensive set of notes is included in each example.
After installation, these examples are located in the "Examples" sub-folder of the Mediator program folder,
generally C:\Program Files\MatchWare\Mediator 9.0. The Quick Start project is also located in this folder.



What's new in Mediator 9

Here is a brief description of the main new Mediator 9 features. Mediator 9 also includes a number of other
enhancements, which are all described in detail in this documentation.

You will also find a comprehensive description of the new features on the MatchWare web site:

http://www.matchware.com/en/products/mediator9

New interface: Mediator 9 has a brand new user interface based on the Microsoft Office Fluent™ interface used
in Microsoft Office 2007 (also referred to as the Ribbon), which helps you create impressive presentations much
more efficiently than you could in earlier versions of Mediator. This new interface has several major advantages:

e |ts features and commands are organized in task-oriented tabs and groups of related options, enabling you to
find what you need quickly, using an intuitive and visual approach.

¢ Rather than applying single properties one by one, you can select predefined styles for your objects from
easily accessible galleries, making it much easier and much faster to create great-looking presentations.

e The live preview feature lets you review the effect of the various formatting options before you commit to
them, resulting in a significant time gain.

For more information on this new interface, see "Setting up your workspace".

New formatting options: Mediator offers new styles, new effects and enhanced formatting options. You can
now preview a whole variety of effects like shadow, glow, soft edges, patterns, textures, gradients, warp and
rotation and apply them to your objects with a simple click.

Multimedia Catalog: The Multimedia Catalog has been expanded with new contents. It includes a collection of
1500 high quality clipart, navigation bars, different types of backgrounds and photos, a broad range of sounds
and various other elements that you can drag freely onto your pages. For more information, see "Using the
Multimedia Catalog".

New examples: Mediator comes with a brand new set of examples designed to showcase its main features. Each
example consists of basic pages aimed at novice users or newcomers to Mediator, as well as advanced pages
demonstrating the extent of the possibilities offered by the feature in question. A comprehensive set of notes is
included in each example. After installation, these examples are located in the "Examples" sub-folder of the
Mediator program folder.

Wizards: The choice of wizards on which to base your projects has been extended to include wizards for HTML
and Flash export.

Unicode: Mediator 9 is now Unicode enabled, allowing users to enter text in objects that accept user input (such
as text objects or input objects) in many different languages, including non- western languages. (Please note,
however, that Mediator only supports left-to-right character entry.)

Merging of Exp and Pro versions: All the features previously reserved to Mediator Exp have now been
integrated in Mediator 9, vastly extending its potential.

The Exp features that are now part of Mediator 9 include:

e Script and Macros: Add runtime script (VB or Java) or macro script to your pages. See "Using runtime
script” and "Using macro script".

e Animation Track action: Gain total control over object position, size, rotation, opacity and speed. See
"Animation Track".

e ActiveX object: Use any existing ActiveX object or create your own. See "The ActiveX object".

e HTTP request: Use the HTTP request in your HTML or Flash export to communicate with web servers. See
"The HTTP Request resource".

10


http://www.matchware.com/en/products/mediator9�

Text object: Mediator's text object has been completely redesigned, giving you access to all the features you
would expect from a standard word processor, such as a broad range of text formatting options including indents
and justification, the ability to create and format tables or insert pictures, spellchecking options and so on.

For more information, see "The Text object".

Smooth 3D transition effects: Mediator 9 includes some impressive real 3D effects for use in page transitions.
These Direct 3D page transitions work on any computer with a graphic card that supports Direct 3D 9.0
(standard for most of today's PC's). If a Mediator 9 project is shown on a computer without Direct 3D 9.0, a
normal transition is used.

Sound and actions: Sounds are now represented by a "wave" in the Timeline action, making it much easier to
synchronize actions with sound. For more information, see "Timeline".

SCORM: With Mediator 9, it is now possible to create a SCORM-compliant course for export to Flash or
HTML and upload to a Learning Management System (LMS) or Virtual Learning Environment (VLE).
Exchange of data between the course and the LMS takes place via two specific SCORM actions, Set SCORM
Variable and Get SCORM Variable.

For more information, see "Using SCORM".

HTML object: The new HTML object lets you embed HTML code into your Mediator page. If you are working
on an HTML project, the object can include any code, including server-side scripting such as ASP or PHP. The
HTML object also contains some predefined HTML code samples that you can use as is or adapt for your
individual projects.

For more information, see "The HTML object".

Scrolling HTML pages: In earlier versions of Mediator, HTML pages could only be designed in a preset screen
resolution. Mediator 9 allows you to choose different page heights for your HTML project and lets you adapt
dimensions to individual page content, as you would with an HTML editor.

Improved HTML support: The Bump Map, Drawing and Headline objects, as well as the Loop/Break action
and the HTTP Request resource, are now supported in HTML export.

XML site map: Mediator 9 also allows you to generate an XML site map for your web site automatically, thus
improving the visibility of your web pages by search engines.

Validation of HTML code: All the HTML code produced by Mediator when exporting to HTML is now
validated according to the W3C HTML 4.01 standard. This ensures that all the common browsers will render the
page content as expected.

Improved Flash support: Video files (.flv) and List Box objects are now supported in Flash export. You can
also export the Flash project as a single Flash file, for easier management and faster page transitions.

Improved interactivity: Mediator 9 includes two new double-click events, a sub-procedure action, array
variables, and a number of other enhancements designed to make it easier to create interactivity.
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Important terms

Most of the terms used in Mediator belong to the familiar Windows® environment. Some terms however
represent important concepts in Mediator. They are defined below.

Data files
All the files that you attach to your project, such as pictures, videos and sounds, are referred to as data files.
Design mode

Mediator can operate in three modes, design mode, test mode and runtime mode:
e Design mode is the mode you spend most of the time in while creating your project.

e Test mode is the mode you use to test that it works properly before you export it. Testing your project allows
you to check how it will look and behave once exported, without having to go through the actual export
procedure.

¢ Runtime mode is the mode used when you or your end users view the exported version of your project.
Display profiler

Because it is not possible to define a single method for displaying data that is guaranteed to be the fastest
regardless of the computer used, Mediator profiles the computer the first time it is run, and selects the fastest
options for that particular system. This ensures that your projects will run with maximum speed on all
computers.

Document type

Mediator allows you to create projects of different types, namely Standard, HTML and Flash. Because some of
the features and effects available in Mediator are not supported on the Internet, Mediator automatically adapts its
user interface to the document type you choose. See "Mediator 9 feature list" for more information.

Exporting
Mediator lets you export your projects to create CD-ROM versions, HTML web sites, Flash files and so on.

You can distribute the exported version of your project to end users that do not have Mediator installed on their
computer. End users are able to run your exported projects, but not to edit them. See the section "Exporting:
Introduction™ for more information.

End users
These are the users to whom you distribute the exported version of your project.
Mediator Viewer

The Mediator Viewer is the cut-down version of Mediator that allows your end users to view your project once
exported. It is automatically packaged with your project when you export it to any format other than HTML or
Flash®. When exporting to HTML or Flash, the Mediator Viewer is not needed as the project is viewed via the
Internet browser.

Objects

This is the word used to refer to all the items that you can place on your page, such as backgrounds, text,
pictures, videos and so on.

Presentation - Project - Document

All these terms are synonyms. They refer to the Mediator project that you create with Mediator and then export
for distribution to your end users. See "Exporting" above.

Runtime mode and Test mode

See "Design mode".
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Mediator 9 feature list

Mediator allows you to create projects of different types. When you create a new document, you can choose

between:

Because some of the features and effects available in Mediator are not supported on the Internet, Mediator
automatically adapts its user interface to the document type you choose, and only shows the features, options and
export formats that are relevant to it. Projects of type HTML or Flash do not have as many tools, effects, events
and actions available as projects of type Standard.

For more information about document types, see "Planning your project” and "Creating a document”.
The following tables give you a complete list of all objects, events and actions available for each document type.

You will also find a complete list of the restrictions applicable to HTML and Flash documents in the topics

Standard to create a multimedia presentation to be stored on CD-ROM or other removable storage medium
(DVD-ROM, USB stick etc.)

HTML to create an HTML presentation or HTML web site

Flash to create a Flash banner or Flash web site

"HTML restrictions" and "Flash restrictions".

Objects Standard HTML FLASH
Picture ° ° °
Hotspot °
Rectangle ° ° °
Polygon ° ° °
Drawing ° new °
Bump Map ° new °
Text ° ° °
Hypertext ° ° °
Headline ] new o
Media Player ° °
Video ] new
Animated GIF ° ° °
Flash ° ° °
Button ° ° °
Animation Path ] o o
Embedded Document °
HTML Object new new
Input/Output Object ° o o
List Box o new
ActiveX °

13




Events Standard HTML FLASH

Mouse Click ° ° °
Mouse Down ° ° °
Mouse Up ° ° °
Right Click °

Right Down ]

Right Up °

Mouse Double Click new

Right Double Click new

On Page Ready ° ° °
On Mouse Move ] °
On Key Down ° °
On Key Up ° °
Move Into [ ° °
Move Out ° ° °
On Show ° °
On Hide o o
Drop On ° °
On Start ] L]
On Stop ° ° °
Collision o

Marker Hit ®

Document Complete °

On Select °

On Change ° °
On Ready State (Flash) ° °
ActiveX °
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Actions/Resources Standard HTML FLASH
Go to Page ° ° )
Show Object ° ° °
Hide Object ° ° °
Timeline ° ° °
Set Cursor ° ° °
Move Cursor ]
Exit o
Set Property ° ° °
Animate ° ° °
Animation Effect °
Animation Track o °
Sound ° ° °
Sound Volume o °
Start ° °
Stop ° °
Pause ° )
Wind o
Drag & Drop ° °
CD Audio °
Execute ]
Web Link ° ° °
INI File °
Open Doc °
Email ° ° °
Open MD8 Doc °
Report °
Assign File o
Read File °
Write File o
Delete File ®
Assign ° ° °
If-Then-Else ° ° °
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Loop ] new new
Break o new new
Sub Procedure new new new
Script °

Set List Box Data °

Message Box ° )

DB Pointer ]

DB SQL °

Set SCORM Variable new new
Get SCORM Variable new new
Click Here Cursor ° ° °
Print Page °

Standard Drag & Drop ° °
Database resource °

HTTP Request resource ° new °
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Installation

Stand-alone installation
» Insert the CD-ROM in the CD-ROM drive.
» Follow the instructions on the screen when the Mediator Install program starts.
If the Mediator Install program does not start automatically:
» Choose Start - Run.
» Type the following:
X:\start.exe

where X represents the CD-ROM drive letter.

Administrative installation (system administrators only)

The Windows® Installer can perform an administrative installation of an application or product to a network for
use by a workgroup. An administrative installation installs a source image of the application onto the network
that is similar to a source image on a CD-ROM. The administrative installation package can then be pushed by
system administrators to client computers in a domain via Group Policies. This is only possible from Windows
2000 Server onwards.

To find out more about Windows® Installer and administrative installations, please refer to the Microsoft web
site.

Creating an administrative installation

Administrators can create an administrative installation from the command line by using the /a command line
option.

» Choose Start - Run.
» Type the following:

msiexec.exe /a X:\install\setup.msi

where X represents the CD-ROM drive letter.

(please check the location of the setup.msi on the CD-ROM)
»  Specify the following in the dialog that appears:

e Where you want to unpack the .msi file
e The user name and company name to use as default
e The serial number

» (optional) Check 'Force activation when Mediator is run' if you want Mediator to be automatically activated
the first time the program runs.

» (optional) Check 'Automatically activate during installation’ if you want to activate Mediator during
installation.

@ These two activation options are "silent"” (i.e. they do not display any messages).

Q The above options are stored in a file called "admin.ini" in the destination folder. You can edit this file using a text
editor like Notepad if you want to change the options without making a new administrative installation.



Applying a patch package to an administrative installation
» Choose Start - Run.

>  Type:
msiexec.exe /p <path to .msp file> /a <path to administrative .msi file>

Members of the workgroup using Mediator must then reinstall the application from the new administrative
source image to receive the update.

To completely reinstall the application and cache the updated .msi file on their computer, users may enter either
of the following commands:

e msiexec.exe /fvomus //server/<administrative .msi file>

e msiexec.exe /1 //server//<administrative .msi file> REINSTALL=ALL
REINSTALLMODE=vomus

Troubleshooting
Changing the location of the activation file
By default, the activation data is stored in:
C:\Documents and Settings\All Users\Application Data\mwas\Mediator 9.0 Exp.mwas

In some rare situations, client computers may be setup with restricted access to the above folder, and this will
cause the activation file not to be saved. If you have a client server system setup in this way, you can move the
activation file to another location by adding an entry to the admin.ini file as follows:

[Activation]
mwas=c:\different folder with write access\Mediator 9.0 Exp.mwas

Storing several activation files on the server

You can store several activation files in the same folder of the server by adding an entry to the admin.ini file as
follows:

[Activation]
mwas=\\server\activations\Mediator 9.0 Exp_%COMPUTERNAME%.mwas
Where:
server = the name of the server
activations = the share name on the server
%COMPUTERNAME% will be replaced with the client computer name
Problem applying a patch
Q. Nothing happens when | double-click the patch file (ex. patch.msp).
A. The .msp file extension may be allocated to an application other than the Windows installer.
In this case, you can apply the patch as follows:
> Chose Start - Run.
» Type the following command:
msiexec.exe /p c:\temp\patch.msp

(assuming that you have copied the .msp file to c:\temp)
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Quick Start

The three basic steps

This Quick Start section contains all you need to know to get started with Mediator.
There are really only three basic steps that you must learn. They are:

1. Creating objects (to add objects to the initial page)

2. Using the Page list (to create additional pages)

3. Using the Events dialog (to create interactivity)
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Creating the document

When you start Mediator, the first screen you see is the Welcome dialog.
» Click 'Create a new document' to create an empty document.
» Click OK to accept the default document type, i.e. 'Standard'.

» Click OK to accept the default window mode, i.e. 'Full screen with frame'.

Q. If you have closed the Welcome dialog, you can create a new document by pressing Ctrl + N.
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First step - Creating objects

[The complete Mediator document "Quick Start.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

The word "object" refers to all the items that you can place on your pages, such as backgrounds, text, pictures,
videos and so on.

To place objects on your pages, you use the Insert tab on the main menu (called "the ribbon™).
»  Click the Insert tab.

B O00OZE A O @E O e xny s =e R
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You add an object to the page by clicking once with the left mouse button on the corresponding icon. The mouse
pointer changes depending on your selection and you can now define (drag) a rectangular shape on the page for
your object. The procedure is the same for all objects except for the Text object, the Polygon object and the
Animation Path object.

We are going to start by placing a rectangle on the page:

Click the Rectangle icon in the Illustrations group.
Move the mouse pointer back on the page.

Hold the left mouse button down and drag the pointer across the page to create a frame for your rectangle.

YV V VYV V

Let go of the mouse button to complete the rectangle.

The Format tab specific to the Rectangle object opens at the right of the ribbon, letting you modify the
properties of the rectangle.
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» Browse through the style gallery, checking the effect of each style on your rectangle as you move the
pointer.

» Once you have found a style you like, click it to apply it to the rectangle.

You can use the other options of the Style group to apply more visual effects to the rectangle, but for now we
will leave it as it is.

Now place a headline at the top of the page:

» Click the Insert tab again.

» Click the Headline icon 1A1 in the Text group.

» Move the mouse pointer to the top left corner of the page.

» Hold the left mouse button down and drag the pointer across the page to create a frame for your headline.
The Headline Object dialog appears.

> Enter "My first Mediator presentation™ and click OK.

The Format tab specific to the Headline object opens at the right of the ribbon, letting you modify the properties
of the headline.
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» Browse through the style gallery, checking the effect of each style on your headline as you move the pointer.
» Once you have found a style you like, click it to apply it to the headline.

As for the rectangle, you can use the other options of the Style group to apply more visual effects to the headline,
but for now we will leave it as it is.

Now place a button on the page:

» Click the Insert tab again.

Click the arrow in the lower part of the Button icon = in the Controls group.

>
» Browse through the categories of predefined buttons and click the one you like best.
» Move the mouse pointer to the bottom right corner of the page.

>

Drag a frame for your button as you did with the rectangle and the headline.

QI You can also just click the left mouse button once.

> Double-click the button.

The default text is "Button", but you can enter any text you like.

In Step 3 we will program the button to go to the next page, so instead of "Button"...

» ... type "Next" as the descriptive label for the button.

» To complete the button, press Esc or click anywhere outside it.

Q To edit the text shown on a button or headline after their creation, just double-click the object. To move an object, click

it once to select it and drag it into place while keeping the mouse button down. To resize an object, click it once and pull one
of its handles.

Wy tirst Mediatior presentafion

I l;

This completes Step 1. You now know how to create objects.

21



Second step - Using the Page list

[The complete Mediator document "Quick Start.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

All the pages contained in the presentation are listed in the Page list. So far we only have one page, called
"Pagel" by default.

QI If the Page list is not already open, click the View tab on the ribbon, then click Page List in the Show/Hide group, or
just press F8.

The next step is to create another page in our Mediator presentation.

» Click the Home tab on the ribbon.

Y

»  Click the upper part of the New icon |—| in the Pages group.

Q. Here we are creating a standard, default page. Clicking the lower part of the New icon would let you browse through a
whole range of predefined page layouts.

Mediator asks for a name for the new page.
» Enter "Page2" and click OK.

You have just created the second page of your document. As you can see the Page list now contains two pages.

X

Mediator places the new page after the current page and automatically switches to the new page, so you can start
adding objects to it right away.

To skip back and forth between Pagel and Page2 simply click the page you wish to work on in the Page list.
This actually completes Step 2, but before we move on we will add a picture and a text object on our new page.
Let us start with the picture.

» Click the Insert tab again.

Click the Picture icon M in the Illustrations group.
Move the mouse pointer back on the page.

Hold the left mouse button down and move the pointer across the page to create a frame for the picture.

vV V VYV V

Let go of the mouse button.
The Open dialog appears so that you can specify the picture you would like to import.

»  Select the picture Traffic.png' from the Quick Start folder.
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Click Open to insert the picture.

The Picture Adjust Size dialog appears. This dialog allows you to adjust the size of the picture. We won't go
into it here, so for the moment just click OK. For more information on the Picture Adjust Size dialog see "The
Picture object".

We are now going to place a text object on the page:

»

>
>
>

Click the Insert tab again.

=
Click the Text icon \J in the Text group.
Move the mouse pointer to the top left corner of the page.

Drag a large frame for your text object on the screen.

The Edit tab opens at the right of the ribbon.

>
»

>

Enter "Traffic and the city" in the text object.

Use the tools from the Font and Paragraph groups of the Edit tab to change the font, resize the text, make
it bold etc., as you would with your usual word processor.

To exit text editing click the Close icon at the right of the Edit tab or click anywhere outside the text field.

You now have two separate pages: Pagel (with a rectangle, a headline and a button) and Page2 (with a picture
and a text object).
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Traffic and the city

This completes Step 2. You have learned to use the Page list and create additional pages.

Third step - Using the Events dialog

[The complete Mediator document "Quick Start.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

You have created two independent pages very quickly. You are now going to create links between the two pages,
or in other words interactivity.

For this we will use the Events dialog. The Events dialog is what makes Mediator so incredibly powerful. It lets
you drag and drop your way to impressive presentations, without any kind of programming.

Events on Page: Pagel x
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First we will link Pagel to Page2.
» Click Pagel in the Page list.
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QI If the Page list is not already open, click the View tab on the ribbon, then click Page List in the Show/Hide group, or
just press F8.

» Click the "Next" button you created on the page.

The button now has handles around it, indicating that it is selected.

We would like to "program" the button to take us to Page2 when clicked.
To apply this functionality we need to open the Events dialog:

» Right-click the button.

» Choose Events in its local menu.

The Events dialog appears. This is where we will now program the button.
Events on Objeckt: Next =
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The left side of the Events dialog shows the list of all the possible events. An event is something that can happen

to an object. For instance the object may receive a left mouse click or a right mouse click, the mouse pointer may
be moved into it, and so on.

The top of the dialog shows the list of all the possible actions. An action is something that is triggered by the
event. For instance, we may want to go to another page, play a sound, start an animation and so on.

Creating interactivity in the Events dialog always consists of combining at least one event with one or more
actions.

Here, in order to make the button go to Page2, we must combine the event Mouse Click with the action Go to
Page.

@
» Click the event Mouse Click —’w. and drag it into the large empty area (called the "active field").

» Click the action Go to Page iij and drag it into the active field to the right of Mouse Click.

When you drop the Go to Page action the Go to Page dialog appears.
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This dialog lets you select the page you wish the button to go to.

4

Every time you drag a Go to Page action into the active field the Go to Page dialog opens a page list
automatically.

This page list is identical to the standard Page list, except that it holds 7 additional special pages, the @pages.
For now these @pages are not important, but you can find out more about them in the topic "Go to Page" that
describes this action.

You can now select the page you want the button to go to.

»  Select Page2 from the Page list and click OK at the bottom of the list.

The name Page2 appears in the page field in the top left corner of the Go to Page dialog.
» To close the Go to Page dialog click OK in the bottom right corner.

The Events dialog has now changed slightly.

The Mouse Click event icon is unchanged, but the Go to Page action icon is now labeled "Page2", of course
indicating that you have programmed the button to go to Page2 when clicked.
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Let us test the presentation to see if the button works.
» Close the Events dialog by clicking the Close button or the small X icon in the top right corner.
» Click the Review tab on the ribbon.

=

> Click the Run Document icon = in the Test group.

You now leave desigh mode and enter test mode, meaning that you will get a preview of what your presentation
will look like once exported and run on another computer.

» Click the button you created.
Your presentation skips to Page2.

On Page2 there isn't anything you can click, as we have not set up any interactive events and actions yet on that
page. We will, however, do so right now.

> Exit test mode and return to design mode by pressing the Esc key.

QI You can also enter test mode by pressing F5. You always return to design mode by pressing Esc.

You are now on Page2. If not, click Page2 in the Page list.

We would like to create a link on Page2 that will take us back to Pagel, and again we will use the Events dialog.
Making an object interactive is always done by opening its Events dialog to combine events and actions.

All objects, not just buttons, can be interactive. We would like to go back to Pagel by clicking the picture shown
on Page2.

» Right-click the picture and choose Events in its local menu.

The Events dialog appears. Once again we will combine events and actions in order to make an object (the
picture) interactive.

@
» Click the Mouse Click event —’MA from the events field on the left and drag it into the active field.

» Click the Go to Page action iij from the actions field at the top and drag it into the active field to the
right of Mouse Click.
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The Go to Page dialog appears, again with the Page list already opened.
» Select Pagel.
» Click OK at the bottom of the Page list.

Pagel now appears in the Page field of the Go to Page dialog. Earlier we just asked you to click OK to close the
dialog and test the presentation. However before you close the dialog you can choose one of the many different
transition effects available for the page turn.

I Go to Page [z|

Fage:

|F'age1 |
3D Fade | Special | Scroll | £oom 5:::ftHeveaI| Reveal

~

Duaration [mz];

B00 |

Curtain Open
Speed control:

<:t =1 ’:/‘\.‘.ﬂ.‘

|
=
| ——
Curtain Cloze £oom Linesz )
Center Presview:

Small Center  Medium Center

Tiles Tiles
[uu [~ v
(] ] [ Cancel

Page turn effects are divided into different categories.

|3D |Fa|:|e Special | Scroll | Zoom || Soft Reveal | Reveal

You can scroll up and down in each category, click an effect, and see a preview of it in the preview window.

Presview

» Find an effect that you like and click it.
» Click OK to close the Go to Page dialog.
Let us now test the presentation to see if clicking the picture takes us to Pagel as expected.

» Close the Events dialog by clicking the Close button or the small X icon in the top right corner.

» Choose Review | Test | Run Document " as earlier or press F5.

Your presentation goes in test mode, starting on Pagel.
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QI To start test mode on the current page instead, choose Review | Test | Run Page LY on the ribbon or press F6.

3

» Click the button on Pagel.

Your presentation goes to Page2.

»  Click the picture.

Your presentation goes back to Pagel, this time using the selected effect.
You can now click back and forth between the two pages.

> Exit test mode and return to design mode by pressing the Esc key.

You have just created a 2-page slideshow with linked pages.

Q If you wish to use a different effect or go to a different page, open the Events dialog and double-click the Go to Page

action. To select another page (once you have created more pages than the two you have now) click the small button I_i% to
the right of the 'Page’ field. This is the Browse button: it opens the Page list.

In a very short time you have created your first Mediator presentation. You have also learned Mediator's three
basic steps.

You can now quit this Quick Start here, or go on to "Further steps" and learn how to:

e Show and hide text using the Move Into and Move Out events

Play a sound

Start and stop a video

Create an animation
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Further steps

Further steps - Showing and hiding an object

[The complete Mediator document "Quick Start_Further Steps.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

So far we have only looked at the Mouse Click event and Go to Page action. Now we will go one step further
and look at the events Move Into and Move Out and the actions Show and Hide.

» Go to Pagel (click Pagel in the Page list or press the Page Up key).

| A

Click the Text icon J in the Insert tab.

Drag out a frame for your text object next to the rectangle without overlapping it.

Enter some text to describe the rectangle, maybe something like "This is a simple rectangle".

Format the text (font, font size, color and so on).

vV V VYV V V

Click outside the text frame to exit text editing mode.

We would now like to display the text when the mouse pointer is moved into the rectangle and hide it when the
mouse pointer is moved out of the rectangle.

In order to apply interactivity to the rectangle (note that we want to assign the events and actions to the rectangle,
and not to the text) we must open the Events dialog of the rectangle.

> Right-click the rectangle and choose Events in its local menu.

The Events dialog appears. We will now use the two events Move Into and Move Out.

» Click Move Into =/ in the events list and drag it into the active field.

A,
» Click Move Out = in the events list and drag it into the active field underneath the Move Into event.
Events on Object: Rectangle =

—_ Standard | Multimedia | External | Programming | Databaze | User

’:;I y—
BB - » A

' e 7 I
: b A H
o] EF:I g ) === S U
-':|SE G0 ko Page Show Hide Timeline Set Cursor  Move Cursar £
G © s 2
b ouze
Click. [a I
Move lnto
=)
On Show !
blowve Ot
=)
On Hide
7] 'I‘u'
Mouze
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We can now assign an action to each of these events. We want to show the text when the mouse pointer is moved
into the rectangle.

> Click Show & inthe actions list and drag it into the active field to the right of the Move Into event.

Standard |h-'|u|timeu:|ia External | Programming | Databasze | User

B g 8 o4 4

Go ko Page Hide Timneline Set Cursor  Mowe Cursor Exit

< R

Make sure you drop the Show action to the right of Move Into. If you accidentally drop the Show action to the
right of Move Out instead, simply drag it back to the right of Move Into (do not select a new Show action from
the actions field).

The Show Object dialog appears. It is similar to the Go to Page dialog, but instead of selecting a page you select
the object that you wish to show.

B Show Object [X]

Object

| |

aD Fade | Special | Scroll | Zoom 5:::ftF|eveaI| HEVEE'l

<:|::|:> | Duration [mz]:
I E |5IIIIII |
Hormnal Curtain Open
Speed contral;
I
i =1 — B ‘ \.‘ f'\-‘
Curtain Cloge Zoom Lines
Presiew:

8
i

Small Center  Medium Center
Tilez Tilez

E

i

Help

OF., { [ Cancel

» Click the button to the right of the 'Object’ field.

This is the Browse button @ It opens the Object list, showing you all the objects available on the current page.
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[ ] Rectangle

k. l [ Cancel

»  Select the text object "Text' and click OK.

You can now click OK to close the Show Object dialog or select an effect first. Selecting an effect in the Show
Object dialog is done exactly as in the Go to Page dialog.

Events on Dbjeckt: Rectangle
E @ Standard |Multimedia | Estemnal | Programming | Database | User |

= ) e =) B,
D C] C] == R wé}a .
Go ko Page Shio Hide

Timeline Set Cursor  Move Cursar 3

1
G & L& |
Mouse
Click, ﬁ@
kove [nto
g .
Or Show |£,
bave Out
=
On Hide
W
Mouse

» Nowclick Hide & in the actions field and drag it into the active field to the right of the Move Out
event.

Standard | ultimedia || Esternal || Programming || Databaze || Iger |

B S (CHN S

530 ko Page Shiow Timneline Set Cursor  Mowe Cursaor E:xik

£ | &

The Hide Object dialog appears. It is identical to the Show Object dialog.
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B Hide Object X

Object
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» Click the Browse button @ next to the 'Object’ field.
»  Select the text object "Text' and click OK.

You can now click OK to close the Hide Object dialog or select an effect first.

Events on Objeckt: Rectangle »

= = Standard |Multimedia External | Programming || Databaze || User
0
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¥
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You have just programmed Mediator to show the text when the mouse pointer is moved into the rectangle, and
hide it when it is moved out of the rectangle.

We are just missing one thing...

We do not want the text to be visible when the page first opens.
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Why not? Well, we only want the text to become visible when the mouse pointer is moved into the rectangle.
Therefore the text must be hidden when the page first appears.

Hiding an object is very simple.

» Right-click the text object.

» Uncheck Show Object in its local menu (remove the checkmark by clicking the option).
EM | Everts...

G| Rename...
Edit *
Arrange 4
v | show Object F3

[j Properties Flz

As you can see the object is still there, but it is now hidden.

S

Let us test the presentation to see if the rectangle works.
» Close the Events dialog.
Il( )

» Choose Review | Test | Run Document = or press F5.

Test your presentation to see if moving the mouse pointer in and out of the rectangle shows and hides the text as
expected. Of course you can still move back and forth between Pagel and Page2.

> Press the Esc key to exit test mode.

Ready for more? How to play music in Mediator is our next step.

Further steps - Playing a sound

[The complete Mediator document "Quick Start_Further Steps.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

By now, you know how to open the Page list and the Events dialog, and how to combine events and actions in
the active field, so we won't describe that in detail anymore.

Remember the rectangle on Pagel? A text label is shown whenever the mouse pointer is moved into it. Well,
how about playing a tune at the same time?

> Select the rectangle and open its Events dialog.

In the Events dialog you already have the Move Into and Move Out events combined with a Show and Hide
action respectively. You can place as many actions after each event as you want, so in order to play a tune when
the mouse pointer is moved into the rectangle simply drop the Sound action to the right of the Show action.

> Click the Multimedia tab above the actions field to see the multimedia actions.

i)

")
> Select the Sound action % .
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Standard | Multimedia |E:-:terna| Frogramming || Databaze | User

O @ Lt & Q. b

Set Properky Anirnake Animakion Animakion Sound Start
EFfect Track Yolurne

£ | >

» Drop it to the right of the Move Into - Show combination.

The Sound dialog appears, in which you select the sound file you wish to use.

» Click the Browse icon .‘E. to the right of the 'Path’ field.

»  Select the sound, for instance "Twist.mp3' from the Quick Start folder.

» Click OK.

To stop the tune when the mouse pointer leaves the rectangle you must use another Sound action.
» Select the Sound action in the Multimedia actions field.

» Drop it to the right of the Move Out - Hide combination in the active field.

» Check the option Cancel current wave sound.

Sound f'5_<|

Fath:
| |

[ ]| Repeat

[ ] Cancel current midi zound

Cancel current wave sound

[ ] Use streaming [only applies to Flash export]
Buffer [zec]:
Help OF. ] [ Cancel

The active field of the Events dialog should now look like this:

By = 9 — @

Mﬁa [t Test Tuwizt.mp3
o _ by & m
Ik_,-' =] I‘\

b e Out Test Saund

You are now ready to test the presentation.

» Close the Events dialog.

®

» Choose Review | Test | Run Document or press F5.
Does your presentation work as expected?

» Press Esc to exit test mode and go back to design mode.
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This is really impressive. You are now creating multimedia presentations with pictures, text and sound, and
you've only just started!

How about watching a video now? Just go on to the next step...

Further steps - Playing a video

[The complete Mediator document "Quick Start_Further Steps.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

Playing videos in Mediator is very simple. You create a frame for your video, select the video, and that's it.
Well, of course you can do a lot more, but let's get started.
» Open the Page list and click Page2.
» Right-click and choose New, or just press the Insert key.
» Enter a descriptive name for the new page, such as "Video".
» Click OK.
A new empty page appears on which we want to place a video.
»  Click the Insert tab.
g
> Click the Video icon “==. in the Media Clips group.
» Drag out a frame for your video on the page.
The Open dialog appears.
> Select the video 'Street.mpg' from the Quick Start folder.
» Click Open.
The Video Adjust Size dialog appears.
» Just click OK to let Mediator adapt the frame size to the video.

You are ready to test the page. Do not choose Run Document this time.

» Choose Review | Test | Run Page ﬂ or press F6.

The video starts automatically, plays once, then stops.

»  Press Esc to exit test mode.

We would like the video to start on demand, and repeat until paused.

> Select the video.

» Onits Format tab, uncheck Auto Start in the Play group.

This will prevent the video from playing when the page is first opened.

» Check Repeat.

Once the video is started, this will repeat it over and over until stopped explicitly.

You will now use two events that you haven't used before, Mouse Down and Mouse Up.

e Mouse Down is triggered when you click the left mouse button.

e Mouse Up is triggered as soon as you let go of the left mouse button.
» Right-click the video object and choose Events in its local menu.

The Events dialog for the video object appears.
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> Scroll down the events list.

o |
»  Select and drag Mouse Down “H”i into the active field.
Iﬂ' ]‘i‘

> Select and drag Mouse Up “~" ™ into the active field, underneath Mouse Down.

Events on Object: ¥Yideo =

e % Standard ||‘--1u|timeu:|ia External | Programming | Database || User
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m G0 ko Page Show Hide Timeline Set Cursor  Move Cursor t
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|§i~ bouze Down
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Right Click. we)

Wi
Right
Down

e

Right Up  +

|1

bouze Up

We now want the video to start when we click it, run for as long as we hold the left mouse button down, and
pause when we let go.

> Click the Multimedia tab above the actions field.

»  Select the Start action D and drag it into the active field to the right of Mouse Down.

The Start dialog appears.

Start [$_<|

Object/Resource:

| (=)
Help ] [ k. H Cancel ]

Click the Browse button @ to access the Obiject list.
Select the video object in the list (the only available object).

Click OK at the bottom of the list.

YV V VYV V

Click OK to close the Start dialog.

The video now plays when the left mouse button is held down.
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Events on Object: ¥Yideo
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» Select the Pause action

Click OK at the bottom of the list.

Y V V VYV

Click OK to close the Pause dialog.

Events on Object: ¥Yideo

E @ Standard | Multimedia | External || Frogramming || Databasze || Lzer |
& 4 & » @ ;
Anirmation Sound Sound Start Stop Pause iy
Track, Yolurmne
E.
= 4 >
Cit | >
We want to pause the video when the mouse button is released.
» Click the Multimedia tab above the actions field.
and drag it into the active field to the right of Mouse Up.
The Pause dialog appears. It is identical to the Start dialog.
Click the Browse button @ to access the Obiject list.
Select the video object in the list (the only available object).
E @ Standard | Multimedia | External || Frogramming || Databasze || Lzer |
& 4 & » @ ;
Anirmation Sound Sound Start Stop Pause iy
Track, Yolurmne
2

@‘i‘ﬁ< |
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You are ready to test the page. Do not choose Run Document.

)
» Choose Review | Test | Run Page |—P'f or press F6.
The video is paused. Click and hold the left mouse button down to play it. Let go of the mouse button to stop it.

» Press Esc to exit test mode.

@ Pagel and Page2 are not linked to the Video page. If you want to link them, create a button on Page2 that
takes you to the Video page (using Mouse Click and Go to Page "Video"), and possibly a button on the Video
page to go back to Page2 (using Mouse Click and Go to Page "Page2").

Now, are you in the mood for some movement? Carry on and learn how to animate objects.

Further steps - Animating an object

[The complete Mediator document "Quick Start_Further Steps.md8" used in this example can be found in the Mediator program folder, in
"...\Examples\Quick Start".]

The final topic in this Quick Start is a tutorial on how to animate objects around the screen.
» Open the Page list.
» Click the Video page.

We would like to animate an animated GIF across the screen.

» Choose Insert | Media Clips | Animated GIF e .

» Click once in the bottom left corner of your page to place it (animated GIFs are not resizable).

The Open dialog appears.

»  Select the animated GIF 'Car.gif' from the Quick Start folder.

» Click Open.

Now we would like to animate the car across the screen. First you must learn how to create an animation path.
D\

» Choose Insert | Controls | Animation Path = = .

The Animation Path Edit tab appears.

_E —:éF e ’ =] v . X
Select | Add | Delete Grid Break To ?“.rs.rl | | D_'J el Close
Poink Curve Position Editing

——

The Add Point icon + is activated, ready for you to create an animation path. Here we will create a simple
path with only two points, but you could create a path with many points joined by straight lines or curves.

» Click once in the bottom left corner of your page.
A white dot with a red rim appears. This is your first animation point.
» Click once in the top right corner of your page.

You have placed the second point in your animation path, and you can now see a blue line connecting point 1
and point 2.
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Your first animation path is complete.

» Click the Close icon at the right of the Edit tab to exit editing mode.
We now want to animate the car along the animation path as soon as it receives a click.

» Right-click the car and choose Events.

» Select Mouse Click @t and drag it into the active field.
» Click the Multimedia tab above the actions field.

» Select the Animate action % and drag it into the active field to the right of Mouse Click.
The Animate dialog appears with the Animation path field already filled in.
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Click the Browse button [ next to 'Object to animate'.

R

Select the animated GIF (the car).
Set Duration to 4000 (4000 milliseconds = 4 seconds). This defines how long the entire animation will last.

Select Fly from object position. This means that the car will be animated from its current position.

vV V VYV V V¥V

Select Follow animation path angle. This means that the car will be rotated in the direction followed by the
animation path, making the animation look more natural.

» Click OK.

You are ready to test the page.

» Choose Review | Test | Run Page |—Q€) or press F6.

The car is spinning its wheels, waiting for you to click it. When you do, it moves across to the top right corner of
the page, where it stays until you click it again.

The video starts as soon as you click it while holding the mouse button down.

You have just created a 3-page slideshow containing all the elements of a multimedia presentation: text, pictures,
sound and video.

You are ready to become a multimedia designer. Good luck!
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User Guide

Setting up your project

Setting up your workspace

The Mediator window is made up of several components:
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e The Mediator Button is displayed in the upper left corner of the Mediator window. It opens the Mediator
Menu, which contains commands affecting the entire document, such as New, Open, Save, Print or Export.

e The Quick Access Toolbar is a component of the Microsoft Office 2007 interface. It is a customizable
toolbar that is available at all times, regardless of the menu tab currently open on the ribbon. By default, it is
located in the upper left corner of the Mediator window, next to the Mediator Button.

e The Ribbon is also a component of the Microsoft Office 2007 interface. Its tabs, corresponding to the main
activities in Mediator, contain all the necessary commands, options and icons, organized in groups. It is
designed to help you quickly find the commands that you need to complete a task.

When a particular object is selected, a special Format tab may appear at the right of the ribbon. It contains
all the commands that are specific to the selected object.

e The Mediator Panels are displayed by default on the left of the Mediator window. Taken together, they give
you a complete overview of your project.

e The Mediator Workspace is the area you use to design your project.
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Customizing the Quick Access Toolbar

The Quick Access Toolbar contains the most frequently used commands. By default, it is located in the upper
left corner of the Mediator window, next to the Mediator Button.

H9-8[0% )F
Home Inserk Page
To move the Quick Access Toolbar closer to the workspace area:

> Click the Customize Quick Access Toolbar arrow ~ on the right of the toolbar.
» Choose Show Below the Ribbon.

You can also add the commands you use most frequently to the Quick Access Toolbar, or remove commands
you use less often. See "Setting up your preferences” for more information.

Minimizing the ribbon
Mediator lets you minimize the ribbon to increase the workspace available:

Click the Customize Quick Access Toolbar arrow " onthe right of the toolbar.
Choose Minimize the Ribbon.

To use the ribbon while it is minimized, click the tab you want to use, and then click the command you want
to use.

As soon as you have made your choice, the ribbon returns to its minimized form.

» To restore the ribbon, click the Customize Quick Access Toolbar arrow again and uncheck Minimize the
Ribbon.

You can also minimize the ribbon temporarily as follows:
» Double-click the current tab.

» To restore the ribbon, just double-click any of its tabs.

Q You can also press Ctrl + F1 to minimize or restore the ribbon.

The layout of the commands, options and icons in the ribbon changes when the width of the Mediator application
window is reduced. Controls normally represented by large icons may for instance now be represented by small
icons. If the width of the application window is greatly reduced, a group may be represented only by its icon.

(=] = | ¥ Mediator 9 - [Mediator... - = X
Home Insert Fage Review Yig - O X

= ) xy i

ShovefHide || Interactivity | Programming | Workspace
Docurment | | Sindow

» To view the contents of such a collapsed group, just click its icon.

Using access keys and shortcut keys

To select a command from the ribbon, all you need to do is click the relevant tab to open it, then choose the
command.

You can also use access keys for this purpose. Access keys are different from shortcut keys.
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e Access keys are used to navigate through the interface and select its different commands using the keyboard.
Each command shown in the Mediator Button menu, the Quick Access Toolbar and the Ribbon has an access
key.

e Shortcut keys are key combinations such as F1 or Ctrl + O used to perform frequently used commands.
Shortcut keys are not related to the organization of the commands in the interface. You will find a list of all
the shortcut keys used in Mediator in "Appendix 1: Keyboard shortcuts".

» To select acommand using an access key, start by pressing the Alt or F10 key. You will now see the first
layer of access keys you can use at that point displayed as small labels underneath each tab or command.

27 (5)
.- Iﬁt F' RLEnimwm
do [ L @]

Paste  Cut  Copy Duplicate Mew Delete Rename  Colar

Clipboard Pages

»  Press the access key for the tab or command you require to see the second layer of access keys.

For instance, pressing H above will open the Home tab and display its access keys, as shown below.

B9 -8[% )+
Home Insert Page Review Wigw

o . N o)
B [ o)

Paste Ut Copy Duplicate Mew Delete Rename Color
LY Clil:ltll:lllf?ﬂ'l G Pageﬂl lEl

» Press the key or keys corresponding to the command you want to select.

For instance, pressing P, then R above will open the Rename Page dialog.

Using the Mediator panels

The two Mediator panels displayed by default on the left of the Mediator window give you a complete overview
of your project:

e The Page List lists all the pages making up your project.

e The Object List lists all the objects placed on the current page.

The View tab gives you access to other important panels and dialogs:

0D R T

Page | Object |Properties Multimedia Mulk-User || Events
Lisk Lisk Catalog  Status

e The Properties dialog lets you view and fine-tune all the properties applicable to the currently selected page
or object.

e The Multimedia Catalog contains a vast collection of high-quality multimedia elements organized in
different categories and themes which you can drag on the pages of your project.

e The Multi-User Status window is useful when working in multi-user mode. It reflects in real-time all the

accesses made to the document by its concurrent users, giving the user name and computer name of each
user.
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e The Events dialog is responsible for all the activity in a Mediator project. It contains a list of events
applicable to the selected object, to which you can associate various actions by simple drag and drop.

The Page List, Object List and Properties dialog always reflect your latest selections or changes:
e When you select a page in the Page list, the Object list is refreshed to show the objects available on that
page.

e When you select an object in the Object list, the Properties dialog is refreshed to show the properties of that
object.

e When you change the name of an object in its Properties dialog, the Object list is updated to reflect that
change.

Please refer to the specific sections describing these panels for more information on how to use them. The
Reference section contains an in-depth description of all the Mediator objects together with their Properties
dialog.

Resizing panels

» To resize a panel, move the pointer on one of its edges until it changes to a double arrow and drag with the
mouse in the required direction.

Undocking panels

It is usually helpful to keep some of the panels open on your workspace while designing your project. To ensure
they take as little space as possible, the Page list and Object list are docked on the left side of the screen when
you first open Mediator.

You can however undock each panel as required.

» Toundock a panel, just drag its title bar away from its current position until it is completely free, then let go
of the mouse button.

Ql You can also double-click the title bar of the panel to undock it and double-click it again to redock it. If you want to
undock a panel and move it freely on the workspace without it “snapping" to a docked position, press the Ctrl key and hold it
down while dragging the title bar of the panel.

Docking panels

You can dock an undocked panel to the left, right, top or bottom edge of the workspace as follows:

» Drag the title bar of the panel and move it in the direction required until you see the arrow shapes left u

required arrow until you see a darker shade of blue outline the new position. Release the mouse button if
you are happy with this new position, else continue dragging to the required position.

You can also dock a panel above, below or on the side of another panel. To do this:

> Drag the title bar of the panel and move it in the direction of the target panel until you see a four-arrow
shape appear.

You now have different possibilities:

e Moving the panel over the left, right, up or down arrow will dock it on the corresponding side of the
underlying panel.
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Here for instance, the Object List is being docked to the right of the Page List.

o Moving the panel to the middle square will integrate it as a tab of the underlying panel, converting it to a
multi-tab panel.

Here, the Object List is being integrated with the Page list as a tabbed panel.

— r

» To free such a tabbed panel, drag it by clicking its tab, not its title bar.
To separate the Object list from the Page list in the example below, you would therefore click the Objects
tab.

s [ Button

-----

e @ Wideo

Pages ‘ Objecks '
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Resetting panels to their default position
If necessary, you can reset all the panels to the default position they had when you first installed Mediator:

» Click the Mediator Button.

» Click Mediator Options in the bottom right corner of the dialog.
> Click Preferences on the left.

» Click Reset Interface.

When using this command, note that other components, such as the Quick Access Toolbar or the list of recently
opened files, are also restored to their defaults.

Using the Mediator workspace

The area available to you to design your project is called the Mediator workspace.

The Mediator document is represented in the middle of the workspace. This area is referred to as the "page”, and
you define its size (also called "resolution™) when you create the document.

The workspace is always three times wider and three times higher than the page. So if your page is 1024 pixels
wide and 768 pixels high, the workspace will be 3072 pixels wide (i.e. 1024 x 3) and 2304 pixels high (i.e.
768 x 3).

Although the page is the only visible area when testing or running the exported version of the project, you can
use the entire workspace when designing your project. You could for instance hide objects initially by placing
them outside the page, and then animate them into the page as a result of a user action. Or animate out of the
page an object initially placed on the page.

Q You may also use the non-visible workspace to store objects that you are not sure about, but don't want to delete yet.

Obijects can be twice as high and twice as wide as the page, except for animation paths, which can stretch across
the entire workspace. If for instance the page is 1024 x 768, the maximum object size is 2048 x 1536 pixels.

To move around the workspace, you can:
e Use the scroll bars

e Press and hold down the Space bar or the Ctrl key while dragging the page.

Setting up your preferences

o L
=22 The Mediator Options dialog lets you customize your environment and gives you access to external web
resources.

» Click the Mediator Button.
» Click Mediator Options in the bottom right corner of the dialog.

The Mediator Options dialog that opens contains several panels, corresponding to different options.

Proofing options

This dialog contains various options which you can set to determine the type of errors reported by the
spellchecker.

It is described in detail in the topic "Spellchecking options".

Saving options

Create backup of document files: Creates a backup of the md8 file and saves it as a *.bak file. The *.bak file is
a copy of the last saved version of your document. See "Saving a document" for more information on this
feature.

47



Save auto-recovery info: When this is checked, Mediator saves a copy of your open documents automatically at
regular intervals. If the Mediator session ends abnormally, Mediator asks you upon restart whether you want to
auto-recover your lost work. Set the interval between automatic saves in the time field. See "Saving a document"
for more information.

Advanced options

Max Undo levels: This field lets you specify the maximum number of tasks that you want to be able to undo
using the Undo command of the Quick Access Toolbar.

Invisible objects, show name: Check this option to display the name of hidden objects in their top left corner. It
is advisable to keep this option enabled so that you have a way of detecting these objects during design.

Visible objects, show name: Check this option to display the name of all visible objects in their top left corner.
Show Welcome dialog when starting: If the checkmark is removed Mediator starts with an empty window.

Show Adjust Size dialog (picture): Here you select whether to show the Picture Adjust Size dialog when you
import a picture. The dialog lets you automatically adjust the frame size to fit the picture in its original size or,
conversely, scale the picture to fit the frame. See "The Picture object" for more information on this dialog.

Show Adjust Size dialog (video): Here you select whether to show the Video Adjust Size dialog when you
import a video. The dialog lets you automatically adjust the frame size to fit the video in its original size or,
conversely, scale the video to fit the frame. See "The Video object” for more information on this dialog.

Reset Interface: Clicking this button resets all the panels to their default positions. When using this command,
note that other components, such as the Quick Access Toolbar or the list of recently opened files, are also
restored to their defaults. See "Using the Mediator panels” for more information on resizing and docking panels.

Reset Multimedia Catalog: Clicking this button removes the elements you might have added to the Multimedia
Catalog and restores its original contents. See "Using the Multimedia Catalog™ for more information.

Check for program updates: This option allows Mediator to check for program updates via the Internet. You
can set the frequency of the checks in the time field, or disable the feature by removing the checkmark.

Customize options

This panel lets you add the commands you use most frequently to the Quick Access Toolbar, or remove
commands you use less often.

» Inthe field Choose commands from, choose the ribbon tab containing the required command.
» Choose the required command in the Commands field and click Add.

You can also add entire groups to the Quick Access Toolbar. Groups are denoted by a drop-down symbol

-

QI A quicker way to add a command to the Quick Access Toolbar is to click the ribbon tab containing the command you
want to add, right-click the command and choose Add to Quick Access Toolbar.

Clicking Reset will restore the original contents of the Quick Access Toolbar.

@ You can also access this panel by clicking the Customize Quick Access Toolbar arrow " onthe right of
the toolbar.

Resources

This dialog lets you access the MatchWare web site and obtain the latest product updates.
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Planning your project

The first step in creating a multimedia project is to plan its design and consider its essential features:

The type of media needed (video, pictures, animation features etc.)

e The level of user interaction required (buttons for navigation, hypertext, input text from user etc.)
e The platforms you wish to support (e.g. Windows® XP, Windows® 2000 etc.)

e The export format you require (CD-ROM, HTML, Flash etc.)

e The specification of the target computer (computer speed, screen and color resolution etc.)
Mediator offers three different document types, corresponding to its export formats:

Create a new Mediator document

Standard

Create a multimedia project For expart ko CO-ROM,
self-executable \EXE file or (ZIP file,

HTML
|_|_|j Create a multimedia project For export to HTHML,

L8

Flash
(F) Create a multimedia project For export ko Flash,

e The document type Standard lets you create a project for distribution on CD-ROM or other removable
storage medium (DVD-ROM, USB stick, etc), as a self-executable .exe file or as a .zip file. This is the
document type that gives you access to the most features.

e The document type HTML lets you create web sites with flying objects, clickable buttons, scrolling text,
timelines and much more. In other words, actions which would otherwise only be possible through advanced
programming.

This is achieved by the use of dynamic HTML and cascading style sheets. By contrast with standard HTML,
dynamic HTML allows the manipulation of objects which is at the core of the Mediator functionality.

Mediator lets you place each object exactly where you want on the HTML page. You can even let objects
overlap and insert more objects without displacing the existing ones, thereby giving you complete control
over the layout of your pages.

The Mediator HTML export does not use any plug-ins, Java applets or other special components. The only
requirement is that the end user must have a standard Internet browser such as Microsoft Internet Explorer 7
or later or Mozilla Firefox 2.0 or later.

e The document type Flash lets you create banners, web pages and full web sites in the widespread Flash
format. You can even create Flash files to be inserted into another Mediator project via the Flash object.

Because some of the features and effects available in Mediator are not supported on the Internet, Mediator
automatically adapts its user interface to the document type you choose, and only shows the features, options and
export formats that are relevant to it.

Once you have determined your preferred export format, you therefore need to check that the corresponding
document type does support all the features you require.

Please refer to the topic "Mediator 9 feature list" for a complete list of all the features available for each
document type. A complete list of the restrictions applicable to HTML and Flash documents can be found in the
topics "HTML restrictions™ and "Flash restrictions".

Q You can also create a dummy document of each type and check the features that are available to you.

For more information on the different export formats available, see "Exporting: Introduction”.
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When you plan the schedule for the project, make sure you include sufficient testing time. It is a good idea to test
each section as you complete it rather than to leave all the testing to the end.

You are now ready to proceed with the creation and design of your project. See "Creating a document" for more
information about this procedure.
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Designing your project

Working with documents

Creating a document

\}' When you start Mediator, the first screen you see is the Welcome dialog.

Welcome to Mediator 9

Create a new document

Open an exizting document

. '\Assign.mdS
e
@ Usze the template wizard to create a new document

[ Da not show this dialog again

Here you can select to:

e Create a new document

e Open an existing document

e Open one of the last documents you worked on in Mediator

e Use the wizard to create the framework for a new project using a ready-made template

You can bypass this screen next time you start Mediator by checking 'Do not show this dialog again'. To show it
again at a later stage, click 'Show Welcome dialog when starting' in the Mediator Options dialog. See "Setting up
your preferences"” for more information.

You can also create a new document by one of the following methods:

¢ Clicking the Mediator Button and choosing New.

¢ Clicking the New icon ! in the Quick Access Toolbar.

e Pressing Ctrl + N.

Specifying the document type

The next step is to define the type of document you would like to create. You can choose:

e Standard to create a multimedia presentation to be stored on CD-ROM or other removable storage medium
(DVD-ROM, USB stick etc.)

e HTML to create an HTML web site or HTML presentation

e Flash to create a Flash banner or Flash web site
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Mediator automatically adapts its user interface to the document type you choose here, and only shows the
features, options and export formats that are relevant to it. Projects of type HTML or Flash do not have as many
tools, effects, events and actions available as projects of type Standard.

Please refer to the topic "Mediator 9 feature list" for a complete list of all objects, events and actions available
for each document type. For a list of the restrictions applicable to HTML and Flash documents, see "HTML
restrictions™ and "Flash restrictions".

For more information on the different export formats available, see "Exporting: Introduction”.
9? You can change the document type at any time after its creation by clicking the Mediator Button and
choosing Prepare | Properties. When changing your document from Standard to HTML or Flash, you will

however need to check that all the elements, objects, actions and other features that you have used in your
project are indeed supported by the new document type. See "Document properties” for more information.

Creating a document of type Standard

When you choose to create a document of type Standard, the following dialog appears:

New Document E|
Mode Border

) window Color: I

Window size

(%) Full screen with frame (%) 800 » 600

(11024 » 768
() Custam

(3 Full screen

“afidth:

Height:

5] [ ool

» Click one of the buttons on the left to select the document mode. This determines how your project is
displayed when running on the end user computer, referred to in the description below as the "destination
computer".

The selection you make in this dialog is only relevant when testing the project or viewing its exported
version with the Mediator Viewer. In design mode, you always view the Mediator document in the Mediator
workspace.

You can select a different document mode at any time during design (see "Document properties™), so your
choice here is not critical.

e Window

In this mode, your project is displayed in a normal window on the destination computer. The end user can
move the window anywhere on the desktop and even place it behind other windows.

It is not possible to change the color resolution, which is automatically adjusted to the color resolution on
the destination computer.

@ You must use this document mode if you intend to use a custom shape window. See the topic "Custom
shape window" for a full description of this feature.
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e Full screen with frame

This mode is similar to the Window mode, except that the project is displayed in the middle of the screen
with a border covering the rest of the desktop.

The 'Color" field on the top right of the dialog lets you choose the border color. The default color is black.

e Full screen

In this mode, the destination computer desktop disappears when the end user runs the project and its screen
resolution changes to match the document size you specify in this dialog.

5@ Some computers do not support application switching when running in Full screen mode. As this
depends both on the operating system and the graphics card driver, it is not possible to determine in advance
which ones will or will not support it.

You should therefore choose one of the other two document modes if you intend to use an action involving
application switching, such as Web Link, Email, Execute, Open Doc or Open MD8 Daoc.

>  Select the document size required.

You can choose one of the standard sizes or the '‘Custom' option to specify your own size.

@ If you have selected the 'Full screen’ mode, you can choose the 'Custom’ option but you must select a
supported screen resolution.

You can also create irregular shapes by using a custom shape window. In that case, you should specify here
the same size as that of the mask picture you intend to apply. For a full description of this feature, see the
topic "Custom shape window".

You can resize the document later if necessary using View | Document | Resize. However, this is not
recommended as document scaling is almost never 100% accurate.

> Click OK.
You are now ready to start designing your multimedia project.

Creating a document of type HTML or Flash

When you choose to create a HTML or Flash document, the following dialog appears:

New Document §|

Wwiindow size Barder

(® 793 » 398 (800 » 500) Color. I
() 1007 » 566 [1024 » 768]

) Cuztom

it

Height:

k. ] [ Cancel

»  Select the document size required.

You can choose either one of the two standard sizes or the ‘Custom' option to specify your own size.

5@ The sizes available are slightly smaller than the standard sizes, to account for the space taken by the
toolbars and scroll bars of the Internet browser used to view the exported project.

These document sizes will allow the end user to see the whole page without any scrolling.
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If you intend to export your project to HTML and need more space vertically, you have two choices:

e If you need the same amount of additional vertical space on all your pages, just enter the required
document height here.

o If you need more vertical space on some pages only, you can set their height via their Properties dialog
by entering a higher value in the 'Height' property. See "Page properties: General tab" for more
information on this property. You can also do this simply by dragging the bottom edge of the page
downwards to the required size at any time during the design phase.

If you intend to export to Flash, you can also create a banner by entering one of the common banner
resolutions below:

e Large banner: 468 x 60

e  Small banner: 250 x 60

e Pop-up window 1: 400 x 250

e  Pop-up window 2: 400 x 400

You can also resize the overall document after its creation with View | Document | Resize.

» Click the 'Color' field on the top right of the dialog to choose a background color for the browser window.

@ You can change this color later on in the Screen tab of the Document properties dialog (see "Document
properties™).
> Click OK.

You are now ready to design your web project.

Saving a document

["_J—,-| Mediator documents are saved as md8 files.
To save a document:
> Click the Mediator Button.

You can now choose either:
e Save to save your document under its existing name and continue working in Mediator.

e Save As to save your document under a different name. This is also a way of creating a copy of your
document.

QI To save your document, you can also click the Save icon (5 in the Quick Access Toolbar or press Ctrl + S.

By default, the previous version of your document is automatically saved as a .bak file. To disable automatic
backups, uncheck 'Create backup of document files' in the Mediator Options dialog.

Once you have saved your document, Mediator helps you to keep track of all the files (pictures, sounds, videos
and so on) that you add to it from external drives. If for instance you use a picture file from a CD-ROM, another
external device or the Internet, Mediator asks you as soon as you insert the picture if you want to copy the
picture file to the project folder (i.e. the folder containing your .md8 document). This ensures that all the files
you use in your project are always available from your hard drive.

Recovering a backup file (*.bak)

If you save a document after having made some changes which you wish you had not made, you can restore the
previous version of the document as follows:

» Click the Mediator Button and choose Open.

» Browse to the folder containing your Mediator document and enter the file name *.* in the Open dialog to
view the list of all the files contained in that folder.

»  Select the filename.bak file, where filename is the name of your Mediator document and click Open.
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» Click the Mediator Button and choose Save As to save the .bak file under its original .md8 name to
overwrite the incorrect version of the document.

Auto-recovery

By default, a temporary copy of your document is also saved automatically at regular intervals to allow auto-
recovery in the event of a program failure. To disable automatic saving of auto-recovery information, uncheck
'Save auto-recovery info' in the Mediator Options dialog.

@ This feature is only available if your document has been saved at least once.

When auto-recovery is enabled, a temporary copy of your document is made as follows:
e At the frequency specified in the Mediator Options dialog

e Just before entering test mode when you use one of the options of the Test group in the Review tab

In the event of a program failure during testing, this gives Mediator the possibility of recovering the last changes
you made before testing, even if you had not saved the document. The first time you start Mediator after the
forced exit, Mediator asks you whether you want to auto-recover the last changes you made or ignore them.

Opening a document

—
=== To open a document:

» Click the Mediator Button.
» Choose Open.

QI You can also press Ctrl + O.

@ Mediator also lets you open documents in multi-user mode. For more information, see "Using multi-user
mode".

Converting Mediator documents from previous versions

Mediator 9 can convert documents created with Mediator 7 or Mediator 8.

Important: Before un-installing the previous version of Mediator and converting your existing documents to
Mediator 9, you should create a "Copy to Folder" distribution of these documents by choosing File | Create
Distribution Files | Copy to Folder in the version of Mediator you used to create them (Mediator 7 or 8). This
will ensure that all the resources used in your project will be copied from their various locations and placed in
your project folder (i.e. the folder containing your .md8 document). This is particularly important if you have
used Mediator resources in your project, such as resources from the Multimedia Catalog, since their path may
not be the same in Mediator 9.

Note that the Keywords list (extension .KIX) and the Text search list (extension .S1X) maintained by Mediator 7
and Mediator 8 in the project folder alongside the main Mediator file (the .md8 document) are now embedded in
the .md8 document itself by Mediator 9.

» To convert a Mediator 7 or Mediator 8 document to Mediator 9, just open it in Mediator 9.

Media Player objects in Mediator 7 documents

Since Mediator 8, Mediator requires Media Player 9 or above to play Media Player objects, although it will use
the latest version of Media Player found on the computer.

In Media Player 9, all the properties that related to the user interface of the Player in earlier versions have been
replaced by a single property called "uiMode". This new property can take the following values:

e None: The Player is shown without any controls. The only visible element is the video window itself.

e Mini: In addition to the video window, the Player is shown with a status window, as well as Play/Pause,
Stop, Mute and Volume controls.
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e Full: This is the default setting. In addition to the video window, the Player is shown with a status window, a
seek bar, and Play/Pause, Stop, Previous, Next, Mute, Fast Forward, Fast Reverse and VVolume controls.

When converting Media Player objects from Mediator 7 documents, Mediator 9 sets the new 'uiMode' property
to 'None' by default. However:

e If the Mediator 7 'Show controls' property was set, 'uiMode’ is set to 'Mini'.

e |f the Mediator 7 'Show tracker' property was set, 'uiMode' is set to 'Full'.

Document properties

LI

(IRLd1) You can display and edit the properties of a Mediator document at any time as follows:
» Click the Mediator Button.

» Choose Prepare | Properties.

The Document Properties dialog is made up of several tabs.

General tab

X

Document Properties

Gereral | Screen | Audio | HTHL

Application fitle; Type:
Standard [CD-ROM etc.) W

Application icor;
Show Mediator logo
[ Restore cursor to default after page turn

[ ] Mo W ait curzor [hourglass] during page tumn

] H Cancel ]

Application title: You can use this field to give a title to your project (distinct from the file name).

This is shown on the title bar of the Mediator Viewer window (for documents of type Standard) or the browser
window (for documents of type HTML or Flash).

Type: This field lets you change the document type you chose when creating the document so that you can have
access to different export formats.

You can choose between:

e Standard to create a multimedia presentation to be stored on CD-ROM or other removable storage medium
(DVD-ROM, USB stick etc.)

e HTML to create an HTML web site or HTML presentation

¢ Flash to create a Flash banner or Flash web site
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Because some of the features and effects available in Mediator are not supported on the Internet, Mediator
automatically adapts its user interface to the document type you choose here, and only shows the features,
options and export formats that are relevant to it. Projects of type HTML or Flash do not have as many tools,
effects, events and actions available as projects of type Standard. When changing your document from Standard
to HTML or Flash, Mediator displays a message advising you to check that all the elements, objects, actions and
other features used in your project are indeed supported by these formats.

Whenever possible, Mediator informs you of any such compatibility problems during export.

Please refer to the topic "Mediator 9 feature list" for a complete list of all objects, events and actions available in
Mediator for each document type. For a list of the restrictions applicable to HTML and Flash documents, see
"HTML restrictions" and "Flash restrictions".

Application icon: Click the Browse button = to access the Open dialog and select the desired icon file. The
icon you select is placed on the left of the title bar (for documents of type Standard) or the browser window (for
documents of type HTML or Flash). It will also appear next to the name of the HTML page when bookmarking
it in the list of Favorites.

Show Mediator logo: A Mediator logo appears at the end of your project at runtime (or at the bottom of the
page in the case of HTML projects). If you do not want to include the logo in your project, remove the
checkmark.

Restore cursor to default after page turn: Checking this option ensures that the standard pointer is displayed
after each page turn, even if you have used the Set Cursor action to specify a different cursor shape on the
previous page and have not reset the cursor before leaving the page. This option is only available for documents
of type Standard.

No Wait cursor during page turn: Check this option if you do not want the Wait cursor to appear while
Mediator goes from one page to the next. This option is only available for documents of type Standard.

Screen tab

Apart from the 'Custom shape window' field, this tab is identical to the dialog that appears when you create a
new document of type Standard. This dialog is described in the topic "Creating a document".

Document Properties E|

Gerneral | Screen | Audio | HTHL
tode Border

Color: I
) window e

(%) Full screen with frame

(3 Full screen

Custom shape window:

5] [ o ]

Custom shape window: This feature allows you to create non-rectangular projects, not just circular or
triangular, but using any irregular shape you can think of.

This is done by applying a mask that defines the areas of the project window to be shown. You can only apply
masks to projects running in Window mode (i.e. not 'Full screen' or 'Full screen with frame").
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For a full description of this feature, refer to the topic "Custom shape window".

Audio tab
This tab is only available for documents of type Standard.

Document Properties PX|

General | Screen | Audio | HTHL
These settingz contral the sound resolution of wour project. All sounds will be converted real
time to these setlings.

Since this converzion takes processor time, it is best if vour zounds already have the
rezolution specified here.

Freguency Bitz Channels
() 44 kHz ) B bit ) Mono
(%1 22 kHz (%) 1E bit (%) Steren
(111 kHz

-

If your Mediator project contains several sounds using different resolution settings, they will all be converted to
the same resolution. The resolution used is the one you specify here.

When choosing this sound resolution, bear in mind the following points:

o Since all the sounds will be played at the resolution shown here, make sure you choose a resolution that gives
the desired sound quality.

e Because the conversion of the sound resolution to the settings chosen here takes processor time, you can
improve overall performance significantly if all or most of your sounds are already set to this resolution.
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HTML tab

X

Document Properties

General || Screen || Audio | HTHL |

keta tags

Dezcrption:

Kepwaords:

¢HEAD >

[ ] l [ Cancel

This tab is only relevant for projects that you intend to export to HTML or Flash. It allows you to enter a
description and/or keywords relating to your entire project, which are inserted in the corresponding meta-tags on
the main HTML page generated during export.

Keywords should be separated by commas or semi-colons.
e When exporting to HTML, the description and keywords are placed in the index.htm file generated.

e When exporting to Flash, they are placed in the main.htm file.

You can also insert HTML code directly into the Mediator project by pasting it in the <HEAD> field. The code
will be inserted in the <HEAD> section of the main html pages (index.htm and default.htm), after the HTML
code created by Mediator.

Note however that although Mediator validates all the HTML code it generates according to the W3C HTML
4.01 standard, this does not apply to code you insert here. It is therefore your responsibility to ensure that it is
valid.

Custom shape window

PR

Most multimedia authoring tools only let you create rectangular projects. Mediator, however, allows you to
create not only custom-sized windows and projects with full screen scaling, but also projects in irregular shapes.

This does not mean just circular or triangular projects, but any shape you can think of, with user-defined
transparent areas.

Here are examples of three different custom-shaped project windows:
e one window shaped as a country (Egypt),
e one shaped as a book,

e one shaped as a CD with a transparent hole in the middle.
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The project window is actually still rectangular, but by applying a mask to it, you can define the area(s) of the
window you wish to show.

9? You can only use apply masks to documents of type Standard, running in Window mode (i.e. not 'Full
screen' or 'Full screen with frame"). For more information on document types and document modes, see
"Creating a document".

A mask is a 3-color picture which must use only these exact three colors:

Black (RGB 0,0,0)
White (RGB 255, 255, 255)
Red (RGB, 255, 0, 0)

e Wherever the picture is black, the window becomes transparent.
e Wherever the picture is white, the window remains visible.

e Red areas can be used to drag the window.

The mask used to create the Egypt project window shown above looks like this:

This picture used as mask is not itself visible to the end user, but determines which part of the project window is
visible.

Here the part of the project window covered by the black area outside the country shape is not shown. The rest of
the project window is shown. The red border defines the area of the project window that the end user can click to
drag the project window around the screen.

The mask picture must have exactly the same resolution as the project window. If your project window is
800x600 pixels, the mask picture must therefore also be 800x600.

9? You are advised to use the picture formats PNG or GIF, since they give the best compression and keep the
original colors (unlike JPG).

Applying a mask
To apply a mask to a project, you must of course specify the mask picture you want to use.

You can make the mask picture yourself using a picture editing program or select one of the masks included in
the folder "Custom Shapes" of the Mediator program folder.
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Q You are free to edit or resize any of the masks that you find in this folder.

In the following we are going to use the Egypt mask shown above as an example.
» Create a new Mediator document of type Standard.

»  Select the document mode 'Window'.

> Select a window size identical to the size of your mask picture.

Since the Egypt mask picture is 800x600 pixels, the window size must be set to 800x600.

9@ Often you will do the opposite, e.g. start by defining your project, then design the mark picture accordingly.

A blank page appears.

Click the Mediator Button.

> Choose Prepare | Properties.
» Click the Screen tab.
» Select the file "egypt 800 600.png" in the field 'Custom shape window'.
Look it | (25 Custom Shapes v| (e W il Preview
. .:] agaresive star 640 430.png ,'-'_‘:].culoud.;i‘itl 430.png .:] FIDWP:E Elle :f_e: ) ;k
___J %] aggresive star 500 600.png |:] cloud 800 600.png ‘:] Flowie| Moeamorlmzlse 582“;1
Recent | %] aggresive star 1024 768 .png %] cloud 1024 768.png =] Flowe| BUUNE;U 24.bit
i ."_"] alien Face 640 480.png ."_"] coffes cup 640 480.png .'_‘] Floweé
B .:‘J alien Face &00 &00.png ."_"] coffes cup S00 600.png .:J Flowe|
Doskt ."_"J alien Face 1024 7658.png ,:] coffee cup 1024 76&.png .:] Flawe|
A iﬂ apple 640 480.png i:]diamond &40 430.png |:_| heap |
3 ,ﬂ apple 500 600.png ,"_"] diamond 500 600.png ,:] heap
____/ ,:] apple 1024 763.png ,ﬂ diamond 1024 768.png ,"_"] heap |
Data %] chain saw 640 430.png .:] egypt 640 480.png :] heart|
- %] chain saw 800 600.png %] heart|
-".{1 ."_"J chain saw 1024 765.png ."_"] eqgypt 1024 765.png ."_‘] heart|
Corpute: ,:'J circle 640 480.png ,"_"J elipse 640 450.png ,:J houseé
,"_"j circle 00 600.png ,:] elipse 800 600.png ,:] house|
‘;} iﬂ circle 1024 763.png i"_"] elipse 1064 763.png %] house|
Net;-vork L ‘_-__ - >_:
File name: :egypt 800 B00.png hd
Files of type: :.Kll.;:.ictures v
> Click OK.

The mask is applied to the window.

You can now design your pages as usual. Objects and parts of objects located in the invisible area are not shown
in the workspace, but you can still access them in the Object list.

9@ Obijects located in the drag area (the red-colored part of the mask picture) will not accessible to the end user.
Therefore make sure you do not place objects containing actions in this area.
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Printing a document

[E] To print a screenshot of each page of the project as it looks in design mode, do as follows:
» Click the Mediator Button.
» Choose Print.

The following dialog appears:

]

Print

Ww'hat bo do
%) Print

) Create document

| I

Wwhat bo print

¥ Cunrent page Width [mm): | 900

© Allpages Height [mm]:
Total
| )
FPage

]

[

] H Cancel ]

You can choose to print to a printer or to a file.

Printing to a file lets you document your project by adding comments or perhaps a logo.
e Click Print to print directly to the printer.

e Click Create document to print to an RTF file.

Create new document in: If you have chosen to print to a file, enter the path name of the file to print to in this

field or click the Browse button = to select it.

The next group of options lets you choose whether to print the current page only or all the pages of your project.
If you select to print the whole project, each Mediator page is printed on a separate page.

Width: Allows you to set the width of the screenshot of the Mediator page to be printed.

Height: Allows you to set the height of the screenshot of the Mediator page to be printed.

Mediator uses the Total and Page fields to show you the progression of the printing operation.

You can also print text files and pictures from within a Mediator project at runtime by using the
Open Doc, Execute or Report actions. See "Printing text and pictures” and "Report™ for more information.

You will find a ready-made Print Page combination using Report and Open Doc in the User tab of the Events
dialog.
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Setting a password

T
l—&; Mediator lets you add a password to your document. Password-protected projects can be viewed, but not
edited unless you enter the proper password.

» Click the Mediator Button.
» Choose Prepare | Set Password.

The Set Password dialog appears.

X]

Set Password

Paszward:

Confirm paszword:

[fJ Help ] [ Ok ] [ Cancel

» Enter the password in the top field.
» Click the bottom field and enter exactly the same password. Confirm by clicking OK.

From now on, Mediator will ask you to enter the password every time you open the document.
e To change the password, enter a new password in this dialog.

e To remove the password, leave both fields empty and save the document.

@ Do not lose your password! It is not possible to edit a password-protected Mediator document without
entering the correct password.

Q Do not set a password before you really need to. If you only want to prevent the users of the exported version of your
project to access it, set the password just before exporting it. It is also advisable to keep a non password-protected version
for your own usage.

Merging documents

U_iJ Mediator allows you to join together two or more projects. This allows several people within a company
to work on different parts of the same project or students to prepare individual projects that will eventually be
merged.

@ If you are working in a networked environment with access to shared folders, it might be easier to use
Mediator's multi-user mode. This allows several users to work concurrently on the same project. For more
information, see the section "Using multi-user mode".

»  Open the main project.

» Click the Mediator Button.

» Choose Merge.

An Open dialog appears.

> Select the project you wish to merge into the main project.

» Click Open to begin the merge operation.
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Mediator merges the two projects and places the pages of the second project after the pages of the main project
in its Page list. The merged pages will adopt the document type of the main project (e.g. Standard, HTML or
Flash).

See the topic "Creating a document" for more information on the different document types.

Merge restrictions

Before merging two projects, Mediator performs several checks to ensure that they are compatible with each
other.

The merge operation is aborted if one of the following problems is encountered:

e The two projects have different sizes.

e The two projects use global variables that have identical names.

A dialog will appear to tell you what the problem is.

You should also take the following points into consideration before merging projects:
¢ Do the projects have the same document type (e.g. Standard, HTML or Flash)?

If not, the properties of the project being merged (including its document type) will be modified to match
that of the main project. This means that any objects or features in the project being merged that are not
supported in the main project are deleted.

e Do the projects have pages with identical names?
If so the page names of the project being merged are automatically renamed, and all page links updated
accordingly.

Document Merge §|

Y'our document has been merged successiully,
The following pages hawve been renamed:

Fagel -» PageZ

e Do the two projects use different custom shape windows?
If so the mask of the project being merged is changed to match that of the main project.

See the topic "Custom shape window" for more information on that feature.

Using multi-user mode

==

& Mediator's multi-user mode allows several users sharing a network to work concurrently on the same
project. If you are working in a team, you can for instance allocate different pages of your project to different
team members, so that the project is created by the whole team simultaneously, each member working on their
own specific area.
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To prevent users from overwriting each other's work when working in multi-user mode, Mediator enforces a
system of locks. Whenever for instance a user starts editing a page, Mediator prohibits any other user from
working on that page. The page can however still be viewed by all users. Similarly, although all users are
allowed to make changes affecting the entire document, only one of them can make such changes at any one
time.

When working in multi-user mode, it is helpful to display the Multi-User Status window, which is continuously
updated to reflect all the accesses made to the document by its concurrent users, giving their user name and
computer name.

» Choose View | Show/Hide | Multi-User Status.

Multi-User Status 4

Element Locked | Compliter

Q You can resize, dock and undock the Multi-User Status window according to your needs. See "Using the Mediator
panels™ in the topic "Setting up your workspace" for more information.

Opening a document in multi-user mode

Any Mediator document can be opened in multi-user mode, provided that the conditions below are met:
e The document is hosted on a shared network folder accessible to all the potential users.
e The users have read and write access rights both to the document and to the folder containing it.

e The document it is not already opened in single-user mode by any of the users.

Conversely, it is not possible to open in single-user mode a document already opened in multi-user mode by
another user.

To open a document in multi-user mode:
» Click the Mediator Button.
» Choose Open as Multi-User.

@ If you open a document that you last saved in multi-user mode by any other method (e.g. by choosing Open,
by pressing Ctrl + O or by clicking the file name in the 'Recent Documents' list), Mediator displays a message
asking you whether you want to open that file in single or multi-user mode.

As soon as you open a document in multi-user mode, Mediator creates a temporary folder with extension
".multiuser' in the shared network folder containing the document. This temporary '.multiuser' folder contains
system files essential to the workings of the multi-user mode. Do not delete the multiuser folder under any
circumstances.

A document accessed in multi-user mode is no different from any other Mediator document. As soon as all
concurrent users of the document have closed it, it can be re-opened by any one user in single-user mode as
normal.

Creating a document for multi-user mode

If you are creating a new document on a shared folder, and want other users to be able to work on it
simultaneously, you must save and close the document after creating it, and then re-open it in multi-user mode.
This enables the other users to open the file in multi-user mode.
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Saving a document in multi-user mode

There is a fundamental difference in the way documents are saved in multi-user mode as compared to single-user
mode.

Whereas it is up to the user to save the document whenever he or she decides to do so in single-user mode, in
multi-user mode the document is saved automatically every time any of the concurrent users makes a change to
it. Individual users are no longer able to save the document themselves and the Save command is actually
disabled.

Working in multi-user mode

Apart from some operations affecting the whole document, most of the Mediator features are available in multi-
user mode. The operations that are disabled in multi-user mode are listed under "Restrictions" below.
Operations on a single page

As soon as a user of the document starts working on a particular page, that page becomes locked, thereby
preventing any of the other concurrent users from making any changes to it.

This is denoted by the presence of a Lock icon next to the page in question in the Page list.

Moving the mouse over the Lock icon gives the user name and computer name of the current "owner" of the
lock.

|Locked by: Administrabor@DESKTOR |

Any user trying to make changes to a locked page will receive a message indicating that the page is locked and
giving the user name and computer name of the owner of the lock.

A locked page can still be viewed by all users, although any changes made by the owner of the lock are not
visible to the other users until the owner leaves the page, thereby releasing the lock.

Also bear in mind the following points that apply to multi-user mode:

e Every time you integrate a file into your project, for instance by creating a picture object or a video object,
Mediator displays a message asking you whether you want to copy this file into the project folder on the
network. Choosing Yes ensures that the object will be visible and accessible to all the other concurrent users.

It is still your responsibility to ensure that any other external data files you use, such as files referred to by
the Embedded Document object, are stored in a shared location accessible to all the other users. You also
need to make sure that Mediator will include such files when creating the exported version of your project.
See "Adding data and program files" for more information.

You are advised to always copy all such external files in the shared network folder containing the project.

e Every time a user makes a change which affects the page list, the display of the page list is refreshed on all
computers accessing the document, showing the list as it appears to the user having made the change. This
means that the pages and sub-pages you have expanded may become collapsed, and vice-versa. You may
need to expand or collapse again the various pages and sub-pages as needed.

e You cannot delete a page containing sub-pages in multi-user mode, even if none of these sub-pages are
locked.

e Although you can still rename a page using the Rename command, you cannot rename a page by slowly
double-clicking its name in the Page list in multi-user mode.
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Operations on multiple pages

In single-user mode, Mediator lets you use the Properties dialog to change the properties of several pages
simultaneously by selecting all the relevant pages first. Only the fields that are common to all the pages selected
are then shown in the Properties dialog. This is convenient if you wish for instance to change the color of several
pages in one go, apply a master page to several pages and so on.

This operation is still possible in multi-user mode. If however some of the pages selected are locked, you will
receive a message to that effect for each of the locked pages, and the change will not be made on those pages.

Note also that if you select a bottom or top master page by entering the name of the master page rather than by
using the Browse button when one of the pages selected is locked, you will receive a message about the lock
every time you enter a character of the master page name.

Operations on the document

It is not possible for two different users to perform simultaneously operations that affect the entire document,
such as:

e Accessing the document properties with Prepare | Properties
e Accessing the Variables dialog with Page | Programming | Variables or View | Programming | Variables

e Accessing the Additional Files dialog with Prepare | Additional Data Files or Prepare | Additional Program
Files

Any user trying to access one of these commands at the same time as another user will receive a message
indicating that the document is locked and giving the user name and computer name of the owner of the lock.

Restrictions

As mentioned above, some of the operations affecting the entire document can only be performed in single-user
mode.

These operations, which are disabled in the relevant tabs and menus, include the following:
e Merging projects

e Setting a password on the document

e Exporting

e Resizing the document

e Using the Search Manager

Note also that any guides set in multi-user mode are not saved when working in multi-user mode. See the topic
"Using the guides" for more information on this feature.
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Working with objects

Creating objects
The Insert tab contains all the objects that you can insert in your project.

B 1OZEEHA O &EH O s x &) =e%

Pickure Rectangle Polygon Drawing Bump Text  Headline Windows  Mideo Animated  Flash Button Animation Embedded  HTML  Inpuk  Lisk  Ackives
- Map = Media Plaver GIF - Path  Document Object= Object  Box

Tlhustrations Text Media Clips Contrals

The choice of objects available depend on the type of your document, e.g. Standard, HTML or Flash.

The document type is normally defined when you create the document, but you can choose a different document
type at any time later by clicking the Mediator Button and choosing Prepare | Properties. For more
information, see "Document properties".

Most of the objects can be inserted using the same procedure:

» Click the desired object in the Insert tab. When you move the mouse pointer away from the tab, you can see
that the corresponding tool has been activated. For instance when you click the Rectangle icon the mouse
pointer changes to a rectangle.

» Move the mouse pointer into the workspace and drag out a rectangular frame of the desired size at the
position where you want to place your new object (you can change both the size and position later).

To "drag out" an object, place the mouse pointer at the point where you would like your object's top left
corner to be. Click and hold down the left mouse button while moving the mouse toward the bottom right
corner and let go of the mouse button when you are satisfied with the size of your object.

For some objects, this is all you need to do to. Others need additional input from you. Pictures and videos for
instance require you to specify a file name: as soon as you let go of the mouse button, an Open dialog appears
which lets you browse and select a file on your computer.

As soon as you have placed the object, a Format tab specific to the object opens at the right of the ribbon to let
you see and modify the object properties.

Here is for example the Format tab of the Headline object.
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Once the object is created, the mouse pointer returns to its standard selection shape, letting you create another
object or select an existing object. You can also return the pointer to its standard selection shape at any time by
choosing Home | Editing | Select Object.

Q If you need to create several objects of the same type, press and hold the Shift key down while clicking the object icon in
the Insert tab and positioning the object. This lets you create a series of objects with the same default properties, which you
can then customize individually if necessary. Release the Shift key before creating the last object or choose Home | Select
Object to return the pointer to its standard selection shape.

You will find a detailed description of the creation process of each object and a full list of their properties in the
Reference section of this documentation, under "Objects".

Handling objects

=i There are many operations that can be performed on objects. Some can be performed on all objects, others
are specific to particular objects. This topic and the other topics of this section describe basic operations that can
be performed on all objects.

You will find a detailed description of each object and all their properties in the Reference section of this
documentation, under "Objects".
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The first thing to do before you can manipulate an object is to select it.
Selecting an object
» To select an object, just click it once.

Notes:

e This assumes that the mouse pointer is in its standard selection mode, identified by the pointer shape % .To
return the pointer to this shape if necessary, choose Home | Select Object.

e Obijects with transparent areas only react when you click their visible areas.
Selecting several objects

You can select several objects in different ways:

e Hold down the Ctrl key while clicking all the objects you want to select.

e Draw a frame around the objects with the mouse. This will select all the objects that are entirely contained
within the frame.

e Choose Home | Editing | Select All (or press Ctrl + A) to select all the objects contained on the page.

Selecting objects in the Object list

Sometimes you will find that an object cannot be selected on the page. This is because objects can be placed on
top of each other making it very difficult to select the lower objects. You can solve this problem by selecting
them in the Obiject list.

> If the Object list is not open, choose View | Show/Hide | Object List or press F4.

The Object list also makes it easier to select several objects and secondary objects such as hypertext objects.
Refer to the topic "Using the Object list" for more information.

Deselecting objects
o |f one object only is selected, click another object or click the workspace to deselect it.

o If several objects are selected, simply click the object you want to deselect.

Deleting an object

» To delete an object from the page, select it and choose Home | Editing | Delete Object or press the Delete
key.

Copying and pasting an object

» To copy an object (including size, position, colors, events and actions), select it and choose Home |
Clipboard | Copy (or press Ctrl + C).

» To paste it back on the same page or a different page, choose Home | Clipboard | Paste (or press Ctrl + V).

Duplicating an object

» To create an object identical to the selected object (including size, position, colors, events and actions),
choose Home | Clipboard | Duplicate (or press Ctrl + D).

Editing an object

Once you have created an object, you may need to modify its contents. To do this, just double-click the object.
This will let you for instance:

e Choose a different picture in a picture object or a different video in a video object.
e Edit the text of a text object, a headline or a button.

¢ Change the shape of a polygon, an animation path or a drawing object.
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Object properties
Obijects also have specific properties which you can view and edit.

As soon as you select a particular object, a Format tab specific to the object appears at the right of the ribbon.
Clicking this tab lets you see and modify its most important properties.

Here is for example the Format tab of the Headline object.
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@ When several objects are selected, only the properties that are common to all these objects are available.

Each object also has a Properties dialog, which lets you view and fine-tune all the properties applicable to the
object. If the Properties dialog is not open, you can open it by one of the following methods:

e Choose View | Show/Hide | Properties, or

¢ Right-click the object and choose Properties in its local menu, or

e Press F12.
Properties for Object: Rectangle =
B 00 @ 8
Fill bype _= |Gradient
Fill color []255,234,218 M
Fill color 2 [ ]255,191,145 M
Fill gradient type | _= |Linear
Fill gradient angle |0
Fill gradient center ¥ 50
Fill gradient center ¥ |50
Fill texture options | = |Scale
Fill texture path e
Cutline color [2z7,108,9 M
Cutline weight 1
Outline style _= |5olid Line
Antialiasing [ False

QI You can resize, dock and undock the Properties dialog according to your needs. See "Using the Mediator panels” in the
topic "Setting up your workspace" for more information.

The Properties dialog always refers to the currently selected object. If no object is selected the Properties dialog
refers to the current page.

You will find a detailed description of each object and all their properties in the Reference section of this
documentation, under "Objects".

Creating interactivity

To find out how to make your objects interactive, see the topic "Using events and actions".

Showing and hiding an object

You can decide whether a particular object should initially be visible or hidden. Hiding an object can be useful if
you only want it to appear once a particular event (such as a mouse click) has occurred on another object. You
can hide an object in several ways:

e Uncheck Show Object in its local menu, or

e Uncheck Visible in the General tab of its Properties dialog, or
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e Press F3.

All these methods are equivalent.

ﬁ' Events. ..
G| Rename...

Edit 3
Arrange 4
v | Show Object F3

D Properties F1z

Important: Hidden objects cannot react to events. Do not confuse transparent objects and hidden objects. They
are both invisible, but transparent objects (often used as hotspots) are still able to react to events whereas hidden
objects cannot.

Defining a default object

If you want to create many objects with similar or identical properties, you can save a lot of work by defining the
first one you create as the default for this particular type of object (e.g. a button, a picture, a text object, etc.).
This means that the next time you create an object of this type it will inherit all the properties of the object you
defined as default, including all its events and actions.

To define a particular object as default for this type of object:
» Right-click the object and choose Edit | Define as Default Object in its local menu.

Example: You have created a blue button with yellow text that goes to the next page. If you define it as default,
all the buttons you create from now on will have the same color, text and functionality as this button.

Using the Object list
U]

B The Object list is very important. It gives you a complete overview of all the objects you have placed on
the page.

If the Object list is not open, you can open it by one of the following methods:
e Choose View | Show/Hide | Object List, or

e Press F4.

Objects =
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QI You can resize, dock and undock the Object list according to your needs. See "Using the Mediator panels" in the topic
"Setting up your workspace" for more information.

Each object is listed by name and represented by the same icon as in the Insert tab. The Object list also reflects
the order in which the objects have been placed on the page.

e A yellow dot next to an object name means that events and actions have been defined for the object.
e A green dot next to an object name means that notes have been entered for this object in the Notes tab of its

Properties dialog.
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Selecting an object

Sometimes you will find that an object cannot be selected on the page. This is because objects can be placed on
top of each other making it very difficult to select one of the lower objects. You can solve this problem by
selecting them in the Object list.

» To select an object in the Object list, just click it.

Selecting several objects

The Object list often provides you with a better overview when you want to select several objects.

The way you select several objects in Mediator is the same as in Windows:

» Click the first object, then press and hold down the Ctrl key while clicking the other objects one by one.
Each of the objects you click becomes highlighted to indicate that it is selected.

You can also select a range of objects:

» Click the first object, then press and hold down the Shift key while clicking the last object in the range you
want to select.

All the objects listed between the first and the last object become selected.

Deselecting objects

» To deselect one or more objects simply click them again while holding down the Ctrl key.

Selecting grouped objects
Grouped objects are identified in the Object list with a + sign as follows:
s
» Click the + sign to see the objects in the group.
5
OG Faolygon

o | Picture
& Video

» Select the secondary object required.

This gives you access to its Properties dialog and Format tab. To access the local menu of a grouped object, you
should right-click it in the Object list, not on the page, as this would display the local menu of the group.

Hotspots and hypertext objects are secondary objects attached to another object. Objects that have one or more
hotspots or hypertext objects attached to them are also identified with a + sign as follows:

5 ]I

ok Picture

» To view the hotspots or hypertext objects in the Object list, click the + sign in front of the corresponding
object.

= [

AEC Hypertest

See "Grouping objects" for more information on this topic.

Selecting locked objects

To fix an object in its current position, you can check the 'Lock’ option in its Properties dialog. Once an object is
locked, you cannot select it by clicking it on the page. The only way to select a locked object is to click it in the
Obiject list.

To unlock a locked object select the object in the Object list and remove the 'Lock’ checkmark in its Properties
dialog.
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See "Object properties: General tab™ for more information on locking.

Arranging objects using the Object list

Obijects are listed in the Object list according to the order in which you create them. The first object you create
appears at the bottom of the list, the most recent object at the top.

The order of the objects in the list also reflects their level on the page. The object at the top of the list is placed in
front of all other objects on the page (it is at the top level) whereas the object at the bottom of the list is placed
behind all other objects on the page (it is at the bottom level).

You can move one or more objects to the back or to the front, one level back or one level forward with the
Arrange commands. Refer to "Arranging objects" for more information on this procedure.

You can also simply click an object in the Object list and drag it to a different level by holding the left mouse
button down. When you start dragging an object (or group) a black line appears in the Object list. This line
indicates the position where the object will be dropped when you let go of the mouse button. As long as you hold
the mouse button down, the black line follows the mouse movement.
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When you need to reorder several objects on the page, it is often much easier to use the Object list rather than the
Arrange commands. Select as many objects as needed and drag them up or down in the list. The black line
indicates the position where all the objects will be dropped.

Objects »
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Renaming an object

You can rename an object in several ways:

¢ Right-click it and choose Rename in its local menu.
e Select it in the Object list and press F2.

e Select it in the Object list and click it again slowly.

Saving an object in the Multimedia Catalog

If you have created an object that you would like to re-use in other pages or future projects, you can save it in the
Multimedia Catalog.

> Select the object or set of objects and drag them to the category of your choice in the User Area of the
Multimedia Catalog.

The object is saved in the Multimedia Catalog with the extension .080 which is specific to Mediator. You can
drag it back from the Multimedia Catalog into your project at any time. See the section "The Multimedia
Catalog" for more information.
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@ You can also right-click the object and choose Edit | Save in Multimedia Catalog. In that case the object is
placed in the root of the User Area.

Moving objects

You can move an object anywhere in the workspace simply by selecting it and dragging it to the desired
location. As soon as you hold the mouse button down on the object, a hand appears to indicate that you can now
grab and move the object.

e To move an object in one direction only, press and hold down the Ctrl key as you start dragging the object.
The object movement will now be confined to the horizontal or vertical direction.

e You can also move an object with the keyboard. Select the object and use the arrow keys to move the object
one pixel at a time. To move the object more quickly, hold down the Shift key. Instead of moving one pixel
at a time, the object now moves by the number of pixels defined in the grid. For more information on the grid
see "Using the grid".

You can also reposition an object more accurately by editing its X and Y coordinates, which correspond to its
top left corner. You can do this in two ways:

e Using the fields of the Position & Size group in the Format tab

X 160 =|oe 233 =
Y L r
Y 41 + 21109 -

Position & Size

e Using the General tab of the Properties dialog

Properties for Object: Rectangle b
| 00 @ @&
Mame Rectangle
A 57
¥ 145
‘idth 190
Height 1153
YWisible [ True
Lock [ False
Collision detection | [ False
Kewwords
Mouse transparency | [ False
Shio boalkip [ False

@ The coordinates (0,0) correspond to the top left corner of the page. The workspace is always three times
wider and three times higher than the page. So if your page is 1024 pixels wide and 768 pixels high, the
workspace will be 3072 pixels wide (i.e. 1024 x 3) and 2304 pixels high (i.e. 768 x 3). Its top left coordinates
will be (-1024,-768) and its bottom right coordinates (2048, 1536).

You can also define vertical and horizontal guides to help you position and align your objects. See "Using the
guides" for more information.

Resizing objects

The quickest way to resize an object is to select it and pull one of its eight handles (one in each corner and one
on each edge):
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e To change the width or the height of the object, pull one of the edge handles.
e To resize the object proportionally (keeping the X/Y aspect ratio), pull one of the corner handles.

e To resize the object freely in both X and Y directions, press and hold down the Ctrl key while pulling one of
the corner handles.

e To resize the object symmetrically in all directions, press and hold down the Shift key while pulling either a
side or corner handle.

@ This only works on non rotated objects.
You can also resize the object accurately by editing its Width and Height values. You can do this in two ways:

e Using the fields of the Position & Size group in the Format tab
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e Using the General tab of the Properties dialog

Properties for Object: Rectangle =
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Lock. [ False
Collision detection | [ False
Kewwords
Mouse transparency | [ False
Shio boalkip [ False

Rotating objects

G Where applicable, Mediator lets you rotate objects after their creation.

Note that some objects cannot be rotated.

Mediator gives you several ways of rotating objects depending on the degree of precision you require.
Rotating an object using predefined rotations

»  Select the object to be rotated.

» Click its Format tab at the right of the ribbon.
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» Choose Style | Effects | Rotate and browse through the gallery of predefined rotations to check their effect
on your object. To apply one of these rotations, just click it.

Rotating an object using the Rotate tool
» Select the object and choose Home | Arrange | Rotate.

A circle appears in the middle of the selected object and your mouse pointer changes to a rotation arrow

/ The circle is your rotation center.

» Rotate the object around the rotation center by pressing the left mouse button while moving the mouse
pointer in the required direction.

A tooltip appears to show you the degree of rotation so far.

Rotating an object via its Properties dialog

You can also view and edit the degree of rotation accurately in the Visibility tab of the Properties dialog of the
rotated object.

Raotbake 313

To unrotate an object set the Rotate value to 0.

Moving the rotation center

If you want to rotate the object around a point (called the rotation center) other than the center of the object, you
can move this rotation center as follows:

» Move the mouse pointer over the circle so that its shape changes to a cross
> Drag the rotation center to its new position.

The 'Rotate X center' and 'Rotate Y center' values of the Properties dialog tell you where the rotation center is
placed in relation to the center of the object.

Raotate 313
Ratate = center -2
Raotate ¥ center &4

To move the rotation center back to the exact center of the object enter 0 in both fields.
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Grouping objects

Mediator lets you group objects together so that you can treat them as a single unit. Grouping is particularly

useful for protecting and maintaining connections and distances between objects.

» To group several objects together, start by selecting the objects one by one while keeping the Ctrl key
down.

» Choose Home | Arrange | Group or press Ctrl + G.

@ The Group command is only active when you have selected two or more objects.
Once objects are grouped, they appear as a group in the Object list.
-
» To view the objects in the group click the + sign.
5
o} Polugon
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If you wish to add more objects to the group, simply drag them into the group within the Object list.

Notes:

e You can still edit objects that are part of a group. Select the object in the Object list (click the + sign to see
the objects in the group, then click the object) to get access to its Format tab, Properties dialog and local
menu.

¢ You can also show, hide or animate a grouped object, as well as apply events and actions to it.

e To select an object within a group when applying an action, click the + sign for the group in the action's
object list and select the object.

e Groups cannot be resized. If you need to resize a group, you can use the following workaround: copy the
group, paste it in a new document, resize this new document with View | Document | Resize (checking the
'Resize objects' option) and copy the group back into the original document.

Q To quickly select a grouped object, press and hold the Ctrl key, then click the object on the page.

Ungrouping objects
»  Select the group.

» Choose Home | Arrange | Ungroup or press Ctrl + U.
@ The Ungroup command is only active when you have selected a group.

Arranging objects

T = |
JJ —{] JJ _J

Bring To Send  Bring Send
Front to Back Forward Backward

When you create objects in Mediator they are placed on the page in a hierarchical order. The first object you
create is placed at the bottom level of the page, behind all the other objects, whereas the last object you create is
placed at the top level, in front of all the other objects.
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You can change the stacking order of objects easily with the Arrange commands:

e To change the order of one or more objects, select them and choose one of the Arrange commands in the
Home or Format tab.

e You can also right-click an object and choose one of the Arrange commands in its local menu.

Arrange | Bring To Front (Ctrl + F)

—| Places the selected object on top (in front) of all the other objects. If you have selected several objects,
they are all placed on top, the relationship between them being maintained.

Arrange | Send to Back (Ctrl + B)
Ny

—L Places the selected object at the bottom (back), behind all the other objects. If you have selected several
objects, they are all placed on the bottom, the relationship between them being maintained.

Arrange | Bring Forward

= Moves the selected object up by one position. If you have selected several objects, they are all placed one
position higher.

Arrange | Send Backward

— Moves the selected object back by one position. If you have selected several objects, they are all placed
one position lower.

The Object list reflects the order in which the objects have been placed on the page.

> To open the Object list, choose View | Show/Hide | Object List or press F4.

Dbjects =
(7 LookT kg ay
|A=] Text
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ot Text
o[ PDF

You can also use the Object list to change the order of the objects by simply dragging them up and down the list.
Refer to "Using the Obiject list" for more information on how to do this.

Aligning objects
=
*d Mediator lets you align objects in relation to the page or in relation to each other.

> Select the object or objects to align.

» Choose Home | Arrange | Align.
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The four radio buttons on the left of the dialog set the horizontal alignment and the four radio buttons on the
right set the vertical alignment. To leave the horizontal alignment unchanged, you select the left 'None' radio
button. Conversely, to leave the vertical alignment unchanged, you select the right 'None' radio button.

If for instance you have selected a picture, checking 'Left' and "Top' will place the picture on the top left corner.

If you have selected several objects, they are aligned in relation to the first object you selected. Checking 'Right'
for instance will align all the selected objects with the right-hand side of the first object you selected.

@‘-

(—

If you check "Top', the selected objects will retain their horizontal position but will be aligned with the top of the
first object you selected. The alignment is therefore determined by the first object you select.

If you check the Relative to screen option, all the selected objects react as if they were grouped. They are
repositioned on the page so as to maintain their inter-relationship. This means that if you check 'Right’, the object
furthest to the right will be placed on the right-hand side of your Mediator page and the other objects will move
along with it, but their vertical and horizontal relationship will be maintained.

E"-
G‘-
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Applying styles

% You can change the look of many Mediator objects by modifying their background properties (fill) or
their frame properties (outline). You can also enhance their visual aspect by giving them shadows or glow
effects, by applying alpha channels to them or by changing their opacity level to make them more or less
transparent.

This topic describes how to apply effects to objects by using the Format tab on the ribbon.

For all these procedures, you start by selecting the object to be edited. As soon as the object is selected, its
Format tab appears on the right of the ribbon.

Notes:
e |f you select several objects, only the properties that are common to these objects can be edited.

e You can also use the Properties dialog of the object to perform the operations described here. The Properties
dialog lists all the properties that are applicable to the object and allow you to fine-tune their values.

You will find a detailed description of each object and all their properties in the Reference section of this
documentation, under "Objects".

Changing the fill of an object
» Choose Format | Style and click the arrow next to Fill. You now have several choices:

e Click one of the solid colors in the upper part of the menu.
e  For more color nuances, click Other and choose a color in the standard Windows dialog.

To remove the fill, thereby making the object transparent, click No Fill.

To change the second color of a gradient, point to Gradient Color and choose a color.
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A gradient is a gradual transition between two colors or two shades of the same color:

» Toadd a gradient to the fill, point to Gradient, and browse through the gallery of predefined gradients to
check their effect on your object. To apply one of these gradients, just click it.

Finally you can apply different textures to the fill:

» Point to Textures, and follow the same procedure as for gradients.
Changing the outline of an object

» Choose Format | Style and click the arrow next to Outline.

As with the fill, you can choose to give the outline a solid color, or you can remove the outline altogether by
choosing No Outline.
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You can also change the Weight (i.e. thickness) of the outline, and define the style of the Dashes used to
represent it.

The procedure to change the outline is the same as that described above for the fill.

Adding a shadow or a glow effect to an object

» Choose Format | Style and click the arrow next to Effects. You can now:

¢ Point to Shadow, and browse through the gallery of predefined shadows.
e Point to Glow, and browse through the gallery of predefined glow effects.

_J Shadow  F
D Gl 3

»  As before, once you have checked the preview of your chosen effect, click it to apply it.

Applying an alpha channel to an object

Soft edges, edges and patterns are predefined alpha channels that can be applied to rectangles and picture objects
to give them a level of transparency.

» Choose Format | Style and click the arrow next to Effects.

» Point to Soft Edges, Edges or Pattern and choose an effect you like.
Soft Edges #

b Edges 3

Patkern k

For more information on alpha channels, see "Using alpha channels and bump maps" and "Object properties:
Visibility tab".

Changing the opacity level of an object

» Choose Format | Style and click the arrow next to Effects.

» Point to Opacity and browse through the different opacity levels to check their effect on your object.

» Click the chosen opacity level to apply it.

5@ Do not confuse transparent objects and hidden objects. They are both invisible, but transparent objects
(often used as hotspots) are still able to react to events whereas hidden objects cannot.
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Rotating an object
This can be done in several ways. For more information, see "Rotating objects".

Choosing a color

&
This topic describes the Colors dialog which lets you choose colors and define custom colors to apply to
Mediator pages and objects.

This dialog can be accessed in different ways:
e From the Format tab of the selected object, for instance when choosing Style | Fill | Other.

HNE EEEER
11 Other

Mo Fill

zradient Colar »
Ml Gradient k
ﬂ Texture r

e From the Properties dialog of the selected object, when clicking the color box on the left of a color field.

Fill calar 0,153,204 |

Both of these operations display the Colors dialog.

Standard | Cuzham

(%)

1]8

Colors:

Cancel
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f Select...
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The Standard tab shows the predefined colors.

» Click one of the color cells to choose that color.

You can also pick an existing color from anywhere on the screen with the pipette A
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»  Click the Select button.

The shape of the mouse pointer changes to a pipette.

You can now click a color from an existing object, background, menu and so on.
The new color appears in the bottom right of the dialog, above the current color.
» Click OK to validate.

You can also click the Custom tab to define you own color.

Colors rg|
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Colors:

Cancel
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Here you can select a color in three different ways:

e Click anywhere in the color matrix and use the slider on the right of the matrix to adjust the color's attributes.
The slider displays the possible amounts of white and black in the color.

Enter the RGB values (Red, Green, Blue) manually.

e Enter the Hue, Saturation and Luminosity values manually.

The easiest way to experiment with different colors is to press and hold the mouse button while moving the
pointer around the color matrix.

Using alpha channels and bump maps

Alpha channels and bump maps are gray-scaled pictures that are used to apply a new look to existing objects or
backgrounds.

e Alpha channels apply transparency.

Alpha channels are not separate objects. They are simply a property of the object being modified. Note that
Mediator also supports the use of pictures with embedded alpha channels.

e Bump maps apply 3D effects or textures.

By contrast with alpha channels, bump maps are independent objects. You obtain the effect by placing the
bump map on top of the object to modify.

Alpha channels

An alpha channel picture applies transparency to the object it modifies via levels of gray-scale colors. The color
black is completely transparent and the color white completely solid. Gray colors between black and white apply
different levels of transparency: the darker, the more transparent. Remember that you can only use gray-scaled (8
bit) pictures as alpha channels. If you select a color picture, Mediator just ignores it.
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Alpha channels are rather special and can be used for many different effects.

Here we have a picture on the left, and on the right the same picture with the above alpha channel.

Here are examples of different kinds of alpha channels:

As you can see not all alpha channels are the same size. You don't have to worry about this, as an alpha channel
is scaled to the size of the object it is applied to. However, if you want the alpha channel to appear without
distortion, its aspect ratio must be very similar or identical to the aspect ratio of the object.

Here the alpha channels have been applied to the same picture. You can easily see the effect achieved by each
alpha channel.

Note that you can apply a separate alpha channel to a picture that already contains an embedded alpha channel to
produce a combined alpha channel effect.

Applying an alpha channel to an object

Mediator lets you apply alpha channels to pictures, rectangles and button pictures in different ways:
e By selecting a predefined style containing an alpha channel in the style gallery of their Format tab.
e By selecting a predefined effect with Format | Style | Effects.

e By selecting an alpha channel in the 'Alpha channel’ path field of their Properties dialog.

For pictures and rectangles, see "Object properties: Visibility tab" for more information. For buttons, see
"Button properties; Picture tab".

Bump maps

A bump map is also a gray-scaled picture which changes the look of the picture placed underneath it. Unlike the
alpha channel, it also appears as a distinct object on the page.
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You can only use gray-scaled (8 bit) pictures as bump maps. In 8-bit pictures color values range from 0 to 255, 0
being black and 255 being white.

o If apixel in the gray-scaled picture has the value 128 the picture or background underneath it is not changed
at all.

o If the value is higher than 128 the picture becomes brighter and if the value is lower than 128 the picture
becomes darker.

Bump maps let you apply a 3D look to existing objects.

Here the bump map has been placed on top of a blue background. It creates a frame on the background, so we
have made it a little bigger and placed a picture inside the hollow area.

These are three different ways of using a bump map:

Texture 3D Buttons 3D Objects

You can even place bump maps on top of each other or animate a bump map to achieve amazing visual effects.

Applying a bump map to an object
> Create a bump map object by choosing Insert | lllustrations | Bump Map.

»  Select the bump map picture required, either from the gallery of predefined bump maps or from your own
hard disk. See "The Bump Map object” for more information.

»  Place the bump map object on top of the object you want to modify.

Using the grid

i
- The grid is a series of evenly spaced horizontal and vertical dots that help you position your objects. When
the grid is activated, objects snap to the grid points when you move them with the mouse. The greater the

spacing, the greater the "jump".

85



You can also move selected objects with the arrow keys. When you hold down Shift while pressing one of the
arrow keys, the selected object moves in the direction of the arrow by the number of pixels entered in the grid.
The grid does not need to be activated for this function to work.

» To access the grid, choose View | Workspace | Grid.

Grid X
¥ ¥

L
.
[ ] Snap to grid

Xand Y fields: The X and Y fields indicate the number of pixels between the grid points. Usually they should
be set between 8 and 16. Remember that the greater the spacing, the greater the "jump".

Show: Checking this displays a series of tiny dots on the page to represent the grid. Even when the grid is
hidden, the objects still snap to the grid points if 'Snap to grid' is checked.

Snap to grid: Check this to activate the grid and make the objects snap to the grid points when moved.

You can also define vertical and horizontal guides to help you position and align your objects. See "Using the
guides" for more information.

Using the guides

' Guides are nonprinting blue lines that help you align and position objects.

You can set guides where you want them using the workspace local menu. You can add, move and delete guides
as needed. You can also lock guides in place so that you cannot move them accidentally.

Adding a guide

Before you add a guide, you must make sure they are visible:
» Choose View | Workspace | Guides.

» Check Show in the Guides dialog and click OK.

Guides ﬁ|

s
Snhap to guides

[]Lock

Move the mouse pointer at the point of the workspace where you want to insert the guide.
Right-click the page to open its local menu.

Choose Guides | Add Vertical or Guides | Add Horizontal to insert the corresponding guide on the
workspace.

Activating and locking the guides

By default, the guides are activated, meaning that objects shap to the guides when you move them with the
mouse within a few pixels of the guides.
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Show: Uncheck this option to hide the guides. When the guides are hidden, the objects still snap to the guides if
'Snap to guides' is checked.

Snap to guides: Uncheck this option it if you don't want the objects to shap to the guides when moved.

Lock: If you check this option, you will not be able to move the guides. This is useful when your page contains
many different objects that you need to position accurately, as it prevents you from moving the guides
themselves inadvertently while trying to drag an object.

Moving a guide

» Place the mouse pointer on the guide so that its shape becomes a double arrow.
You can now move the guide in two different ways:

e Move the guide with the mouse in the direction required.

The number shown in the yellow box changes dynamically as you move the guide to indicate its current
position.

226

+F

I
e Double-click the guide and enter the new position for the guide in the white box that appears.
Deleting a guide

> Place the mouse pointer on the guide so that its shape becomes a double arrow.

» Right-click the guide to open its local menu.

» Choose Delete Guide.
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Working with pages

Creating pages

|—| The page is the foundation of any Mediator project: this is where you place all your objects, and the way
you navigate in a Mediator project is by going from page to page.

When adding a new page to your project, you have two choices:

e Creating an empty page, or

e Creating a page based on a predefined page layout

Creating an empty page

You can add a new empty page to your project in several ways:

e Choose Home | Pages | New (clicking the upper part of the icon), or

e Choose Page | Page Setup | New (clicking the upper part of the icon), or

e Press the Insert key.

The New Page dialog appears.

New Page E

Fage name:

Color: [
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Enter a name for the new page.
(optional) Choose a color for the new page by clicking the Color button.

This opens the standard Colors dialog in which you can set the background color of the page. For more
information on the Colors dialog, see "Choosing a color".

The color you select becomes the new default page color, and remains so until you select another color in
the New Page dialog.

Creating a page based on a predefined page layout

Clicking the arrow in the lower part of the New Page icon lets you choose from a gallery of predefined pages.
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When you insert one of these predefined pages into your project, it is placed immediately after the current page.

Page Layouts: Here you will find families of pages which you can drop directly onto your project to save you
from having to do all the design work yourself. You can customize the pages as you wish by adding or deleting
buttons. You can link the pages to create a full web project and are free to use some or all of the pages more than
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once. The page layouts displayed correspond to the document type and document size you chose when creating
the document in the New Document dialog. For more information on document types and document sizes, refer
to the topic "Creating a document". Note that you can change the document type after its creation. See
"Document properties” for more information. You can also resize a document after its creation with the View |
Document | Resize command. If you have chosen a custom size for your document, all the page layouts
available for your document type are displayed, and you can choose the size nearest to your own document size.

Dynamic Templates: This category contains four ready-made interactive pages - Contents, Index, Search and
History - which you can drop in your projects to integrate the corresponding functionality automatically.

These interactive pages are fully described in the topic "Using the dynamic templates".

Handling pages

The Page Setup group of the Page tab contains the most important commands when working with pages.

L] A ) @ [

Fename Color  Properties
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Page Setup

Q For convenience, the Pages group of the Home tab also contains the most important page commands.
You can also access the commands related to the currently selected page in other ways:

e By right-clicking the page in the Page list

e By right-clicking the workspace (without hitting any other object)

All the pages contained in your project are listed in the Page list. You can select a page simply by clicking it in
the list.

If the Page list is not open, you can open it by one of the following methods:
e Choose View | Show/Hide | Page List, or
e Press F8.

The Page list also allows you to change the order of the pages within the project, and gives you access to a few
additional commands. For a full description, refer to "Using the page list".

Deleting a page

> Select the page in the Page list and choose Page | Page Setup | Delete or press the Delete key.
Note that page deletions cannot be undone.

Renaming a page

> Select the page in the Page list and choose Page | Page Setup | Rename.

Changing a page color

e Choose Home | Pages | Color, or

e Choose Page | Page Setup | Color.

Copying and pasting a page

» To copy a page select it in the Page list and choose Home | Clipboard | Copy (or press Ctrl + C).

»  Select the page in the Page list after which you would like to insert the copied page and choose Home |
Clipboard | Paste (or press Ctrl + V).
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Page properties
All pages have a Properties dialog where you can make any necessary changes.

If the Properties dialog is not open, you can open it by one of the following methods:
e Choose Page | Page Setup | Properties, or
¢ Right-click the page in the Page list and choose Properties in its local menu, or

e Press Ctrl + F8.

QI You can resize, dock and undock the Properties dialog according to your needs. See "Using the Mediator panels” in the
topic "'Setting up your workspace" for more information.

Q You can quickly change the properties of several pages simultaneously by selecting all the relevant pages. In that case,
only the fields that are common to all the pages selected are shown in the Properties dialog. This is convenient if you wish to
change the color of several pages in one go, apply a master page to several pages, etc.

See the topics "Page properties: General tab" and "Page properties: Notes tab" for a complete description of all
the properties applicable to the page.

Creating interactivity

To find out how to create interactivity on your pages, refer to the topic "Using events and actions".

Using the Page list

\jjJ The Page list enables you to quickly access all the pages of your project and to jump to any page simply
by clicking it.

If the Page list is not open, you can open it by one of the following methods:
e Choose View | Show/Hide | Page List, or
e Press F8.

Pages x
| welcome
= L9 Solutions
L9 Industry
|9 Education
L Govemment
a Products
|j| Support
= L9 Community

| Designers
L Partners

QI You can resize, dock and undock the Page list according to your needs. See "Using the Mediator panels™ in the topic
"Setting up your workspace" for more information.

The pages are listed with their default names, in order of creation. You can move pages anywhere in the Page list
simply by dragging and dropping them.

You do no have to place all pages in a straight line under each other. You can also create sub-pages by indenting
them under higher-level pages in order to structure large projects. This allows you to visualize very easily the
structure of your project with chapters, sub-chapters, start pages etc.

The + sign next to a page name indicates that the page contains one or more sub-pages. To see the sub-pages,
simply click the + sign, which then changes to a - sign. The sub-pages appear to the right of the main page.
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When you have finished viewing the sub-pages, click the - sign again and the + sign re-appears next to the main
page.

The structure of the Page list is important because:
e A Mediator project always runs from the first page in the Page list (from top to bottom).

e The commands @Next, @Previous etc. in the Go to Page action all relate to the structure of the Page list.
Refer to the description of the Go to Page action for a description of these special @pages.

Selecting a page

» To select a page in the Page list, just click it.

Selecting several pages

The way you select several pages in Mediator is the same as in Windows:

» Click the first page, then press and hold down the Ctrl key while clicking the other pages one by one.
Each of the pages you click becomes highlighted to indicate that it is selected.

You can also select a range of pages:

» Click the first page, then press and hold down the Shift key while clicking the last page in the range you
want to select.

All the pages listed between the first and last page become selected.
Deselecting pages
» To deselect one or more pages simply click them again while holding down the Ctrl key.

Inserting a new page

» To insert a new page in the Page list simply right-click the page after which you would like to place the new
page, and choose New (or select the page and press the Insert key).

Mew Page §|
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You can choose a color for the new page by clicking the Color button. The color selected becomes the new
default page color, and remains so until you select another color in the New Page dialog.

Renaming a page

You can rename a page in several ways:

¢ Right-click it and choose Rename in its local menu.
e Select it and press F2.

e Select it and click it again slowly.

Moving a page

» Click the page in the Page list and move it to the desired location while keeping the mouse button down. Let
go of the mouse button.
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e If you let go of the mouse button between two pages (thin line visible between the pages), the selected page
is placed between the two pages.

e [f you let go of the mouse button on top of (or next to) another page (highlighted by a thick line), the page
you are moving is inserted as sub-page of the highlighted page.

Saving a page in the Multimedia Catalog

If you have designed a page or a set of pages that you would like to re-use in your current or future projects, you
can save them in the Multimedia Catalog.

> Select the page or set of pages and drag them to the category of your choice in the User Area of the
Multimedia Catalog.

The pages are saved in the Multimedia Catalog with the extension .080 which is specific to Mediator. You can
drag them back from the Multimedia Catalog into your current project or any other project at any time. See the
section "The Multimedia Catalog" for more information.

@ You can also right-click the page and choose Save in Multimedia Catalog. In that case the page is placed
in the root of the User Area.

Copying a page to another project using Windows

As well as using the Multimedia Catalog as described above to copy one or more pages from one project to
another, you can also use your desktop or any other folder:

> Select the page or set of pages and drag them to the desktop or folder of your choice.

This will create a file with the name of the first page you are copying followed by the extension 080, for
instance "mypage.o80".

» Open the project you want to copy the pages to.
» Drag the .080 file into its Page list.
You can even select several *.080 files and drag them all into the Page list at once.

If some of the new pages have the same names as existing pages Mediator will rename the pages being inserted.
5‘5’ To merge two entire projects together, refer to the topic "Merging documents".

Using master pages

A master page is a page that you use as a bottom or top layer on one or more other pages.

If used properly, master pages will save you a lot of work. If for instance you want to have a Next and Back
button on each page of a slideshow, you only have to create the buttons once on a separate page that you
designate as a master page.

If you later decide to choose a different button type, change the events and actions, add another button and so on,
you only have to change the page designated as master page instead of all the pages using the buttons.

You can designate a particular page as top master page or bottom master page:

e Objects placed on a top master page appear in front of objects placed on the current page. A top master
page is therefore useful for buttons and menus.

e Obijects placed on a bottom master page appear behind objects placed on the current page. A bottom master
page is therefore useful for backgrounds and page design.

You can have as many master pages as you want, which means that you can create different sections in your
projects, each using different backgrounds, buttons, menus etc.
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@ A page that uses another page as a master page can itself be used as a master page, but it will be shown
without its assigned master page. Note also that the background color of a master page is ignored on a normal
page. This gives you the option of creating pages with different background colors, although still sharing the
same master page. If you want to use a master page to define the same background color for all pages, place a
rectangle of the required color on the master page, making sure it covers the entire surface of the page.

Creating a top or bottom master page

At the bottom of the screen you will see three tabs =~ &=~}

The middle tab = represents the current page. It is the tab that is selected while you are designing your
page.

The other two tabs let you assign a master page to the current page, as follows:

e Click the left tab &&= to assign a bottom master page.

e Click the right tab #e®  to assign a top master page.

@ You can also assign a master page to a page by opening the Properties dialog of the page and clicking the
Browse button next to 'Bottom master page' or 'Top master page' to select the required master page.

The first time you click one of the master page tabs the Page list appears to let you choose the page to use as
master page.

L welcome

Mew... ][ Q. H Cancel

> Either select an existing page from the list or click New to create a new page.

If you click New the following dialog appears:
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> First select a name for the page. Here we have used the name "master"”, but you can use any name.

> Select a color for the page (if you are only going to use the page as master page you do not need to select a
color, since the background color of a master page is ignored).

> Select where you wish to insert the page in the Page list.
After the current page: Places the master page immediately after the current page in the Page list.

As the last page: Places the master page as the last page in the Page list. It is often convenient to regroup all
your master pages at the bottom of the Page list.

As a subpage of the first page: Places the master page as a sub-page of the first page in your project. This
is convenient when you have many pages in your Page list, and wish to access your master pages often and
quickly.

As soon as you select a master page, the tabs shown at the bottom of the screen change appearance:

Rl == =

o If you assigned a bottom master page to the current page, the left tab is selected.

e |f you assigned a top master page to the current page, the right tab oo | o = | is selected.
You can now edit the master page itself.

Editing the master page

Create all the buttons and objects that you require on your master page.

When you have finished simply click the middle tab =& to go back to the normal page.

The tabs shown at the bottom of the screen have now changed.
e e T == | ,

e If you assigned a bottom master page, the eye on the left tab is now visible
indicating that the current page now has a bottom master page.

- k= |

e |f you assigned a top master page, the eye on the right tab is now visible , indicating

that the current page now has a top master page.

e |f you assigned both a bottom master page and a top master page, both eyes are visible
= I 2

You will see that the objects placed on the top master page appear in front of the objects on the normal page
while the objects placed on the bottom master page appear behind the objects of the normal page.

5@ You can also edit a master page by selecting it on the Page list.
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Using the master page tabs
Once you have assigned a master page to the current page, you can access it for further editing as follows:

> On the left master page tab ®2 | click the part of the icon representing pages = (not the eye) to go
automatically to the page assigned as the bottom master page.

> On the right master page tab @&, click the part of the icon representing pages 2 (not the eye) to go
automatically to the page assigned as the top master page.

Clicking one of the master page tabs allows you to edit the corresponding master page, although you actually
remain on the normal page. The eyes disappear from the master page tabs and the relevant master page tab is
selected.

You can use these tabs to skip back and forth between the three pages.

When a page has a master page attached to it, it can sometimes be convenient to view it without its master page.
You might for instance want to edit an object placed under an object belonging to the top master page.

» To hide the bottom master page click the eye on the left tab @&, The eye is now marked with a red cross
W

» To hide the top master page click the eye on the right tab @ . The eye is now marked with a red cross
iRl

When both master pages are hidden, the eyes on both tabs are marked with a red cross D o |S6 I.

» To view a master page again, simply click the corresponding eye to remove the red cross.
Quick example
In the following example we create a project that shows license plates from each of the 50 American states.

On our normal page we place a picture of a license plate:

[~ FLORIOA =g

asCHARLDTTE .

s —— e ——rre————

We click the left tab &2 to create a common background. The Page list appears and we click New to create a
new page that we will use as our bottom master page.

The master page tabs now change to g0 | o ] oo )
master page.

, indicating that we are ready to edit the bottom

On the bottom master page we place a rectangle, which we tone from black to light blue.

We click the middle tab to go back to the normal page.
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O |

The master page tabs change to
master page attached to it.

, indicating that our normal page now has a bottom

The normal page is now displayed with a toned rectangle in the background.

™ FLORIOA -‘E

aCHARLDTTES

We now wish to assign a top master page with a headline and two buttons. We click the tab on the right @ |
select New in the Page list, and start designing our top master page.

LTS E I..-Hli"-L.

We place a headline (License Plates) at the top of the page and two navigation buttons (Back and Next) at the
bottom.

We click the middle tab to go back to the Normal page.

The master page tabs change to G = T e
bottom and a top master page attached to it.

, indicating that our normal page has now both a

The normal page is now displayed with the toned rectangle as background and our headline and buttons on the
foreground.

License Plates
(™ FLORIOA =g

aCHARLOTTE.

We can assign these two master pages to all the pages of our License Plates project...

License Plates

T S

— ALOHA STATE -
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...which means that if we later decide to change the look of the buttons, the headline or the background, we only
need to edit those two pages (the bottom master page and the top master page) instead of the 50 pages of the
slideshow.

@ We did not set up the actual Go to Page actions on the buttons in this quick example.
Assigning a master page
There are four different ways of assigning a master page to a page.

1. Using the master page tabs at the bottom of the screen

2. Using the page Properties dialog of the page

3. Using the page Properties dialog on multiple pages

4. Copying a page that has master pages already assigned

1. You can use the master page tabs = I k==l (as described above) to assign master pages to the
current page. Once you have selected a bottom or top master page, you cannot however delete it or choose a
different master page using these tabs.

2. To choose a different master page, choose Page | Page Setup | Properties, and select a new page in the
relevant master page field. To delete a master page, just clear the field.

Properties for Page: Pagel bt
Description Pagel
Colar [ ]=55,255,255 M

Bottom master page | ... |MasterBottom
Top master page . |MasterTop

Keywords
Searchable [w True
Use in Conkents [w True

Size of pictures (KB} | 125

3. If you wish to attach the same master pages to many pages and do not want to go through the same process
for each page (using the tabs to select bottom and top master pages), you can use the Mediator multi-edit
function.

» Open the Page list (View | Show/Hide | Page List).

> Select all the pages to which you want to assign the same master pages (hold down the Ctrl key while
selecting the different pages).

» Choose Page | Page Setup | Properties.
» Click the Browse button of the relevant master page field (Top or Bottom).
»  Select the page you want to use as a master page.

4. If you have created a page and have assigned one or two master pages to it, it is very easy to create more
pages that also use the same master pages. Simply copy and paste the page in the Page list.

» Open the Page list (View | Show/Hide | Page List).
Select the page you wish to copy.
Right-click and select Copy or press Ctrl + C.

Right-click and select Paste or press Ctrl + V.

YV V VYV V

Repeat the last step until you have the right amount of pages.
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Using the dynamic templates

This topic describes the four ready-made interactive pages - Contents, Index, Search and History - which you can
drop in your projects when creating a page (Page | New | Dynamic Templates) to integrate the corresponding
functionality automatically.

Although these dynamic template pages are fully functional, you can change their visual appearance to match the
rest of your project design. You can add more buttons, pictures, change the color, change the text, etc.

We will now describe these pages one by one.

Contents

Dragging the Contents template into your project gives it a Table of Contents.

In design mode, the contents field is empty. In test mode and in the exported version, it contains a list of all the
pages you have chosen to include in the contents list. (You must check 'Use in Contents' in the Properties dialog
of a page if you want that page to be included in the list.) The end user can select a page to jump to that page.
The Back button takes the user back to the page he/she came from.

Index

Dragging the Index template into your project gives it an Index page.
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The left field lists all the keywords defined in the project. When the end user clicks a word in this field, all the
pages containing this particular keyword appear in the right field. The user can now select a page to jump to that
page. The Back button takes the user back to the page he/she came from.

You can associate keywords with pages and objects at design time:

» Open the General tab of the Properties dialog of the page or object and enter the keywords in the Keywords
field, separating them with semicolons, without spaces (e.g. Flower;Tulip;Yellow).

Search

Dragging the Search template into your project allows the end user to perform text searches.

The user enters the words to be searched for in the three fields on the left. When the And button is displayed,
Mediator looks for pages containing all the words entered by the user. Clicking the And button changes it to an
Or button. In that case, Mediator looks for pages containing any of the words entered by the user. Clicking
Search starts the search.

Mediator looks for pages whose keywords or objects contain the words entered by the user. Keywords may be
associated with pages or objects as described above. Note that the 'Searchable' property of the page or object
must be enabled for that page or object to be searched.
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The pages that meet the search criteria are listed in the large field on the right. The end user can now select a
page to jump to that page. The Back button takes the user back to the page he/she came from.

The Reset button erases the words from the search fields.

History

Dragging the History template into your project gives it a History page of all the pages that have been visited so
far.

_Contents_
Products
Solutions
Welcome

The end user can select a page to jump to that page. The Back button takes the user back to the page he/she came
from.

Creating interactivity

Using events and actions

@ Events and actions are responsible for all the activity in a Mediator project.

e Anevent is something that can happen to a page or to an object. For instance an object may be clicked, the
mouse pointer may be moved over it, it may receive a right click and so on.

Most events can occur on all objects, although some objects have specific events that are unique to them.
Other events, such as 'On Page Ready', are only available for pages.

For a complete list of the events available to both pages and objects, see "Events" in the Reference section.

e An action is an operation you perform when a particular event occurs on a page or on an object. For
instance, you may want to display another page when the user clicks a button, or play a sound when a picture
appears.

There are many different actions available. Each one of them is described in detail in the Reference section
of this documentation.

This topic describes how to use the Events dialog to combine events with actions.

ﬁ Objects for which events and actions have been defined are identified in the Object list by a yellow dot.
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Opening the Events dialog

You can open the Events dialog in various ways:

e To open the Events dialog related to the currently selected page, choose Page | Interactivity | Events or
press F9.

e To open the Events dialog related to a particular object, click the object and choose View | Interactivity |
Events.

You can also right-click the object and choose Events in its local menu.
You close the Events dialog by clicking the Close button or the X in the top right corner.
Q You do not have to close the Events dialog every time you have "programmed" an object. If you need to program several

objects, simply leave the Events dialog open and click the next object to which you wish to add functionality. The Events
dialog always refers to the selected object. If no object is selected the Events dialog refers to the current page.

Events on Page: Pagel x

Standard | Multimedia | External | Programming | Databaze | User

=
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OnStop
The Events dialog works in the same way for all pages and objects. The only difference is that some elements
have more events available to them than others.

e The vertical field on the left contains the events applicable to the selected page or object.

e The area in the middle is called the "active field". This is where you associate particular actions with
particular events.

e The actions are located in the horizontal bar above the active field. They are grouped in different tabs
according to their function.

QI You can resize, dock and undock the Events dialog according to your needs. See "Using the Mediator panels" in the
topic "'Setting up your workspace" for more information.

95’ The User tab, located at the far right of the Events dialog, contains some predefined event combinations
which are described at the end of this topic.

Attaching an action to an event
To attach an action to an event, you start by dragging the required event into the active field:

» Click the event and drag it into the active field.
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> Click the tabs above the active field to browse through the actions. Some tabs (depending on the size of your
Events dialog) have a scroll bar that you can use to reveal more actions.

» Once you have chosen the action you want to attach to the event, drag it into the active field immediately to
the right of the event. You cannot drag an action unless you already have an event in the active field.

Most actions open a separate dialog as soon as they are dropped in the active field.
» Fill in the dialog and click OK to return to the Events dialog.
The action now appears in the active field with a descriptive label, which varies depending on the action.

» To specify your own description, right-click the action and choose Description in the local menu.

@ The actions available depend on the type of the document. Documents of type HTML or Flash do not have
as many actions available as documents of type Standard. See the topic "Creating a document™ for more
information on the different document types. Please also refer to the "Mediator 9 feature list" for a complete list
of all the actions available for each type of document.

Attaching several actions to the same event

You can attach several actions to the same event. In that case, they are placed in a horizontal line after the event
and executed in order of appearance from left to right.

@ =)
e MP it &’:I
bouze Chok, Sound Set Cursor Goto Page

If the actions used do not make much use of the computer resources, it may seem that they are all executed
simultaneously. To avoid this, or to execute the actions in a specific sequence, you can use a timeline action.
Refer to the "Timeline" topic for more information.

@ The actions are started one after the other without any delay. This means that Mediator does not wait until
an effect has finished, or a sound or video has played to the end, before starting the next action.

Defining several events

You can also place more than one event in the active field for any given object. You can drag any of the events
listed in the events field under the events already placed in the active field, and attach actions to all of them.

When you work with multiple events, make sure that you place the actions to the right of the correct event in the
active field.

Working in the active field

Placing events and actions in the active field can be a little confusing to start with, particularly if you use actions
that open their own dialogs or if you need many combinations of events and actions.

Instead of recreating an entire event combination from scratch, it is often easier to copy an existing combination,
paste it where needed and make the required adjustments.

The operations involved are described below.

Selecting actions

e To select an action, click it once.

e To select several actions, hold down the Ctrl key while clicking each action.
Selecting combinations

e To select an entire combination of actions with their event, just click the event.
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e To select several combinations, hold down the Ctrl key while clicking each event.

e To select all the combinations of events and actions, right-click inside the Events dialog and choose Select
All in the local menu.

Cutting, copying or deleting actions or combinations

e To cut actions or combinations from the active field, first select the elements you wish to cut as described

above and drag them to the Clipboard icon N in the top left corner of the Events dialog while holding the
Shift key down. Let go when the pointer is on top of the Clipboard icon.

You can also right-click the selected elements and choose Cut in the local menu.

e To copy selected actions or combinations, just drag them to the Clipboard icon N (the shape of the
mouse pointer changes to a + sign). The elements remain in the active field, but are also placed on the
clipboard where they will stay until you replace them with something else.

You can also right-click and choose Copy in the local menu.

e To delete selected actions or combinations, press the Delete key or drag them to the wastepaper basket

=

L9 "

o'
You can also right-click and choose Delete in the local menu.

When you delete actions or combinations, they are removed from the active field and not placed on the
clipboard. You can restore deleted actions and combinations by choosing Undo in the Quick Access
Toolbar.

Pasting actions and combinations

You can paste back the actions or event combinations that you have just cut or copied, in the Events dialog of the
same page or object, or in the Events dialog of a different page or object. To do this:

i

» Move the mouse pointer to the Clipboard icon N click and drag the elements back into the active field
(the shape of the mouse pointer changes to a + sign).

You can also right-click the active field and choose Paste.

Moving a combination

» To move an event combination (over or under other combinations), click the event to select the whole
combination, then simply drag it to the desired location in the active field.

This has no effect on the functionality of the page or object, but can sometimes give a better overview of the
combinations you have created.

Saving actions and combinations in the User tab

As the Windows clipboard, the Events dialog clipboard is only useful as temporary storage. Anything stored on
the clipboard is lost as soon as something else is placed on it or when the computer is shut down.

You can however save actions and event combinations permanently in the User tab of the Events dialog. To do
this:

» Open the User tab at the far right of the Events dialog.
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» Drag the selected actions or event combinations from the active field to the User tab.

To re-use these saved actions and combinations:

» Open the Events dialog of the page or object you are programming.

» Drag the actions or event combinations from the User tab into the active field.

Saving actions and combinations in the Multimedia Catalog

You can also save your favorite actions and combinations for later use in the Multimedia Catalog. To do this:
» Open the Multimedia Catalog by choosing View | Show/Hide | Multimedia Catalog.

» Open the User Area of the Multimedia Catalog, and create or choose the required category.

> Drag the actions or event combinations from the active field into that category.

You can re-use these saved actions and combinations at any time simply by dragging them to the Events dialog
of the page or object you are programming.

For more information about the Multimedia Catalog, refer to the section "The Multimedia Catalog".

Viewing the active field

The active field can be viewed in two different ways:

e The Default View displays all the actions belonging to a particular event in a row. You can see all the action
icons and add a descriptive text underneath each one (right-click the action and choose Description).
However the length of this descriptive text is limited by the space available between the icons. If your events
have many actions attached to them, this view may become cluttered.

Events on DObject: ButtonOpen
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e The Script View (showing here the same content as above) displays each event and each action on a separate
line, just like script code, and offers much more detail about the actions. To view these details in the Default
View, you would need to open the related dialog by double-clicking the action icon.
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Events on Object: ButtonOpen
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Placing and editing the actions is done in exactly the same way in both views. The only difference is the way
they are displayed.

> To switch between the Default View and the Script View, right-click the active area of the Events dialog and
check or uncheck Script View.

Disabling events and actions temporarily

Mediator allows you to disable particular events and/or actions while testing your project by "commenting them
out". This is only operational in test mode. In the exported version of your project, events and actions are
executed as normal, whether they are commented out or not.

To disable a particular action or event combination:
> Right-click the event or action which you want to disable temporarily.
» Choose Comment Out in its local menu.

A commented out event or action is identified by a red cross on top of the icon.

& A
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» To re-enable the event or action, just choose Comment Out again.

Using the predefined event combinations

Mediator offers some predefined event combinations, stored in the User tab of the Events dialog.

Click Here Cursor

{b This combines the events Move Into and Move Out with a Cursor action. On Move Into the cursor is
changed to a hand, on Move Out the cursor is changed back to normal. This combination lets you quickly set up
a cursor change on buttons, hypertext, hotspots, etc.
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Standard Drag & Drop

\—ITJJ This combines the events Mouse Down and Mouse Up with a Drag & Drop action. On Mouse Down the
current object is selected as the object to drag (using the system variable @ ThisObject). On Mouse Up the object
is dropped. This combination saves you time when you want to create drag and drop functionality for a particular
object.

o
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MDL&E_ Lo Drag & Drop
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Print Page

a
' Ei This combines the actions Report and Open Doc to create a print function. Place this combination after a
Mouse Click (or another event) to print the current page at runtime.

|
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Using keyboard events

Advanced

Mediator's keyboard events let you program particular actions depending on the key pressed by the user.

Pressing a key as two immediate effects:
e The On Key Down event is triggered.

e The @Key system variable receives the "value" of the key.

If for instance the user presses 'k’, the system variable @Key is assigned the value 'k'. See "System variables" for
more information on these variables.

The same goes for On Key Up. As soon as a key is released the system variable @Key is assigned the "value" of
the released key.

The only difference between the two events is the moment the event is triggered:
e On Key Down occurs as soon as the key is pressed.

e On Key Up occurs as soon as it is released.

These keyboard events are triggered every time a key is pressed or released, except when an input object is
active (since in that case the user is typing text which should not trigger any keyboard event).

You can choose to execute a particular action;

e When the user presses any key

In this case simply drag one of the two keyboard events into the active field following by the desired action.
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As soon as the user presses a key, the event will be triggered and the action executed.
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e When the user presses a particular key

This is still fairly simple. Drag one of the keyboard events into the active field followed by an If action
(from the Programming tab).

On key Up @k ep="k"

In the 'IF (Condition)' field, specify the key which the user must type in order for the action to be executed
(if you want to perform a particular action when the user presses 'k', enter @key="k"). Place that action in
the "'THEN (Do if condition is true)' field. You can also place an action in the 'ELSE (Do if condition is
false)' field that will be executed if any key other than 'k’ is pressed.

If-Then-Else [X]

|F [Condition]

@Kep="k" |

Standard |Multimedia External | Programming | Database | User
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The keyboard events react to any normal keys, any combination using Shift or Ctrl and all the function keys F1,
F2 etc. except F10. Letters and numbers will appear in the @Key variable between quotes: the letter a appears as
"a", the number 6 appears as "6" etc.

9? When testing for key combinations such as Ctrl + C or Shift + X, you should use the On Key Down event.
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Possible values of @Key:

Key @Key

[a]..[z] , [0]...[9] "tz """
[Shift] + [a]..[2] "A".Z"

- [Right Arrow] "right"

< [Left Arrow] "left"

N [Up Arrow] "up"

¥ [Down Arrow] "down"

[Ctrl] + [Up Arrow] "ctrl+up"

[Ctrl] + [a] “ctrl+a"

[Ctrl] + [Shift] + [a] "ctrl+A"

[Page Up] [Page Down]

"page up" "page down"

[Delete] [Backspace]

"delete” "backspace”

[Tab]

ntabu

[Return] [Enter]

"enter"

[Esc] "escape" (works only in runtime mode)
[F1]....[F12] "F1".... "F12" (F10 does not work)
[Spacebar] " " (space)

Using resources

&l Mediator lets you define resources on your pages.

A resource is nothing more than an action that you can pre-define and re-use. This simple enhancement of the
action offers some new powerful possibilities. With resources you can make your objects blink, you can pause
animations, you can create loops, and much more.

Resources can be compared to master pages. A master page lets you apply a particular set of objects to several
pages in one go. Similarly, a resource lets you re-use several times on the page an action which you only need to
define once.

If for instance you want to place the same action with the same parameters on different objects of your page, it is
a good idea to create the action as a resource. If you then decide to change one of the parameters, you only have
to do this once in the resource.

Quick example: You have 28 buttons on a page that all play the same sound when clicked. Then you decide to
change the sound. Instead of changing it on all 28 buttons, you only need to change it in the resource.

@ Resources belong to the page in which they are created, and are only valid for that page.

Opening the Resources dialog

You can open the Resources dialog in various ways:

e Choose Page | Interactivity | Resources or View | Interactivity | Resources.
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¢ Right-click the page and choose Resources in its local menu.

You close the Resources dialog by clicking the X in the top right corner.

Resources x
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By default, the Resources dialog contains the following resources: Timeline, Animate, Sound, Loop, Sub
Procedure, Database and HTTP Request.

Note however that you are not restricted to these preset resources since you can create a resource from any action
by dragging it directly from the Events dialog to the Resources dialog.

e The Timeline, Animate and Sound resources are ordinary actions which can also be found in the Events
dialog. They are particularly useful, and their advantages are described further down in this topic.

e The Loop resource lets you repeat an action or series of actions until interrupted by a Break action. See the
topic "Loop/Break" for more information.

e The Sub Procedure resource lets you group several actions for re-use on different objects. See the topic
"Sub Procedure" for more information.

e The Database resource is a special resource which lets you exchange data with a database. You can read
more about it in "Using databases" and "The Database resource".

e The HTTP Request resource is also a special resource. See the topic "The HTTP Request resource" for
more information.

Creating resources

» To create a resource, simply drag the icon required to the active field.

This opens the relevant dialog in which you can specify the parameters for that specific action/resource.
The default names Resource01, Resource02, etc. are not always convenient.

» To rename a resource, right-click it and choose Rename in its local menu.

Resources behave like actions.

» To edit a resource, double-click it.

Starting, pausing and stopping a resource

» To start a resource, simply place a Start action in the Events dialog of the object which is meant to start the
resource, and specify the name of the resource.

G

Mouse Click
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» To pause it, use the Pause action.

'ﬁi‘ - D

kousge Click, Rezourcell

» Tostop it, use the Stop action.

'ﬁ‘i R

M ouze Click Fezourcell

Resource events

(@ @ In addition to the Start, Pause and Stop actions that you can use on other objects to manipulate the
resource, you can also place actions on the resource itself using the On Start and On Stop events which are
triggered when the resource starts or stops.

Using the Timeline resource

You can use the Pause action to pause a Timeline resource and a Start action to restart it.

You can also use the Pause action in the timeline resource itself so that it pauses itself. This is a useful feature
when doing live presentations, where you place several Pause actions in the resource itself, and use a button to
start the resource every time it has been paused. This way you can execute both the resource and the presentation
in small steps.

oy | Timeline_resource o [Timeline_resource | Timelin
@ [ @ [ @

Timeline_resource
@[

Timelne_resource
@[

Oms  100:  200s  3ds  400s  SMs  600s  7Ods 800 9Ms
¢ >

":? You can get a Timeline resource to restart itself, thereby creating a loop. Place a Start action on the Timeline resource
where you wish to loop it. Select the resource itself as the object to start.

For a full description of the Timeline action, see the topic "Timeline".

Using the Animate resource

The advantage of this resource is that it lets you start, pause and stop the animation. You can also start it from
many different objects as described above.

For a full description of the Animate action, see the topic "Animate".
Using the Sound resource
Since the Start, Stop and Pause actions all work with resources, you can use them to control a sound resource.

You can for instance create a button that starts a piece of music, one that pauses it, and one that stops it or starts
another sound resource.

You can also use the Sound Volume action with the resource to control the volume and balance of the sound.

For a full description of these actions, see the topics "Sound" and "Sound Volume".
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Using project variables

X
24 Mediator lets you create project variables that you can combine with other project or system variables to
create expressions.

Creating a project variable

> Open the Project Variables dialog by choosing View | Programming | Variables.

Project Variables PS_<|

Mame | Scope | Tvpe | Initial “alue |

['_?\J Help ][ Mew... ][ Delete ][ Cloze

Here you can create new variables, change the type and scope of existing variables or delete them.
You can use the 'Initial Value' field to give an initial value to the variable.
Defining the variable scope
A project variable can be local or global:
e Local variables can only be used on the page where they are created.
Use them for calculations that are only needed on specific pages.

Local variables of the same name which are placed on different pages do not interfere with each other.

e Global variables can be accessed from any page in the project.

If you want to present on a particular page the result of a calculation done on another page, you should use a
global variable. Similarly, if you want to ask for the user name on one page so that you can use it on a
different page, you should store it in a global variable.

Global variables must have unique names.

Defining the variable type

Mediator supports six variable types:

o Text

Any sequence of ASCII characters, normal letters, special characters and numbers.
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Note that numbers that are stored in text variables cannot be used in calculations.
e Floating point
These are decimal numbers in the range 3.4*10 to the power of -38 to 3.4*10 to the power of +38 (32 bit).
e Integer
These are whole numbers in the range -2,147,483,648 to 2,147,483,647 (32 bit).
e Boolean (True/False)
Unlike the other types, boolean variables can only have one value: 1 (True) or 0 (False).
All comparisons result in a True/False expression.
e Object

Obiject variables are variables containing a reference to an object. This allows you to modify an object at
runtime without knowing its identity at design time.

You can assign an object to an object variable in two ways:

e Using the Mediator Assign action
e Using the Assign statement in script

e Array

Array variables let you store more than one value. They are described in detail below.

@ Only integer and floating point numbers can be used in number calculations.
Using arrays
An array is a variable with an index, enabling it to store more than one value.

In the example below, "Array" is the array variable name. The expression inside the square brackets [ ] is the
index.

Array[0] = "test”

Array[1] "abc"

@ It is not possible to initialize an array with values when creating the array variable in the Variables dialog.

Mediator arrays have only one dimension, which you do not need to specify as the array expands automatically
as you add more values to it.

The data contained in the array is of variant type. You therefore do not need to specify a variable type (text,
floating point, integer, boolean, etc.). Instead, each element of the array automatically inherits the type of the
value you assign to it.

You can for instance assign the following values to the "Array" variable without having to specify their type:
Array[0] = "Test"
Array[1] 512

@ Make sure you write the index immediately after the array name, without a space, i.e. Array[0], not
Array [0].

The index of the array is implemented as a string. In the following example, each of the index values is
converted to a string:

Array[0] = 400
Array[''test'] = 500
Array['abc™] = "text"
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This means that:
Array[0] = 5

is the same as:
Array["0™] = 5

The order in which the values are held internally is the order in which each index is added. This is only relevant
if you use script to iterate through the indexes (keys).

Using arrays with the Assign action

e To assign a value to a specific element of an array, you specify the element and its index in the Variable field
of the Assign dialog, e.g. Array["Test"], and fill in the assignment expression as usual.

e Toremove a single element from an array, you specify the element and its index in the Variable field, and
leave the assignment expression empty.

e Toclear an array, just specify the array name in the Variable field, and leave the index and assignment
expression empty.

Using arrays in Mediator objects
You can use arrays in list box objects and input objects:

e You can display the contents of an array in a list box by assigning the array to the list box using its
DataArray property. In a Set Property action for instance, you would have:

Listbox.DataArray = Array
You do not need to specify the index of the array.

You can also assign the contents of a list box to an array.
e You can perform similar operations with multiline input objects, using their TextArray property.

Using arrays in the HTTP Request resource
You can also refer to arrays in the Data field of the HTTP Request resource.
The Data field will expand automatically using the index as parameter name. So if you have:

Array[paraml'] = "test"

Array["param2'] abc

Data will expand to:
paraml=test&param2=abc

Integration with script

The Mediator array does not correspond to an array in script, but to an object.

To access the array data the script can use the functions:

e Get(index)

e Put(index,data)

e Clear()

e Remove(index)

Additionally the array object implements a container interface so that you can use "For each™ statements on the
array.

"Keys" is a sub-object implementing a container interface for iterating the keys (index).
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As an example, the code below will show a message box displaying each index:
For each index in myarray.Keys
Msgbox index

Next

Using expressions

Many of the fields in Mediator actions, including most Duration fields, accepts variables and expressions.

An expression may be a combination of project variables, system variables, numbers, object properties in the
Object.Property notation, functions and fixed text between quotes, all linked with operators.

Here are two examples showing the advantages of using variables and expressions in a Mediator project:

e Specifying a variable instead of a page name in the Go to Page action. The value of the variable is read when
the action starts, and used as the page name to go to. This lets Mediator determine at runtime the name of the
page to display, on the basis of the contents of the variable.

e Using an expression in the Duration field of an Animate action. The expression is only evaluated when the
action starts. This lets Mediator determine the duration of the animation at runtime, on the basis of the
contents of the expression.

Some of the fields that accept expressions are followed by an Expression button £z,

Clicking this button gives you access to all the elements you can use to build your expression, namely:

e System variables

These are built-in variables that help you in a number of different ways. For instance, @Key holds the value
of the last key pressed on the keyboard, @Date shows the current date, @ TempDir holds the path to the
user's temporary folder, etc. You can use any of these system variables in the expression field.

For a complete list of the built-in system variables available, see "System variables™ in the Reference
section.

e Functions
This list shows all the built-in functions you can use with variables, e.g. STRING, INT, COS, etc.

For a complete list of the built-in functions available, see "Functions" in the Reference section.

e Operators

This lists shows all the operators available. You can use operators to add values, multiply values, combine
variables, check for larger than (>), smaller than (<) etc.

For more information on operators, refer to "Using operators".

e Project variables
This is a list of all the variables you have created in your project. It includes all local and global variables.
For more information on project variables, refer to "Using project variables".

Using expressions to build file names

You can also use expressions to build file names and path names to external files. In that case, if you intend to
export and distribute your project to other users, you will need to ensure that Mediator includes the files in the
exported version, by using the command Prepare | Additional Data Files or Prepare | Additional Program
Files prior to exporting. See "Adding data and program files" for more information.
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Using object expressions
Object expressions are expressions of type object. They have the syntax:

Object.Property

where object can be the name of a Mediator object or an object variable, i.e. a project variable containing a
reference to an object.

Object expressions can be used in various ways:
¢ In Mediator actions that refer to objects: Show/Hide, Start/Stop/Pause etc.
¢ In Mediator expressions, in order to get or set properties with either:;

e ObjectVar.Property (object variable) or
e ObjectName.Property (object constant)
e To transfer Mediator object references from Mediator to script code (parameters in the Script action)

Using operators

A dvane ‘

An operator allows you to perform an operation between two expressions. You can select an operator from a list

by clicking the Expression button f% that appears in most programming dialogs, but it is often quicker to enter
the operator manually.

Priority Mediator | Function

1 0 Parentheses

2 A Power
* Multiplication
/ Division

3 + Addition

- Subtraction

4 = Comparison
<> Not equal
< Less than
<= Less or equal to
> Greater than
>= Greater or equal to
5 AND And
OR Or

All operators within the same priority group have the same priority.
Operators in group 1, 2, 4 and 5 cannot be used on text expressions.

All operators in group 4 result in a true/false expression.
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Examples:

10+5*2=20 (* has priority over +)

(10+5)*2=30 (expression between parentheses is calculated before applying *)
2"r3=8 (2 raised to the power of 3)

2723+2=10 (™ has priority over +)

"Medi" + "ator" = "Mediator" (addition of two text expressions)

10 <20 =True (comparison of two numbers)

Using control characters

L dvane ‘

The character | is a special character in Mediator. It is referred to as an "escape character”. You can use it in
combination with other characters to insert new lines and other special characters in variables and text files.

The following is a list of useful combinations:

Characters | Resulting | Comment
entered character

[| | Since the character | has a special significance for Mediator, if you
want to use this character in your text, you must enter two of them,

e.g. ||

" " To place quotes inside an expression enter |"

|r Line feed | To go to a new line within an expression use |r
(CR)
[n Line feed | To go to a new line within an expression, you can also use |n
(LF)
Examples
"This is a text constant” Text placed between quotes in an Assign action
"A |"true|" constant” To use quotes inside the assignment expression you

must place a | in front of each ".

"This is on the first line. [r And this is on the second | The |r is equivalent to a line feed, so that the text will
line." appear like this:

This is on the first line.
And this is on the second line.
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Assign

" ariable;

[rpt L

Azsignmment expression;

"4 |"truel" constant. Thiz iz on the first line rdind thiz iz anthe | {x
gecond line."

[ ok [ Cancel

A"true" constant. This is on the first line.
And this is on the second line.

Using o08o files

An 08o file is a Mediator file that contains single or multiple Mediator items. These items can be pages, objects,
actions, events with actions and so on.

If you have created general purpose functions that you use often, you can save them as 08o files in order to reuse
them easily.

A simple example is the sequence 'Move Into - Change cursor to hand' and 'Move Out - Change cursor back to
normal’. As this combination of events and actions is frequently used, it is saved by default as an 08o file in the
User tab of the Events dialog, under the name Click Here Cursor.

. ¥
E. 4 b
bove Int Hand
. ¥

A (B3
blowve Ot Maormal

Creating an 08o file

> Set up the events and actions required, then select them all and drag the selection to your desktop, to a
folder, to the User Area of the Multimedia Catalog or to the User tab of the Events dialog.

Mediator automatically creates an 080 file containing the events and actions. You can do the same with objects,
for instance if you have a special object which you don't want to recreate every time. All the object functionality
is included in the 08o file.

Using an 08o file

To use an 08o file, simply drag it from where you placed it back into your Mediator project. You can drop it on
the workspace, in the Events dialog, in the Resources dialog and so on. Obviously you cannot drag an 08o file
containing an object to the Events dialog.

Using o8o files with macros

08o files are particular useful when using macros since objects or actions created from a macro script must be
located in an o8o file.

To create a slideshow macro for instance, just predefine the picture object you want to use. Then let the macro
insert it on the pages and change the file path in each object created with the macro.
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Printing text and pictures

W

One possibility for printing text and pictures from within a Mediator project is to use the Open Doc and Execute
actions.

Printing text

The Open Daoc action is well suited to printing any type of text document.

Its ‘Action’ field gives you access to the same commands as when you right-click the document on your
computer. Selecting 'print’ will therefore allow you to open, print and close the document. Note however that the
actions available depend on the program associated with the file extension on the computer. The actions
available to the end user may therefore not be the same as the actions available to you.

Here we have selected to print a Microsoft® Word file placed in the same folder as our Mediator project by
using the @DocDir system variable.

Open Document [z|
Diocument;
|@DocDir +"MyFile doc” |
Action;
| Frintta [Frintto] w

You can also use the Execute action with Notepad to print simple text files.

» Enter "Notepad /p" in the 'Application’ field (with the quotes) and enter the file name, e.g. "MyTextFile.txt"
in the 'Command line' field.

The Execute action will open Notepad, and the /p command will open, print and close MyTextFile.txt.

Execute [5_(|

Application [file name]:
|"N|:-tepau:| At |

Command line;

| "CAMyD ocumentshbdu T extFile " |

To print formatted text, use the Windows program WordPad rather than Notepad:

» Enter "Write /p" in the 'Application’ field (with the quotes) and enter the file name, e.g. "MyTextFile.rtf" in
the 'Command line' field.

Printing pictures
The Open Doc action also works very well with pictures.
» Enter the path to the picture.

»  Select 'print' in the 'Action’ field to open, print and close the picture.
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Open Document E

Dacument;

"DADaatasPictures s yFicture. brop"
Achan:

printto [printto] v

5@ If you are printing text or pictures that are not an integral part of a project that you intend to export and
distribute to others, you need to add the files to the project to ensure that Mediator will include them when
exporting the project. See "Adding data and program files" for more information.

Using the Search Manager

Advancec
1

ﬂ Mediator allows your users to perform keyword and text searches on your project at runtime. For this
purpose, Mediator maintains two internal search lists per project:

o A Keywords list

This contains all the keywords you have added to your project. You can attach keywords to each page and
each object via the Keywords field of their Properties dialog. Keywords should be separated with
semicolons:

Top master page | ... |

Kewwords brand; product
Searchable [w True
IJse in Conkents [w True

e A Textsearch list

This list is maintained automatically by Mediator. It contains all the words appearing in the project's page
descriptions, text objects, headline objects and buttons.

@ For a word to be added to this list, both the object and the page it belongs to must have their
'Searchable' property set to True.

Searchable v True

Maintaining the search lists

The purpose of the Search Manager is to help you remove insignificant words (such as "and", "or", "the", "it",
etc) from the two search lists in order to optimize search speed.

» Choose Review | Search | Search Manager to open the Search Manager dialog.
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Search Manager

Whords [3): Excluded words:
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In this dialog, the left field lists all the words contained in the Keywords list and the Text search list added
together, whereas the right field contains the list of words that are excluded from the search.

The icons in the middle allow you to perform operations on the lists:

=
e Clicking = empties the list of excluded words.

=
e Clicking =

right.

moves the word(s) highlighted in the search lists on the left to the list of excluded words on the

=5
e Clicking 5] jets you exclude words according to their frequency of use within the project.

Exclude Words by Frequency [$_<|

Frequency limit: A frequency himit of 5 will move a ward
from the word ligt to the exclude list if
mare than 5 pages refer to the word.

The frequency limit can alzo be specified az a percentage,
such az 2%,

ak. l [ Cancel

Entering the value 5 in the 'Frequency limit' field would exclude any word appearing on more than 5 pages
from the search.

You may also specify this value as a percentage. Specifying the value 2% for instance would exclude any
word appearing on more than 2% of the pages.

=
e Clicking E removes the highlighted word(s) from the list of excluded words, which means that the word(s)
will become searchable again.

e Clicking % recreates the search lists. This process may take a long time for large documents. You can
interrupt it if necessary, but this will of course prevent the search lists from being fully refreshed.
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0 To select several words in one of the lists press and hold the Ctrl key while selecting the words.
Searching for keywords or text at runtime

Mediator gives you two ways of letting the user search your project for particular words at runtime:
e Using a list box

A list box of type 'Index' lists all the words contained in the project's Keywords list, whereas a list box of
type 'Search word' lists all the words contained in the Keywords and/or Text search list.

You can then decide what action to take depending on the word selected by the user in the list box.
For more information on these list boxes, refer to "List Box properties: List box tab".
e Using a ready-made page

You can include one of Mediator's ready-made Index or Search pages into your project. In addition to listing

the contents of the Keywords and Text search lists, these pages have the necessary functionality to let the
user click a word and go automatically to the page containing that word.

For more information on these ready-made pages, see "Using the dynamic templates".
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The Multimedia Catalog
Using the Multimedia Catalog

=
] L . . . . .
L The Multimedia Catalog can help you apply a professional design to your project very quickly. It contains
a vast collection of high quality multimedia elements organized in different categories and themes.

It gives you fast access to clipart, navigation bars, players, photos, backgrounds, sounds and much more. All the
Multimedia Catalog elements are free for you to use in your projects.

You can also store your own elements in the Multimedia Catalog. This enables you to re-use them whenever
needed by dragging them from the Multimedia Catalog into your projects.

Finally, you can connect one or more of your user categories to a folder on your hard disk or to a shared network
folder in order to view and use their contents. This feature is particularly useful when several users want to make
use of the same multimedia elements stored on a shared network folder.

> If the Multimedia Catalog is not already visible, choose View | Show/Hide | Multimedia Catalog to open

it.
Multimedia Catalog x
Search for:
Searchin: | Al w
* [ o User Area A

kLo Wy buttons
P [ Templates
* LgButtons
¥ [ Clipart
T [ llustrations
¥ [gPhysical Sciences

¥ L Earth Sciences
P [ Life Sciences ~

QI You can resize, dock and undock the Multimedia Catalog according to your needs. See "Using the Mediator panels"” in
the topic "Setting up your workspace" for more information.
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Overview of the Multimedia Catalog

The Multimedia Catalog consists of different categories, some of which contain sub-categories:

User Area: This area is reserved for your own use. You can add or drag any element to it, create as many
sub-categories as needed and even connect one or more of your user categories to an external folder. See
"Adding elements to the Multimedia Catalog" below for more information.

e Templates: Contains navigation bars and player bars which you can drop directly onto your page.

e Buttons: Contains all the buttons used in the page layouts available when creating a page, numerous square
and round buttons in different colors, and a full range of push buttons.

e Clipart: Contains over 1500 high quality illustrations covering many different educational fields, as well as
business and web-related illustrations. Also includes animated GIFs, photos, all kinds of different
backgrounds and bump maps.

e Sounds: Contains a broad range of different sounds which you can drop directly onto your pages or objects,
creating the relevant Sound action automatically.

e Preloaders: Contains a number of Flash preloaders.
e Favorites: You can place in this category any element you want to be able to find again quickly.

e Recent: When you add a Multimedia Catalog element to your page, this element is automatically copied to
the Recent category. This allows you to quickly find recently used multimedia elements in case you want to
use them again.

e Search Results: This category only appears once you have done a search in the Multimedia Catalog. It
shows all the elements of the catalog that correspond to your search criteria.

See the topic "Contents of the Multimedia Catalog" for more information about how to use some of these
contents.

Important: The Multimedia Catalog only shows elements compatible with your document type. If for instance
you have selected the document type HTML when creating your project, multimedia elements that are not
supported in HTML export are not shown in the Multimedia Catalog. The document type is hormally defined
when you create a document, but you can choose a different document type at any time later (see "Document
properties™). In that case, Mediator displays a message advising you to check that all the elements already
inserted in the project are compatible with your new choice of document type.

Browsing the Multimedia Catalog

> To see the contents of a category, select it by clicking it or by pressing the up or down arrow key on the
keyboard.

A small right-pointing arrow next to a category name indicates that this category contains sub-categories.
»  Click this arrow or press the right arrow key on the keyboard to show the list of sub-categories.
d7=RButtons|

You can collapse a category again by clicking its arrow or by pressing the left arrow key on the keyboard.

You can examine a particular multimedia element more closely by placing the mouse pointer over it. This shows
an enlargement of the element as well as relevant information such as the name of the element and its size.
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Using elements from the Multimedia Catalog

» To insert a Multimedia Catalog element on your page, just drag it from the catalog.

Some Multimedia Catalog elements actually consist of several objects grouped together as one. When the
element is dragged from the Multimedia Catalog onto the page it appears as a group in the Object list * 2] .

You can access a grouped object (for instance to edit the text on a button) in two ways:
e Open the group in the Object list (click the + sign) and select the object in the group you wish to edit.

e Press and hold the Ctrl key, then click the object you wish to edit.

Using the Favorites category

If you often use the same elements, placing them in the Favorites category allows you to find them again very
quickly. You can do this in two ways:

e Right-click the relevant element and choose Add to Favorites in its local menu.

e Drag the element from one of the Multimedia Catalog categories to the Favorites category.

The element is now copied to the Favorites category. If you want to remove it from this category at a later stage,
right-click it again and choose Remove from Favorites in its local menu.
Searching the Multimedia Catalog

If you need an element related to a particular topic (for instance Europe) or a particular type of element (for
instance a button), you can search the entire catalog for all the relevant elements:

» Type a search word in the Search for field. For instance, if you are working on a map describing various
countries and want to insert their flags on the map, start typing the word "flags". As soon as you enter the
3rd character (i.e. the letter "a"), pictures of flags appear in the Search Results category.

> (optional) If you want to restrict the search to a particular category, select this category in the Search in
field and click the Search icon [‘i to restart the search.

» Scroll down the Search Results category until you find the flag you require.

QI During a search, the Search icon changes to Q@- You can interrupt a search at any time by clicking this icon.

Searches in the Multimedia Catalog are keyword-based. Many different keywords have been associated with the
Multimedia Catalog elements to help you find rapidly what you need. By way of example, here are some of the
many different keywords you can search for:

people, men, women, children, buildings, symbols, countries, maps, flags, animals, plants, computing, transport

If you are looking for particular elements, for instance arrows or buttons in a specific shape or color, you can
search the Multimedia Catalog by typing relevant keywords, such as "arrows" or "purple".

When you enter the first few characters of a word or a full word in the 'Search for' field, Mediator goes through
all the keywords that have been associated with the Multimedia Catalog elements. All the elements which have
one or more keywords containing the characters you entered appear in the Search Results category.
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You can view the keywords associated to a particular element and even add your own as follows:
> Right-click the element in the Multimedia Catalog display area.
» Choose Properties in its local menu.

The Properties dialog appears.

Properties g|

Description:

Keywiords;
business;work; office; deals; transactions;

Separate mulkiple keywords with a semicolon “;

Help ] [ (0] 4 l [ Zancel

» Type the new keywords you want to associate with this element, separating them with semi-colons.

5@ The Properties dialog also lets you edit or remove unwanted keywords or change the description that
appears when you view an enlargement of the element.

Adding elements to the Multimedia Catalog

You can keep your own elements in the Multimedia Catalog for future use, either in an existing category or in

the User Area. You are also free to create your own categories within the User Area, to rename them or to delete

them.

e Any element you add to one of the existing categories of the Multimedia Catalog is identified by a little
shortcut icon, indicating that the element is not actually copied to the Multimedia Catalog, but only inserted
as a link to the actual element.

.7

e Any element you add to one of the User Area categories is identified by a small gray arrow.

There are different ways of adding an element to the Multimedia Catalog. Here is one of them:
» Select the category to which you want to add the element.

> Right-click the category and choose Add Element in its local menu.

» Choose the required element in the Open dialog.

You can also add elements by dragging them from your desktop, provided that their file type matches the
contents of the category in which you are trying to place them.

In addition, you can copy the following Mediator elements directly into any of the User Area categories you
might have created:
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e Mediator objects
e Mediator pages
e Mediator actions or combinations (i.e. an event and all the actions associated with it)

This allows you to store these elements for future re-use. The detailed procedure is described below.

@ Mediator elements are added to the Multimedia Catalog with the extension ".080", which is specific to
Mediator.

Copying Mediator objects into the User Area

» Open the Object list.

» Select the required User Area category.

» Drag the object(s) from the Object list to the User Area category.

Important: You cannot drag an object directly from the Mediator page to the Multimedia Catalog. You must
select the object in the Object list and drag it from there.

You can also right-click an object and choose Edit | Save in Multimedia Catalog. In that case the object is
placed in the root of the User Area.

Copying Mediator pages into the User Area
> Select the page or set of pages in the Page list and drag it to the required User Area category.

You can also right-click a page and choose Save in Multimedia Catalog. In that case the page is placed in the
root of the User Area.

Copying Mediator actions and combinations into the User Area
» Open the Events dialog for the object whose events and/or actions you want to copy.

You can now either:
e Drag an event into the required category to copy the event and all its associated actions, or

e Select one or more actions and drag them to the required category.

@ You can also copy actions and combinations from the Timeline dialog into the User Area.

Q To drag several elements simultaneously from Mediator, press and hold the Ctrl key down while selecting the elements
required, then drag the selection into the relevant category. The selection is added as a single ".080" file, named after the
first selected element but containing all the elements. When you drop such a file back into Mediator, all the elements you
selected are extracted from it.

Renaming an element

You can give relevant names to all the elements you add to the Multimedia Catalog or rename existing elements
as follows:

> Right-click the element you wish to rename and choose Properties in its local menu.
» Enter a new description for the element.

The new description will appear when you view an enlargement of the element.
Deleting an element

You can delete any element you have added to the Multimedia Catalog as follows:

» Right-click it and choose Delete in its local menu or select it and press Delete.
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Creating a category within the User Area

You are free to create your own categories within the User Area as follows:
» Right-click the User Area or the sub-category of the User Area in which you want to create a category.
» Choose Create Category in the local menu.

» Type the new category name in the white box that appears.

* [0 User Area
* LA Wy buttons
Lg My documents

You can also rename or delete any category in the User Area by right-clicking it and choosing Rename Category
or Delete Category respectively in its local menu.

Resetting the Multimedia Catalog

You can restore the original contents of the Multimedia Catalog at any time:
» Click the Mediator Button.

» Click Mediator Options.

» Click Preferences on the left.

» Click Reset Multimedia Catalog.

This will leave your User Area untouched, but will remove all the elements you might have added to any other
category.

Connecting a category to an external folder within the User Area

Mediator allows you to connect one or more of your user categories to a folder on your hard disk or to a shared
network folder. This feature is particularly useful when several users want to make use of the same multimedia
elements stored on a shared network folder.

» Right-click the main User Area or one of its sub-categories.
» Choose Connect to Folder in its local menu.

The Connect Category to Folder dialog appears.

Connect Category To Folder

Connect ta Folder;

Include Filker:

Image Filker: (*.jpa *.prg *.bmp *.qif * wmf *,emf) w

[ Include sub-Folders

Ik ] [ Cancel

S .
»  Type the path of the folder you want to connect to or use the Browse button = to locate it.

» Choose the required filter. If for instance you only want to view the available videos, choose the Video
filter.

Note that you can also type your own filter, such as *.bmp; *.jpg (separating the formats with a semi-colon
as shown here) to see only pictures using these file formats or *.* to view all the files contained in the
connected folder.
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> (optional) Check the 'Include sub-folders' option if you also want to see the contents of all the sub-folders of
the connected folder.

A new category is now created within the User Area, filled with all the contents of the connected folder that
match the filter you specified. The new category takes the name of the folder that you connected it to. It is
identified by a special icon to show that it is a connected category.

iy documents

If the contents of the connected folder are likely to change while you are working with the Multimedia Catalog,
for instance if the connected folder is a shared network folder to which other users have access, you can refresh
the connected category to make sure you see the latest contents.

» Right-click the connected category and choose Refresh in its local menu.

Note that you can also refresh any of the sub-folders of the connected category.

QI If the connected folder is very large, the Refresh operation may take a long time. You can interrupt it by right-clicking
the connected category and choosing Stop Refresh in its local menu.

Finally you can change the filter used to view the contents or even change the connection by connecting to a
different folder as follows:

> Right-click the connected category and choose Modify in its local menu.
» Choose a different path and/or a different filter in the Connect to Category Folder dialog as described above.
You can disconnect a connected category at any time as follows:

> Right-click the connected category and choose Disconnect in its local menu.

@ Disconnecting a connected category removes the link between your User Area and the folder you connected
to, but does not affect the external folder or its contents in any way.

Contents of the Multimedia Catalog

|

JEEd L . . . . N o
The Multimedia Catalog contains a vast collection of high-quality multimedia elements organized in

different categories and themes. It gives you fast access to clipart illustrations, templates, navigation bars, clipart,
preloaders and much more. All the Multimedia Catalog elements are free for you to use in your projects.

@ If you need an element related to a particular topic (for instance Europe) or a particular type of element (for
instance a button of a particular shape or color), you can search the entire catalog for all the relevant elements.
For more information, see the paragraph "Searching the Multimedia Catalog" in the topic "Using the Multimedia
Catalog".

Templates

Navigation Bars: This category holds top bars, side bars and generic menus that you can drop directly onto your
pages and use to setup the links you require via the Events dialog.

Player Bars: This category holds buttons that can be used to start and stop videos and sounds.

Buttons

Here you will find a vast collection of predefined buttons, including alpha channels, transparent colors and so on.

The only functionality attached to the Multimedia Catalog buttons is a Set Cursor action used to change the
pointer from its standard shape to the hand shape when it is placed on the button. Once you have dragged your
chosen button on the page, you will need to apply the functionality you require using the Events dialog.

Template Buttons: This sub-category contains all the buttons used in the page layouts available when creating a
page.

Square Buttons: Here you will find a range of square buttons in various colors, some containing text, some
containing only icons.
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Round Buttons: Here you will find a range of round buttons.
Push Buttons: Here you will find a range of push buttons.

Clipart

llustrations: This category contains over 1500 high quality illustrations covering many different educational
fields, as well as business and web-related illustrations.

Animated GIFs: Holds a variety of animations that you can use in your projects.
Photos: Contains 200 photos on a variety of themes.

Backgrounds: Here you will find pictures of scenery and many different textures that you can drag onto your
page. When dropped, the background is scaled to cover the whole page, but you can resize it as any other object
by pulling its handles.

Bump Maps: Holds Bump Map buttons and shapes that will apply a 3D design to your pages and objects.

Sounds

This category contains a broad range of sounds organized in different categories. To preview a sound, just place
the mouse pointer over it in the Multimedia Catalog.

You can drop these sounds directly onto your pages or objects, creating the relevant Sound action automatically
in the process:

e |f you drop the sound onto a page, the Sound action is created after an On Page Ready event.
¢ If you drop the sound onto an object, the Sound action is created after a Mouse Click event.

o If you drop the sound on the right of an event in the Events dialog, the Sound action is created after the
event.

Preloaders
This category contains a number of Flash preloaders (animated GIFs).

A preloader should be placed on each and every page that needs to display it. Note that when changing from one
page to another, it is always the current page that shows the preloader until the new one is ready for display.

To insert a preloader on your page, just drag it from the Preloaders category. Make sure its name appears as
"Preloader" in the Object list for the page.

Unless loading is under way, the preloader will be hidden regardless of whether its Visible property is set or not.
If it is set to repeat, it will loop continuously until loading is finished. If not set to repeat, it will "flick" through
its frames until loading is complete, so that it always ends on the last frame just before loading is finished.

Since the preloader GIF file of the first page in a project must be loaded before it can be shown, it should be as
small as possible so that the user gets visual feedback as soon as possible.
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Using the Drawing tool

Drawing tool: Overview

Z The Drawing tool is a very powerful built-in module which allows you to draw all kinds of different
shapes, using more advanced editing functions than with the Polygon tool.

You can create simple shapes, such as ellipses, stars or polygons using the tools provided. You can also create
freeform shapes and curves using the Bezier and Pencil tools and edit the points that define those shapes.

Although you can export your drawings from the Drawing tool in a variety of file formats, they are stored in
Mediator as vector graphics. Vector graphics (such as EMF or WMF files) describe images by considering the
geometrical shapes, lines and curves that make them up. This mathematical technique makes it possible to scale
vector graphics to any size without losing detail.

By contrast, bitmap graphics (such as JPG files) represent images as a collection of pixels arranged in a grid.
They usually appear jagged when enlarged.

The other advantage of vector graphics is that they are much smaller than bitmap graphics, which makes them
particularly interesting for Flash projects.

Antialiasing is applied to all shapes within the Drawing tool.

The Drawing tool is fully described in this section of the documentation.

Drawing tool: Creating a drawing

VA

> To create a drawing with the Drawing tool, choose Insert | lllustrations | Drawing and drag out a frame for
your drawing just as for any other object.

The Drawing Object dialog appears.

New Drawing Object

(%) Create new drawing

{:} Cpen exiskting drawing

[ Help ] I (04 l [ Cancel

This lets you either:

e Create a new drawing

Click Create new drawing, select a file name and folder where to save your new drawing and click Save.

e Open an existing drawing previously created with the Drawing tool

Click Open existing drawing and browse for the required drawing. When you click Open, the drawing is
inserted in the Mediator workspace. You can either leave it as it is or double-click it to modify it in the
Drawing tool.

Mediator drawings are created and saved with the extension .vdpr, specific to Mediator.

The Drawing tool window contains a menu bar, toolbars, a Properties panel and the workspace in which you
create your drawings.
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By default, the Properties panel is docked to the right of the workspace. You can however position it anywhere
on the screen by dragging its title bar or double-clicking it. You can also undock each tab separately or
recombine it with the other tabs by dragging its title bar.

You can also customize the location of the toolbars and hide or show the various panels and toolbars using the
View | Toolbars and View | Properties Panels menu.

By default, the contents of the Mediator window are shown in the background of the Drawing tool workspace,
allowing you to draw over existing objects or trace their outlines. You can however change the level of opacity
of this background, or choose your own picture as background by choosing View | Background in the Drawing
tool.

Background Settings El

[v Show background image
Background

{* Mediator background

" Image

Opacity: 40

v Show workspace

Help O | Cancel

Creating or modifying a drawing

To create or modify a drawing, you use the tools located on the Toolbar to draw shapes and set properties for
each shape using the Properties panel. All the shapes drawn make up a drawing object which will be inserted in
your Mediator project when you return to Mediator.

Note that if you draw several shapes at one time within the Drawing tool, these shapes are inserted into Mediator
as a single Drawing object. To insert multiple drawing objects into Mediator, you need to create each one
separately by clicking the Drawing tool, creating the shape and then returning to Mediator before creating the
next one.

For a complete description of all the shapes available in the Drawing tool as well as their properties, refer to
"Drawing tool: Creating shapes".

» To save your drawing at regular intervals and continue working in the Drawing tool, choose File | Save or
press Ctrl + S.

» Once you have finished working on your drawing, choose File | Return to Mediator.

If you have not saved your drawing yet, Mediator invites you to do so. Your drawing is then inserted in the
Mediator page. You can edit it further at any time by double-clicking it to re-open the Drawing tool.

e While working in the Drawing tool, you can create a backup copy of your drawing under a different name by
choosing the command File | Copy To.

e You can also import the contents of an existing drawing into your drawing by choosing the command File |
Copy From. This will overwrite the current drawing with the imported drawing.
Exporting a drawing

The Drawing tool also lets you export your drawing in a variety of file formats. You can for instance export your
drawing as a vector graphics EMF file and re-import it in Mediator as a picture object or as an image on a button
object.
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Replacing a drawing

You can replace the drawing displayed in a Drawing object by another drawing by modifying its Path in the
Drawing tab of its Properties dialog in Mediator. See the topic "Drawing properties: Drawing tab" for more
information.

Cloning a drawing

As with any other object, you can create a copy of a drawing in Mediator with the Edit | Duplicate command or
the Copy and Paste commands. In this case, both objects refer to the same .vdpr drawing file (their Path property
points to the same file). If you double-click one of these drawings and make changes to it using the Drawing
tool, the changes are made to both objects.

You can however create a copy of a drawing in such a way that an identical copy of the .vdpr file is also created:
» Right-click the drawing in Mediator and choose Create Clone in its local menu.

This generates an identical copy of the drawing, but the new drawing refers to a separate .vdpr drawing file. You
can now make changes to either drawing without affecting the other.

Drawing tool: Creating shapes

To create a drawing in the Drawing tool, you use the tools located on the Toolbar.
K%, ¢ 20078 MQ

The toolbar contains the following tools:

e Selection tool

¢ Point Edit tool - containing the sub-tools Add Point, Delete Point and Split Point
e Bezier tool

e Pencil tool

e Rectangle tool

o Ellipse tool

e Custom Shape tool - containing sub-tools for Polygon, Star and Heart shapes
¢ Rotate tool

e Hand tool

e Zoom tool

Terminology

The drawing tools allow you to draw two kinds of shapes:
e Predefined shapes, such as rectangles, ellipses or custom shapes (polygon, star, heart)

e Freeform shapes, such as Bezier curves and Pencil lines that follow the direction of the mouse movements

All shapes are defined by an outline, which may be visible or invisible. A shape can be opened or closed. A
closed shape may therefore also have a fill, which may also be visible or invisible.

By contrast with predefined shapes, the outlines of freeform shapes can be edited point by point.
It is however also possible to edit the outlines of predefined shapes by converting them first to Bezier curves.

The characteristics of each shape's outline and fill are defined in the corresponding tab of the Properties panel.
See "Drawing tool: Properties" for a complete description of all the properties applicable to each shape.

Properties x

General | Fill | Cutline |
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Drawing rectangles

>

Click the Rectangle tool L or press M on the keyboard.

Move the mouse pointer on the workspace, hold the left mouse button down and drag in the required
direction.

e Holding down the Shift key while dragging will grow the shape by the same amount in the X and Y
directions, thereby creating a perfect square.

e Holding down the Alt key while dragging will draw the rectangle from the center outwards.

e Holding down the Shift + Alt keys while dragging will draw a square from the center outwards.

Release the mouse button when the shape has reached the required size.

Drawing ellipses

>

Click the Ellipse tool O or press E on the keyboard.

Move the mouse pointer on the workspace, hold the left mouse button down and drag in the required
direction.

e Holding down the Shift key while dragging will grow the shape by the same amount in the X and Y
directions, thereby creating a perfect circle.

e Holding down the Alt key while dragging will draw the ellipse from the center outwards.

e Holding down the Shift + Alt keys while dragging will draw a circle from the center outwards.

Release the mouse button when the shape has reached the required size.

Drawing custom shapes

The Custom Shape tool lets you create polygons, stars and heart shapes.

>

>

Click the Custom Shape tool O, if its icon already depicts the shape you want to draw. If not, hold the
mouse button down to display the custom shapes available, then click the sub-tool required. This sub-tool
becomes the new default for the Custom Shape tool until you choose a different sub-tool.

)
[

7
v

Move the mouse pointer on the workspace, hold the left mouse button down and drag in the required
direction.

e Holding down the Shift key while dragging will grow the shape by the same amount in the X and Y
directions.
¢ Holding down the Alt key while dragging will draw the shape from the center outwards.

e Holding down the Shift + Alt keys while dragging will draw the shape proportionally from the center
outwards.

Release the mouse button when the shape has reached the required size.

Drawing Bezier shapes

These are shapes that consist of a series of connected Bezier lines or curves. The resulting line or curve may be
open (that is, it has non-connected ends) or closed (that is, its ends are connected so as to form a loop). Once
created, these shapes can be edited point by point using the Point Edit tool. You can also reshape each curve as
desired.

» Click the Bezier tool & or press B on the keyboard.

133



To create a series of connected straight lines:
» Click and release to place the start point and move the mouse in the required direction.
» Click and release again to place the second point and repeat until your line is finished.

To end the shape, do one of the following:

e Right-click or press Esc to create an open shape.

o Click the first point to create a closed shape.

To create a curve:
» Click and release to place the start point and move the mouse in the required direction.
» Click and hold the mouse button down, then move the pointer away from the point you have just clicked.

You will see something like this:

A handle now extends from the second point, which you can manipulate by dragging the white circle situated at
its end. The handle is not part of the curve itself, but determines its shape as follows:

e The position of the handle sets the direction of curvature and the angle at which the curve passes through the
point.

e The length of the handle sets the amount of curvature.

» Now drag the handle some more, extending it and changing its position.
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Notice that the curve is more accentuated, the direction of curvature has changed and so has the angle at which
the line passes through the second point.

» Right-click or press Esc to end the shape.

To create a series of connected curves:

Click and release to place the start point and move the mouse in the required direction.

Click and hold the mouse button down, then move the pointer away from the point you have just clicked.
Drag the handle until the first curve has the shape you require.

Release the mouse button to place the second point, thereby ending the first curve.

Move the mouse at the position where you want to place the third point.

Click and hold the mouse button down and drag the handle until the second curve has the shape you require.

Release the mouse button to place the third point, thereby ending the second curve.

vV V VYV ¥V V¥V VYV V V¥V

Repeat these steps as necessary to create all the curves you need.

¢

Q You can delete the last point drawn at any stage by pressing the Delete key.
To end the shape, do one of the following:

e Right-click or press Esc to create an open shape.
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e Click the first point to create a closed shape.

When you create a series of curves in this way, the two handles of each point are mirror images of each other.
You can however modify each handle independently later using the Point Edit tool. See "Drawing tool: Using
the Point Edit tool" for more information.

Drawing Pencil shapes

These are shapes that consist of one long curve, created by "drawing" directly with the mouse. The resulting
curve is open (that is, it has non-connected ends).

»  Click the Pencil tool Z or press P on the keyboard.

» Click to place the first point of your curve, and without releasing the mouse button, drag the mouse on the
screen. The tool will follow your mouse movement until you release the mouse button to end the shape.

Once created, Pencil shapes can be edited point by point in the same way as Bezier shapes. They can also be
converted to Bezier curves. See "Drawing tool: Using the Point Edit tool" for more information.

Drawing tool: Working with shapes

The Drawing tool lets you manipulate the shapes you create in a number of ways. You can for instance select
one or several shapes, move them, resize them, rotate them or group and ungroup them.

You can also arrange and duplicate selected shapes.

All these operations are described below.

Undoing actions
The Edit | Undo and Edit | Redo commands let you undo and redo up to 10 actions.

If the Undo or Redo commands are disabled, it means that there are no actions to undo or redo.

e Choose Edit | Undo, click the Undo icon = or press Ctrl +Z to undo your last action.

e Choose Edit | Redo, click the Redo icon B or press Ctrl + Shift +Z to redo the last action undone.
Selecting shapes

The most common method to select one or several shapes is as follows:

» Click the Selection tool k or press V on the keyboard, then either:

e Click the specific shape you want to select, or

e Hold down the Shift key and click all the shapes you want to select.

If a shape has no fill, click its outline to select it.

Ql If you are using another tool, you can enable the Selection tool momentarily by holding the Ctrl key down.

Another method for selecting one or several shapes is to drag a frame on the screen so as to completely enclose
all the shapes to be selected.

To select all the shapes on the workspace:
> Choose Edit | Select All or press Ctrl + A.

To deselect a shape:

» Click another shape or click an empty area in the workspace.

To deselect one of several selected shapes:

» Hold down the Shift key and click the shape to deselect.
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Copying, pasting and cutting shapes

You can use the usual Cut, Copy and Paste commands and icons for performing the corresponding operations on
one or more selected shapes within the Drawing tool.

Note that if you paste on the workspace one or more shapes previously copied, the pasted shapes are superposed
to the original shapes. To see the original shapes again, you need to move the pasted shapes away from them.

Duplicating shapes

You can very quickly obtain a duplicate or one or more shapes by selecting the shapes which you want to
duplicate and choosing Edit | Duplicate or pressing Ctrl + D.

Deleting shapes
»  Select the shape or shapes to be deleted.

> Choose Edit | Delete or press the Del key.

Moving shapes
You can use different methods to move selected shapes:

e Drag the selected shape or shapes with the mouse. If a shape has no fill, drag it by clicking its outline.

e Use one of the arrow keys to move the selected shape or shapes one pixel at a time in the direction of the
arrow.

e Hold the Shift key down while using one of the arrow keys to move the selected shape or shapes 10 pixels at
a time in the direction of the arrow.

e Change the X and Y properties of the shape (single shapes only) in the General tab of the Properties panel.
See "Drawing tool: Properties” for more information.

Resizing shapes
You can use different methods to resize a single shape:
» Click the Selection tool k or press V on the keyboard, then either:

e Move the pointer to one of the side squares of the frame surrounding the shape until it changes to a double
arrow and drag in the direction required.

e Move the pointer to one of the corner squares of the frame surrounding the shape until it changes to a double
arrow and drag in the direction required.

---B,

e Change the Width and Height properties of the shape in the General tab of the Properties panel. See
"Drawing tool: Properties” for more information.

QI You can resize several shapes simultaneously by grouping them first. See below for more information on grouping
shapes.
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To resize a shape proportionally:

» Hold down the Shift key while dragging the mouse pointer.

To resize a shape from its center:

» Hold down the Alt key while dragging the mouse pointer.

To resize a shape proportionally from its center:

» Hold down the Shift and Alt keys while dragging the mouse pointer.

Rotating shapes

One of the methods available to you to rotate selected shapes is as follows:

» Click the Rotate tool goy or press R on the keyboard.

» Place the Rotate cursor on the shape and move it around in the direction required.

QI You can rotate multiple selected shapes simultaneously by placing the Rotate cursor on any one of them, then moving it
around in the direction required.

You can also rotate the selected shape or shapes by entering a value in the Rotation field or using the Rotation
wheel in the General tab of the Properties panel. See "Drawing tool: Properties” for more information.

Arranging shapes

It may happen that the last shape you created covers partially or fully previously created shapes, thus preventing
you from working on these other shapes.

The Arrange commands let you change the order of your shapes:
»  Select the shape or shapes whose display order you want to change.

» Choose Arrange | Send Backward to send the selected shapes one level below their current level.
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» Choose Arrange | Bring Forward to bring the selected shapes up one level from their current level.
Grouping shapes

The Drawing tool allows you to group shapes together so that you can treat them as a single unit:

»  Select the shapes you want to group by clicking them one at a time while keeping the Shift key down.
» Choose Edit | Group or press Ctrl +G.

The Group command is only available when you have selected two or more shapes.

You can now move, resize and rotate these shapes as one unit.

» To separate a group back into its individual shapes, choose Edit | Ungroup or press Ctrl + U.

Drawing tool: Using the Zoom and Hand tools

Zooming in and out

The Drawing tool lets you zoom in or out to magnify or reduce your view, selected shapes or a particular area.
Note that the scaling of the rulers change as you zoom in and out to reflect the zoom factor.

Magnifying the view

You can choose between several methods to magnify your view by increments:

e Choose View | Zoom In.

e Hold the Ctrl key down and press the plus sign (Ctrl +).

e Click the Zoom tool Q then click the workspace.

Conversely, the following methods allow you to reduce your view:
e Choose View | Zoom Out.

e Hold the Ctrl key down and press the minus sign (Ctrl -).

e Click the Zoom tool Q hold the Alt key down and click the workspace.
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Magnifying selected shapes

> Select the shapes to enlarge with the Selection tool k .
» Choose View | Fit Selection or press Ctrl + Alt + 0.

This fits all the selected shapes within the boundaries of the workspace.

Magnifying an area

> Click the Zoom tool Q’ then either:
e Click the area to enlarge.
e Drag a frame around the shapes to enlarge.
This fits the framed area within the boundaries of the workspace.
Returning to the default enlargement
» Choose View | Fit to Screen or press Ctrl + 0.

Scrolling the view

As well as the scroll bars, you can use the Hand tool to reach different areas of the view.

» Click the Hand tool {rr? or press H on the keyboard, then drag the area of the view that you want to
reposition within the workspace.

QI If you are using another tool, you can enable the Hand tool momentarily by holding the Space bar down.

Drawing tool: Using rulers and guides

You can use the rulers and guides provided by the Drawing tool to help you position and size your shapes.

Using rulers

Rulers help you place and measure shapes accurately. They appear at the top and at the left of the workspace,
with large graduations denoting units of 100 pixels and small graduations denoting units of 10 pixels.

The rulers adjust as you scroll and zoom in the workspace. By default, the zero point is set at the upper left
corner of the workspace.

100

You can reset the rulers to their default position by choosing View | Fit to Screen or pressing Ctrl + 0.
Using guides
Guides are blue lines that help you draw and position shapes.

You can add, modify, and delete guides as needed and choose whether or not shapes should "snap" to the guides
when you move them.

Adding guides

» Click the top left corner of the workspace (zero point of the rulers) and drag a set of guides on the
workspace.
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If necessary repeat the operation to create further sets of guides.

If the guides are not fully visible, choose View | Guides | Show Guides to show them. This command
toggles between showing and hiding the guides. A check mark indicates that the guides are visible.

Modifying a guide
You can modify the position of a guide in two ways:

» Place the mouse pointer over the part of the guide located in the ruler until the pointer becomes a double
arrow and then either:

e Move it in the direction required.
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e Right-click it and choose Set Position in its local menu, then enter the new paosition for the guide.

Sek Position, ..

Delete

Deleting a guide

» Place the mouse pointer over the part of the guide located in the ruler until the pointer becomes a double
arrow, and then either:

¢ Right-click it and choose Delete in its local menu.
e Move the guide back into the top left corner of the workspace (zero point of the rulers).

Making shapes snap to the guides

You can use the guides to help you align the top, bottom, right or left edge of your shapes manually, but you can
also make your shapes align automatically with the guides.

When you move a shape within 10 pixels of a guide, the shape "jumps" so that it aligns automatically with the
guide. This is called making the shape "snap" to the guide.

You can enable or disable this feature by choosing View | Guides | Snap to Guides. This command toggles
between enabling and disabling the snapping of the shapes to the guides. A check mark indicates that the shapes
will snap to the guides.

Drawing tool: Using the Point Edit tool

The Point Edit tool and its sub-tools allow you to edit point-editable shapes created with the Bezier tool or the
Pencil tool or predefined shapes converted to Bezier curves. You can for instance:

e Select and move points and handles using the Point Edit tool % 4
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o
e Add points using the Add Point tool [E
e Delete points using the Delete Point tool %

e Open a closed shape or split an opened shape into two by using the Split Point tool E&&

e Modify the curves of Bezier shapes or any other shape converted to Bezier curves

All these operations are described below.

@ Whenever you select a sub-tool of the Point Edit tool, this sub-tool becomes the current default sub-tool.

Converting a shape to Bezier curves

You can convert predefined shapes and shapes created with the Pencil tool to Bezier curves. This enables you
not only to edit their points with the Point Edit tool, but also to modify their curves by moving their handles.

Note that it is no longer possible to edit any of the original specific properties of a predefined shape once it has
been converted to Bezier curves. If for instance you convert a polygon to Bezier curves, its 'Number of sides'
property is no longer available in the Properties dialog.

You can use different methods to convert a shape to Bezier curves:

o Select the predefined shape or Pencil shape to convert and choose Edit | Convert Selected Shape(s) to
Bezier.

¢ Right-click the predefined shape or Pencil shape to convert and choose Convert Selected Shape(s) to
Bezier in its local menu.

o Click the Point Edit tool % 4 or press A on the keyboard and select the predefined shape or Pencil shape to
convert.

If you use the third method, the Conversion to Bezier Curves dialog appears to warn you of the consequences of
converting a predefined shape to Bezier curves.

If you disable the display of the Conversion to Bezier Curves dialog, you can re-activate its display at any time
with View | Preferences.

QI You can undo a conversion to Bezier curves by clicking Edit | Undo or pressing Ctrl + Z.

Moving a point on a shape

Moving a point on a shape allows you to change not only the position of the point, but also the position and
curvature of both curves connected to the point.

» Click the required shape to select it.

»  Click the Point Edit tool % 4 or press A on the keyboard.

Points are shown as black squares on the outline. Each handle is made up of a white circle with a line connecting
it to a point. Unless it is positioned at the end of a line or curve in an open shape, each point has two handles, one
for each of the curves that connect to it. The handles may be very short, or of zero length, in which case the
white circles appear right next to the black square representing the point.

A
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» Click the point that you want to move and hold the mouse button down.

The cursor changes to a cross with four arrows.
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» Move the point in the direction required.

» Release the mouse button.
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Note that the selected point is shown as a white square on the outline.

Modifying the curves making up a shape

As well as moving points, you can modify each end of the curves connecting to a single point by moving the
relevant handle.

» Click the required shape to select it.

» Click the Point Edit tool % 4 or press A on the keyboard.
»  Click the handle that you want to move and hold the mouse button down.

The cursor changes to a cross with four arrows.
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» Change the orientation and/or length of the handle.

> Release the mouse button.

Note that if you want the curves connecting to a point to pass smoothly through it, the two handles that control
the curves on either side of the point must be in line with each other.

This is most easily achieved by making both handles mirror images of each other:
» Hold down the Shift key while moving one of the handles.

The length and position of the other handle are automatically adjusted so that it becomes a mirror image of the
handle you are moving.

Adding a point to a shape
» Click the required shape to select it.

»  Click the Point Edit tool R and hold the mouse button down.
. . [ .
» Drag the pointer to the Add Point sub-tool and release the mouse button to select it.
@ You can select the Add Point sub-tool temporarily by holding the Alt key down.

+
Move the Add Point cursor I% at the position of the shape's outline where you want to add a point.

When a little square becomes visible on the outline, click to place the point.
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Deleting a point from a shape
» Click the required shape to select it.

» Click the Point Edit tool % < and hold the mouse button down.

» Drag the pointer to the Delete Point sub-tool E& and release the mouse button to select it.
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» Move the Delete Point cursor E& on the point of the shape's outline which you want to delete.
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» Click the point to delete it.

The point disappears.
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Another method for deleting a point is to use the Delete key as follows:

» Click the required shape to select it.

» Click the Point Edit tool % a,
» Click the point to be deleted.

The selected point now appears as a white square.
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> Press the Delete key to delete the point.
Splitting a point into two points

The Split Point tool Ay allows you to split a point into two points. This works rather like a pair of scissors,
opening up a closed shape or cutting an open shape into two separate sections.

Let us consider first the effect of the procedure on an open shape.

»  Click the required shape to select it.
»  Click the Point Edit tool %  and hold the mouse button down.
» Drag the pointer to the Split Point sub-tool W’ and release the mouse button to select it.

@ You can select the Split Point sub-tool temporarily by holding the X key down.

El
» Move the Split Point cursor L\-f' on the point of the shape's outline which you want to split.
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»  Click the point to split it.

The point has now been split, which has the effect of disconnecting the curves at that point, each disconnected
curve now ending with a separate point and handle. Only the part of the shape on the left of the point just split
stays selected.

It is now possible to select this left part of the shape with the Selection tool and to move it away from the right
part.

The two shapes are now independent from each other.

AWa

If you perform the same operation on a closed shape, the effect is to open the shape at that point, each end of the
shape now ending with a point with one handle, as shown below.
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Making a point soft or sharp

If you want the curves connecting to a point to pass smoothly through it, the two handles that control the curves
on either side of the point must be in line with each other. This can be done automatically by converting the
point from "sharp" to "soft" as follows:

> Select the point to convert so that it shows as a white square.

o

ot

> Right-click it and choose Make Selected Point(s) Soft in its local menu.

e

The two handles of the point are now mirror images of each other.

[

QI You can also keep both handles as mirror images of each other by holding down the Shift key while moving one of the
handles.

Conversely, you can "sharpen™ a point, making the angle between the curves that connect to it as small as
possible, as follows:

> Select the point to convert so that it shows as a white square.

» Right-click it and choose Make Selected Point(s) Sharp in its local menu.

Selecting multiple points

Some of the operations described above, such as moving, deleting or converting a point from sharp to soft and
vice-versa, can be performed on several points simultaneously. All you need to do is to start by selecting all the
points that you want to act on.

»  Click the required shape to select it.

» Click the Point Edit tool % 4,
> Hold down the Shift key and click each of the required points one by one.

The selected points appear as white squares.
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QI A quicker method for selecting multiple points on a point-editable shape is to drag a frame around the part of the shape
containing the points. This has the effect of selecting all the points contained by the frame.

Drawing tool: Properties

The Properties panel of the Drawing tool contains three tabs:

e The General tab describes the properties applicable to the selected shape. It contains properties common to
all shapes, as well as some properties specific to particular shapes.

e The Outline tab describes the properties of the selected shape's outline.

e The Fill tab describes the properties of the selected shape's fill.

QI You can change many of the properties below for several shapes simultaneously by selecting all these shapes first.

General properties
Properties x

General | Fill | Cutline |

% 434
¥ | 99
Width 150

Height

I 151
Ratation I 0 ° Q

X, Y, Width, Height: These fields let you position and resize your shapes very accurately, down to one pixel. X
and Y represent the top left corner coordinates of the shape. Enter new values in these fields to change the
position of the selected shape. You can also use the up and down arrows on the right of the fields to change the
coordinates one pixel at a time. The Width and Height fields are used to resize the shape. They work exactly as
the X and Y fields.

Rotation: Use this field to enter a degree of rotation for your shape. You can also use the rotation wheel on the
side. Just click the small circle and drag it in the required direction. The X, Y, Width, Height and Rotation fields
are updated dynamically to reflect the new coordinates of the shape.

F.okation I 35 .

Round corner: This property is specific to rectangles. It allows you to create rectangles with round corners.
Enter a value in this field or use the slider on the right side to specify the degree of roundness.

Round carner 15

Number of sides: This property is specific to polygons. It lets you change the number of sides of your polygon
from the default value of 6. Enter a value in this field or use the slider on the right side to define it. The lowest
possible value is 3, which corresponds to a triangle. The maximum value, 50, corresponds to an ellipse.
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Star points: This property is specific to stars. It lets you change the number of "branches" of your star from the
default value of 6. Enter a value in this field or use the slider on the right side to define it. The lowest possible
value is 3, which corresponds to a triangle.

Inner radius (%): This property is also specific to stars. It allows you to change the angle between the branches
of your star from the default value of 50. The lower the value, the more pointed the branches are.

Smooth factor: This property is only applicable to shapes drawn with the Pencil tool. It allows you to smooth
out sharp angles in the shape. Enter a value in this field or use the slider on the right side to define it.

Outline properties
Properties x

General | Fill Cutline |

Show aukline

v
Colar .
Width [t
Shyle I— j
Arrowheads INDne j INDne j

New Outline properties set in this tab affect the selected shape (if any) and any new shape you create.

Show outline: Check this option to show the outline of the selected shape and uncheck it to hide it.

Color: This defines the color of the outline. Click the color box to open the standard Windows Color dialog or
use the Pipette to choose a color by "picking" it from the screen.

Width: You can use this field to enter a new value for the width of the outline of the selected shape.
Style: Click the down arrow on the right of this field to choose one of the styles available for the outline.

Arrowheads: This property only applies to opened shapes, such as lines and curves or predefined closed shapes
that you have "opened" by deleting one of their points. Click the down arrow to the right of these two fields to
choose the required arrow head.

Fill properties
Properties x
zemeral il | Outling |

Show Fil r
Fill Type | sclid =]

Color

_
iGradient Angle I b Q

|
[ [
Imange File I e

Skrebech ko Fit r

New Fill properties set in this tab affect the selected shape (if any) and any new shape you create.

Show fill: Check this option to show the outline of the selected shape and uncheck it to hide it.

149



Fill type: Click the down arrow to the right of the field to choose one of the available Fill types, namely:

e Solid - to fill the shape with a solid color
e Gradient - to fill the shape with a color gradient
e Image - to fill the shape with one of your own pictures

Color: This property is only active when you choose a fill of type Solid. It defines the color of the fill. Click the
colored box to open the standard Windows Color dialog or use the Pipette to choose a color by "picking™ it from
the screen.

Gradient angle: This property is only active when you choose a gradient fill type. It lets you set the direction of
the fill gradient. You can also use the rotation wheel on the side. Just click the small circle and drag it in the
required direction.

Color bar: This bar is only active when you choose a fill of type Gradient. It represents the gradient of colors
used in your shape. Use the two Color boxes placed underneath the bar to specify the colors to be used at each
end of the gradient.

Image file: This property is only active when you choose a fill of type Image. Click the Browse button to the
right of the field to choose the image you want to use inside your shape.

Stretch to fit: Click this property to resize the image to the dimensions of the shape.

Drawing tool: Shortcuts
The table below lists all the keyboard shortcuts provided by the Drawing tool.

Keyboard shortcut | Description

Ctrl+N Create a new drawing

Ctrl+O Open and browse for an existing drawing
Ctrl+S Save the current drawing

Ctrl+C Copy the selected data to the clipboard
Ctrl + X Cut the selected data to the clipboard
Ctrl +V Paste the data contained in the clipboard
Delete Delete the selected element

Ctrl+Z Undo the last action

Ctrl + Shift + Z Redo the last action undone

Ctrl + A Select all shapes in the workspace
Ctri+B Send selected shapes to back

Ctrl+F Bring selected shapes to front
Ctrl+D Duplicate selected shapes

Ctrl +G Group all selected shapes

Ctrl+U Ungroup selected group

Ctrl+0 Zoom to actual size

Ctrl + Alt+0 Fit selection to workspace

Ctrl +"'+" Zoomin

Ctrl +"-" Zoom out

A Select the Point Edit tool
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B Select the Bezier tool

E Select the Ellipse tool

H Select the Hand tool

M Select the Rectangle tool

P Select the Pencil tool

R Select the Rotate tool

\% Select the Selection tool

X Temporarily select the Split Point tool when the Point Edit tool is active
z Select the Zoom tool

Shift + Click Select multiple shapes or multiple points

Shift + drag Draw or resize a shape proportionally

Alt Temporarily select the Add Point tool when the Point Edit tool is active
Alt + drag Draw or resize a shape from the center outwards

Shift + Alt +drag Draw or resize a shape proportionally from the center outwards

Shift + drag handle | Move both handles simultaneously, keeping each one a mirror image of the other
Ctrl Temporarily select the Selection tool

Space Temporarily select the Hand tool

F4 Show/Hide Properties panel
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Using databases

H Mediator enables you to read from and write to Microsoft Access and MySQL databases.

The interface used to connect Mediator with databases is the database resource. Taking a Microsoft Access
database as an example, this topic explains how to setup a database link using the database resource and how to
navigate a database using the Mediator actions provided.

Setting up a database link

» To open the Resources dialog, choose View | Interactivity | Resources.
» Drag a Database resource in the active field to open the Database Resource dialog.

This dialog points to a special file called the DSN file, that contains information about which driver to use, what
database file to use and so on. It is an ASCII file, which can be created with the ODBC Manager from the
Windows configuration panel. However this method is quite complex, and it is usually much easier to create the
DSN file using a simple text editor (e.g. Notepad), either from scratch, or by adapting an existing DSN file.

The DSN file for the Microsoft Access driver should look like this:

[ODBC]

DRIVER=Microsoft Access Driver (*.mdb)
UlD=admin

UserCommitSync=Yes

Threads=3

SafeTransactions=0

PageTimeout=5

MaxScanRows=8

MaxBufferSize=2048

FIL=MS Access

Driverld=25

DefaultDir= (leave this empty)
DBQ=database filename.mdb (where database filename is the name of your
database)

> Once you have created the DSN file, copy both the DSN file and the MDB file to the project folder
(containing the .md8 file) and follow the rest of the procedure below.

Connecting Mediator and the database

Once you have created a DSN file, either via the ODBC Manager or by typing the entries above in a text editor,
you need to use it to connect Mediator with the database:

» Check the option File (*.dsn) in the Database Resource dialog.

» Type the path to the DSN file in the Database field or use the Browse button to select it.

This sets up the link to the database. The Table structure field should now list all the database fields.
You must now link the individual database fields to Mediator variables.

» Create a Mediator variable for each of the fields whose value you want to use in your project, making sure
that the type of the variable matches the type of the field.

For a VARCHAR field for instance, you would define a variable of type text.
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> In the Database Resource dialog, click the name of the first field you want to connect to a Mediator variable,
then click the Link To button.

> In the New Binding dialog that appears, select the Mediator variable to be connected.

This creates a link between the database field and the Mediator variable. The connection is indicated by a
red dot on the left of the field. Fields that are still unconnected are identified by a green dot.

> Repeat this operation for all the fields that you want to connect to a variable.

Now that the database fields you want to use are connected to the corresponding Mediator variables, you need to
display their contents. Here is one way to do it:

» Create an input object to show the contents of the first database field you want to use.

> Drag an On Page Ready event in the Events dialog of your Mediator page, followed by a Set Property
action.

> Fill it as follows:

Object = input object
Property = Text
Value as expression = name of the variable you linked to the field

> Test the page to check that the value of the field corresponding to the variable is shown in the input field as
expected.

> Repeat these steps for all the fields that you want to display via input objects.

For additional information about the database resource, see "The Database Resource".

Navigating the database

The DB pointer action lets you navigate through the database, as shown by this short example:

» Create a 'Next' button and open its Events dialog.

» Drag a Mouse Click event followed by a DB Pointer action (Database tab).

»  Select the name of the database resource in Database resource name.

» Check Next record and close the dialog.

The variables are now updated, but their contents need to be transferred to the input objects.

» Add a Set Property action to the right of DB Pointer for each variable/input object as described above.

To be able to navigate the entire database, create three more buttons, e.g. Previous, First and Last and repeat the
steps above, each time choosing a different option in DB Pointer, e.g. Previous record, First record and Last
record.

Searching the database

The real value of a database is that it enables you to retrieve specific entries very easily. The DB SQL action lets
you search the database.

> Create an input object and label it for instance 'Search'.

This will be used to specify the contents to be searched. The search will be executed whenever the user presses
Enter in the input object or clicks away from it.

» Drag an On Stop event followed by a DB SQL action in the Events dialog of the input object.
> Select the name of the database resource in Database name.
» Enter the statement required in the SQL statement field.

Example: If you wanted to search for the word 'Tina' in the field FirstName of a table called DemoTable, you
would execute the following SQL statement:
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“"SELECT * FROM DemoTable WHERE FirstName = "Tina® "
To search for the name entered by the user in the input object, you would replace ‘Tina' by 'Search.Text'.
The SQL statement is entered as an expression in Mediator to enable the use of variables.

“"SELECT * FROM DemoTable WHERE FirstName = * " + Search.Text + " = "
Please note the use of quotes. This may be a little confusing as you have to use two types of quotes, the Mediator

quotes (") and the SQL quotes ().

QI The use of spaces in the SQL statement is not significant. You can therefore put a space between Mediator and SQL
quotes (" 'entry' " instead of "'entry™ ) to improve legibility.

If you want Mediator to look for the search word in more than one field, for instance in the fields FirstName and
LastName, the SQL statement should read:

"SELECT * FROM DemoTable WHERE FirstName = * " + Search.Text + " " OR
LastName=" " + Search.Text +

Tips on using the SQL syntax in Mediator

e The whole statement is set in double quotes.

Example: ' SELECT * FROM DemoTable''

e Database field names are written without any quotes or other signs.

Example: "SELECT * FROM DemoTable WHERE Fieldname= .. "

e Input (of any sort) coming from Mediator is enclosed in SQL quotes (").

Example: "SELECT * FROM DemoTable WHERE FirstName = "Tina'"

e Mediator text variables or object.properties of type ‘text' are enclosed in Mediator quotes ("), additionally to
the SQL quotes.

Example: "SELECT * FROM DemoTable WHERE FirstName = * "+ Search.Text + '

e Mediator integer/floating point variables or object.properties of type integer/floating point do NOT have
these Mediator quotes (™).

Example: "SELECT * FROM DemoTable WHERE Age = " + age.value + * "

e Mediator variables and properties in general are enclosed in + signs.

Example: "SELECT * FROM DemoTable WHERE FirstName = * " + Search.Text + *

As you will seldom use anything but Mediator variables or object.properties in a Mediator SQL statement, here
is a quick guide about how to refer to them:;

> Start with an SQL quote (') whenever you are quoting something from Mediator.

» Add a Mediator quote (") if it is a text variable or a text property. If it is of type integer or floating point,
skip to the next point.

» Add a + sign and then type the name of the variable or the object.property.

Now follow the steps in the reverse order:

> Enter the + sign again (to "close" the name of the variable/property).

> If you have opened Mediator quotes ("), close them by entering a Mediator quote again.

> Close the SQL quotes (') by entering a SQL quote again.
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Resetting the database

Once you have executed a search as described above, any future navigation operation is restricted to the set of
records matching the search criteria. If only one record matched the search, the Next and Previous buttons would
therefore no longer produce any results.

To make the entire DemoTable of our above example accessible again, you would use the following SQL
statement:

“"SELECT * FROM DemoTable™

Preparing for export
Checking the DSN file

Before exporting your project, you need to make sure that the DSN file you use does not contain full paths to the
database files. This is particularly relevant if you have used the 'ODBC Manager' method above to create it.

» Use Notepad to view your DSN file, which may look like this:

[ODBC]

DRIVER=Microsoft Access Driver (*.mdb)
UlD=admin

UserCommitSync=Yes

Threads=3

SafeTransactions=0

PageTimeout=5

MaxScanRows=8

MaxBufferSize=512
ImplicitCommitSync=Yes

FIL=MS Access

Driverld=25
DefaultDir=Drive:\Folder\Sub-folder\
DBQ= Drive:\Folder\Sub-folder\Database.mdb

As you can see, the entries DefaultDir and DBQ have full path names. Change them as follows by removing the
paths:

DefaultDir=
DBQ=Database.mdb

(where Database.mdb is the file name of your database)

If you are going to use the project from a read-only media such as a CD-ROM or DVD-ROM, you must add the
following line to the DSN file, for instance after the UID entry.

ReadOnly=1

Adding relevant files

Before exporting the project, you need to make sure that Mediator will include the database and all the
associated files required in the exported version. If you are using the recommended Microsoft Access Driver,
there is only one database file (.mdb). Other databases however may consist of more than one file.

»  Click the Mediator Button.
» Choose Prepare | Additional Data files, and add all the necessary files, namely:

e The DSN file and the database file (*.mdb)
o Additional files like pictures and sounds that the database is pointing to
You are now ready to export the project in the usual manner.
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Using SCORM

SCORM is an acronym for Sharable Content Object Resource Model. It is a set of specifications meant to make
it easier for educators to create, share and reuse e-learning courses.

This topic describes how you can create a SCORM compliant course with Mediator.

@ This feature is only available for documents of type HTML or Flash.

Definition of a SCORM system

In somewhat simplified terms, a SCORM system consists of a Learning Management System (LMS) that holds
and catalogs various e-learning courses (SCOs, or Sharable Content Objects). The LMS also holds the student
accounts that contain information about the students, such as their name, the courses they attend, and the score
they received upon completing e-learning courses in the past. The details of the different LMS systems on the
market vary and are beyond the scope of this documentation. A SCORM compatible LMS also incorporates a
web server that allows the courses to be downloaded and displayed by the browser (e.g. Internet Explorer or
Firefox) on the students computers.

To attend an e-learning course, the student sits at a remote computer with a web browser open, logs in to the
system, and chooses a course. The course (SCO) is downloaded and displayed in the browser. (SCOs basically
just consist of HTML files, Flash files, video files and other associated web files.)

Once the course is displayed in the browser, the browser sends a message back to the LMS, stating that the
learning session has begun. Similarly, when the student exits the course, for instance by closing the browser or
by navigating to another unrelated web page, the browser sends a message to the LMS, stating that the current
learning session has now ended.

While the learning session is in progress, the SCO displayed in the web browser can communicate with the

LMS. The SCO can for example retrieve a number of variables from the LMS such as the hame and ID number
of the student currently logged-in, and other information such as the student's preferred language. This allows the
content author to customize the learning content to the particular student (for example by providing texts in both
English and French at design time, and then dynamically determining which texts to display at runtime). The
SCO can also send information to the LMS about the current student's progress in the course. This student
specific information is stored on the LMS, so that teachers can later examine it to determine how well the student
completed the particular course. Typical data sent to the LMS includes quiz scores, and how long the course took
to complete. The content author can also allow the student to send plain text comments about the course.

Creating a SCORM compliant course

When creating a project in Mediator to be exported as a Flash or HTML SCO (that is, a SCORM compliant
course), you don't need to do anything particular besides what you would normally do when creating any other
course, quiz or tutorial for putting up on an ordinary web server. It is not a requirement to receive data (student
name, student ID, etc.) from the LMS, nor is it necessary to send any data (score, completion time, etc.) to the
LMS. The only required communication between the SCO and the LMS are the Initialize and Terminate
messages that begin and end a learning session, and both of these messages are sent automatically by the SCOs
created in Mediator.

» To export the SCO project in Flash or HTML, check Create as SCORM compatible package in the Flash
or HTML Advanced Export dialog.
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Advanced Flash Export

Create all pages in a single SWF file [] Optimize pictures
Frame rate: fps [ Embedded Fonts. . ]
SCORM Alignrment

[ ] Create as SCORM compatible package E () Top It

l_! (%) Top center

Output falder:

| (&)

| C:\My documents

) [cae ]

» (optional) Click SCORM settings.

The SCORM Manifest Settings dialog opens to let you specify additional information about the course.

SCORM Manifest Settings X
Catalog narme: | Courses created with Mediator |
Course kitle: | Advanced Course |

Course descripkion:

Comma separated keywords: | |

Manifest identifier: | ADYAMCED COURSE_ID |

o) [Ccmea ]

The SCORM Manifest file that is included in all SCO packages is automatically created by Mediator.
Among other things, it includes details about the SCO course that are used by the LMS to catalogue the
course, so that teachers and/or students can search for specific learning content with the use of keywords.

Catalog name: This specifies the name of the LMS group or category of courses (e.g. Maths, Physics,
Chemistry, etc.) in which the SCO should be placed.

Course title: This specifies the name used to identify the course within the LMS.
Course description: This is used to provide a description of the course, and its intended use.

Comma separated keywords: This field can be used to enter keywords (which must be separated by
commas) which the students and teachers will be able to use to locate the course once the SCO is deployed
on the LMS.

Manifest identifier: This compulsory ID uniquely identifies the course among all the other courses (SCOs)
deployed on the LMS.

> Click OK.
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The output of the export will be a zip file containing all the Flash or HTML content and other SCORM related
helper files. This package (which is technically speaking the SCO) can then be uploaded to the LMS (which
must be SCORM 2004 compliant). How the SCO is placed on the LMS depends on the specific LMS, but
generally it is done by a teacher using the web-based interface of the LMS. Please refer to the documentation of
the LMS in question for information about this.

Using SCORM variables

A SCORM 2004 compliant LMS keeps track of a number of variables associated with each of the students
following a course. They allow the SCO to save and/or retrieve information about each student and their
progress in the course, and allow the teacher to collect information about the students performance.

All these SCORM variables have names that begin with "cmi.". Some of them are arrays that can contain a
number of sub-variables, while others are just simple variables.

Some, such as "cmi.learner_id" and “cmi.learner_name" are "read only" from the point of view of the SCO.
Others, such as "cmi.score.raw", are both readable and writable by the SCO. A few variables, such as the
variable "cmi.session" and "cmi.exit", are "write only".

In Mediator, the SCORM tab of the Events dialog provides two specific actions which make use of all these
variables:

e Set SCORM Variable lists all the writable variables and allows you to set their values.
For a complete description of this action, see "Set SCORM Variable".

e Get SCORM Variable lists all the readable variables and allows you to retrieve their values.
For a complete description of this action, see "Get SCORM Variable".

Detailing the purpose of all the SCORM variables is beyond the scope of this topic, but you will find a complete
description in the SCORM_RunTimeEnv.pdf document available for free download on the "SCORM 2004 3rd
Edition Documentation™ page of http://www.adInet.gov/scorm/.
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Using script

Using runtime script

—& Using runtime script, you can create functions that would be very difficult or impossible to create in
Mediator using only its icon-based drag & drop interface, objects, events and actions.

There is however a strong interface between Mediator and runtime scripts:
e You can call script functions directly from any Mediator expression.
e You can access and manipulate Mediator variables directly from the script.

e You can also manipulate object properties directly from the script.

Another important use of runtime script is to control the ActiveX object. You can find many ActiveX objects
that provide anything from simple text/graphic effects to advanced database and video functionality. You can
also create your own ActiveX objects to obtain exactly the functionality you need. This lets you expand
Mediator beyond its built-in features.

Mediator uses ActiveX scripting. This means that you can use either Visual Basic Script or Java Script. Other
companies even supply other script languages that can be used. Here we focus on Visual Basic Script since it is
easy to use and available on most computers.

Document scripts and page scripts

You can place scripts either on the document or on the page.

e Scripts that are assigned to the document can access all the global variables, but not local variables or local
objects.

General scripts which you intend to access from many pages should be placed on the document. These
scripts would typically consist of constants or global calculations that work in the same way on all pages and
do not need to access local objects on individual pages. Document scripts cannot access local objects
because these scripts are initialized when the document is loaded, at a time when the local objects are not yet
"known".

e Scripts that are assigned to a page have access to all the variables and objects belonging to that page.

If for instance you have a script that manipulates the same object name on five different pages you would
just place that same script file on each of the five pages.

Creating a script

To create a script you start by creating the .mds file that will contain the code.

» Open the Scripts dialog via View | Programming | Scripts.

» Click the relevant tab (Document or Page) depending on the type of script you want to create.
» Click New.

The Save dialog appears, enabling you to browse to the folder where you want to place the script.
» Enter the name of the script file and save it.

» To edit the script, select it in the Scripts dialog and click Edit to open the Script editor.

» When you have finished editing, choose Exit & Return to Mediator to save the .mds file and close the
editor.
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@ You can obtain complete reference information about the VBScript Language by pressing F1 in the Script
editor.

» Once the script is written and saved, you can execute it via the Script action (Programming tab of the
Events dialog).

Script E|

Script procedure nanme;

Parameter 1:

—
)

Parameter 2

=
&)

Parameter 3

=
=]

Parameter 4:

—
&

[ ok [ Cancel

> Write the name of the function in the Script procedure name field and the necessary parameters in the
parameter fields, in the correct order.

Accessing object properties

There are two ways of accessing the properties of a Mediator object from a script:

e You can access it statically by using its name:

ObjectName.Property = Something

e You can access its properties dynamically by using an object variable. You create the object variable in
Mediator and assign it the name of an object. Then you can change the property value from script:

ObjectVar.Property = Something

See "Using project variables" and "Using expressions" for more information.

Structuring your scripts

Dividing your scripts into separate modules containing well-defined functions will enable you to re-use them
easily. Think ahead and try to group your script functions cleverly so that you maximize re-use and do not lose
the overview. Building a general library of scripts will save you a lot of time when you develop.

Optimizing the script duration

When you execute a script from Mediator, the script takes over all of Mediator's CPU time. Mediator is therefore
blocked while the script is running. It also means that only one script can run at a time.

Why is this? If both Mediator and script were to access the same objects and variables at the same time, the
potential for bugs would be much higher. On the other hand, implementing real multitasking is a task for highly
experienced programmers. However the loss is not as serious as it may seem if you follow the simple rules
below.

When you design your scripts make sure that they only last a very short time. Apart from sorting routines or
similar functions, they should only perform very quick operations lasting less than a second. Let us suppose for
example that you wanted to use a script to move an object across the screen. Such a script could run for several
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seconds and therefore block Mediator. The best way to achieve this is to create a Mediator timeline resource that
repeats itself (e.g. once every 0.1 sec.). Place the Script action that calculates the object position and moves the
object on the timeline. This way the script is called repeatedly (you control how often on the timeline) but
returns immediately each time, leaving Mediator free to carry out other tasks.

Script encryption

At design time all scripts are stored in simple text files with the extension .mds (which stands for "MeDiator
Script"). You can therefore edit them very easily with any text editor you wish, including Notepad.

To avoid exposing your script code when you export your project, the script files are encrypted during the
export.

An encrypted file has the extension .m8cs. You must not change this extension, otherwise Mediator will not
recognize the file as an encrypted file.

When executing a script Mediator always looks for the .mds file first. If it does not find it, it then looks for the
.m8cs file. Therefore if you are in the middle of a design session and for some reason both files are present,
Mediator will find the design script first, in other words the most recent version.

Using macro script

& Macros are script files that you can create to automate operations you perform often while designing your
projects.

Do not confuse macro scripts with runtime scripts, which are executed when the project is running, either in test
mode or after export.

Macros can be programmed using Visual Basic Script or Java Script.
Creating a macro
To create a macro you need to start by creating the .mdm file that will contain the code.

» Open the Macros dialog via View | Programming | Macros and click the Add button.

Macros §|

Add...

The New Macro dialog appears.

> Type the name of the new macro and click OK.

The Script editor appears with the new macro opened ready for editing.
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» When you have finished editing, choose Exit & Return to Mediator to save the .mdm file and close the
editor.

» To edit the macro at a later time, open the Macros dialog, select the required macro and click Edit.

@ You can obtain complete reference information about the VBScript Language by pressing F1 in the Script
editor.

Collections

A group of objects, events, actions or other groups of similar items is referred to as a collection. A collection can
be for instance all the pages in a Mediator project, all the objects on a Mediator page, all the events on an object
or all the actions on an event.

All collections have the "Count" property and the "Item" member reference:
e Count is a read-only property that specifies the number of items in the collection.

e Item is a method that returns one object from the collection. Item has one parameter of the type integer,
string or both depending on the collection.

In VBScript the "For Each" statement can be used to go through all items in a collection as follows:
For Each obj in Md80Objects
obj.x = 10
Next

This runtime script sets the X property of all the objects in the Md80bjects collection to 10 (moving them to the
X position 10).

Manipulating Mediator items

The diagram below shows how Mediator objects are linked. To access an object it is necessary to access it
through the objects it belongs to.

@ If you want to add an object to a collection, the object must be available as an 080 object (see the topic
"Using 08o files").

There are different ways of accessing an object but the dot notation is always used.

e Accessing an object using the index method (only for objects belonging to a collection):
Application.Window.Page.Objects.item(1)

¢ |f the name of the object is known:
Application.Window.Page.Objects. item(*'ObjectName™)
or

Application.Window.Page.Objects.ObjectName
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Objects Actions (Resources) |

Events |
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An important method is how to make a page active in order to access objects belonging to it:

Application.Window.Page ""PageName"’
or

Application.Window.Page = Application.Document.Pages. Item(1)

Example: A macro that is to access the object "Headline" on the "Intro" page in order to change the text to
"Welcome™ would look like this:

Application.Window.Page = "Intro”

Application.Window.Page.Objects.Headline.Text = "Welcome"

Executing a macro

As shown in the diagram above all items are accessed through either the Active Document or the Active
Window. This means that it is necessary to have a document open for the macro to work upon.

To execute a macro in Mediator:
» Choose View | Programming | Macros to open the Macros dialog.

> Select the macro and click Run.
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Spellchecking your project

Using the spellchecker

Mediator allows you to find and correct spelling errors in your entire project as well as on individual pages. The

Mediator spellchecker is able to check for misspelled words and automatically correct common misspellings in
the following objects:

e Text
e Headline
e Button

In addition to looking up words in its own dictionaries, the spellchecker also references custom dictionaries to
determine whether a particular word is correctly spelt or not. You can customize these dictionaries by adding,
replacing or deleting words.

The spellchecker also uses an AutoCorrect list to correct common mistakes automatically. Again, you can
customize this list by adding, replacing or deleting word pairs.

Finally the spellchecker allows you to spellcheck your projects in several languages, including American and
British English, French, German, Italian, Spanish, Dutch and Danish.

Spellchecking as you type
By default, Mediator checks for spelling errors as you type, underlining in red any mistakes found.
You have the option of correcting the mistake straight away by right-clicking the misspelled word.

This opens the local menu, in which you can choose any of the following commands:

e Corrections

This lets you choose one of the suggestions listed, which then replaces the misspelled word.

e Ignore All

Choose this command to ignore the currently highlighted occurrence of the word and all other such
occurrences in the project and any other project opened during this Mediator session.

e Add to Dictionary

Choose this command to add the underlined word to your default custom dictionary, thereby making it a
valid word which the spellchecker will no longer report as a mistake. See the topic "Spellchecking options"
for more information on custom dictionaries.

e AutoCorrect

This lets you choose one of the suggestions listed. In addition, the misspelled word and its corrected
equivalent will be added to the AutoCorrect list. This means that whenever you type this misspelled word in
the future, it will be automatically replaced by its corrected equivalent. See the topic "Spellchecking
options" for more information on the AutoCorrect list.

e Spelling
This opens the Spelling dialog, which allows you to spellcheck the entire object.

Spellchecking a page
» Choose Review | Proofing | Spellcheck Page or press Ctrl + F7.
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@ Mediator goes through all the objects on your page that contain text, looking for spelling mistakes. As
soon as it detects a spelling mistake in one of the objects, Mediator selects the object in question and opens the
Spelling dialog.
Spelling

Mok in Dickionary:

i5 incorreck Ignore Once

Ignore All

#dd ko Dickionary

Suggestions:

This's Change

Theists Change All

Thirsts
Thais - AutoCorrect

[ 0

Dictionary language: American English b |

Options. .. ] [ Zancel

The top field shows the contents of the object, with the first misspelled word highlighted. The bottom field
shows a list of suggestions from which you can choose an alternative spelling for the highlighted word.

You can choose one of the following options:

Ignore Once
This will ignore the currently highlighted occurrence of the word.
e Ignore All

This will ignore the currently highlighted occurrence of the word as well as any other such occurrences
during the entire Mediator session.

e Add to Dictionary

This will add the misspelled word to your default custom dictionary.

e Change

If you have edited the misspelled word in the top field, this replaces it with the edited word. Otherwise the
misspelled word is replaced by the alternative spelling chosen in the Suggestions field. Only this occurrence
of the misspelled word is corrected. If you also want all following occurrences of the word replaced, click
Change All.

e Change All

If you have edited the misspelled word in the top field, this replaces it with the edited word. Otherwise the
misspelled word is replaced by the alternative spelling chosen in the Suggestions field. This replaces all the
occurrences of the misspelled word on the page.

e AutoCorrect

This replaces the misspelled word by the alternative spelling chosen in the Suggestions field. In addition, the
misspelled word and its corrected equivalent are added to the AutoCorrect list.
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e Dictionary language
This lets you choose a different language for the spellchecker to use to check your project.
e Options
This opens the Spellchecking Options dialog, which lets you set various options to control the way the
spellchecking is done. See the topic "Spellchecking options™ for a full description of this dialog.
Spellchecking a document

» Choose Review | Proofing | Spellcheck Document or press F7.

Mediator goes through all the pages of your project, examining any object containing text for spelling
mistakes. As soon as it detects a spelling mistake on one of the objects, Mediator displays the relevant page,
selects the object containing the mistake and opens the Spelling dialog described above.

Once you have processed all the spelling mistakes reported by the spellchecker and closed the Spelling dialog,
Mediator returns to the page you were working on when you started the spellchecking.

Spellchecking options

ABC
%]u'_i This dialog contains various options which you can set to determine the type of errors reported by the
spellchecker.

You can access it in several ways:
¢ By choosing Review | Proofing | Spelling Options.
e By clicking Options in the Spelling dialog.

¢ By clicking the Mediator Button, then Mediator Options and Proofing.

Check spelling as you twpe

[ 1lgnore words in UPPERCASE
lgnore words with numbers

Ignare Intermet and file addresses
Phonetic suggestions ([Englizh only]
Typographical suggestions

Caze sensitive

AutaCorrect
Correct T'wo [Mitial Capitals
Capitalize first letter of sentences

[ AutoCorect List... ]

[ Custorm Dictionarnies. .. ]

Default language:

American Englizh W

Check spelling as you type: If you disable this option, the misspelled words will not be automatically
underlined in red as you type them. You will need to use the Spellcheck commands to spellcheck your objects
after their creation.

Ignore words in uppercase: When enabled, this option causes any word written entirely in upper case to be
ignored by the spellchecker and skipped. It is useful to keep this option enabled if your document contains many
acronyms.
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Ignore words with numbers: When enabled, this option causes any word containing numbers to be ignored by
the spellchecker and skipped. It is useful to keep this option enabled if your document contains many words or
symbols including numbers, such as Q4.

Ignore Internet and file addresses: When enabled, this option causes any words that appear to make up an
Internet domain name, a URL or an email address to be ignored and skipped.

Phonetic suggestions (English only): When enabled, this option causes suggestions to be made on the basis of
their phonetic similarity to the misspelled word. This option tends to improve suggestions for badly misspelled
words.

Typographical suggestions: This is the default option. It causes suggestions to be made on the basis of the
similarity of their spelling to that of the misspelled word. Note that the spellchecker does not offer suggestions if
you disable both this option and the 'Phonetic suggestions' option.

Case sensitive: When enabled, this option causes the spellchecker to distinguish between capitalized and non-
capitalized letters. The word "europe™ for instance would be considered as a mistake. If you disable this option,
"europe™ and "Europe™ would be considered identical and both regarded as correct.

AutoCorrect: If you disable this option, even if a misspelled word is included together with its correct
equivalent in the AutoCorrect list, the misspelled word will not be automatically replaced by its equivalent.

You can also click AutoCorrect List or Custom Dictionaries to open the corresponding dialogs. Both dialogs
are described below.

Default language: This lets you choose the default language which you want the spellchecker to use to check
your projects.

Using the AutoCorrect list

This list contains all the misspelled words which you have corrected by using the AutoCorrect feature described
above. Each line is made up of the originally misspelled word in the 'Replace’ column on the left, together with
the suggestion you chose to replace it with in the 'With' column on the right.

AutoCorrect: (American English)

Replace: With:
abbout abauk
abscence absence
accesories accessories
accidant accident
accomodate accommodate
accross Across
acheive achiewe
acheived achieved
acheiving achieving
acommodate acconmmiodate
acomodate acconmmiodate
additinal additional
Ry -

(0] 4 l [ Cancel

If you work with different languages, the spellchecker maintains one such AutoCorrect list per language.

You can customize the AutoCorrect list in various ways:

e You can add new AutoCorrect pairs by typing a commonly misspelled word in the 'Replace’ field followed
by its correct equivalent in the 'With' field and clicking Add.
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e You can replace the correct equivalent of a misspelled word by selecting this misspelled word in the
'Replace’ list, typing the new equivalent in the 'With' field and clicking Replace.

e You can delete an AutoCorrect pair by selecting the corresponding row in the list and clicking Delete.

Using the custom dictionaries

This dialog contains a list of all your custom dictionaries as well as several buttons allowing you to customize
them.

Custom Dictionaries

Dictionary lisk:

cuskom, dic (default)
mediator 9,0 exp.dic

Madify. ..

II X

Cief aulk

Mew, ..

Full path:

c:\documents and settingsgenevievel applicatior |

Remove

Cancel

Lo |

Custom dictionaries contain all the words reported as misspelled by the spellchecker that you decided to accept
as valid by clicking Add to Dictionary during spellchecking. This means that a word included in any of the
custom dictionaries is no longer reported as a misspelling by the spellchecker.

The Custom Dictionaries dialog allows you to:

e Modify one of the custom dictionaries by clicking it, then selecting Modify. You can then add new words to
the dictionary or remove existing words.

e Set one of the custom dictionaries as default by selecting it and clicking Default. Any new word you now
accept as valid by clicking Add to Dictionary while spellchecking will be automatically added to this
dictionary.

o Create a new custom dictionary by clicking New.
e Add an existing custom dictionary by clicking Add.

e Remove an existing custom dictionary by selecting it and clicking Remove.
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Testing your project

Even if you are experienced, it is quite likely that you will make a few mistakes while designing your project.
You might for instance create a picture object without linking it to an actual picture, or specify an incorrect
picture path. You might create a Show action and forget to indicate which object to show. Or you might create a
Go to Page action, but at some later stage delete the page to go to.

The Test group of the Review tab gives you various tools to help you test that your project works as intended:
»
e — Run Document (F5)

This starts a runtime simulation of your project beginning on the first page in the Page list. Mediator uses
the screen mode you have selected in the New Document dialog to give you a preview of what the project
will look like in "real life".

To exit test mode, just press the Esc key.

[,
Fam,
\

. uﬁf Run Page (F6)

Similar to Run Document, except that Mediator starts the simulation from the current page.

. = Preview Page (Shift + F6)

This only applies to documents of type HTML or Flash. Click it to obtain a real preview of the current page
in your default Internet browser.

&
¥
. %" Check Document (F11)

Checks the entire project for errors such as missing files, illegal page turns, missing links, etc.

.
. 9] Check Page (Ctrl + F11)
Checks the current page for errors such as missing files, illegal page turns, missing links, etc.
Using the Messages window
i 1

- Any error that Mediator detects while checking the document or the current page is displayed in the
Messages window.

> If the Messages window is not already open, choose Review | Test | Messages.

Here is an example of what the Messages window might look like.

Messages

I Page Item Type Item Mame Ewent Action Meszage
[#1 Pagel Rectangle Rectangle Mouze Click.  Set Propetty Mo object specified
[#1 Pagel Rectangle Rectangle Mouze Click  Set Propertty Mo property specified
[#1 Pagel Rectangle Rectangle Mowe Into IMI File Undefined variable:
% Pagel  Animated GIF  AniGif Unable ta find the: file:
ﬁ Pagel Dirawing Dirawing Unable to find the file;

The first column shows an icon.
[%1 Means that you can fix the problem straight away by double-clicking the line in the Messages window.

P Indicates a problem which you can correct by going to the specific page.
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+" Denotes a problem that you have corrected from within the Messages window.
The various columns contain the following information.

Page: The page on which the error occurs.

Item Type: The type of the object causing the error.

Item Name: The name of the object.

Event: The event name if applicable.

Action: The action name if applicable.

Message: A description of the error.

When you click a line in the Messages window, Mediator automatically jumps to the relevant page and
highlights the object causing the error.

There are errors that Mediator is not able to detect, particularly in advanced expressions. You may for instance
have specified an object name that does not exist, or built an expression that does not give a valid result at
runtime.

The Debug window may help you identify and resolve these problems.

Using the Debug window

|;] This tool enables you to track the actions and their parameters in real time while testing your project.
» Choose Review | Test | Debug to open the Debug window.

The list on the left displays the variables and their values. New values being assigned are highlighted in red
briefly, enabling you to check that the change occurs as expected and when expected.

The track list on the right denotes the start of each new page with an empty line.

Debug =
_gamepage Pagel Sting Object: ButtonS core, Event: Mousze Chck ”
Flayerl String Set Property Input. Text =2,0
Foints 3 Integer Object: ButtonS core, Event: Mousze Chck

Set Property Input. Text =3,0
Object: Mext, Event: Mouse Chick
Fage: Master, Event: On Stop
Aszsign _gamepage = "Fagel"
Aszsign Points = 3
Go to Page @Mext, Homal, 0

Page: Master, Event: On Page Ready
Set Property Input. Text =3,0

Troubleshooting a problem

If the problem remains and you have checked all the help options mentioned in "Getting help", try to pinpoint it
as follows:

> Locate the page on which the problem occurs. This is normally straightforward, but in rare occasions, for
instance while exporting, the procedure might stop without identifying the page causing the problem.

In this case you must start deleting pages (always make a safe copy of your project first) until you find the
page giving the error. This can be quite a task since you also have to remove any links to the pages you
delete. Normally you should have an idea about which section of your project is more likely to cause
problem so that you can concentrate on it.
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> Locate the object or action causing the problem. You can use the same approach as for finding the
troublesome page. Simply start removing objects and actions until the problem disappears.

HTML restrictions

|
U—j Because some of the features and effects available in Mediator are not supported on the Internet, Mediator
automatically adapts its user interface to the document type you choose, and only shows the features, options and
export formats that are relevant to it. In particular, HTML projects do not have as many tools, effects, events and
actions available as projects of type Standard.

Please refer to the "Mediator 9 feature list" for a complete list of all objects, events and actions supported in
HTML projects.

This topic describes additional restrictions applicable to HTML that you should be aware of when creating
projects for HTML export.

Alpha channels
The use of another picture as alpha channel is not supported on the web.

Pictures with embedded alpha channels are converted to PNG files when exported to HTML. This ensures that
their edges will be antialiased.

Glow and Shadow

The glow and shadow effects set during design are supported, but cannot be changed at runtime.
Rotation

The rotation effects set during design are supported, but objects cannot be rotated at runtime.
Hotspots

Mediator hotspots can follow moving or scrollable objects. This feature is not supported on the web. To make
hotspots place transparent rectangles on top of the picture instead of using the hotspot object.

Unclickable transparent areas

When you insert a picture in Mediator you may define one of its colors as transparent. In a standard Mediator
project transparent areas on pictures do not respond to mouse events. This feature is not supported on the web.
The entire object frame will become clickable, not just the visible area.

Transition effects

Mediator only supports a limited number of show/hide object transition effects in Internet Explorer and Mozilla
Firefox.

Picture formats

The only picture formats used on HTML pages are GIF, JPG and PNG because of the good compression level
they offer. All other picture formats will be converted to PNG.

JPG should be used as much as possible, particularly for large photos. Do not however choose this format if you
want to use the transparent color option to define one color as transparent. Choose instead either GIF, where you
can define one exact color as transparent, or PNG with an alpha channel.

Audio and video formats

The recommended formats are the Microsoft® WMA (audio) and WMV (video) streaming formats. Files using
these streaming formats can start playing as soon as a minimum buffer size of data is loaded. The rest is
downloaded while playing.

Text objects
Only one type of bullet lists and numbered lists is supported, depending on the chosen font.

Embedding of images is not supported.
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Input objects

The On Stop event is only triggered when the user clicks a different object. It is not triggered when the user
presses the Enter key.

The Password option is not supported in HTML export.
Message Box action

When using this action in HTML export, only the text is exported. It is not possible to choose an icon to
represent the type of message conveyed and the only button available is the OK button.

HTTP Request resource

Some restrictions apply with this resource. See "The HTTP Request resource” for more information.
Functions

The following functions are supported in HTML export:

ABS
ARCCOS
ARCSIN
ARCTAN
cos
FLOAT
FORMAT
INT
LOWER
LEN
LOG
NOT
RGB
RND

SIN
STRING
SUBPOS
SUBSTR
SQR
TAN
UPPER

System variables
The following system variables are supported in HTML export.

@Date
@DateDay
@DateMonth
@DateYear
@Time
@TimeHour
@TimeMin
@TimeSec
@CursorXpos
@cCursorYpos
@ScreenXsize
@ScreenYsize

Flash restrictions

]
LL£) Because some of the features and effects available in Mediator are not supported on the Internet, Mediator
automatically adapts its user interface to the document type you choose, and only shows the features, options and
export formats that are relevant to it. In particular, Flash projects do not have as many tools, effects, events and
actions available as projects of type Standard.
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Please refer to the "Mediator 9 feature list" for a complete list of all objects, events and actions supported in
Flash projects.

This topic describes additional restrictions applicable to Flash that you should be aware of when creating
projects for Flash export.

Glow and Shadow
The glow and shadow effects set during design are supported, but cannot be changed at runtime.
Opacity

When setting opacity to 0 for an object, a faint outline of the object sometimes remains. This is only a problem
when the screen resolution is set to 16 bit colors.

Color

Only polygons, rectangles and headlines can have their color property set at runtime (using the Set Property
action). Polygons and rectangles have both an outline color and a fill color. In Flash export however, outline and
fill color cannot be changed separately. Changing the outline color will also change the fill color and vice-versa.

Hotspots

Mediator hotspots can follow moving or scrollable objects. This feature is not supported in Flash export. To
make hotspots place transparent rectangles on top of the picture instead of using the hotspot object.

Unclickable transparent areas

When you insert a picture in Mediator you may define one of its colors as transparent. In a standard Mediator
project transparent areas on pictures do not respond to mouse events. This feature is not supported on the web.
The entire object frame will become clickable, not just the visible area.

Transparent colors are not supported for jpg pictures.

Effects

Only a limited number of transition effects are supported in Flash export.
Text and fonts

Only TrueType fonts are supported in Flash export.

Fonts embedded in Flash export will not always appear quite as they do in Mediator. This is most noticeable
with smaller font sizes. Sometimes changing the font size a little can yield a significant quality difference in the
Flash export.

The positioning of characters may differ by up to a few pixels as compared to their appearance in design mode.

Non-character fonts (such as Symbol and Wingdings) are not supported in bold and italic versions, and won't
appear in the Flash export.

Text object hyperlinks only support the event Mouse Click.
Text object hyperlinks cannot change color.

If the text object has a Mouse Down or Mouse Click event, the event will be triggered even when the mouse
pointer is positioned over a hyperlink.

Pictures / Bump maps
Picture and bump map objects behave differently in Flash export when resized at runtime.

In Mediator the individual tiles do not change size, so increasing the object size will result in more visible tiles
than before. In Flash export, the entire graphical content of the object is resized, meaning that each tile changes
size when the object is resized.

Picture objects that differ only by their alpha channel and their transparent color will not share data in Flash
export. This is because the alpha channel and transparent color must be embedded in the image data. This results
in larger file sizes in Flash export if pictures have different alpha channels, but the same image file.
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If a picture is tiled and has an alpha channel, the picture will be tiled at export time (and not at runtime). This
will result in a larger file size than a tiled picture without alpha channel.

Sound
Only *.wav and *.mp3 audio file types are supported in Flash export.

WAV file formats are supported as long as they are 8 bit or 16 bit files with one of the following sample rates:
5.5 k Samples/sec, 11.025 k Samples/sec, 22.050 k Samples/sec, and 44.100 k Samples/sec. No other sample
rates are supported.

MP3 is the recommended format for all sounds, except very short sound effects.
MIDI (*.mid) and WMA sound files (*.wma) are not supported in Flash export.
Sound actions/resources in Flash export have the following limitation:

Any one sound (from the same file) cannot be played more than once at a time. If the same sound is started by
different events, the extra sound actions are ignored while the sound started by the first event is still playing.

The only files that can be streamed (that is, only downloaded to the player when the sound is played) are MP3
files. If a MP3 sound has its 'Use streaming' option set in the corresponding Sound action, this sound cannot be
looped. See the topic "Sound" for more information.

Note that even if the 'Create all pages in a single SWF file' option is selected during export, any MP3 sounds
with the 'Use streaming' option enabled will still reside in their individual .mp3 files. They will not be embedded
in the single .swf file as this would prevent their streaming.

Text objects
Not all text object formatting options are exportable to Flash.

Numbered lists are not supported. Only one type of bullets are supported in bulleted lists, usually round bullets,
although this depends on the chosen font.

The appearance of lists and indents may not be the same as in design mode. Justifying text is not supported.
Embedding of images is not supported.

Text color is supported, but setting a specific background color for individual characters/words/sentences is not
supported. The strikeout format attribute is not supported. Increasing and decreasing indent levels for paragraphs
is not supported, although tabs are. Tables are not supported.

Video objects
e The video must be a .FLYV file, since this is the only video format supported by the Flash player.

e The properties 'Load on show' and 'Discardable’ are not supported, since FLV videos are always streamed to
the Flash player.

e The properties 'Enable transparent color', ‘Transparent color' and 'Always on top' are not supported, since it is
not technically possible.

e The properties 'Auto start' and 'Repeat’ cannot be read or changed at runtime.
Animated GIF objects

If the frame rate of the Flash file is lower than that of an animated GIF contained in the Flash file, the frame rate
of the animated GIF is lowered to match that of the Flash file.

Flash objects

o Not all .swf files, especially if they use complex scripting, are guaranteed to work. Therefore you are advised
to use .swf files containing simple non-interactive graphics that do not use fonts.

5@ .swf files created by Mediator contain complex scripts that make them unsuited to being used in a Flash
object in another Mediator Flash project.

e The .swf file selected must exist locally. It cannot be located at a remote URL.
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You cannot access the properties of the Flash file in the Flash object through programming actions or script.

The .swf file that is used in the Flash object will run at the same frame rate as the Flash project as a whole.
Therefore the Flash object may run faster or slower than intended if the two frame rates differ.

Advanced users

The external .swf file should not contain ActionScript that uses absolute paths to internal objects/variables.
The reason for this is that a .swf file, when played independently, is loaded into the "_root" namespace of

" level0". This is not necessarily the case when the .swf file is loaded into a Flash export from Mediator.
Therefore ActionScript using references like *_root.MyVariable = 17" or " _level0.MyObject = Something"
will have undefined (and quite likely undesirable) effects. This kind of script may prevent the entire
Mediator exported Flash project from functioning correctly.

In general, you should only use external .swf files that work when loaded into a MovieClip (in a different
Flash project) using the "loadMovie( )" ActionScript function.

Input objects

There are some small differences between the regular Mediator input object and the Flash export version:

The Flash input object does not support horizontal scrollbars.
Single-line Flash input objects will always auto-scroll horizontally.
Multi-line Flash input objects will always auto-scroll vertically. Horizontal auto-scroll can be disabled.

If the input object loses focus because the mouse is pressed on another object, then this other object's Mouse
Down, Mouse Up and Mouse Click events will trigger before the input object's On Stop event triggers.

Pressing the Enter key in a single-line input object will trigger the On Stop event, and the input object will
lose focus.

In multi-line input objects a new line is added when pressing Enter.

Setting the ' Flash device fonts' property to True lets you use the three built-in Flash fonts (Arial, Times New
Roman, and Courier New). These fonts do not need to be embedded, thus reducing the size of the exported
file. It is advisable to always use device fonts. This is particularly relevant for input objects and list box
objects, where it is impossible to know ahead of time which character will be entered. Because of this, the
entire alphabet for the chosen font would otherwise need to be embedded in the file.

List box objects

The 'Selected background color' property is not supported, and the background color of the selected item is
only visible while the list box has focus.

A selection is considered to have been made in the list box not when the mouse button is pressed, but when it
is released.

As for the input object (see above), setting the ' Flash device fonts' property to True lets you use the three
built-in Flash fonts (Arial, Times New Roman, and Courier New).

The properties that can be read and set at runtime are: Height, Width, Data, DataArray, SelectedIndex,
SelectedString, Size, Visible, X, Y.

Timeline

When a timeline is used as a resource the Pause action cannot be used. The Start and Stop actions work as in a
regular Mediator project.

HTTP Request resource

Some restrictions apply with this resource. See "The HTTP Request resource” for more information.
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Keyboard events

A Flash project running in a browser may not always react to keyboard events. This is because the Flash player
(in the browser) does not have focus. Clicking the browser window will give focus to the Flash player, and the
On Key Up and On Key Down events should then work as designed.

e The F1 - F12 function keys are not supported.
e Combination keys using Ctrl + key or Shift + key are not supported.

e Certain keys such as Esc may only trigger the On Key Up event (but not On Key Down). This depends on
the platform on which the Flash player is running (Windows, Mac, etc.) and the browser (Internet Explorer,
Firefox, etc.).

e When pressing certain keys on keyboards that differ from the standard English keyboard layout, the @Key
variable will be set to the character that corresponds to the English version of the key being pressed.

Functions
The FORMAT function is not supported in Flash export. The following functions are supported:

ABS
ARCCOS
ARCSIN
ARCTAN
COS
FLOAT
INT
LOWER
LEN
LOG
NOT
RGB
RND

SIN
STRING
SUBPOS
SUBSTR
SQR
TAN
UPPER

System variables
The following system variables are supported in Flash export.

@DateDay
@DateMonth
@DateYear
@TimeHour
@TimeMin
@TimeSec
@Timer
@CursorXpos
@cCursorYpos
@ScreenXsize
@ScreenYsize
@Key
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Preparing for export

Viewing and replacing data files

=l
|L‘£E? Data files are pictures, videos and sounds that you use in your project.

As your project grows, it is sometimes useful to see the list of all such files with their complete path.

The Data Files dialog can be used for this purpose. It also lets you replace a data file by another on all the pages
where it is used.

» Click the Mediator Button.

» Choose Prepare | Data Files.

The following dialog appears.

I Data Files

x]

Files:
Mame Size Fath e
videnl JPG A kB C:%Program Fileshkd atchw arehbdedia
videol_bmp.png 21 KB C:AProgram Fileshh atchiw/arghbdedia
videnZ JPG G kB C:AProgram Files' atchw arehbedia
viden3 PG A KB C:\Program Files\tatchiw/ arettedia =
vidend PG G kB C:AProgram Files'h atchw arehbdedia
¢ | >
Fages:
S b
Paged Replace File...
P?QEE Bitmap pictures -
Wideo
WMF pictures
wave files
kidi files
Curzor filesz
Yideo filez
Other files

By default, all file types are shown.

To exclude unwanted file types from the list, remove the corresponding checkmark in the Show group.

To see a list of the pages where a particular file is used, click the file in the Files list. If you then click one of
the pages listed in the Pages list, Mediator displays that page automatically, without closing the Data Files
dialog.

To replace one of the data files listed by another file, select the file to be replaced, click Replace File and
select the new file. Mediator will replace the file reference on all the pages where it is used, saving you the
trouble of editing each reference manually.
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Adding data and program files

Lt )

ER

When you export your project, Mediator automatically collects and includes in the exported version all the
external files you have used in the project. However, this is only true for files that are visibly part of the project
(pictures, videos, GIFs etc.), not external files such as programs, forms, spreadsheets, INI files, databases etc.
that you might refer to in the various actions or in the Embedded Document object.

Additional data files

To ensure that Mediator will include these additional data files in your exported version, you must specify them
in the Additional Data Files list. When generating the exported version, Mediator copies all the files that are
listed in the Additional Data Files list to the folder containing the Mediator project file.

» Click the Mediator Button.

» Choose Prepare | Additional Data Files to open the following dialog:

B Additional Files X

M ame Path Add

Rermove

)4 ] [ Cancel

» Click the Add button to select the file you wish to include in the export.

Q You can select multiple files with the standard Windows combinations Shift + click (to select consecutive files) and Ctrl
+ click (to select non consecutive files).

When running your exported version, Mediator always starts by looking in the Mediator project folder for
external data files referred to by the project. Therefore if you have used actions or expressions that refer to
external data files, as well as including them in the Additional Data Files list, you must make sure that their path
in these actions and expressions does indeed point to the Mediator project folder.

When working on documents of type Standard, Mediator provides a system variable called @DocDir that you
can use in actions and expressions to refer to the Mediator project folder.

If for instance your Mediator project file is stored in the folder "C:\MyProjects\Data" on the end user's computer,
the expression @DocDir + "MyDocument.doc" will be equivalent to the path name
"C:\MyProjects\Data\MyDocument.doc".

You can also use @DocDir to build other path names relative to the project folder. In this case, you will need to
reproduce your relative folder structure in the project folder by copying the relevant folders and files manually
after the export.

See "System variables" for more information on @DocDir.
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Additional program files

In addition to external data files, Mediator also allows you to include external program files via
the Additional Program Files dialog. When generating the exported version of your project, Mediator copies all
these files to the program folder containing Mediator Viewer (md8rntm.exe).

@ This is only applicable to documents of type Standard.
> Click the Mediator Button.
» Choose Prepare | Additional Program Files.

Self-registering ActiveX controls that are used in the project should be contained in OCX files in order to be
registered by Mediator. You should also include these OCX files in the Additional Program Files dialog.

As well as including external program files in the Additional Program Files list, you must make sure that the
path of any external program you refer to in actions and expressions does indeed point to the program folder
containing Mediator Viewer. Mediator provides a system variable called @ProgramDir for this purpose.

Notes:

e Many programs require .dll files as well as the main .exe. You should also include these additional files in
the Additional Program Files list.

e You do not need to add applications that are part of Windows (e.g. WordPad, Paint etc.)

e When including other programs in your project make sure you do not violate any copyright laws.

Optimizing the pictures

|

[ S
—“57 Pictures can be selected and inserted quickly in Mediator, in picture objects or on buttons.

Their resolution however is often much higher than necessary. This slows down the project at runtime, as
Mediator needs extra time to load them and resize them.

When you work with web sites (HTML or Flash) it is particularly important to keep the resolution of your
pictures as small as possible, to minimize the download time of your online projects and maximize their
performance.

To help you optimize your projects Mediator includes a built-in Image Optimizer®.
You can access the Image Optimizer in two ways:

e Before exporting your project, by clicking the Mediator Button, then choosing Prepare | Optimize.

e During the export procedure, by checking Optimize pictures in the Advanced Export dialog.

The first window of the Image Optimizer lets you choose between two modes, further described below:
e Automatic: Mediator optimizes your pictures automatically using the default JPG quality level shown.

e Manual: You customize the process yourself in the next screens.
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Picture 0 ptimization

Optimization method
JPG quality:

il -

w

(%) Automatic
) Manual

|n automatic mode, Mediator optimizes pour pictures
Lzing the quality setting above far all jpg pictures.

|r manual maode, vou can define the file format,
color resolution and quality of each picture.,

Help ][ ] ][ Cancel ]

95’ When you check the 'Optimize pictures' option in Quick export, Mediator uses the automatic mode with the
default JPG quality level of 70%.

The Image Optimizer starts by creating copies of the original pictures and places them in a folder called
Optimized. Once optimized, the pictures are kept in this folder. The Optimized folder is created in the same
folder as your project file (the md8 file) and should not be moved.

You are strongly advised not to place more than one md8 file in the same project folder if you wish to use the
Image Optimizer, as it may cause problems for two or more md8 files to share the same Optimized folder.

9? Your original pictures are of course not changed or moved during the optimization process. Mediator uses
the optimized copies of your pictures in the exported version.
Automatic mode

When you select Automatic and click OK, Mediator quickly runs through all your pictures, resizing and
optimizing them as required.

Optimizing §|

[llllllllllllllllllllllllllllllllllllllllllllllq

Original zize: 271 KB
Optimized gize: 172 KB - B3%

%  Ong.. 0Op.. | Mame Fath

30 3KB 1KBE  roundd_D5tt_onpng o hprogram fileshmatchware’
100 85 KB 85 KB gravitationpng c:hprogram filezhrmatchwars’
10 104KE 10KE cawvebmp c:hkemph,

32 3KB TKE  roundd_D5kt_off prg o hprogram fileshmatchwars’
100 62KEB  B2EB  geiger counter.png c:hprogram fileshmatchware’
100 11 EE 11 KB altemating cument.prg o sprogram fileshmatchwars’

By default, the JPG quality level is set to 70%. This value ensures a good level of quality, but you may lower it
to further compress the pictures, and therefore reduce the file size. To get an idea of how much you can
compress them while still retaining an acceptable level of quality, run the Image Optimizer in manual mode on a
few of your pictures until you find a level of compression that you are satisfied with.
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Manual mode
In manual mode, Mediator opens the following dialog.

e Image0ptimizer

-

Criginal: plant03.jpg  Use ariginal image Cuality: 90%: Save image Ciaality: &0% Save image
Size: 257Kb Size: 252Kh Fine tune Size: 185Kb Fine tune

- o -
Cuality: 70%: Save image Cuality: 0% Save image Ciaality: S0% Save image
Size: 129Kb Fine tune Size: 107Kb Fine tune Size: 84Kb Fine tune

-

Cuality: 40%: Save image Cuality: 30% Save image Ciaality: 20% Save image
Size: 74kb Fine tune Size: 61Kb Fine tune Size: 48Kb Fine tune
Adjust quality: | ¥ I 60 o

Image Optimizer opens up the pictures one by one, and lets you select the format and quality you wish to use for
each one. The nine thumbnails show you how different levels of compression affect the picture.

The top left thumbnail shows the original image. The other eight show compressed versions, ranging from an
image quality of 90% to an image quality of 20%.

The thumbnails only show a part of the image. You can move the image within the thumbnail by dragging it.

Quality: 60%: Save image
Sizes 107KB Fine tune

» To see a bigger representation of a compressed image, double-click the relevant thumbnail. Click the Close
button I or press Esc to return to the Image Optimizer.

Use original image: To skip to the next picture without optimizing the current one, click 'Use original image'
below the original image (top left corner).
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Save image: To save one of the compressed versions, click its 'Save image' label to create an optimized copy of
the image in the Optimized folder.

Fine tune: To find the perfect compression factor for your image, select the thumbnail that comes closest to
what you need, then click its 'Fine tune' label to see 8 new compression factors within 10% of the initial
compression rate. Select a thumbnail and click 'Fine tune' again to zoom into 8 further compression factors
differing by just 1%. You can save the image at any time during this process.

Adjust quality: You can also use the 'Adjust quality' slider to change the level of compression. This slider
appears at the bottom of the Image Optimizer when you click one of the thumbnails. Drag the slider to increase
of decrease the quality of the image in the selected thumbnail. Then click 'Save image' to create a copy of the
image in the Optimized folder, or 'Fine tune' to update all 8 compression thumbnails.

Adjusk quality: | 60 %o

Menu options

The Image Optimizer menu bar contains the following options:

Ira "’l [v Resizeimage | Display original image  Reset quality values

Format: Choose between JPG and PNG. If a picture uses a transparent color, PNG is the only picture format
available, as the JPG format does not handle single-color transparency very well.

Resize image: When this option is checked, Image Optimizer resizes the picture to the same size than the picture
object or button in which it is placed.

@ If you have used the same picture more than once in your project in different object sizes, Image Optimizer
optimizes it to the largest size used, giving you optimal quality for all the objects that refer to the given picture
file.

Display original image: When this option is checked, the original image is shown in the top left corner.

Reset quality values: Click to reset the compression thumbnails to range from 90% to 20% in quality.
Exiting Image Optimizer

» To exit Image Optimizer before having optimized all the images in your project, click the Close button X

Optimizing for CD-ROM export

There are various points to bear in mind at the design stage in order to optimize your project for CD-ROM
distribution. This topic is relevant to projects that you intend to export with the CD-ROM (without installation)
method, e.g. without installation on the end user's hard disk.

The transfer speed of a CD-ROM is lower than that of a hard disk. Consequently, you must bear in mind that the
performance obtained when the project is run from a CD-ROM will not be as high as when you test it on your
hard disk.

The other factor likely to affect performance is the search time. This is the time it takes to move from one track
to another, for instance when searching for all the files needed to display a Mediator page. The search time is
usually significantly lower on a CD-ROM than on a hard disk. You can minimize the total search time by
limiting the number of files that have to be loaded when displaying a new page, for instance by enabling the
‘Load on show' option. See "Object properties: graphic properties" for more information on this property.

If this is a concern, it is a good idea to create a "dummy" project with all the elements that might affect
performance, export it to CD-ROM and test it under real conditions before getting too advanced in the design.

Q Spread out the contents of your project on different pages whenever possible. Rather than placing a large number of
objects on a small number of pages, it is far better to create new pages to distribute the contents. Not only does this reduce
the volume of data to be loaded when displaying each new page, but it usually improves the project overview. The Mediator
Active Page Management system ensures that a large number of pages does not negatively affect performance.
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Data folders in large CD-ROM projects

This topic describes how to control the folder structure used for the data files of large CD-ROM
projects.

When you export your project to CD-ROM, all the files (pictures, sounds, videos, etc.) that you have included in
your project are copied to a folder named Data on the CD-ROM. When your project is run on the end user's
computer, the files are read from this Data folder on the CD-ROM.

This method works fine for most projects, but may impact performance for extremely large projects with
thousands of data files. The more files the Data folder contains the longer it takes Mediator to find and open a
specific file.

You can however overcome this problem, and take the opportunity to improve the organization of your project at
the same time, by placing all the files you require in different sub-folders at design time.

You can for instance place all the picture files in a sub-folder named Pictures, all the sound files in a sub-folder
named Sounds, etc.

= @ W @

kizcelaneous Pictures Sounds Yideoz

Here we have created 4 sub-folders, but you can use as many as you like, and name them according to their
content or any other characteristic.

Here is the procedure to follow:
» Save your .md8 project into an empty folder of your hard disk.

> Create within that folder a folder structure of your choice (e.g. a sub-folder for the pictures, another for the
sounds etc.). You can even create sub-sub-folders if required.

> Place all the files (e.g. pictures, sounds etc.) in the relevant sub-folders before integrating them to the
Mediator project. This will ensure that all the file paths in the project will point to one of these sub-folders.

» When you have completed your project, export to CD-ROM in the normal way. See "Exporting to CD-ROM
(without installation)" for the detailed procedure.

> Once the exported version is created on your hard disk, but before burning the CD, delete the contents of the
CDROM\Data sub-folder created on your hard disk during the export and replace them with the contents of
your own project folder (i.e. the folder of your hard disk where you placed the .md8 project and all your data
sub-folders).

> Burn the CD-ROM with the contents of the CDROM folder.
Your folder structure will now be maintained when the end user runs your project from the CD-ROM.

Notes:

e |f you move files from one data sub-folder to another during the design phase, you must also change the path
names of all the files concerned in the Mediator project.

e If you rename one of the sub-folders, you must also make the relevant changes in the Mediator project for all
the files contained in that sub-folder.

e You can add more sub-folders to the structure at any time during design.

e This procedure will also work if you have used the Prepare | Additional Data Files command to add external
data files (INI files, PDF files, databases and so on) to your project.
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Exporting your project
Introduction

IEEI Mediator lets you export your project in various formats for distribution to other users.
The export formats available depend on the type of your document, e.g. Standard, HTML or Flash.

The document type is normally defined when you create the document, but you can choose a different document
type at any time later by clicking the Mediator Button and choosing Prepare | Properties. For more
information, see "Document properties".

Note that if you change the document type from Standard to HTML or Flash, you will need to check that all the
elements, objects, actions and other features you have used in your project are indeed supported by the HTML or
Flash format.

Whenever possible, Mediator informs you of any such compatibility problems during export.

Please refer to the topic "Mediator 9 feature list" for a complete list of all objects, events and actions available in
Mediator for each document type. You will also find a detailed list of the restrictions applicable to HTML and
Flash in "HTML restrictions"” and "Flash restrictions".

@ If you are referring to external data or program files in your project, you need to make sure that Mediator
will include them in the exported version. See "Adding data and program files" for more information.

Once you have chosen your preferred export format, specified an output folder and filled in the relevant dialogs,
Mediator starts by checking your project. If no errors are found, it collects all the files making up your project to
create the exported version and adds the Mediator Viewer if necessary.

The Mediator Viewer is the cut-down version of Mediator that allows your users to view your project once
exported. It is automatically packaged with your project when you export it to any format other than HTML or
Flash. When exporting to HTML or Flash, the Mediator Viewer is not needed as the project is viewed via the
Internet browser.

Mediator stores the exported version in the output folder you specified, ready for you to copy it to the
appropriate distribution medium.

Export formats

The various export formats available in Mediator are as follows:

e CD-ROM (without installation)

Only for projects of type Standard. See "Exporting to CD-ROM (without installation)" for more
information.

e CD-ROM (with installation)
Only for projects of type Standard. See "Exporting to CD-ROM (with installation)" for more information.
o Self-executable EXE
Only for projects of type Standard. See "Exporting as self-executable EXE file" for more information.
e Zip'N'Run
Only for projects of type Standard. See "Exporting as Zip'N'Run file" for more information.
e HTML
Only for projects of type HTML. See "Exporting to HTML" for more information.
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e Flash
Only for projects of type Flash. See "Exporting to Flash" for more information.
e Copy to Folder

For all project types. See "Copy to Folder distribution" for more information.

@ The "myMediator.com" option, available in the Education version of Mediator, allows you to create a Flash
version of your project and upload it to the Mediator School Server in one step. Please refer to the topic
"myMediator.com” for more information.

Export modes

Some of the export formats listed above can be used in two modes:

e Quick export

IE"_' The Quick export allows you to export your project quickly, using the Mediator defaults.

e Advanced export

IEEI The Advanced export allows you to set various export settings in the Advanced Export dialog.

Exporting to CD-ROM (without installation)

This topic describes how to export your project to CD-ROM (or other removable storage medium), without
including an installation program.

@ This export format is only available for projects of document type Standard (as opposed to HTML or Flash).
To find out how to change the document type of your project, refer to "Document properties".

With this export format, all your project files (.md8 file, all data files and Mediator Viewer) are copied onto the
CD-ROM and remain on the CD-ROM at all times. Whenever the user wants to run the project, he/she needs to
insert the CD in the CD-ROM drive. None of the project files are copied on the end user's hard disk.

This export format is therefore a good choice for large projects containing many pictures, videos, sounds and so
on. For advice about performance and folder structure for very large projects, see "Optimizing for CD-ROM
export".

If you want to create a CD-ROM containing an installation program so that the entire project can be installed on
the end user's hard disk, see "Exporting to CD-ROM (with installation)".

Quick export

> Click the Mediator Button.

» Choose Export | Quick Export.

» Select CD-ROM (without installation) in the Quick Export dialog.

185



Quick Export

Type
(%) CO-ROM [without installation]
) Self-executable EXE file

Optimize pictures

Output folder:
C:Ahy documents

QI You can also press Ctrl + Q to access the Quick Export dialog.

>

»

Check Optimize pictures to let Mediator optimize automatically the pictures contained in your project.

If your project contains many pictures, it is advisable to let Mediator optimize them, as pictures are often
much larger than they need to be. Optimizing them reduces the size of your project and maximizes its
performance.

Specify an output folder. By default, this is the folder containing your project.

. Ak
Enter a new folder name or click the Browse button = to select another folder.

Click OK.

Mediator creates a sub-folder called CDROM in your output folder and copies to it all the files making up your
project, the auto-run files and the Mediator Viewer.

>

>

To view the contents of the CDROM folder, click Open File Folder when the Export Finished dialog
appears.

Copy all the files and folders from the CDROM sub-folder to the root of your CD using your CD burner
software.

CData
B [ Directx
1 Runtime
E Avtarin.inf
Cd rom % Start. exe
5] Start.inf

Distribute the CD to your end users. As auto-run is always included on the CD, the project will start as soon
as the user inserts the CD in the drive.

Advanced export

>
>
>

Click the Mediator Button.
Choose Export | Advanced Export.
Select CD-ROM (without installation) in the Advanced Export dialog.
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Advanced Export E|

Type

(%) CO-ROM [without installation)]
() CO-ROM [with inztallation]
() Self-executable EXE file

) ZipM'un

[ ] Enable Auto Run for the CO-ROM
[ ]Include Direct:
[ Usze Viewer splash screen

] Embed TrueT vpe fonts

[ ] Optimize pictures

Output falder:
4y documents

k. H Cancel ]

» Choose the export settings required. These settings are described in "Advanced export settings".

» Specify an output folder. By default, this is the folder containing your project.

. Ak
Enter a new folder name or click the Browse button £ to select another folder.
> Click OK.

Mediator creates a sub-folder called CDROM in your output folder and copies to it all the files making up your
project, the auto-run files if requested and the Mediator Viewer.

» To view the contents of the CDROM folder, click Open File Folder when the Export Finished dialog
appears.

» Copy all the files and folders from the CDROM sub-folder to the root of your CD using your CD burner
software.

» Distribute the CD to your end users.

e If you have included auto-run on the CD, the project will start as soon as the user inserts the CD in the
drive.

e If not, instruct your users to double-click 'Start.exe’ to start your project.

Exporting to CD-ROM (with installation)

This topic describes how to export your project to CD-ROM (or other removable storage medium), with its own
installation program.

9? This export format is only available in Advanced export, for projects of document type Standard (as
opposed to HTML or Flash). To find out how to change the document type of your project, refer to "Document
properties".

As the CD-ROM (without installation) export format, this export format lets you create a CD-ROM containing
all your project files (.md8 file, all data files and Mediator Viewer) for distribution. The end user however needs
to install the project on his/her hard disk in order to view it.

This export format is therefore suitable for large projects where speed of execution is particularly important

Advanced export
» Click the Mediator Button.

» Choose Export | Advanced Export.
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» Select CD-ROM (with installation) in the Advanced Export dialog.

Advanced Export E|

Type

(%) CO-ROM [without installation]
() CO-ROM [with inztallation)]
() Seli-executable EXE file

) ZipM'un

] Enable fuba Fun for the CO-RORM
[ Include Directs
[ ] Usze Viewer splash screen

[ ]Embed TrueT vpe fonts

] Optimize pictures

Clutput folder:
C:hhy documents

5] oo ]

Choose the export settings required. These settings are described in "Advanced export settings".

Specify an output folder. By default, this is the folder containing your project.

. Ak
Enter a new folder name or click the Browse button = to select another folder.
» Click OK.

Mediator creates a sub-folder named CDROM in your output folder, compresses your project and saves it in this
sub-folder.

It then starts a separate module called InstallMaker to create an Install program for your project. You can define
different installation settings and customize the design and the messages of the Install dialogs. Refer to "Using
InstallMaker" for more information.

» Click Close in the last InstallMaker dialog once the installation files have been created.

» To view the contents of the CDROM folder, click Open File Folder when the Export Finished dialog
appears.

» Copy all the files and folders from the CDROM sub-folder to the root of your CD using your CD burner
software.

%_install. e
D 8B install exe
5] Start.inf

Cdrom

> Distribute the CD to your users and instruct them to double-click 'Install.exe’ to install your project on their
hard disk.

The Install program creates a folder for the project on the end user's hard disk, as well as two shortcut icons in
Start | Programs: one for running the project and one to uninstall it. Clicking the Uninstall icon removes all the
program files, data files, folders and shortcuts related to the project.
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Exporting as self-executable EXE file

This topic describes how to export your project as a self-executable EXE file.
@ This export format is only available for projects of document type Standard (as opposed to HTML or Flash).
To find out how to change the document type of your project, refer to "Document properties".

With this export format, all the project files (.md8 file, all data files and Mediator Viewer) are embedded in a
single self-executable file (.exe), using your project name as file name. When the end user double-clicks the .exe
file to run the project, rather than being decompressed, the files are streamed and read directly from the .exe file.
This ensures an optimum speed of execution regardless of the project size.

This method has two main advantages:
e Speed

The project is executed directly from the .exe file. There is no decompression, and therefore no waiting time.
e Protection

As all pictures, sounds, videos etc. contained in the project are embedded in the .exe file, they are not visible
to outsiders and therefore cannot be copied.

This export method has some restrictions:

¢ Video and sound files being played back in the Media Player object, files used within the Embedded
Document object, Flash files being shown in the Flash object and Databases cannot be accessed directly from
the exported .exe file at runtime. Mediator therefore does not embed them in the .exe file, but copies them
separately in the same folder as the .exe file. If you are creating an .exe file for distribution via CD-ROM and
do not mind leaving these files unencrypted, just copy them along with the .exe on the CD, and Mediator will
find and use them as intended.

e Picture files inserted in a text object will not be accessible from the exported .exe file.

e The 3D page and object transition effects available in Mediator require DirectX 9 or later including the
Microsoft D3DX utility library. This library is not available in Windows Vista by default and is not installed
by Windows Update. Although Mediator includes DirectX 9 in the exported .exe file, it cannot embed the
D3DX library in the file. The 3D effects will therefore work on Windows Vista only if this library is already
available on the computer.

@ The icon used to identify the .exe file is the same as the icon used to represent your project. You can replace
this icon if you wish. See "Document Properties” for more information.

Quick export

> Click the Mediator Button.

» Choose Export | Quick Export.

» Select Self-executable EXE file in the Quick Export dialog.

Quick Export

Type
(%) CO-ROM [withaut installation]

i) Self-executable EXE file _

Cptimize pictures

Output folder:
C:hhy documents =2
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QI You can also press Ctrl + Q to access the Quick Export dialog.

» Check Optimize pictures to let Mediator optimize automatically the pictures contained in your project.

If your project contains many pictures, it is advisable to let Mediator optimize them, as pictures are often
much larger than they need to be. Optimizing them reduces the size of your project and maximizes its
performance.

» Specify an output folder. By default, this is the folder containing your project.

. A
Enter a new folder name or click the Browse button = to select another folder.
> Click OK.

Mediator creates a sub-folder called EXE in your output folder and copies to it the .exe file (as well as any other
data files that cannot be embedded, as described above).

The Export Finished dialog appears.

Export Finished El

kediator haz exported vour project successfully.

To open the folder containing the exparted project, click
'Dpen File Folder'

Dpen File Folder l [ Email... ] [ Cloze

e To view the contents of the output folder, click Open File Folder.

e You can also click Email to send the .exe file via your default email program.

You can now send the .exe file to your end users via e-mail or post it on your web site. All the end user has to do
to run the project is to double-click the .exe file.

Advanced export

The only difference between Quick and Advanced export is that Advanced export allows you to choose various
export settings in the Advanced Export dialog. These settings are described in "Advanced export settings".

Creating an auto-run file

If you intend to distribute the .exe file on a CD-ROM you may also want to create an auto-run file that will
automatically start the project when the end user inserts the CD into the CD-ROM drive.

» Open Notepad.

> Type the following:
[autorun]
open=yourfile.exe (where yourfile is the name of your .exe file)
Save the Notepad file as Autorun.inf.

When you burn your CD, place the file in the root of the CD along with the .exe file.
Exporting as Zip'N'Run file
This topic describes how to export your project as a Zip'N'Run file.

5@ This export format is only available in Advanced export, for projects of document type Standard (as
opposed to HTML or Flash). To find out how to change the document type of your project, refer to "Document
Properties".
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With this export format, all the project files (.md8 project file, all data files and Mediator Viewer) are
compressed and saved in a self-extracting executable (.exe), using your project name as file name.

All the end user has to do to run the project is to double-click the .exe file. This extracts the project files to a
temporary folder on the hard disk, from which the project is then executed. When the user exits the project, all its
files except for the .exe file are deleted from the hard disk. As the decompression step may take time, this export
format is only recommended for small projects limited to a few megabytes.

The advantage of this method is that it encrypts all the files, including the additional data files, thereby keeping
the data safe from unwanted user access.

@ The icon used to identify the .exe file is the same as the icon used to represent your project. You can replace
this icon if you wish. See "Document Properties" for more information.

Advanced export

> Click the Mediator Button.

» Choose Export | Advanced Export.

» Select Zip'N'Run in the Advanced Export dialog.

x]

Advanced Export

Type

(%) CO-ROM [without installation)]
() CO-ROM [with inztallation]
() Self-executable EXE file

) ZipM'un

[ ] Enable Auto Run for the CO-ROM
[ ]Include Direct:
[ Usze Viewer splash screen

] Embed TrueT vpe fonts

[ ] Optimize pictures

Output falder:
4y documents

k. H Cancel ]

Choose the export settings required. These settings are described in "Advanced export settings".

Specify an output folder. By default, this is the folder containing your project.

. Ak
Enter a new folder name or click the Browse button £ to select another folder.
> Click OK.

The following dialog appears.
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Self-Executable EXE X

kediator iz preparing your project az a single EXE file. Thiz method iz
particularly suitable far distributing small projects az email attachments ar
wia Intermnet.

When ugzers start the EXE file, the Mediator project files are extracted to their
hard digk. and executed. ‘When they exit the project, all the project filez
except the zingle EXE file are deleted from the hard disk.

Extracting files takes time, 2o thiz diztribution methad iz anly recommended
for zmall projects limited to a few megabytes.

Cancel

The Export Finished dialog appears.

Export Finished El

Mediator has exported your project succezsfully.

To open the folder containing the exparted project, click
'Dpen File Folder".

Open File Faolder l [ Email... ] [ Cloze

e To view the contents of the output folder, click Open File Folder.

e You can also click Email to send the .exe file via your default email program.

You can now send the .exe file to your end users via e-mail or post it on your web site. All the end user has to do
to run the project is to double-click the .exe file.

Exporting to HTML

This topic describes how to export your project to HTML.

5@ This export format is only available for projects of document type HTML (as opposed to Standard or Flash).
To find out how to change the document type of your project, refer to "Document properties".

Please refer to the topic "Mediator 9 feature list" for a complete list of all objects, events and actions available in
HTML export. You will also find a detailed list of the restrictions applicable to HTML in "HTML restrictions".

All the HTML code produced by Mediator when exporting to HTML is validated according to the W3C HTML
4.01 standard.

This ensures that all the common browsers will render the page content as expected.

Note however that this only applies to HTML code generated by Mediator. HTML code inserted directly by
yourself in the project, for instance in the HTML object or in the HEAD meta-tag (via Prepare | Properties) is not
validated by Mediator. It is your responsibility to ensure that it is valid.

When exporting to HTML, any keyword attached to the page (see "Page properties: General tab™) will be
inserted in the Keyword meta-tag on the HTML page. The description and keywords attached to the entire
project (see "Document properties”) are placed in the main index.htm file generated. The Document Properties
dialog also lets you define a favorite icon for the HTML project.
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Quick export
» Click the Mediator Button.

» Choose Export | Quick Export.

Quick HTML Export (%]
Cluatput folder:
|E:"~I'-.-1_I,I documents |

Optimize pictures

[ OK |[ Cancel ]

Q. You can also press Ctrl + Q to access the Quick Export dialog.

» Specify an output folder. By default, this is the folder containing your project.

. =1
Enter a new folder name or click the Browse button I to select another folder.
» Check Optimize pictures to let Mediator optimize automatically the pictures contained in your project.

If your project contains many pictures, it is advisable to let Mediator optimize them, as pictures are often
much larger than they need to be. Optimizing them reduces the download time of your online project and
maximizes its performance.

» Click OK.

Mediator creates a sub-folder named HTML in your output folder and saves your project in this sub-folder.

Advanced export

The only difference between Quick and Advanced export is that Advanced export lets you specify additional
options.

Advanced HTML Export [5_(|

Aligrment Site map

Path ta target URL (2. http:Adweana. dr.dk]:
) Top left | |

—-_ ) Top center SCORM
]

[ ] Create as SCORM compatible package

(%) Center

[ ] Optimize pictures

Output falder:
|E:"~M_I,I document s |

] 4 H Cancel ]

Alignment: Choose if you wish to position the project in:

o the top left corner of the browser
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o the top center of the browser

¢ the center of the browser

5@ The color used for the browser background is the color you defined when creating the document. You can
change it via Prepare | Properties. See "Document properties” for more information.

Site map: This option allows you to get Mediator to generate an XML site map for your web site automatically.
XML site maps are used to improve the visibility of your web pages by search engines. They contain information
such as frequency of change, priority, date of creation and more, which search engines can look up rather than
having to crawl your entire site. The site map is held in a file called sitemap.xml and stored in the root folder of
the project (i.e. in the same location as your project's main page).

To generate an XML site map, you need to enter in the 'Site map' field the URL of the folder to which you intend
to upload your HTML project.

QI If you do not yet know the URL of the folder you intend to upload to, or if you decide to upload your project to a
different server after having exported it and generated the site map, you can edit the sitemap.xml file manually and replace
all the occurrences of the server URL to the new URL.

SCORM: These options let you export your project as a SCORM compliant course. Please refer to "Using
SCORM™" for a full description of this feature.

Optimize pictures: Checking this option will start the built-in Image Optimizer just before the export to let you
specify how your pictures should be optimized. See "Optimizing the pictures” for more information.

» Click OK.

@ The default export settings used in Quick export are as follows:

e Alignment: The project is centered if all the HTML pages have the same height. If not, it is positioned at the
top center of the browser.

e Site map: No site map is created.

Finalizing the export

The export may take a few minutes for larger projects, but is usually done within seconds. When export is
complete, the following dialog appears.

Publish x|

[ Freview ][E&] [ FTF ] [ Open Folder ] [ Cloze |

Here you can:

e Click Preview to open the main HTML file in your default browser for preview. If you have several
browsers installed on your computer, clicking the icon to the right of the field will let you choose a different
one.

e Click FTP to upload your project using the Mediator FTP Upload Manager program. For more information,
see "Mediator FTP Upload Manager".

e Click Open Folder to open the folder containing your HTML files.

¢ Click Close to exit the dialog. If you choose to close this dialog without uploading your HTML files to the
web, you can do so later by uploading the contents of the HTML sub-folder to the Internet using your FTP
software.
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Exporting to Flash

This topic describes how to export your project to Flash (.swf files).

9? This export format is only available for projects of document type Flash (as opposed to Standard or HTML).
To find out how to change the document type of your project, refer to "Document properties".

Please refer to the topic "Mediator 9 feature list" for a complete list of all objects, events and actions available in
Flash export. You will also find a detailed list of the restrictions applicable to Flash in "Flash restrictions".

Quick export
» Click the Mediator Button.

» Choose Export | Quick Export.

x]

Quick Flash Export

Cukput Folder:
My documents =

|:| Opkimize pickures

(0] 4 H Cancel ]

Ql You can also press Ctrl + Q to access the Quick Export dialog.

» Specify an output folder. By default, this is the folder containing your project.

. A
Enter a new folder name or click the Browse button = to select another folder.
» Check Optimize pictures to let Mediator optimize automatically the pictures contained in your project.

If your project contains many pictures, it is advisable to let Mediator optimize them, as pictures are often
much larger than they need to be. Optimizing them reduces the download time of your online project and
maximizes its performance.

> Click OK.
Mediator will create a sub-folder named Flash in your output folder, and compresses and saves your project in it.

Advanced export

The only difference between Quick and Advanced export is that Advanced export lets you specify additional
options.
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x]

Advanced Flash Export

Create all pages in a zingle SWF file ] Optimize pictures
Frame rate; 300 | fps [ Embedded Fonts. .. ]
SCORM Aligrment

[ Create as SCORM compatible package E () Top left

l_! (%) Top center
Output folder:

L4y documents

5] [cmea ]

Create all pages in a single SWF file: Checking this option means that the exported Flash project will only
contain one .swf file. It will however also contain HTML files and JavaScript files for loading the project and
displaying it in a browser window. If you have included some .mp3 sound files using streaming, these files will
also be included separately. This is also the case with video files (.flv) associated with video objects, as they
cannot be embedded in a .swf file.

Using this option will result in smoother and faster page turn transitions, at the expense of having to download
all pages, even if only the first one is visited.

Optimize pictures: Checking this option will start the built-in Image Optimizer just before the export to let you
specify how your pictures should be optimized. See "Optimizing the pictures" for more information.

Frame rate: Use this field to define the number of frames per second your Flash file should use. The default
value is set to 30.0, which ensures a smooth play back.

Embedded Fonts: Ignore this button if your project only uses western languages, as the relevant character fonts
(Basic Latin and Latin-1 Supplement) are embedded by default.

If on the other hand you have included input boxes and list boxes in your project in which non western
characters might be entered, this button will enable you to select only the character ranges that you need, rather
than having to embed them all, thus minimizing the file size.

» In the Flash Font Embedding Options dialog, for each of the fonts displayed in the upper part of the
dialog, choose the character ranges to be embedded from the list shown in the lower part. To minimize the
file size, only include the ranges actually required.

SCORM: These options let you export your project as a SCORM compliant course. Please refer to "Using
SCORM" for a full description of this feature.

Alignment: Choose if you wish to position the project in:
o the top left corner of the browser (adjustable frames to the right and at the bottom)

o the top center of the browser (symmetric adjustable frames on either side and at the bottom)

» Click OK.

@ The default export settings used in Quick export are as follows:
e All pages are created in a single SWF file
e Frames per second = 30

e Alignment = Top center
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Finalizing the export

The export may take a few minutes for larger projects, but is usually done within seconds. When export is
complete, the following dialog appears.

Publish X

[ Presview ][L:E-] [ FTP ] [ Open Faolder ] | Cloze |

Here you can:

e Click Preview to open the main Flash file in your default browser for preview. If you have several browsers
installed on your computer, clicking the icon to the right of the field will let you choose a different one.

e Click FTP to upload your Flash project using the Mediator FTP Upload Manager program. For more
information, see "Mediator FTP Upload Manager".

o Click Open Folder to open the folder containing your Flash files.

¢ Click Close to exit the dialog. If you choose to close this dialog without uploading your Flash files to the
web, you can do so later by uploading the contents of the Flash sub-folder to the Internet using your FTP
software.

To launch the Flash project as a web site in a browser window, just double-click the index.htm file.

If however you want to use the Flash project as a banner within an existing html page or web site, or if you want
to include it in a different Mediator project as a Flash object, you can access the main.swf file directly.

In both cases you must keep all the exported files together in the same folder.

5@ If you open the main.swf file itself in the web browser (instead of the container file index.htm), the Flash
object is scaled to fit the entire space available. It does not keep to a specific size as it does when displayed
within an html page.

Advanced export settings

This topic describes the export settings available when exporting your project using the Advanced export
procedure.

5@ These settings are not relevant to the HTML, Flash or 'Copy to Folder' export methods.
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Advanced Export E|

Type

(%) CO-ROM [without installation)]
) CO-ROM [with inztallation]
) Self-executable EXE file

) Zip'M

[ ] Enable futa Fiun for the CO-ROM
[ Include Directs
[] Uze Viewer splazh screen

[] Embed TrueT ype fonts

[] Optimize pictures

Output falder:
Ay documents

ak. H Cancel ]

Enable Auto Run for the CD-ROM
This setting only applies to the CD-ROM (without installation) export format.

e [fthis option is checked, the project will start automatically as soon as the user inserts the CD-ROM in the
CD-ROM drive, provided that the auto-run feature is enabled on his/her computer.

The files Autorun.inf, Start.inf and Start.exe are also copied onto the CD-ROM.

| :] £ Rurtime
%] Auborun.int

cd rom Start.e:-:e

o If you leave this option unchecked, or if the end user has disabled auto-run on his/her computer, the project
will not start automatically. Instruct your end users to double-click 'Start.exe' on the CD-ROM to start it.

9? Auto Run is always enabled when using Quick export.

Include DirectX

Check this option to include DirectX 9 in your exported version. This ensures that 3D page and transition effects
will be available to your end users even if the version of DirectX installed on their own computer is an older
version.

@ The DirectX files are always included when using Quick export.

Use Viewer splash screen

Check this option to display the Mediator Viewer splash screen when your project starts up. This option is only
relevant to the CD-ROM (without installation) export format, where viewing the splash screen can be useful to
occupy the small delay while the files are read from the CD-ROM or other storage medium.

5@ This option is disabled when using Quick export.

Embed TrueType fonts

Check this option to include the fonts used by your project in the exported version. If you do not include them,
your project may appear differently on the end user's computer.
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If you check this option, Mediator will display a dialog called Font Embedding, listing all the fonts used in your
project and letting you choose the ones to include.

Font Embedding [‘S_<|

[ ]Arial Graz (343 Kb) [Standard ‘windows Font)
[ ]Arial Graz Italique [221 Kb) [Standard windows Fort)
[ ]Arial Mormal [358 Kb) [Standard windows Font)

[ OF. ] [ Cancel

5? Some fonts may be protected by copyright laws. Be also aware that font files can be very big (e.g. Arial
normal, bold or italic takes about 1MB).

9? The fonts are always all included when using Quick export.

Screen saver
This setting is only relevant to the CD-ROM (with installation) export format.

It allows your end users to install your project as a screen saver on their computer.

Optimize pictures

Checking this option will start the built-in Image Optimizer just before the export to let you optimize your
pictures. If your project contains many pictures, it is advisable to let Mediator optimize them, as pictures are
often much larger than they need to be. Optimizing them reduces the size of your project and maximizes its
performance.

See "Optimizing the pictures" for more information.

Using Copy to Folder

I_. |

=== This export method enables you to regroup in a single folder all the pictures, sounds, videos etc. that you
have used in your project.

» Click the Mediator Button.
» Choose Export | Copy to Folder.

The following dialog appears:
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Copy All Data Files (%]

Output folder:
C:hky documents

A zubfolder named ALLDATA will be created in the output folder.
[f the ALLDATA subfolder already exists, any filez it contains will
be deleted.

All the data files aof thiz Mediatar dacurnent will then be copied ta
the ALLOATA subfolder.

[ OF. H Cancel ]

» Click OK to copy all the files.

All the files you have used in your project (including the md8 project file) are now copied and placed in a folder
called ALLDATA. By default the ALLDATA folder is located in your project folder.

Using myMediator.com

léEl Schools can upload their Mediator Flash projects to www.myMediator.com. This free service from
MatchWare lets teachers and students upload their Flash web sites and share their work with other classes,
schools, teachers, parents, etc.

Each Mediator Class or School license is delivered with 20 myMediator.com accounts. You are free to use one,
two or all 20 without any additional charge. Single School licenses give access to 1 myMediator account.

@ This feature is only available in the Educational version of Mediator.
Several projects have already been uploaded to myMediator. To view any of them please visit:

www.mymediator.com

Why myMediator.com?

One of the most frequently asked questions is: "Where and how can | upload my class projects?"

Not only does MatchWare supply the free web space, but with myMediator.com, uploading and maintaining
your projects is easier than ever.

The main advantage of myMediator.com is that it requires no software other than Mediator and no technical
knowledge about uploading projects. All you need to know is the login name and the password.

@ Only projects made with Mediator for Flash distribution can be uploaded to myMediator.com. Flash export
is performed automatically when you select myMediator.com.

Administrative and User login

All myMediator.com accounts have an Administrative login/password and a User login/password:
e The Administrative login/password can be used to upload projects, delete projects and change passwords.

e The User login/password can only be used to upload projects.

Before an account can be used it must be activated. The first time you try to upload to your free account, you
will be asked to activate the account. Activation requires the Administrative login/password.

Activation is instant, and uploading can be done immediately afterwards.
You can activate an account directly from Mediator or from the following web site:

www.mymediator.com/activate
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http://www.mymediator.com/�
http://www.mymediator.com/activate�

If you try to upload a project to an account that has not yet been activated you will be taken to the Activate page.

ﬁ' Accounts on myMediator.com are free for one full year after activation.

Uploading to myMediator.com

Once you or your students have completed the project, you can upload it as follows after saving it:
» Click the Mediator Button.

» Choose Export | myMediator.com.

The project is automatically exported to Flash and the Logon dialog appears:

= myMediator Upload

Uzer name; Pazsword:

| IIpdate existing project | Upload entire project Close

» Enter the username and password and click Upload entire project to upload all the project files or Update
existing project to only upload changes made since the original upload. The first time you upload a project,
you must select 'Upload entire project'.

? myMediator Upload :”:|E|

ploading: md&logo, png

9kb |52 kb

Cancel

Your project is uploaded to the MatchWare server dedicated to school projects. When upload has been
successfully completed, your browser opens and you are taken to myMediator.com:

. = TUTEESSPT = |
-

myMediator.com % !'

Project Description

*Project Name: |

*Description: Please give a short description of vour project
and how you made it What software and
toals did you use e.q. digital carnera,
scanner ete,

‘ E

H

Author(s): |

Contact Email: |

*Age group: I-- Flease Choose -- =
*Project Language: | Please Choose -- «

*Subject Area: |-- Please Choose -- =~
* these fields mustbe filled in. Reset Continue >

Here you can enter information about yourself, your class, the project, etc.

» When you have filled in the required fields, click Continue to finish the upload.
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Using InstallMaker

This topic describes InstallMaker, the built-in module that lets you create an Install program for your project
when you choose to export it using the 'CD-ROM (with installation)' export format. For information on how to
use this export format, refer to "Exporting to CD-ROM (with installation)".

Once you have chosen the required export settings in the Advanced Export dialog, Mediator starts InstallMaker,
which creates the Install program that your end users will need to run to install your project on their own
computer.

Default settings

Unless you modify the relevant settings, the Install program created by InstallMaker will have the following
characteristics:

e |t will have a standard side bar.

o It will use default messages and text strings. You can however customize these messages and strings and
even create different interfaces for your Install programs. See below "Customizing the Install messages".

e A Starticon and an Uninstall icon will be created in the relevant sub-folder of the Start | Programs menu.

e Once installed, all the labels and icons used by Windows to represent the project on the end user's computer
will use the parameters defined in the Document Properties dialog. See "Document properties" for more
information.

Selecting the Install language

The first InstallMaker dialog allows you to choose the language in which the Install program should appear to
your end users when installing your project.

= InstallMaker §|

Installer Settings
Select installation language:

Enadlish w

Show ELLA page (End User License Agresment)

Installer Appearance

[ ] show cuskam sidebar image in installer

Mexk = ] [ Cancel

Select installation language: Select your preferred language for the Install program messages.

Show EULA page: Check this option if you want a License Agreement to be displayed at the start of the Install
program.

Show custom sidebar image in Installer: Check this option to use your own side bar for the Install program,
which you can enter or select using the Browse button.

> Click Next.
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Selecting the Install folder

The next dialog to appear is the Install Folder dialog.

%]

= |nstallMaker

Default install folder:

| Mediatorl |

Place in Z:\Program Files

Allow user bo change the install Folder

C:\Program FilesiMediatorl

< Back ] I Mext = ] [ Cancel

Default install folder: This field contains the name of the folder where the project will be installed on the end
user's computer.

> (optional) Check Place in C:\Program Files if you want the Install folder to be created in the C:\Program
Files folder of the end user's computer.

» (optional) Check Allow user to change the install folder to enable the user to specify a different Install
folder during the installation.

» Click Next.

Selecting the Install/Uninstall shortcuts

The Shortcut dialog that appears next allows you to specify the shortcuts to create on the end user's computer.
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X

= |nstallMaker

Shorkcuts

Create a shorkout ko the application in the Stark menu
[ ] create a shortcut to the application on the Desktop

Create an Uninstall shorbcuk in khe Skart menu

< Back ] | Mext = | [ Cancel

» Make your selections and click Next.

Creating the Install program
Once you click Create, InstallMaker displays a dialog showing the progression of the building operation.

= InstallMaker E3

When waou click Create, the installation file(s) will be created in the selected
destination folder, This may take a few minutes, depending on the amount of
data involved,

File creation progress. ..

[ )

< Back ] [ cCreate | [ Cancel

> Click Close once the installation files have been created.
You are now in a position to distribute your exported project.

Customizing the Install messages

You will find the various language files holding the default InstallMaker messages and strings in the Mediator
InstallMaker folder (usually .\InstallMaker in the Mediator program folder).

The file English.ini for instance contains all the English default messages used by InstallMaker.
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You can either customize one of these files using Notepad, or create your own file by making a copy of one of
the existing files, editing it and saving it under a different name. This file will then appear in the drop-down list
of the field 'Select installation language' shown in the first InstallMaker dialog.

Using the Upload Manager

To help you get your HTML and Flash projects on the web as quickly and effortlessly as possible, Mediator
comes with a built-in FTP program, the Mediator FTP Upload Manager.

Starting the FTP Upload Manager

Before you can use the FTP Upload Manager you must export your project to HTML or Flash (see "Exporting to
HTML" and "Exporting to Flash" for more information). Upon completion the Publish dialog appears:

Publish x|

[ Fresiem ][L'__a] [ FTF ] [ Open Folder ] | Cloze |

» To open the FTP Upload Manager click FTP.
The FTP Upload Manager dialog appears:

&b Lpload Manager

FTP zerver address:
Uzer name: Paszward:

Destination falder:

| Browse

[ Attempt to reconnect if connection is lost

—

|Ipdate Esisting Project | |lpload Entire Project | Cloze |

» Inthe FTP server address field, enter the FTP upload address that you have received from your Internet
Service Provider (ISP).

» Enter your User name and Password in their respective fields.

9? If you do not have an FTP address, user name or password or have lost them, contact your ISP.

» Clicking the Browse button next to Destination folder will connect you to the Internet. Once online, search
for the remote folder you wish to upload your project to.
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%)

Browse FTP Folders

Select the destination folder for the project and click OF.

&2
&L Austria
&1 Denmark
-1 France
{:I Germarny
&1 Greece
D [taly
D Monway
D Partugal
D Spain
-1 Sweden

M ew Folder | k. | Cancel

»  Select the folder required and click OK to return to the Upload Manager dialog.

If you would like to upload the project to a new folder, click New Folder to create a new remote folder on the
server. Click OK to return to the Upload Manager dialog.

Mew Folder P§|

&, new folder will be created in the zelected folder,
Pleaze enter a name far the new falder:

|I3 reatBritain

Cancel

0 To quickly create a new remote folder enter a forward slash and the name of the new folder in the Destination folder
field.

Deztination folder;

|£E Lrope/lreland Browse

If your Internet connection goes down often, you are advised to check the option 'Attempt to reconnect' in the
Upload Manager dialog to ensure that your upload is successful.

[ istternpt to reconnect if connection is lost

bl aw. number of reconnection attempts for any one file: b

You can also set the number of reconnection attempts you want the Upload Manager to perform for a given file.
If upload is still unsuccessful after this number of attempts, it is cancelled.

Uploading your project

» If you are uploading your project for the first time, click Upload entire project to connect to the FTP server
and upload all the files.

You can follow the progress of the upload in the Upload dialog.
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ab Lpload Manager

Iploading files ta FTF server...
Currently uploading:

Europedlrelanddd_jpa_.swf

Ilpload progress. ..

46.06Kb of 130.56Kb total uploaded.

Cancel | |

If upload is completed successfully, the following dialog appears:

Chd Lipload Manager,

The filez were successfully uploaded.

Jpload progress...

130.56KE of 130.56Kb tatal uploaded.

| Cloze

» Click Close to return to Mediator.

The FTP Upload Manager remembers your FTP address, Username, Password and Destination. If you make
changes to your project and would like to upload it again, click Update existing project to upload only the files

that have changed since your last upload.
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Support

Getting help

The Mediator documentation is provided as online help in the program. It can also be found in PDF format in the
Mediator installation folder.

Service Packs

If you encounter a problem that you are not able to solve by following the steps described in "Testing your
project”, check that you have installed the latest Mediator service pack available. MatchWare releases service
packs regularly to provide enhancements and correct errors reported by its users.

You can find service packs for MatchWare products at:

http://www.matchware.com/en/support/default.ntm

@ A looming deadline is the only reason not to install a service pack immediately. Because a service pack may
introduce changes to existing functionality, you should always test your project thoroughly after its installation.

The FAQ Knowledge Base
For additional information, please refer to our FAQ Knowledge Base:

http://faqg.matchware.com/en/

As well as answering the most commonly asked technical questions concerning the MatchWare products, this
database allows you to post comments and send questions to MatchWare.

MatchWare web site

The MatchWare web site contains extensive information on all the products offered, as well as tutorials,
templates and reviews. Updates are posted regularly. To see what is currently available, please visit:

http://www.matchware.com/en

Reporting a problem

To report a problem, bug or any other error in Mediator, please send a message to MatchWare via our FAQ
Knowledge Base:

http://fag.matchware.com/en/

MatchWare is registered with the Windows® Quality Online Services. In the unfortunate event of an application
failure, the Windows Error Reporting system will capture relevant product data and enable you to forward this
data to MatchWare automatically.
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Reference

Pages
Page properties: General tab
Properties for Page: Pagel x
By
Description Pagel
Colar [ ]255,255,255 A

Bottam master page | .. |
Top master page | .. |

kKeywords
Searchable [w True
IJse in Conkents [w True

Size of pickures (KB) | 125

Description: The Description field allows you to enter a descriptive label for your page in addition to its name.
This field accepts spaces and other characters that are not allowed in the page name.

By default, the description field is identical to the page name.

@ Changing the description does not change the page name.

The page Description field is also what the predefined Contents, Index, Search and History dynamic templates
display in their page lists. For more information on how to use these templates, see "Using the dynamic
templates".

Color: Choosing Page | Page Setup | Color or clicking the color box in this Properties dialog opens the Colors
dialog in which you can set the background color of the page. For more information, see "Choosing a color".

Height: This field only appears if your document is of type HTML. It lets you change the height of individual
pages from the overall default height chosen when creating the document. Note that you can also do this simply
by dragging the bottom of the page downwards to the required size.

Bottom master page - Top master page: The master page fields show the names of the pages currently selected
as top and bottom master pages. If a master page field is empty, it means that there is no master page selected.
To select or change a master page click the Browse button to access the Page list. To remove a master page,
delete the page reference in the Master page field. For more on this feature see "Using master pages".

Keywords: You can enter one or more words to describe the page in this field. You can display these keywords
in list boxes of type 'Index’ or 'Search word', or from the Index and Search dynamic templates. For more
information on how to use these templates, see "Using the dynamic templates". To enter several words, simply
place a semicolon (;) between each word. You can also associate keywords with objects.

5@ When exporting your project to HTML (see "Exporting to HTML"), any keyword attached to the page is
inserted in the Keyword meta-tag on the HTML page.

Searchable: When this field is checked, all the words contained on the page are added to the Text search list
maintained by Mediator. You can access this list with a list box of type 'Search word' or from the Search
dynamic template. Text contained in objects that do not have 'Searchable’ checked is not included in the Text
search list.

Use in Contents: When this field is checked, the page description is added to the Contents list maintained by
Mediator. You can access this list with a list box of type 'Page list' or from the Contents dynamic template. Pages
that do not have 'Use in Contents' checked are not included in the Contents list.
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Size of pictures (KB): Here you can see the combined size in kilo-bytes of all the pictures and animated GIFs
used on the page. This is useful when creating web projects, as it enables you to monitor the overall size of your
page, and therefore the download time. The smaller the overall size is, the faster the page will load.

HTML extension: This field only appears if your document is of type HTML. The default page extension 'html'
is only suitable if the page contains pure html code. If you have used the HTML object to insert server-side
scripting in your project (asp or php), you should change the page extension here accordingly. See "The HTML
object" for more information.

Page Properties: Notes tab

You can use the Notes tab during the design phase to enter comments about the purpose of the page or any other
useful information.
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Objects

Common properties

Object properties: General tab

The General tab is common to all objects in Mediator.

Note however that the properties displayed depend on the object type. Only the properties relevant to a particular
object type are displayed.

Properties for Object: Rectangle »
[ OO0 @ @
Mame Rectangle
X 57
Y 145
Wiidkby 190
Height 1153
Wisible [w True
Lock. [ False
Collision detection | [ False
Keywords
Maouse transparency | | False
Shioww koalkip [ False

Name: This contains the object's default name. Objects that have a file attached to them have the name of the
first file that was placed in that object. In large projects or pages containing many objects, it is a good idea to
give the objects relevant names to make it easier to identify them in the Object list.

X, Y, Width, Height: These fields let you position and resize your objects very accurately, down to one pixel. X
and Y represent the top left corner coordinates of the object. Click these fields and enter new values to reposition
the object. The up and down arrows on the right let you change the coordinates one pixel at a time. The Width
and Height fields are used to resize the object.

See "Moving objects™ and "Resizing objects"” for more information about these operations.

Visible: Use this option to select whether you want the object to be initially visible or hidden. You might want to
hide the object so that you can show it later when a particular event (such as a mouse click) occurs. Objects are
visible by default.

Lock: Checking this option anchors an object to its current position.

Locking an object can be useful to let you access objects placed on top of it or underneath it:

e If you have placed a picture, bump map or other object as background, and would like to select objects
placed on top of it, locking the background lets you drag a rectangle to select the top objects without
accidentally selecting and moving the background.

e Itis not normally possible to select an object placed underneath another object by clicking it on the page.
Locking the top object allows you to access the objects underneath it.

Once an object is locked you cannot select it by clicking it on the page. The only way to select a locked object is
by clicking it in the Object list.

To unlock an object select it in the Object list and uncheck 'Lock'.

@ Locking an object does not affect its behavior at runtime. The only purpose of this property is to facilitate
the design work.

211



Collision detection: When animating the object, this lets you detect if the animated object hits other objects. If
the animated object and the object it hits both have 'Collision detection' enabled, the Collision event is triggered.
You can find the Collision event in the Events list of most objects.

Keywords: You can enter one or more words to describe the object in this field. You can display these keywords
in list boxes of type 'Index’ or 'Search word' or from the Index and Search dynamic pages. For more information
on how to use these pages, see "Using the dynamic templates". To enter several words, simply place a semicolon
(;) between each word. You can also attach keywords to pages.

Searchable: This property only applies to objects containing text. When checked, the text contained in the
object is added to the Text search list maintained by Mediator. You can access this list with a list box of type
‘Search word' or from the Search dynamic template. Note that the 'Searchable’ property of the page must also be
checked for the text to be included.

Mouse transparency: This property applies to most objects. It is False by default, meaning that the object
always reacts to any mouse events that have been set for it (Mouse Click, Move Into, Mouse Down etc.). If you
set it to True, the object will not react to mouse events. If the object covers another object, the mouse events will
therefore go "through™ it as if it was not there, and reach the object underneath. Setting this property to True
improves the performance of Flash projects, as the object no longer needs to be monitored for mouse events.

@ If you set the 'Mouse transparency' property of an object to True and then define a mouse event for that
object, the property is automatically reset to False.

Show tooltip: You can use this property to display a small tooltip about the object when the user places the
mouse pointer on the object. Just set this property to True and enter the tooltip in the Notes tab of the Properties
dialog. See "Object properties: Notes tab". This property is only available for relevant objects. It is not available
in documents of type HTML.

Tab stop: This property only applies to input objects. If you have two input objects, enabling this property
allows you to use the Tab key to go from one input object to the next. If you have more than two input objects
the order of the tab stops is decided by the order of the input objects in the Object list.

Object properties: Visibility tab

The Visibility tab lets you control the appearance of some of the Mediator objects. It lets you rotate objects, set
their opacity level or add an alpha channel to them. The contents of the Visibility tab vary from object to object,
and some objects do not have a Visibility tab.

This is the Visibility tab for a picture:

Properties for Object: Picture =
[ (=] H 0@ @

Opacity Raln]

Rokate ]

Rotate X center (0
Ratate % center 0

Alpha path ]

Opacity: Use this field to set the opacity of the object. An opacity value of 100 means that the object is 100%
visible. A value of 0 means that the object is completely transparent.

@ Do not confuse transparent objects and hidden objects. They are both invisible, but transparent objects
(often used as hotspots) are still able to react to events whereas hidden objects cannot.

Rotate: This field shows you how many degrees an object has been rotated by. You can change the rotation
angle by entering a new value. To unrotate an object enter 0. For more on rotation see "Rotating objects".

Rotate X center and Rotate Y center: You do not have to rotate an object with respect to its center. Changing
these values lets you move the rotation center.

Alpha path: Alpha pictures (alpha channels) are external gray-scale pictures that apply transparency shapes to
the object. To select an alpha channel enter a path or click the Browse button to access the Open dialog. Note
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that instead of applying a separate alpha channel to a picture or a rectangle, you can choose pictures that already
contain embedded alpha channels. For more on alpha channels see "Using alpha channels and bump maps".

Object properties: Shadow tab
The Shadow tab lets you control the shadow effects applied to the object.

Properties for Object: Rectangle o
[ OB80 @ @
Enable shadow [v True
Shadow color | iR A
Shadow ¥ offset 3
Shadow ¥ offsek 3
Shadow opacity 50
Shadowe width 1]
Shadow blur 3

Shadow excl, object shape | [ False

Enable shadow: Check this option to activate the effect.

Shadow color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for more
information.

Shadow X and Y offset: Here you set the displacement of the shadow effect. The default displacement is 3 by 3.
o Positive values displace the effect to the right and down.

e Negative values displace the effect to the left and up.

Shadow opacity: Here you set the opacity level (visibility) of the shadow. The lower the value the more
transparent the shadow. The default value is 50.

Shadow width: The default value is 0 (zero), meaning that the shadow has the same size as the object.

Shadow blur: This value defines the appearance of the shadow edge. The value 0 means it is completely solid.
The higher the value the more blurred the effect.

Shadow excl. object shadow: Check this option to show the shadow around the object, but not the shadow
covered by the object. This is only useful when the object is not fully opaque.

Object properties: Glow tab
The Glow tab lets you control the glow effects applied to the object.

Properties for Object: Rectangle b
B 00 @2
Enable glow [w True
Glaw calor []255,224,0 M
Glow ¥ offset n
Glow ¥ offset n
Glow opacity an
Glow width 1
Glow blur 5

Glow excl, object shape | [ False

Enable glow: Check this option to activate the effect.

Glow color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for more
information.

Glow X and Y offset: Here you set the displacement of the glow effect.
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o Positive values displace the effect to the right and down.
e Negative values displace the effect to the left and up.

Glow opacity: Here you set the opacity level (visibility) of the effect. The lower the value the more transparent
the effect. The default value is 80.

Glow width: The default value is 1 (one), meaning that the glow effect is one pixel larger than the object.

Glow blur: This value defines the appearance of the glow edge. The value 0 means it is completely solid. The
higher the value the more blurred the effect. The default value is 5.

Glow excl. object shape: Check this option to show the glow effect around the object, but not the glow effect
covered by the object. This is only useful when the object is not fully opaque.

Object properties: Notes tab

During the design phase, you can use this tab to enter details about the purpose of the object or any other useful
information for your own reference.

There is no need to delete this information when exporting your project, since it stays invisible to the user at
runtime.

Properties for Object: Button o

..

0 = A EE

This butkan is what the user will dick ko go ba the
validation page once all the questions have been
answered,

You can also use this tab to display a small tooltip about the object after a short delay when the user places the
mouse pointer on the object. Just enter the tooltip here, and check the 'Show tooltip' property of the object in the
General tab. See "Object properties: General tab". Note that this property is only available for relevant objects. It
is not available in documents of type HTML.

Picture objects

If you export your project to HTML, any text that you enter in this tab is inserted in the Alt meta-tag for the
picture in the .html file.

This text will therefore appear on the HTML page as a tooltip when the user moves the mouse pointer on the
picture.
Object properties: graphic properties

All graphic objects have the following two settings in the relevant tab (e.g. Picture, Bump Map, etc.) of their
Properties dialog.

Load on show

If 'Load on show' is checked, the object file is only loaded in memory when it is used. If it is not checked, the file
is loaded in memory as soon as the page is displayed. Checking 'Load on show' has both advantages and
disadvantages:

Advantage: If you have many large objects on a page, displaying that page can take some time since all the
graphics objects (pictures and videos) must first be opened. You can speed up the page turn by checking 'Load
on show' for all invisible objects.

Disadvantage: An object that has 'Load on show' checked takes a little longer to show as the file must first be
opened from the disk or CD-ROM. The length of the delay depends on the speed of the computer.

Discardable

If 'Discardable’ is checked, Mediator removes the file from memory as soon as it becomes invisible (e.g. via a
Hide action).
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Advantage: Memory is freed up.

Disadvantage: The file must be opened every time it is shown.

The Picture object

H Mediator lets you insert all kinds of different pictures on your pages.
» Toinsert a picture, choose Insert | Illustrations | Picture and drag out a rectangular frame on your page.
Once you have created the picture frame, the Open dialog appears.

> Select the picture you want to place in the picture object. Checking Preview in the right-hand side of the
dialog lets you see a preview of the selected picture file.

» Click Open to accept the selected file.

QI At the bottom of the Open dialog you will see a field containing the most recent paths you have used. Simply click the
path to the folder you wish to select your picture file from.

Picture size

Once you have selected the picture the Picture Adjust Size dialog appears. This dialog lets you automatically
adjust the size of the picture frame to fit the picture. You have two choices:

e Click OK to resize the picture frame.

@ If the picture is more than twice as high or twice as wide as the page, the Adjust Size function resizes
the picture frame to a maximum size of twice the page size. To view a picture larger than this area within the
picture frame, you need to use the scroll option.

e To keep the size of the frame as it is, uncheck 'Adjust the frame size' and click OK.
Picture Adjust Size §|

Adjust the frame zize ta fit the picture

(%) Always show this dislog
{3 Do not show this dialog again - always adjust the frame size

{3 Do not show this dialog again - never adjust the frame size

reactivate the dizplay of thiz dialog later in the Preferences panel of

l@ If you chooze one of the bwo 'Da not show...' options, you can
the Mediatar Optionz dialog.

[]Uze az background picture

The three radio buttons let you define the default behavior for future picture imports. You can set Mediator to:

o display this dialog every time you import a picture,
o never display this dialog and always import the pictures in their original size,

o never display this dialog and always scale the pictures to fit the frames you created.

Use as background picture: Check this option to automatically adjust the picture size to the project size.
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You can resize the picture manually later by pulling one of its handles. Use the corner handles to keep the aspect
ratio.

@ Digital camera pictures and scanned pictures usually have a much higher resolution than what Mediator
needs. To reduce the overall size of your Mediator project, you can use Mediator's built-in Image Optimizer to
compress them, in automatic or manual mode. See "Optimizing the pictures"” for more information.

If you want to scale the pictures yourself with an image processor, you should give them the same size as the
picture object. A picture displayed in its original size always gives the best quality..

Picture properties
Once the picture is inserted on the page, its Format tab opens at the right of the ribbon.

3 = = Fg EH | =
*f* X 191 s oil4 - JJ —Jl JJ i |¢.J

18 J & A b o | A z L
Ad_just Y a3 . ‘E.J a4 - E m w w m ml _ FEffects  BringTo Send  Bring Send Align
Size 5 — — : > Front  To Back Forward Backward
Position & Size Skyle Arrange

The Format tab contains the most common operations that can be performed on pictures:

You can restore the picture to its original size by choosing Adjust Size.

You can then resize it proportionally if necessary by pulling its corner handles.

e You can use the fields of the Position & Size group to change the position and size of the picture object. See
"Moving objects" and "Resizing objects" for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your picture as you
go. Once you have found an effect you like, just click it to apply it to the picture.

e You can use the Effects command to change the visual aspect of the picture. See "Applying styles" for more
information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to
pictures. Refer to the topic "Common properties"” for a description of the properties that are common to all
objects. To learn more about the particular properties of the Picture object, refer to the next topics.

Picture description

If you intend to export to HTML and would like a small tooltip to appear when the user moves the mouse pointer
over a picture on the HTML page, you can enter this description in the Notes tab of the Properties dialog of the
picture.

Mediator will then insert this text in the Alt meta-tag for the picture in the .html file during the export procedure.

Picture properties: Picture tab
A click on the Picture tab displays the following dialog.

Properties for Object: France o
[ (=] 0@ 3
Path .. |y documents\France., gif
Tile [ False

Antialiasing  |[ False
Load on show | [w True
Discardable | [w True
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Path: This field shows the path you selected when you created the picture object. To change the path (or picture)
click the Browse button _--| to display the Open dialog. You can also just double-click the picture frame to access
the Open dialog.

Tile: If you check this option, instead of being scaled, the picture will be repeated in the picture object as many
times as necessary to fill it completely. If the picture is larger than the picture object, parts of the picture will be
cropped. This property lets you use a very small picture to create a background for the entire page (e.g. bricks,
boards, etc.).

Antialiasing: This option only affects the scaling of pictures. Although antialiasing is turned off by default,
scaled pictures often look better with antialiasing - you can test the effect by simply clicking it on and off in
design mode. Antialiasing takes up more memory than traditional scaling.

Refer to the topic "Common properties” for a description of the Load on show and Discardable options.

Picture properties: Color tab
A click on the Color tab displays the following dialog.

Properties for Object: France 4
[ = 0@
Enable transparent color | [ False
Transparent color [ ]z55,255,255
scroll bar color 128,128,240

Scroll bar frame color | J0.0,0
Scroll bar button calar ([ ]192,192,192

P e

The transparent color options allow you to select a color within the picture that should become transparent.
Enable transparent color: Check this option to enable the effect.

Transparent color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for
more information.

Examples

e |f you have a picture with a solid color around it, you can remove the solid color by selecting it as transparent
color.

e When working with objects like 3D logos that have a solid background color, using a transparent color
creates the illusion of a flying logo.

@ You can only select one color as your transparent color. When using a transparent color the picture uses
twice as much memory as the same picture without a transparent color.

Scroll bar color: Only relevant if 'Enable scroll bar' is checked in the Picture Scroll tab. This sets the color of
the scroll bar.

Scroll bar frame color: Use this field to choose a color for the scroll bar frame.

Scroll bar button color: Use this field to choose a color for the scroll bar elevator and arrow buttons.

Picture properties: Scroll tab

Mediator supports the use of scrollable pictures. This means that you can use pictures that are larger than the
picture object, even larger than the page, and let the end user scroll the picture. You can use 360° panoramic
pictures with the wrap-around feature to give the user the illusion of being in the middle of the picture.

A click on the Scroll tab displays the following dialog.
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Properties for Object: France =
[ (=] 0 @ @

Enable scroll bar | | False

Auto scrall | False

Drrag scrall | False

Scroll bar size |15
Wrap around | False

Enable scroll bar: Check this option to add scroll bars to your picture. If the picture is taller than the frame, a
vertical scroll bar will be added; if it is wider than the frame, a horizontal scroll bar will be added.

This field must be checked in order to access areas of the picture that fall outside the frame.

You can set the area of the picture that you want to be visible when the picture appears. Simply use the scroll
bars to define the area while in design mode. When you save the project, Mediator also saves the information
about which area of any given scrollable picture you want visible. If you do not want to show the scroll bars in
runtime mode simply remove the checkmark from 'Enable scroll bar' after you have set the visible area.

Auto scroll: Scrolls the picture automatically when the mouse pointer gets close to the picture frame. If the user
moves the mouse pointer to the left of the picture frame the picture is scrolled from left to right, and vice-versa.
The closer the mouse pointer gets to the frame the faster the picture is scrolled. This option can only be selected
with 'Drag scroll' enabled (Mediator switches drag scroll on automatically), and is not compatible with scroll
bars.

Drag scroll: Check this option to enable the user to drag and scroll the picture in any direction within the picture
frame. This option can be selected on its own or with any other scroll option.

Scroll bar size: Use this field to set the size of the scroll bar when 'Enable scroll bar' is checked.

Wrap around: When this option is checked, picture scroll does not stop when the right or left edge of the
picture is reached, but continues seamlessly all the way around. This is especially useful when working with
360° panoramic pictures, as you can achieve a true panorama effect whereby the user has the illusion of standing
in the middle of a room or outdoor area and looking around. This option is not compatible with the use of scroll
bars.

@ You can add hotspots and hotspot objects to a scrollable picture and scroll the hotspots with the picture. You
cannot, however, use transparency effects, transparent colors or alpha channels with picture scroll.

Possible uses of picture scroll

e Interactive city or country maps. You can place hidden pictures on the maps and show them using hotspots.
The user has to click a certain area or building to get specific information about it.

e 360° panoramic pictures. Create games, mazes or interactive holiday slideshows, where the user must make
certain decisions in order to move on.

e Interactive "tours" of houses, buildings, etc. using several 360° panoramic pictures linked with hotspots.

The Hotspot object

A hotspot is an area within a picture that can react to events. With hotspots you can create several interactive
areas within the same picture. You can even use other objects (video, text, etc.) as hotspots.

When you right-click a picture, you will find two items in the picture's local menu called Add Hotspot and Add
Hotspot Object.

218



B | Everts...
| Rename...

Edit 3

Arrange b
v | show Object F3

adjust Size

Add Hotspok

Add Hotspok Object

Lj Properties Flz

Add Hotspot

Selecting Add Hotspot creates a transparent polygon object. For more information about polygons, refer to "The
Polygon object”. You can move and resize the polygon as you wish and manipulate it further simply by double-
clicking it. The polygon object is not hidden, but simply transparent and therefore still able to react to events.
You can apply events and actions to the hotspot as for any object.

The hotspot (i.e. the polygon) is created as a secondary object of the picture.

» Toview it in the Object list, click the + sign in front of the picture to which it belongs.

#- || Pictwre = || Picture
i:- Palygon03

i.__,"‘- Palygon0z2
i:- Palygonl

@ Hotspots are not supported in projects exported to HTML or Flash. You can however place a transparent
rectangle over the object to obtain the same effect.

Add Hotspot Object

As mentioned above, Mediator allows you to add any object as a hotspot in a picture. To define another picture,
a video, a button or a text object as a hotspot you must first create this picture, video, button or text object. You
then choose Add Hotspot Object from the local menu of the picture to which you want to add the hotspot. This

displays the Object list where you can select the required hotspot object.

A hotspot object is considered as a secondary object of the picture it belongs to.
» Toview it in the Object list, click the + sign in front of the picture to which it belongs.
- || Picture = |2 Picture
[A5] Text
e AniGif

G2 Video

Adding an object as a hotspot, instead of merely creating transparent hotspots, gives you many new options, such
as moving a picture or text along with a picture that is being scrolled.

The Rectangle object

Mediator lets you create rectangles of any size, shape and color.

> To insert a rectangle on your page, choose Insert | lllustrations | Rectangle and drag out a frame of the
required size.
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Rectangle properties

Once the rectangle is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on rectangles:

e You can use the fields of the Position & Size group to change the position and size of the rectangle. See
"Moving objects" and "Resizing objects" for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your rectangle as you
go. Once you have found an effect you like, just click it to apply it to the rectangle.

e You can use the Fill, Outline and Effects commands to change the visual aspect of the rectangle. See
"Applying styles" for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
rectangles. Refer to the topic "Common properties™ for a description of the properties that are common to all
objects. To learn more about the particular properties of the Rectangle object, refer to the next topic.

Rectangle properties: Rectangle tab
A click on the Rectangle tab displays the following dialog.

Properties for Object: Rectangle b
O« oBfe@
Fill bype _= |Gradient
Fill colar []255,234,218 M
Fill calar 2 []255,191,145 M

Fill gradient type | _= |Linear
Fill gradient angle |0

Fill gradient center ¥ 50

Fill gradient center ¥ |50

Fill texture options | = |Scale
Fill texture path e

Cutline color [2z7,108,9 M
Cutline weight 1

Outline style _= |5olid Line

Antialiasing [ False

Fill type: This property allows you to change the fill (i.e. interior) of your rectangle. You can choose between:
e No Fill: This will make your rectangle transparent. It is only useful if you only want to create a simple
outline or an invisible area.
o Solid: This option lets you choose a solid color for your rectangle.
e Gradient: This lets you create a color transition of different types.
e Texture: This lets you apply a texture to your rectangle.

Fill color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for more
information.

The next properties only apply if you have selected a gradient fill type.

Fill color 2: Use this field to choose the second color for the color transition.
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Fill gradient type: This lets you choose between different gradient types which you can experiment with.

Fill gradient angle: This only applies to linear gradients. It indicates the direction of the color transition. A
value of 0 for instance means that the gradient is vertical, a value of 90 means that it is horizontal.

The next two properties define the coordinates of the gradient center. For radial and rectangular gradients, the
gradient center is the point where the second color of the gradient is the strongest.

Fill gradient center X: This specifies the X coordinate of the gradient center.
Fill gradient center Y: This specifies the Y coordinate of the gradient center.
Fill texture options: The next properties only apply if you have chosen a texture fill type.

e Scale: This scales the texture picture to fit the object size.

o Tile: Here the texture picture is used in its original size. If necessary, it is tiled to match the object size.
o Tile Flip X: Displays every second tile mirrored in the X direction. This prevents vertical hard edges.

e Tile Flip Y: Displays every second tile mirrored in the Y direction. This prevents horizontal hard edges.

e Tile Flip XY: Displays every second tile mirrored in the X/Y direction. This prevents hard edges in
both directions.

Fill texture path: This specifies the path of the picture used as texture.
The bottom of the tab contains the outline settings.

Outline color: Use this field to choose the outline color.

Outline weight: Use this field to define the width of the outline.
Outline style: Choose between the different styles available.

Antialiasing: Antialiasing smoothes the outline of your rectangle. Check this option to apply antialiasing to the
rectangle. Note that the effect is only visible when the rectangle is rotated.

The Polygon object

' Mediator lets you create polygons as well as curves, lines, circles, arrows and so on.
The procedure to follow to insert a polygon is not the same as for other objects:
» Choose Insert | Illustrations | Polygon.

You have two choices:

¢ Clicking the arrow in the lower part of the icon lets you browse and choose from a gallery of predefined
polygons.

|Polegon| Drawing  Bump
= Map

Basic ki

r

Rectangles » | *

Stars 4
Arros 4
Callouts k
Lines L4

Once you have found a shape you like, click it, then drag a frame for your polygon on the page.

o Clicking the upper part of the icon lets you create your own shape.
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A special Edit tab appears at the right of the ribbon. You are now in polygon editing mode.

e — | HHER = 2 -
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The Add Point icon, activated by default, lets you create your polygon by placing points on the page.

» To place a point, simply move the mouse pointer where you would like the point and click the left mouse
button.

A white point with a red rim appears.
o
» Click somewhere else on the page to place the next point.

The first point changes to gray and the new point now has the red rim to show that it is activated. A blue line
connects the two points. This is all you have to do to create a straight line or an arrow.

L2

(optional) Continue to place points on the page as required.
If necessary, click Undo in the Quick Access Toolbar to undo the last change(s) made.

(optional) To connect the end points (thereby creating a polygon) click the very first point you made.
Mediator asks you whether you want to connect the end points. Confirm by clicking Yes.

It is only when you place the final point that you determine whether you will obtain a line, a polygon, or a
curved object. If you leave polygon editing mode without connecting the end points, you create a line.

» When you have finished, click Editing | Close or choose Close in the local menu to exit editing mode.

@ Once you are out of editing mode, clicking Undo will undo all the changes made in the polygon object
since entering editing mode.

» To edit the polygon later double-click it to re-enter editing mode.

The tools you use for polygon editing are described below.
> To see what a particular icon does, place the mouse pointer over it until you see its descriptive label appear.

The icons in the Point group let you place the points making up your polygon.

| e .
i += R |
Select | Add  Delete arid

Paink

e
W The Select icon lets you select an existing point (which changes from gray to white with a red rim). You
can then move it by dragging it.

You can select several points in the following ways:
e Hold down the Ctrl key while clicking each point you want to select.

e Hold down the Shift key while clicking any two points. All points placed between the two points will be
selected.
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e Press Ctrl + A to select all the points.

e Hold down the left mouse button and drag a rectangle out on the page. All points within the rectangle will be
selected.
- Click Add to add a new point. Be aware that it will be added after the selected point (the white point with
ared rim).

To place a point between two existing points, select both points, click Add and click where you would like to
place the new point.

To delete a point, select it and click the Delete icon.

l—l The Grid icon lets you activate the grid. See "Using the grid" for more information.

The next group of icons let you create curves rather than straight lines.

& ¢~ f-

Break To Symmebric To
Eezier Bezier

CUrye

/?\\_.

" The Break icon is only available if you have already closed the polygon. To open it, select a point and
click this icon. Mediator opens the polygon at the selected point, thereby converting it to a line, and adds a new
point. This is how you change polygons to lines or arrows.

ff“ The To Symmetric Bezier icon is only enabled when at least one point is selected. It lets you convert the
sharp angles between the lines to curves. If only one point is selected the effect of the command will be as
follows:

D
P

The yellow line now visible at the selected point is called a tangent. Stretch or move the green dot at either end
of the tangent to change the curve. If you stretch one of the green dots, the curve flattens at the selected point and
is moved further away. If you move the dot, the tangent turns and the curve becomes sharper on one side of the
selected point and more rounded on the other.

In contrast to the To Bezier command described below, the To Symmetric Bezier command lets you change the
curve on both sides of the selected point simultaneously. This gives you a complete curve without any angles. As
you can see the adjacent points also receive a tangent. These, however, are only half-tangents and therefore only
work in one direction.

{J\L_’ The To Bezier command is very similar to the To Symmetric Bezier command. The difference is that it
lets you change each side of the curve independently. This gives you the opportunity to create all sorts of shapes
(with curves, sharp angles, corners etc.). If only one point is selected the To Bezier command will have an effect
similar to the following:
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By contrast with what happened with the To Symmetric Bezier command, here the shape of the polygon remains
unchanged, and the tangents are placed on top of the polygon lines, as shown above. To create curves, pull or
turn the tangents as we described for the To Symmetric Bezier command. Experimenting with both commands
will help you understand the difference between their mode of operation.

}l\ The To Line icon lets you remove the curves you create. Select a point (or more) on the curve and click
this icon to return all the adjacent curves to the original straight lines.

Finally you can position a point accurately after having selected it by typing its coordinates in the X, Y fields.

X

Polygon properties

Click Close to accept all changes and exit polygon editing mode.

Once the polygon is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on polygons:

e You can use the fields of the Position & Size group to change the position and size of the polygon object.
See "Moving objects" and "Resizing objects" for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your polygon as you
go. Once you have found an effect you like, just click it to apply it to the polygon.

e You can use the Fill, Outline and Effects commands to change the visual aspect of the polygon. See
"Applying styles" for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects” and "Aligning objects” for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
polygons. Refer to the topic "Common properties™ for a description of the properties that are common to all
objects. To learn more about the particular properties of the Polygon object, refer to the next topic.

Polygon properties: Polygon tab
A click on the Polygon tab displays the following dialog.
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Properties for Object: Polygon =

B« GO @@

Fill bype = |5olid

Fill color 0, 153,204 A
Fill color 2 oo |
Fill gradient tvpe | _= |Linsar

Fill gradient angle |0

Fill gradient center ¥ |50

Fill gradient center ¥ |50

Fill texture options | = |Scale

Fill texture path ]

Cutline colaor | [N |
Cutline weight 1

Cutline style _= |5olid Line

Arrow skyle = |Line

Arrow size 10

Skart arrow [~ False

End arrow [~ False

Stark 0

End 100

antialiasing [w True

Fill type: This property allows you to change the fill (i.e. interior) of your polygon. It is only relevant when
working with closed polygons, not lines or arrows. You can choose between:

e No Fill: This will make your polygon transparent. It is only useful if you only want to create a simple
outline or an invisible area.

o Solid: This option lets you choose a solid color for your polygon.
e Gradient: This lets you create a color transition of different types.
e Texture: This lets you apply a texture to your polygon.

Fill color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for more
information.

The next properties only apply if you have selected a gradient fill type.
Fill color 2: Use this field to choose the second color for the color transition.
Fill gradient type: This lets you choose between different gradient types which you can experiment with.

Fill gradient angle: This only applies to linear gradients. It indicates the direction of the color transition. A
value of 0 for instance means that the gradient is vertical, a value of 90 means that it is horizontal.

The next two properties define the coordinates of the gradient center. For radial and rectangular gradients, the
gradient center is the point where the second color of the gradient is the strongest.

Fill gradient center X: This specifies the X coordinate of the gradient center.
Fill gradient center Y: This specifies the Y coordinate of the gradient center.
Fill texture options: The next properties only apply if you have chosen a texture fill type.

e Scale: This scales the texture picture to fit the object size.

o Tile: Here the texture picture is used in its original size. If necessary, it is tiled to match the object size.
o Tile Flip X: Displays every second tile mirrored in the X direction. This prevents vertical hard edges.

e Tile Flip Y: Displays every second tile mirrored in the Y direction. This prevents horizontal hard edges.

o Tile Flip XY: Displays every second tile mirrored in the X/Y direction. This prevents hard edges in
both directions.

Fill texture path: This specifies the path of the picture used as texture.
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The bottom of the tab contains the outline settings.
Outline color: Use this field to choose the outline color.
Outline weight: Use this field to define the width of the outline.

Outline style: Choose between the different styles available. To make the polygon border invisible, choose No
Outline. This can be very useful if you want to use your polygon as a hotspot (an invisible area that behaves
exactly like any other object).

Arrow style: The arrow options are only enabled when working with lines (unclosed polygons). The style option
lets you choose the kind of arrowhead you would like.

Arrow size: Use this field to set the arrow size.

Start arrow and End arrow: These fields are used to determine at which end you would like the arrowhead.
You can select both ends if necessary. Simply click the check boxes to turn them on or off and the line is updated
immediately.

The next two fields, Start and End, let you "grow" or "shrink™ a line or a curve dynamically by showing only
segments of the line or curve at any one time.

Start: This field determines the point in the polygon's outline from which this outline starts becoming visible.
The value of this field is expressed as a percentage of the overall length of the outline. Its default value is O,
meaning that the outline will be visible from its real start.

End: This field determines the point in the polygon's outline at which this outline stops becoming visible. The
value of this field is expressed as a percentage of the overall length of the outline. Its default value is 100,
meaning that the outline will be visible from its start point to its real end. Using two Set Property actions, you
can for instance increase first the End value, then the Start value of a thick curve every time the user clicks a
button, thereby creating the illusion of a worm creeping along the curve.

Antialiasing: Antialiasing smoothes the lines of your polygon. Check this option to apply antialiasing to the
polygon object.

The Drawing object

LZ The Drawing tool is a very powerful built-in module which allows you to draw all kinds of different
shapes, using advanced editing functions.

Although you can export your drawings from the Drawing tool in a variety of file formats, they are created as
vector graphic objects. By contrast with bitmap graphics (such as JPG files), which represent images as a
collection of pixels arranged in a grid, vector graphics (such as EMF or WMF files) describe images by
considering the geometrical shapes, lines and curves that make them up. This technique makes it possible to
scale vector images to any size without losing detail. Vector graphics are particularly interesting for Flash
projects in view of their comparatively small size.

For a full description of the many features of the Drawing tool, refer to the section "Using the Drawing tool" in
the chapter "Designing your project”.

Drawing object properties

Once the drawing is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on drawings:

e You can use the fields of the Position & Size group to change the position and size of the drawing object.
See "Moving objects" and "Resizing objects" for more information.
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e You can use the Effects command to apply specific shadow and glow effects or set the opacity level of your
drawing. See "Applying styles" for more information.

e You can change the placement order of the drawing object or align it differently using the commands of the
Arrange group. See "Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to
drawings. Refer to the topic "Common properties™ for a description of the properties that are common to all
objects. To learn more about the particular properties of the Drawing object, refer to the next topic.

Drawing properties: Drawing tab
A click on the Drawing tab displays the following dialog.

Properties for Object: Drawing o
[ 210 @ @

Path _. iy documentstdrawing, wdpr

Path: This field shows you the path to the drawing you created with the Drawing tool. To change the path (or
drawing) click the Browse button - | to display the Open dialog or enter a new path.

The Bump Map object (3D surface)

L'—] Bump Map objects let you give a 3D look to your existing objects. Refer to the topic "Using alpha
channels and bump maps" for a detailed description of the effects that can be achieved with bump maps.

» To insert a bump map on your page, choose Insert | lllustrations | Bump Map.
You have two choices:

o Clicking the upper part of the icon lets you select a bump map file from your hard disk.
e Clicking the arrow in the lower part of the icon lets you browse and choose from a gallery of predefined

bump maps.
= A
= [2s) Al
[Bump || Text Headline
Map -
Basic Frames 4

-

Rectangular Frames
Found Edges ¥
Arrows 3
Makural Textures »

Artificial Texkures r

» Drag out a rectangular frame for the bump map, exactly as for an ordinary picture object.

@ You can only use gray-scaled (8 bit) pictures as bump maps.

Bump Map properties
Once the bump map is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on bump maps:

e You can restore the bump map to its original size by choosing Adjust Size.

You can then resize it proportionally if necessary by pulling its corner handles.

e You can use the fields of the Position & Size group to change the position and size of the bump map object.
See "Moving objects" and "Resizing objects" for more information.

e You can use the Effects command to change the opacity level of the bump map. See "Applying styles" for
more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
bump maps. Refer to the topic "Common properties" for a description of the properties that are common to all
objects. To learn more about the particular properties of the Bump Map object, refer to the next topic.

Bump Map properties: Bump Map tab
A click on the Bump Map tab displays the following dialog.

Properties for Object: arrowl _left »
B
Path ... |Ci\Program Files. . \arrowl-left.jpg
Opacity o0
Til= [~ False
Load on show [ True
Discardable [ True

Mon scale left n
Mon scale top n
Mon scale right |0
Mon scale bokbom |0

Path: This field shows you the path to the gray-scaled picture you selected when you created the bump map
object. To change the path (or picture) click the Browse button _..| to display the Open dialog.

Opacity: Use this field to set the opacity of the bump map. An opacity value of 100 means that the object is
100% visible. A value of 0 means that the object is completely transparent.

@ Do not confuse transparent objects and hidden objects. They are both invisible, but transparent objects
(often used as hotspots) are still able to react to events whereas hidden objects cannot.

Tile: If you check this option, instead of being scaled, the bump map will be repeated in the frame as many times
as necessary to fill it completely. If the bump map is larger than the frame, parts of the bump map will be
cropped. This lets you use a very small bump map picture to create a 3D surface for the entire page.

Refer to the topic "Common properties” for a description of the Load on show and Discardable options.
Non scale left: Specifies the number of pixels from the left edge of the bump map that should not be scaled.
Non scale top: Specifies the number of pixels from the top edge of the bump map that should not be scaled.

Non scale right: Specifies the number of pixels from the right edge of the bump map that should not be scaled.
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Non scale bottom: Specifies the number of pixels from the bottom edge of the bump map that should not be
scaled.

The Text object

|A
J The Text object lets you write and format text, create bullet and numbered lists, insert tables, define
hyperlinks and perform many other operations on your text.

> To create a text object, choose Insert | Text | Text and drag out a rectangular frame of the required size on
your page.

As soon as you let go of the mouse button, a special Edit tab appears at the right of the ribbon.

"= P = 7 e 1 B ] 4 shading - 1 || ABG
i Azl - 18 - | AR || (= == | B | . |__ﬁ | \_bd = EI X
= Copy Iﬂ i+ Borders
Paste B I U abe x, |- A - == Table | Delete | Insert Insert Insert Insert = Split Speling Close
L - - Above  Below  Left  Right = Cell -
Clipbaard Fant Paragraph Tahle T& || Proofing || Editing

> You can now type text, paste text from the clipboard or import text from an RTF or TXT (ASCII) file using
the local menu.

If necessary, click Undo in the Quick Access Toolbar to undo the last change(s) made.
Once you have finished editing your text, click Editing | Close, press Esc or simply click outside the text
field.
@ Once you are out of text editing mode, clicking Undo will undo all the changes made in the text object
since entering text editing mode.

» To edit the text later double-click the text object to re-enter text editing mode.

Q If the text object is transparent (i.e. without a background color), the background color used during editing is the

background color of the page. If the color of your text is the same as the color of the page background, this may not be
convenient. You have two options to solve this:

e Press Shift while double-clicking the object to edit it on a white background.

o Press Ctrl while double-clicking the object to edit it using the background color last defined for the text object.

Text editing in Mediator works in the same way as with most word processors and you will recognize many of
the commands below. Some of these commands are also included in the mini toolbar that appears when you
select text with the mouse.

» To see what a particular icon does, place the mouse pointer over it until you see its descriptive label appear.

Q To select the entire contents of your text object, press Ctrl + A.

Arial -1z - . . .
i These fields let you view and change the font and font size of the currently

selected text.

- -*

A These icons let you increase and decrease the font size from their current values. If a piece of text is
selected, the size of each character is increased (or decreased) individually from its current value.

B 7 U abk x. X . . . .
These icons help you set and remove formatting attributes in the usual way. You

can set the selected characters as superscript or subscript by clicking the relevant icon.
abs . A

= "/ The first of these icons let you change the color of the background of the selected text so that it
looks highlighted. The second icon lets you change the color of the text itself.
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- —_ 1—
= 7 5= " Use these icons to create bulleted lists or numbered lists. Place the pointer in the relevant
paragraph or at the beginning of a new line and click the appropriate icon. Clicking the arrow next to the icon
lets you choose between different bullet styles and numbering formats. Clicking the icon again removes the

formatting.

[
RIkaN
"

Use these icons to increase or decrease the indent level of the selected paragraph.

These icons let you align the current paragraph within the text object. You can align it to the
left margin, center it, align it to the right margin or justify it so that it is aligned with both left and right margins.

| Clicking this icon displays all the special marks and symbols within your text object, such as line feeds
and spaces. Click it again to hide these symbols.

K Click this icon to insert a picture in the text object.
e Click this icon to convert the selected text to a hypertext object. To learn more about hypertext objects,

refer to the "The Hypertext object” topic. Clicking the Hyperlink icon again will remove the hyperlink and revert
the text to normal.

The next group of icons relates to tables.

—— | ﬂ| :_'?j:,‘ ﬁ ﬂg_l \—% 11"? Shading ~ . E
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e To insert a table in your text object, click the Table icon and choose the initial number of rows and columns
required. The table is inserted at the cursor position. To change the height of table rows, or the width of table
columns, drag the row or column dividers. You can add and remove rows and columns later using the Insert
commands.

e To delete the entire table, click the upper part of the Delete icon.

e To delete the selected cell(s), row(s) or column(s), click the arrow in the lower part of the Delete icon and
choose the relevant command.

e Toinsertarow or column, place the cursor at the point of insertion, and choose the relevant Insert
command.

e To change the interior color of the selected cell(s), choose Shading and select your preferred color.

e To add and remove borders or change the border color, choose Borders.

You can also change the interior and border colors of the cells by clicking the diagonal arrow in the bottom
right of the Table group to open the Table Borders and Shading dialog.
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Table Borders and Shading
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You can assign a background color to all the cells in the table or to the selected cells only. You can also
assign a border width and color to the left, right, top or bottom edges of the entire table or to each of the
selected cells. To keep the current border width, just leave the Width field empty. Similarly, to keep the
current colors, leave the Color field(s) unchanged (diagonal line on a white background).

e To merge cells, select them and choose Merge Cells.

e Tosplitacell into two, select it and choose Split Cell.

Finally to check the spelling of the text contained in your text object, choose Spelling. Clicking the lower
part of the icon will enable you to choose a different language and set the spelling options. See "Using the
spellchecker" for more information about this feature.

X

Text properties

Click Close to accept all changes and exit text editing mode.

Once the text object is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on text objects:

e You can use the fields of the Position & Size group to change the position and size of the text object. See
"Moving objects" and "Resizing objects"” for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your text object as
you go. Once you have found an effect you like, just click it to apply it to the text object.

e You can use the Background, Frame and Effects commands to change the visual aspect of the text object.
See "Applying styles"” for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.
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In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
text objects. Refer to the topic "Common properties” for a description of the properties that are common to all
objects. To learn more about the particular properties of the Text object, refer to the next topics.

Text properties: Text tab
A click on the Text tab displays the following dialog.

Properties for Object: Text =
[ = O @ B

Margin 0

Enable scroll bar | [ False
14

Text aignment | = |Tap

Auto adjust height | [~ False

Flash device fonts: This property is only available if your document is of type Flash. See the topic "Creating a
document"” for more information on the different document types. When this property is set to True, only the
Flash system fonts Arial, Times New Roman and Courier New will be available for the text object when
exported to Flash. You should therefore replace any other font you are using with one of these fonts.

You should use device fonts:

e When using small font sizes that may look blurred (due to antialiasing)

e To reduce the size of the exported files (since there is no need to embed the fonts)
Limitations of Flash device fonts:

e They scale in increments at runtime. The effect is therefore jerky rather than smooth.
e They do not support partial opacity.

e They may not look as smooth as embedded fonts at larger font sizes.

Margin: This indicates the spacing between the frame of the text object and the text itself. The margin is set in
pixels.

Enable scroll bar: Check this option to add a scroll bar on the right of your text object.

Scroll bar size: This option is only available if you have checked 'Enable scroll bar'. Use it to set the width of
the scroll bar.

See "Text properties: Color tab" for a description of additional design options for your scroll bar.
Text alignment: Click this field to choose a vertical alignment option for the text within the text object.

Auto adjust height: Click this field to adjust the height of the frame to the height of the text.

Text properties: Color tab

This dialog allows you to change the color settings of the text object. Note that these properties relate to the color
of the text object itself, not to the color of the text contained within the text object. You can define the color of
the text when you work in text editing mode. Refer to "The Text object™ for a description of the text editor.

232



Properties for Object: Text =

B EED @ 2

Transparent v True

Background colar [ 255,255,255 A
Frame colar | [ |
Scroll bar button colar |[0] 192,192,192 |
scroll bar color 128,128,255 |

Transparent: This option is checked by default, which means that the text object does not have a background
color and that you therefore only see the actual text. Remove the checkmark to see the selected background
color.

Background color: Use this field to change the background color of the text object. Click the color box on the
left of the field or use the Pipette. See "Choosing a color" for more information.

Frame color: Use this field to choose a color for the frame of the text object. The frame is not visible if the
option "Transparent' is checked.

The next two options relate to the text object's scroll bar. They are only available if the 'Enable scroll bar' option
of the Text tab is checked.

Scroll bar button color: Use this field to choose a color for the elevator button and the two arrow buttons of the
scroll bar.

Scroll bar color: Use this field to choose a color for the scroll bar itself.

The Hypertext object

Q

‘== A hypertext object is a word or phrase in a text object that has the same interaction capabilities as any
other object.

This means that text defined as hypertext can react to events such as Mouse Click, Move Into, Right Down and
so on and can therefore be used to trigger an action.

It can for instance show another descriptive label, a picture, go to a different page, start a video etc. It is possible
to apply exactly the same functionality to a hypertext object as to a button.

Hypertext objects can only be created in text editing mode. When you define a hypertext object within a text
object, it becomes a sub-object of the text object. In order to view a hypertext object in the Object list, you must
click the + sign in front of the primary text object. See "Using the Object list" for more information on this
procedure.

Creating a hypertext object
Here is the procedure to follow to define a hypertext object within a text object:
> Double-click the text object to enter editing mode.
You will find a full description of the text editor in "The Text object".
»  Select the word or words that you want to define as hypertext.

You now have several choices:

e Click the Hypertext icon e in the Paragraph group or,

e Choose Hypertext | Activate in the local menu, or

e Press Ctrl + H.

This converts the highlighted text into a hypertext object, meaning that it is now able to receive events.

» To define events and actions for the hypertext, choose Hypertext | Events in its local menu.

233



QI You can also place the mouse pointer over the hypertext object, press Ctrl (the mouse pointer changes to a hand) and
click the object to open its Events dialog.

As soon as you exit text editing, the hypertext object behaves as any other Mediator object.

The third option of the Hypertext local menu, Default Hypertext Style, lets you set a default format.

Default Hypertext Style §|

7 o -

[] Size |0 3 Color N

Italic Biold Underline

%) Mo change (%) Mo change () Mo change
) 5et ) 5et (%) Set

) Clear ) Clear () Clear

——

o If you select No change, the hypertext keeps the current italic, bold or underline attribute.

e Set applies the relevant formatting (e.g. italic, bold or underline) to the hypertext object.

e Clear removes the relevant formatting from the hypertext object.

You can also select a font, size and color for the text by choosing a value and checking the box to the left of the
relevant option to apply it.

The Change All button allows you to apply the options selected to all the existing hypertext objects.

De-activating a hypertext object

You can convert a hypertext object back to normal text as follows:
> Double-click the text object to enter editing mode.

» Place the mouse pointer within the hypertext.
o Click the Hypertext icon 2 in the Paragraph group or,

e Choose Hypertext | De-activate in the local menu, or

e Press Ctrl + H.

QI You can also select the hypertext object in the Object list and delete it. See "Using the Object list" for more information.

Hypertext properties

The Properties dialog lets you view and fine-tune all the properties applicable to hypertext objects. Refer to the
topic "Common properties” for a description of the properties that are common to all objects. To learn more
about the particular properties of the Hypertext object, refer to the next topic.

Hypertext properties: Hypertext tab
A click on the Hypertext tab displays the following dialog.
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Properties for Object: Hypertext 4

E A
Transparent | [ False

Color Bl ez00 |

Transparent: When this is checked, the hypertext object does not have its own background color, but is shown
on the same background as the rest of the text.

Color: This lets you select a color for the background of the hypertext object. Click the color box on the left of
the field or use the Pipette. See "Choosing a color" for more information.

Please note that the selected background color is not visible while editing the text object.

The Headline object

lAl Rather than using a Text object, you can use a Headline object when all you need is a single line of text on
your page as a heading. Another advantage of the headline is that it can be rotated.

» To create a headline, choose Insert | Text | Headline and drag out a rectangular frame for the headline.

» Type your headline in the dialog that opens.

Headline Object (%]

Texk:

[_'?J Help ] [ Ok ] [ Cancel

The headline text is fitted inside the rectangular frame you defined.

Headline properties
Once the headline is inserted on the page, its Format tab opens at the right of the ribbon.

.
- | SR Fil -

; L = | i~
X 120 et - Arial = ‘J __! J i ‘6
A \ ~ il Cutling =] L = = |
¥ 70 NS 2 = . B 7| [ antialiasin Bring To Send  Bring Send Aligr
2 =[G Effects ~ | Front To Back Forward Backward

Position & Size Skyle Font Arrange

The Format tab contains the most common operations that can be performed on headlines:

e You can use the fields of the Position & Size group to change the position and size of the headline object.
See "Moving objects" and "Resizing objects" for more information.

The text is always adjusted to fit inside the object.
To adjust the text to the closest font size right-click the headline object and choose:

e Adjust Height to resize the object while maintaining its width
e Adjust Width to resize the object while maintaining its height

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your headline as you
go. Once you have found an effect you like, just click it to apply it to the headline.

e You can use the Fill, Outline and Effects commands to change the visual aspect of the headline. See
"Applying styles" for more information.
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@ In addition to shadow and glow effects, you can also apply transform effects to the headline so that it
appears warped or curved.

¢ You can change the font and the attributes of the headline using the commands of the Font group.

e You can change its placement order or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
headlines. Refer to the topic "Common properties” for a description of the properties that are common to all
objects. To learn more about the particular properties of the Headline object, refer to the next topic.

Headline properties: Headline tab
A click on the Headline tab displays the following dialog.

Properties for Object: Headline =
B AD @ [

Text Headline

Fonit: _= | arial

Bold [w True

Italic [w True

Fill type _= | 5alid

Fill calar 0, 175,84 |
Fill colar 2 o020 |

Fill gradient type _= |Linear
Fill gradient angle |0

Fill gradient center ¥ |50

Fill gradient center ¥ |50

Fill tescture options | = |Scale
Fill texkure path |

Outline color lo.0.0 |
Ctline weight 1]

Ctline style _= |5alid Line

Warp X 0

Warp ¥ 0

Curve height 1]

Curve length 100

Antialiasing [ False

Text: Enter or change the headline text. You can also double-click the object itself.

Font: This field defines the headline font. Click the black arrow next to the font name to see the list of available
fonts.

Bold: Check this option to make your text bold.
Italic: Check this option to make your text italic.
Fill type: This property allows you to change the fill (i.e. interior) of your headline. You can choose between:

e No Fill: This will make your headline transparent.

e Solid: This option lets you choose a solid color for your headline.
e Gradient: This lets you create a color transition of different types.
e Texture: This lets you apply a texture to your headline.

Fill color: Click the color box on the left of the field or use the Pipette. See "Choosing a color" for more
information.

The next properties only apply if you have selected a gradient fill type.

Fill color 2: Use this field to choose the second color for the color transition.
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Fill gradient type: This lets you choose between different gradient types which you can experiment with.

Fill gradient angle: This only applies to linear gradients. It indicates the direction of the color transition. A
value of 0 for instance means that the gradient is vertical, a value of 90 means that it is horizontal.

The next two properties define the coordinates of the gradient center. For radial and rectangular gradients, the
gradient center is the point where the second color of the gradient is the strongest.

Fill gradient center X: This specifies the X coordinate of the gradient center.
Fill gradient center Y: This specifies the Y coordinate of the gradient center.
Fill texture options: The next properties only apply if you have chosen a texture fill type.

e Scale: This scales the texture picture to fit the object size.

o Tile: Here the texture picture is used in its original size. If necessary, it is tiled to match the object size.
o Tile Flip X: Displays every second tile mirrored in the X direction. This prevents vertical hard edges.

e Tile Flip Y: Displays every second tile mirrored in the Y direction. This prevents horizontal hard edges.

e Tile Flip XY: Displays every second tile mirrored in the X/Y direction. This prevents hard edges in
both directions.

Fill texture path: This specifies the path of the picture used as texture.
Outline color: Use this field to choose the outline color.

Outline weight: Use this field to define the width of the outline.
Outline style: Choose between the different styles available.

Warp X: Warps the headline text horizontally (values from -100 to 100). Positive values narrow the upper part,
negative values the lower part.

Warp Y: Warps the headline text vertically (values from -100 to 100). Positive values narrow the left part,
negative values the right part.

Curve height: Curves the headline text vertically (values from -100 to 100).

Curve length: Defines the "frequency" of the curve (values from -400 to 400). The default value of 100 shows
one complete horizontal cycle.

Antialiasing: Antialiasing smoothes the text. This is checked by default.

The Media Player object

@ The Media Player object allows you to play video and sound in a Media Player window inserted in your
page.

@ The Media Player object is not available in documents of type Flash. See the topic "Creating a document”
for more information on the different document types. You can however use the Video object to show a video in
a document of type Flash.

If you want to embed a video directly into the Mediator page, you should use the Video object. The Video object
also has other advantages compared to the Media Player object. For more information, see "The Video object".

Compared to the Video object, the Media Player has the following advantages:

e It supports all the common Windows formats, including the streaming file formats ASF, WMV (video), and
WMA (audio).

e Itisavailable in documents of type HTML.
e It lets you use a slider on sound and videos, as well as built-in sound control.

o It lets you make use of markers inserted in the media files to ensure perfect timing with other interactive
elements.
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@ The Mediator Media Player object always uses the latest Windows Media Player installed on the computer.
This must be version 9 or above. Although the vast majority of system configurations supported by Mediator
already include Media Player, you may want to indicate to your end users that they can download it from the
Microsoft Download Center if necessary.

» To insert a Media Player object, choose Insert | Media Clips | Media Player and drag out a rectangular
frame on your page.

The Open dialog appears to let you select the video or sound file you wish to use.
» Use the preview pane on the right-hand side of the Open dialog to ensure you have selected the correct file.

When you close the Open dialog the Media Player object looks as follows.

o — ~
-. Lt ,
i321| i321| i321| i321|
i321| i321| i321| i321|
5 . oy
L Lt o

Since the Media Player object is actually just a frame for an external program (Windows® Media Player) you
cannot see the file you have selected until you go into test mode. This also means that you cannot see if the size
of the Media Player object you created is adequate. You must adjust the size manually later. By contrast with the
Video object, you cannot auto-adjust the Media Player object.

The size of the Media Player object must be sufficient to accommodate both the contents and the navigation bar.
If for instance you have a video of 320 x 240, are using Media Player 9 and have enabled the display of the
navigation bar, you should define an object size of 320 x (240 + 64) to ensure that the video fits the space
exactly. The aspect ratio of the video is however always maintained, even when the object size defined does
match the video size exactly. In that case the "empty" space surrounding the video is filled by black stripes.

Bear in mind also that if you animate objects or use elaborate show/hide effects at the same time as playing the
video, you will not get the same performance as when playing the video on its own since Mediator needs to
perform all these actions in parallel.

Media Player object properties

Once the Media Player object is inserted on the page, its Format tab opens at the right of the ribbon.

V| auko Start : = | =
X 190 s s = = -
Play Count: 2 = | = J J =
Y 179 + a]]|z33 = BringTo Send  Ering  3end  Align
+ Full - Front  To Back Forward Backward
Position & Size Flay Arrange

The Format tab contains the most common operations that can be performed on Media Player objects:

e You can use the fields of the Position & Size group to change the position and size of the Media Player
object. See "Moving objects" and "Resizing objects" for more information.

¢ You can modify the Auto Start, Play Count and Ul Mode properties of the object. For a description of
these properties, see the next topic.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to Media
Player objects. Refer to the topic "Common properties" for a description of the properties that are common to all
objects. To learn more about the particular properties of the Media Player object, refer to the next topic.

Using streaming video and audio

The Media Player object enables you to use streaming media in your offline and online projects.
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The advantage of streaming media is that the audio or video can start playing as soon as an initial amount of data
is loaded. The rest is downloaded while playing.

If you are using the Media Player object for an online project, you are advised to use one of these formats. You
can convert your existing video files to ASF or WMV with the Windows Media®© Encoder, which can be
downloaded freely from the Microsoft Download Center.

QI To include a WMA sound in your project without actually showing the Media Player object which contains it, just move
the object in the non-visible part of the workspace. You will still be able to play and control the sound as expected.

Using markers (cue points) in media files

ASF and WMV files can sometimes contain markers (also called cue points), which Mediator
can detect and react to.

Markers identify precise positions within the file.

.p

AL

Using this event gives you the possibility of timing your project perfectly. You can ensure that a picture is shown
exactly at the right moment, make an animation start on a high note, or display an explanation at the right time.

The Marker Hit event, specific to the Media Player object, is triggered every time such a marker is hit.

To insert markers in an ASF file you can use the Media File Editor contained in the Windows Media Encoder.

The name of the most recently encountered marker is stored in the Media Player object property
CurrentMarkerName. CurrentMarkerName is a read-only property and is therefore not accessible in the
Properties dialog. However, you can access it from the Set Property action as any other property by entering the
name of the object followed by the name of the property, e.g. MPlayer.CurrentMarkerName, as shown below.

Set Property g|
Ohbject:
Input @
Froperty
Text W

) Constant value

(%) Value az expression

b Player Currenthd arkerM ame

[ OK |[ Cancel ]

Media Player object properties: Media Player tab
The Media Player tab lets you adjust the playback settings and the contents of the Player window.
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Properties for Object: MPlayer o
File name | .. |y documentsitraffic.mpg
Auko skart | v True

Play count | 2
Yolume 100
Balance |0

UImode | = |Ful

File name: Shows the selected file. Click the Browse button .| to select another file.

The Media Player object can be used with HTML export to play back streaming video and audio. It works
without madification in Microsoft Explorer and Mozilla Firefox.

Auto start: Starts the selected file automatically. This is checked by default.

Play count: Indicates how many times to play the selected file. If the value is set to 0 (zero), the file plays
repeatedly, restarting as soon as it reaches the end.

Volume: Used to set the volume output level. Possible values range from 100 to 0 (%), where 100 specifies full
volume and 0 specifies no volume.

Balance: Used to set the balance. The default value of 0 (zero) indicates that the sound is balanced equally
between the left and right speakers. A value of -100 indicates that all sound is going to the left speaker. A value
of 100 indicates that all sound is going to the right speaker.

Ul mode: This property can be used to determine the appearance of the Media Player window. It can take one of
the following values:

e None: The Player is shown without any controls. The only visible element is the video window itself.

e Mini: In addition to the video window, the Player is shown with a status window, as well as Play/Pause,
Stop, Mute and VVolume controls.

e Full: This is the default setting. In addition to the video window, the Player is shown with a status window, a
seek bar, and Play/Pause, Stop, Previous, Next, Mute, Fast Forward, Fast Reverse and VVolume controls.

The Video object

(-1 )
.-9
2% Mediator lets you embed video objects on your page to show different types of videos.

@ The Video object is not available in documents of type HTML. See the topic "Creating a document" for
more information on the different document types. You can however use the Media Player object to show a
video in a document of type HTML.

The formats supported by the Video object for documents of type Standard are AVI and MPG. Other formats,
such as WMV, might work in test mode, but are not supported in runtime mode. To include a WMV video in a
document of type Standard, use the Media Player object instead.

For documents of type Flash, the only format supported is FLV. If necessary, you can convert AVI and MPG
videos to FLV by using one of the freeware tools available on the Internet.

Compared to the Media Player object, the Video object has the following advantages:

e Itis available in documents of type Flash, with some restrictions. Please see "Flash restrictions" for more
information.

e Itis possible to auto-adjust the size of the video frame so that it fits the video perfectly.
e It can be played with other objects shown on top of it.

e Asitis embedded on the page, it can have transition effects and special effects such as rotation applied to it.

240



» Toinsert a video, choose Insert | Media Clips | Video and drag out a rectangular frame on your page.
Once you have created the video frame, the Open dialog appears.

» Select the video you want to place in the video object, choosing from the video formats supported by the file
type "Video files". Checking Preview in the right-hand side of the dialog lets you see a preview of the
selected video file. Use the buttons on top to Play *, Pause ™ or Stop ‘B your video.

» Click Open to accept the selected file.

QI At the bottom of the Open dialog you will see a field containing the most recent paths you have used.. Simply click the
path to the folder you wish to select your video file from.

Video size

Once you have selected the video the Video Adjust Size dialog appears. This dialog lets you automatically
adjust the size of the video frame to fit the video. You have two choices:

e Click OK to resize the video frame.

e To keep the size of the frame as it is, uncheck 'Adjust the frame size' and click OK.

Video Adjust Size (%]

Adjust the frame zize ta fit the video

(%) Always show this dislog
{3 Do not show this dialog again - always adjust the frame size

{3 Do not show this dialog again - never adjust the frame size

reactivate the dizplay of this dialog later in the Preferences panel of
the Mediator Options dialog.

@ If you chooze one of the bwo 'Da not show...' options, you can

@ It is recommended to always play videos in their original size.

The three radio buttons let you define the default behavior for future video imports. You can set Mediator to:
o display this dialog every time you import a video,
e never display this dialog and always import the videos in their original size,

e never display this dialog and always scale the videos to fit the frames you created.

Video properties

Once the video is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on videos:
e You can restore the video to its original size by choosing Adjust Size.

You can then resize it proportionally if necessary by pulling its corner handles.
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e You can use the fields of the Position & Size group to change the position and size of the video object. See
"Moving objects" and "Resizing objects" for more information.

¢ You can modify the Auto Start, Repeat and Always On Top properties of the video. For a description of
these properties, see the next topic.

e You can use the Effects command to rotate the video object. For more information, see "Rotating objects".
Note that rotating a video object automatically disables its 'Always on Top' property.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to videos.
Refer to the topic "Common properties" for a description of the properties that are common to all objects. To
learn more about the particular properties of the Video object, refer to the next topic.

Video properties: Video tab
A click on the Video tab displays the following dialog.

Properties for Object: Yideo o

[ E =

Path _. iy docum, Abraffic. mpg
Auko skark [v True

Repeat [ False

Load on show [v True

Discardable [v True

Enable transparent color | [ False

Transparent colar |:|255,255,255 ﬂ
Always on bop [w True

Path: This field shows the path to the video you selected in the Open dialog. Click the Browse button -] to
select a different video.

Auto start: When this is checked, the video starts playing as soon as the page is displayed. Otherwise, the video
does not play until a Start action activates it. Until then, the first frame appears in the video object.

Repeat: When this is checked, the video plays over and over until a Stop action terminates it or the page is left.
If the box is not checked the video stops after the first play-back. It then shows the last frame of the video.

Refer to the topic "Common properties” for a description of the Load on show and Discardable options.
Enable transparent color: Check this option to enable the effect.

Transparent color: Click the color box or use the Pipette to select the color you would like to make transparent.
See "Choosing a color" for more information. This visual effect is not as good on ordinary videos as on pictures,
unless you want the video to have "holes" here end there while it is playing! Even though many videos appear to
have a solid background color, they are often made of several almost identical colors.

@ You can select one color, and one color only, as your transparent color. When using a transparent color the
video uses twice as much memory as the same video without a transparent color.

Always on top: When this is checked, the video always stays in front of other objects. As it requires a lot less
computer power to play the video when this option is enabled, you should only disable it if you really need to
place other objects on top of the video.

@ Special effects placed on the video object will only work when 'Always on top' is disabled. If the computer
is not able to play the video with 'Always on top' disabled, Mediator re-enables it automatically before playing
the video (which means that the special effects will not show).

Bear in mind also that if you animate objects or use elaborate show/hide effects at the same time as playing the
video, you will not get the same performance as when playing the video on its own since Mediator needs to
perform all these actions in parallel.
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The Animated GIF object

| The Animated GIF object lets you show animated GIF files.

» Toinsert an animated GIF object on your page, choose Insert | Media Clips | Animated GIF and click the
position on the page where you want to insert it.

You do not need to drag out a rectangular frame when working with animated GIF objects, since animated
GIFs always keep their original size. Unlike pictures and videos, animated GIFs cannot be resized.

The Open dialog appears.

»  Select the animated GIF you would like to use. Checking Preview in the right-hand side of the dialog lets
you see a preview of the animation. Use the buttons on top to Play », Pause ‘M or Stop ‘B your animated
GIF.

Animated GIF properties

Once the animated GIF object is inserted on the page, its Format tab opens at the right of the ribbon.

X 63 1 ¥ Auka Start 'IJJ J_j JJ _lJ EJ
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The Format tab contains the most common operations that can be performed on animated GIF objects:

e You can use the fields of the Position group to change the position of the animated GIF object. See "Moving
objects" for more information.

e You can modify its Auto Start and Repeat properties. For a description of these properties, see the next
topic.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to
animated GIF objects. Refer to the topic "Common properties" for a description of the properties that are
common to all objects. To learn more about the particular properties of the Animated GIF object, refer to the
next topic.

Animated GIF properties: Animated GIF tab
A click on the Animated GIF tab displays the following dialog.

Properties for Object: France b

ERrE - e

Path . | My dacuments\France. gif
Auko skark [w True
Repeat [w True
Load on show | v True
Discardable | v True

Path: Specifies the path of the selected animated GIF file. You can enter the path manually or select a file by
clicking the Browse button k...

Auto start: When this is checked, the animation starts playing as soon as the page is loaded in memory.
Otherwise it waits for a Start action before playing. Until then the first frame appears in the animated GIF object.
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Repeat: When this is checked, the animated GIF plays over and over until a Stop action terminates it, or the
page is left. If the box is not checked, the animated GIF stops after the first play-back. It then shows the last
frame of the animated GIF.

Refer to the topic "Common properties” for a description of the Load on show and Discardable options.

The Flash object

@ The Flash object lets you display Flash files (*.swf files) on your page.
» Toinsert a Flash object, choose Insert | Media Clips | Flash and drag out a rectangular frame on your page.

The Open dialog appears to let you select the Flash file you would like to use. You can select a Flash file from
your hard drive or a remote URL.

@ The Flash object has certain limitations when exporting to Flash. Please see "Flash restrictions" for more
information.

Flash object properties

Once the Flash object is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on Flash objects:

e You can use the fields of the Position & Size group to change the position and size of the Flash object. See
"Moving objects" and "Resizing objects" for more information.

e You can modify the Repeat property and use the Background command to set a color for the background of
the Flash object. See the next topic for a description of both of these properties.

e You can change the placement of the Flash object or align it differently using the commands of the Arrange
group. See "Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to Flash
objects. Refer to the topic "Common properties” for a description of the properties that are common to all
objects. To learn more about the particular properties of the Flash object, refer to the next topic.

Flash object events

E’j The Flash object has only three events: On Show, On Hide and the special Flash event On Ready State.

This event is triggered every time a change occurs in the state of the selected Flash file. During loading and play
back of a Flash file the state can take five different values:

0=Loading
1=Uninitialized
2=Loaded
3=Interactive
4=Complete

You can check for each of these values and trigger any given action as a result.
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Flash object properties: Flash tab
A click on the Flash tab displays the following dialog.

Properties for Object: Flash =
File name . |y documentshanimation, swf
Barckground color | [J0,0,0 |
Repeat [ False

File name: Specifies the path of the selected Flash file. You can enter the path manually or select a Flash file by
clicking the Browse button ..

Background color: If the frame of the Flash object is larger than the selected Flash file, the Flash file is scaled
proportionally to fit the frame, meaning that the width and height of the Flash file always keep the same aspect
ratio. The areas of the Flash object left empty will be shown in the selected background color. Click the color
box on the left of the field or use the Pipette. See "Choosing a color" for more information.

Repeat: Some Flash files, primarily older files, start over when they reach the end. When this option is
unchecked, the Flash file stops on the last frame after one play back.

The Button object

- 0K

—— Creating buttons with Mediator is quick and easy.

> Toinsert a button on your page, choose Insert | Controls | Button.
You have two choices:

e Clicking the upper part of the icon lets you create a default button.

e Clicking the arrow in the lower part of the icon lets you browse and choose from galleries of predefined
buttons.

fod > (8}
o Y s
[Burton | Animation Embed:

- Path  Docurme

Push L

Round - Text b
Round Plawver »
Square - Texk r

Square Player 1 »

Square Player 2 #

» Drag out a rectangular frame for the button.

If you are creating a default button, Mediator immediately enters editing mode to let you change the default
label. Otherwise, all you have to do to enter editing mode is to double-click the button.

»  Type the button label. If you need more than one line, press Ctrl + Enter at the end of the first line.

» When you have finished, press either Enter or Esc, or click anywhere outside the button to leave editing
mode.
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Button properties

Once the button is inserted and selected on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on buttons:
e You can reset the button object to the size of the button picture by choosing Adjust Size.

e You can use the fields of the Position & Size group to change the position and size of the button. See
"Moving objects" and "Resizing objects"” for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your button as you
go. Once you have found an effect you like, just click it to apply it to the button.

e You can use the font and attribute icons of the Font group to format the button label.

e You can change the placement of the button or align it differently using the commands of the Arrange
group. See "Arranging objects” and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
buttons. Refer to the topic "Common properties" for a description of the properties that are common to all
objects. To learn more about the particular properties of the Button object, refer to the next topics.

QI If you have created a button that you would like to re-use (including its events and actions), drag it from the Object list
to the desired User Area category of the Multimedia Catalog. You can then drag it straight back from the Multimedia
Catalog on any other page of your project.

Q You could also make it your default button type by choosing Edit | Define as Default Object in its local menu. This
means that any button you create from now on will automatically inherit the properties of your default button, as well as all
its events and actions.

Button properties: Button tab
A click on the Button tab displays the following dialog.

Properties for Object: Button »
0 = e B

Butkon bype |+ |Custom

[]212,208,200 |
[]212,208,200 |
[]212,208,200 |
Matrgin 1]
Border z

Button type: This property determines the type of the button, which can be Normal or Custom. By default the
button type is set to Normal.

The differences between the two button types are as follows:

e Normal: With this button type, you can use the three color fields underneath the 'Button type' option to
choose different colors depending on the state of the button.

The three possible states are: "Normal™ (when the mouse pointer is not on the button), "Focus" (when the
mouse pointer is on the button) and "Down" (when the button is clicked or activated).

Using the Picture tab, you can also place a picture on the button. This picture will be displayed in the center
of the button, in each of its three states. Refer to "Button properties: Picture tab" for more information.
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e Custom: If you select Custom the button's color and frame disappear and only the text remains. You must
now click the Picture tab and choose pictures for each of the three states of the button (Normal, Focus,
Down).

The middle section contains the three color fields relating to the Normal button type described above.

Normal color: The standard color of the button before it is clicked. Click the color box on the left of the field or
use the Pipette. See "Choosing a color" for more information.

Focus color: This is the color the button changes to when the mouse pointer is placed on the button.
Down color: This is the color the button changes to when it is clicked.
The bottom half of the dialog contains two additional design options related to buttons of Normal type.

Margin: If you have placed a picture on the button, you can specify here the number of pixels representing the
spacing between the edges of the button and the picture.

Border: This field relates to the button's 3D effect. Mediator achieves this three-dimensional effect by showing
the top and left sides of the button in a lighter shade than the button surface, and the other two sides in a darker
shade. You can increase or decrease this 3D effect by increasing or decreasing the value of the Border field.

Button properties: Text tab

The Text tab contains the format settings related to the button label.

Properties for Object: Button »
O = A E B
Fonit: _= | Arial
Text size 13
Text colar [ ]255,255,255 A
Bold v True
Italic [ False
IInderline v True
Text alignment _= |Center

Text padding left 0
Text padding right |0
Text padding kop 0
Text padding botbom |0

Font: This field defines the font of the button label. Click the black arrow next to the font name to see the list of
available fonts.

Text size: This determines the font size for the button label. Click the field and enter a value, or use the arrow
buttons to increase or decrease the value displayed.

Text color: Click the color box on the left of the field or use the Pipette to choose the text color. See "Choosing
a color" for more information.

Bold-Italic-Underline: Check the box next to one of these options to apply the corresponding attribute to the
button label.

Text alignment: Click this field to choose one of the alignment options available for the button label.

The next four settings specify the number of pixels between the edges of the button and the button label. Use
these settings to ensure that the label does not overlap with any graphics elements placed on the edges of the
button.

Text padding left: Number of pixels between the left edge of the button and the label. You can also use this
property to prevent the label from being so close to the edge of the button that it is hard to read.

In the example below, the property "Text padding left' has been set to 30 to leave some space on the left of the
button for the graphic element placed before the label.
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Text padding right: Number of pixels between the right edge of the button and the label.

Text padding top: Number of pixels between the top edge of the button and the label.

Text padding bottom: Number of pixels between the bottom edge of the button and the label.

Button properties: Picture tab
A click on the Picture tab displays the following dialog.

Properties for Object: Button »

0 &= A & E

Marmal picture path oo Around0l_05Skxk_aff.pr
Marmal alpha path o | AroundD ikt _alpha.prg
Diowwin pickure path o |voAround0l_05Exk_an.prg
Diowin alpha path o | AroundD ikt _alpha.prg
Facus pickure path oo v Around0l_0Skxk_aff.pro
Facus alpha path o | AroundD ikt _alpha.prg
Load on show [w True

Discardable [w True

Pickure aligniment _= |Center

Picture enable transparent | [ False

Picture transparent color |:|255,255,255 ﬁ
Mon scale left n

Mon scale top 1]

Mon scale right 1]

Mon scale boktom n

The first two properties, Normal picture path and Normal alpha path let you choose pictures to display on
your button. As you can see there are two different path fields, one for the picture and one for an external alpha
channel. These properties have a slightly different meaning depending on whether the button type is Normal or
Custom. Refer to "Button properties: Button tab" for more information about button types.

o If the button type is Normal, the pictures you select here will always be shown on the button, regardless of its
state. The picture maintains its X/Y aspect ratio (i.e. it is not stretched to fill the entire button).

e |f the button type is Custom, the pictures you select here will be shown when the button is in its "normal"
state (i.e. when the mouse pointer is not on the button). The X/Y aspect ratio is not maintained, which means
that Mediator scales the picture to fill the entire button frame. If you wish to keep the picture at its original
size, right-click the button and choose Adjust Size from the local menu.

> Click the Browse button -1 to display the Open dialog and select the picture you wish to use.

The purpose of an alpha channel is described in "Using alpha channels and bump maps". In brief, it is used to
add a transparent effect to the picture on the button. You do not have to use an alpha channel, so if you do not
want a transparent effect, leave this field empty.

The following four options are only available if you have chosen the button type Custom in the Button tab.

e The Down picture path and Down alpha path let you select the picture and alpha channel you wish to use
when the button is clicked.

e The Focus picture path and Focus alpha path let you select the picture and alpha channel you wish to use
when the button has the focus (i.e. when you move the mouse pointer on the button without clicking it).

Note that instead of applying a separate alpha channel to the Normal picture, Down picture and Focus picture,
you can choose pictures that already contain embedded alpha channels. You can also combine such a picture
with an additional alpha channel.

Refer to the topic "Common properties” for a description of the Load on show and Discardable options.
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Picture alignment: Use this field to determine the position of the picture on the button. Picture alignment is
only relevant when working with Normal buttons. The pictures shown on Custom buttons are scaled to fill the
entire button frame, making the Alignment option redundant.

Picture enable transparent: Check this option to enable the effect.

Picture transparent color: Click the color box or use the Pipette to select the color you would like to make
transparent. See "Choosing a color" for more information. With Normal buttons (with a picture), you can use this
function to create transparent areas. With Custom buttons, you can use it to create non-rectangular buttons
(round, triangular, star-shaped etc.).

5‘5’ On Custom buttons, you can only select one color contained on all the pictures selected.

The following four options are only available for Custom buttons. They allow you to specify the number of
pixels from each edge that should not be scaled when you resize the button. This avoids the distortion of any
graphical elements shown on the edges of the button that would otherwise occur when you resize the button, for
instance to accommodate a longer label.

Non scale left: Specifies the number of pixels from the left edge of the button that should not be scaled.

Non scale top: Specifies the number of pixels from the top edge of the button that should not be scaled.

Non scale right: Specifies the number of pixels from the right edge of the button that should not be scaled.
Non scale bottom: Specifies the number of pixels from the bottom edge of the button that should not be scaled.

Consider for instance the button below:

ﬁ MatchWare

Stretching it without setting any of its 'Non scale' properties gives the result below. The graphical element on the
left is badly distorted, the button label partially overlaps the graphical element and the rounded ends of the
button have become rough and grainy.

l;&ﬂt chy¥are

Stretching it after setting its 'Non scale left' and 'Non scale right' properties to 25 and its 'Non scale top' and 'Non
scale bottom' properties to 12 give the much more satisfactory result below.

lﬁ Matchyvare

—

Of course, this technique only works well if there is a central area in the button that can be stretched without any
visible negative effect.

@ If the picture displayed on your button has been scaled to fill the entire button and is therefore not shown at
its original size, you can use the properties above to undo this scaling on the left, top, right or bottom. If for
instance the picture's original size is much smaller than the button size, setting 'Non scale left' and 'Non scale top'
to the original width and height of the picture will give you a large button, mostly invisible, except for the
picture displayed in its top left corner.

The Animation Path object

N
-
)':3 The Animation Path tool lets you create a path along which you can animate one or more objects using the
Animate action.

Creating an animation path is done in exactly the same way as creating a polygon, as both tools connect points
with straight lines or curves. You will find a complete description of the creation process in "The Polygon
object".

Q. To create a loop, connect the end points of the animation path to close it.
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The Edit tab of the Animation Path is almost identical to that of the Polygon. The only difference is the Browse
Object field, which lets you see how the object you intend to animate will look at each point of the animation
path.

Each point of the animation path represents the center of the animated object.
» Click the Browse for Object button and select the required object from the Object list.

» Click the Select icon, then click each point of the animation path in turn.

R T | [ T | x[2s2] vl = X

Select | Add  Delete iarid Break To Symmetric  To To D"ﬂ Rectangle | |cl Close
Bezier  Line

Paoint Position Editing

05,124

If you intend to use the animation path for more than one object, simply select each of the other objects in the
Browse field once you have previewed the animation of the first object.

When you define an Animate action for an object, you can decide whether the animation path should be fixed or
relative to the object:

¢ In the first case, the object will move to the start of the animation path before following it.

¢ Inthe second case, you can choose whether the animation path should start from the object's current position
or end at the object's current position. The entire path is then displaced so its start - or end - point coincides
with the object's position.

Please refer to "Animate" for a complete description of these settings.

Animation path properties

Once the animation path is inserted and selected on the page, its Format tab opens at the right of the ribbon.
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Position & Size Arrange
The Format tab contains the most common operations that can be performed on animation paths:

e You can use the fields of the Position & Size group to change the position and size of the animation path
object. See "Moving objects” and "Resizing objects" for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
animation paths. Refer to the topic "Common properties" for a description of the properties that are common to
all objects.
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The Embedded Document object

=
Lﬂ The Embedded Document object lets you place a browser window within your project to display an
external file. The file therefore appears as if it was embedded in your Mediator page.

5@ The Embedded Document object is not available in documents of type HTML or Flash. See the topic
"Creating a document” for more information on the different document types.

QI To display a URL or afile in a separate browser window, do not use the Embedded Document object. Use the Web Link

action instead.

» Choose Insert | Controls | Embedded Document and drag out a frame for the Embedded Document
browser on your page.

The Embedded Document dialog appears.

Embedded Document Object E|
Path/URL:
hittp: 4w, matchiware. com

Enter a path to a local file or a complete URL.

5[ cwes

The Embedded Document object can open web sites, web-based documents and files that support the Active
Document standard. Applications that support this standard include Adobe Acrobat®, Microsoft® Word,
Microsoft® Excel, Microsoft® PowerPoint etc. You can also use this object to show pictures (online or offline),
download items, etc.

Path/URL.: Enter the address of a web site or a web document, or even a path to a file on your hard drive. You
. A .
can also click the Browse button = to select a file.

If you intend to export your project for distribution to other users, you should only enter the file name and
extension, without its path. Then choose Prepare | Additional Data Files to add the file (and any other required
file) to the project so that Mediator can include it when exporting your project. See "Adding data and program
files" for more information.

Notes:

e Embedded Document objects are displayed in an Internet Explorer browser window. As Internet Explorer is
part of Windows, the browser window will open on all systems, regardless of whether Internet Explorer is
the default browser on those systems or not. If you are using the Embedded Document object to display
commonly used files (e.g. Flash files, PDF files etc.), you can assume that the end user will have the plug-in
required (e.g. Flash Player, Adobe Acrobat Reader etc.) installed in their browser. If you are using more
unusual file types, it is advisable to supply a link from which the user could download the relevant plug-in.

e When the Embedded Document object is used to display a web site or web document, Mediator
automatically connects to Internet using the end user's default connection settings, even if the Embedded
Document object is hidden.

Embedded Document object properties

Once the Embedded Document object is inserted on the page, its Format tab opens at the right of the ribbon.
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e You can use the fields of the Position & Size group to change the position and size of the Embedded
Document object. See "Moving objects” and "Resizing objects” for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
Embedded Document objects. Refer to the topic "Common properties” for a description of the properties that are
common to all objects. To learn more about the particular properties of the Embedded Document object, refer to
the next topic.

Embedded Document event

=

L‘sz The Document Complete event, specific to the Embedded Document, is triggered as soon as the
download of a web site or a web document is complete, or when the picture or document displayed in the object
is fully loaded.

Embedded Document properties: Embedded Document tab
A click on the Embedded Document tab displays the following dialog.

Properties for Object: EmbedDoc 4
B =B

Path oo | RtEp i ey, matchware, com

This tab only holds one field, the path of the site or document to display.

You may enter the address of a web site or a web document, or even a path to a file on your hard drive. You can
also click the Browse button _-.-| to select a file.

If you intend to export your project for distribution to other users, only enter the name and extension of the file,
without its path. Then choose Prepare | Additional Data Files to add the file (and any other required file) to the
project so that Mediator can include it when exporting your project. See "Adding data and program files" for
more information.

The HTML object

<html=
'—I The HTML object is used to embed HTML code seamlessly into your Mediator page.

It is only available in documents of type Standard or HTML. See the topic "Creating a document" for more
information on the different document types.

For documents of type Standard, the HTML object has the same limitations as when you run an HTML page
locally on your computer. You cannot for instance use any server-side scripting such as ASP and PHP in an
HTML object in a document of type Standard.

The real strength of this object is in HTML mode, as it lets you inject any HTML code into your Mediator
HTML project. This could be JavaScript, PHP or ASP code.

In order to use server-side scripting such as PHP and ASP, you will need to upload your exported project to a
web server that supports server-side scripting.

» To insert an HTML object on your page, choose Insert | Controls | HTML Obiject.
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You have two choices:

e Clicking the upper part of the icon lets you create your own HTML object.

e Clicking the arrow in the lower part of the icon lets you browse and choose from a gallery of predefined
HTML objects.

Drag out a rectangular frame for the HTML object.

The HTML Obiject dialog appears.
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Q You can resize this dialog if necessary by dragging one of its edges with the mouse.

You now have several options:

You can open an existing HTML object, either predefined or custom, by clicking the Open HTML Object

icon = on the left. When you have found the object you want, click Open or double-click the object name
to open it in the HTML Object dialog.

You can paste code into the dialog.

You can save any changes made, either to a predefined object or to a custom object, by clicking the Save
HTML Object icon H. This lets you overwrite an existing custom object, or create a new one.

You can also delete an existing custom object by right-clicking it in the Open HTML Object dialog or Save
HTML Object dialog and choosing Delete.

Notes:

The HTML object should only contain the contents of the <body> tag. Therefore, make sure you do not
include anything outside the <body> tag when entering or pasting code.

If you include PHP or ASP code in the HTML object, most web servers require that the web page is renamed
with the correct extension (.php or .asp). You can do this by modifying the 'HTML extension' property of the
page in its Properties dialog. See "Page properties: General tab™ for more information.
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HTML object properties
Once the HTML object is inserted on the page, its Format tab opens at the right of the ribbon.
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e You can use the fields of the Position & Size group to change the position and size of the HTML object. See
"Moving objects" and "Resizing objects" for more information.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
HTML objects. Refer to the topic "Common properties” for a description of the properties that are common to all
objects.

The Input object

Input objects can be used in many different ways, but they basically serve two purposes:
e Showing information to the user

e Getting information from the user
Choose Insert | Controls | Input Object and drag out a rectangular frame for the input object on the page.

(optional) Enter text to be displayed initially in the input object. If you need more than one line, press Ctrl +
Enter at the end of the first line. When you have finished, press either Enter or Esc, or click anywhere
outside the input object to leave editing mode.

@ The Input object has certain limitations when exporting to HTML or Flash. Please see "HTML restrictions"
and "Flash restrictions" for more information.

Here are two typical examples of use of the Input object:

Showing information to the user: To show the current date, create an input object (for instance with the name
Input01). Attach a Set Property action to the page event On Start. Select the object Input01 in the Object field of
the Set Property action and the property Text in the Property field. Check the option "Value as expression’, and
enter the expression @Date in the field.

You can also use Set Property to assign to the input object an integer or floating point value stored in a variable.
Select the input object in the Object field and the property Value in the Property field. Check the option 'Value
as expression’, and enter the variable name in the field.

Getting information from the user: You might wish to obtain the user's name to use it elsewhere in your
project. Prompt them to enter their name in an input object (for instance Input02). You can now access the user
name entered in the input object by referring to its Text property. In this case it would be Input02.Text. You can
assign this value to a variable or use it directly in any expression.

If you want to read a number from an input object, you can refer to its Value property (e.g. Input02.Value in our
example).

You can also display the contents of an array in an input object, or assign the value of the input object to an
array.

For more on variables, arrays and expressions, see "Using project variables" and Using expressions".

Input object properties

Once the input object is inserted on the page, its Format tab opens at the right of the ribbon.
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The Format tab contains the most common operations that can be performed on input objects:

e You can use the fields of the Position & Size group to change the position and size of the input object. See
"Moving objects" and "Resizing objects" for more information.

e You can use the Background and Frame commands to change the visual aspect of the input object.

e The Multiline box specifies whether the input object is allowed to contain more than one line of text or not.
Check it to let the user enter more than one line of text or to import an external text file into the input object.

¢ You can change the font and the attributes of the input object with the commands of the Font group.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and edit all the properties applicable to input
objects. Refer to the topic "Common properties” for a description of the properties that are common to all
objects. To learn more about the particular properties of the Input object, refer to the next topics.

Input object events

Two events can be used to control what is entered in the input object.

@

. The On Stop event is triggered when the user presses the Enter key or clicks a different object. This
allows you to perform an action based on the entire contents of the input object.

. B By contrast, the On Change event is triggered every time the contents of the input object changes.
This gives you total control on user input. You can for instance display an error message if an incorrect
character is entered, restrict the number of characters allowed in the input object, etc.

Input object properties: Input tab
A click on the Input tab displays the following dialog.

Properties for Object: Input =
B BEE DO @R
Text
Transpatrent [ False
Background color |[]212,208,200 |
Wisible Frame [w True
Frame color 114,114,114 |
Frarne width 1
Read-only [ False
Preselect on focus | [ False
Decimal poink
Z2

Enable FP decimals | [ False

Text: This is a text property that holds the default contents of the input object.

Transparent: Check this option to make the background transparent. Unless the input object is "read-only" (see
below), the background will become visible as soon as the input object is selected.
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Background color: Use this field to choose a color for the background. Click the color box on the left of the
field or use the Pipette. See "Choosing a color" for more information.

Visible frame: If you uncheck the box the input object will not have a frame.
Frame color: Use this field to choose a color for the frame.
Frame width: Use this field to set the width of the frame (if it is visible).

QI If you choose the same color for the background and for the frame, you can use the frame width to set a "margin" for the
contents of the input object.

Read-only: When this is checked, the end user can only read from the input object, not enter new values.

Preselect on focus: Check this option if you want the entire contents of the input object to be selected as soon as
it receives the focus.

Decimal point: Use this field to change the character representing the decimal point in input objects used to
display floating point values.

Enable FP decimals: Check this option to allow decimals after the decimal point.

FP decimals: Use this field to set the number of decimals after the decimal point.

Input object properties: Text tab
A click on the Text tab displays the following dialog.

Properties for Object: Input »
O =HED @@

Fank _= |Arial
Texk size |20

Text color 0,00 |

Bold [ False
Italic [ False
Alignment |~ |Center
Muliline | [ False
Password | [ False

This dialog lets you set the appearance of the text in the input object.

Font: Here you set the font that will be used in the input object. Unlike the Text object, the Input object always
uses the same font and formatting.

Text size: Use this field to set the font size.

Text color: Use this field to choose the font color. Click the color box on the left of the field or use the Pipette.
See "Choosing a color" for more information.

Bold/Italic: Formats the input object text in bold or italic.
Alignment: Use this field to set the horizontal text alignment.

Multiline: Using this option, you can let the user enter more than one line of text or you can import an external
text file into the input object.

Password: Allows you to hide the contents of the input object by replacing it with stars. You can only use this
option when 'Multiline' is disabled.

Flash device fonts: This property is only available for documents of type Flash. Setting it to True lets you
choose from the three built-in Flash fonts (Arial, Times New Roman, and Courier New). These fonts do not need
to be embedded, which reduces the size of the exported file. It is advisable to always use device fonts when
exporting to Flash.
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Input object properties: Scroll tab
A click on the Scroll tab displays the following dialog.

Properties for Object: Input b
[ ENE = NN

Auto scroll horizantal | v True

Scrall bar havizontal | [ False

Auto scroll wertical | [ False
Scrall bar vertical [ False

Auto scroll horizontal: If you use an input object to get input from the user but do not know how many
characters to expect, you can select this option to enable user input to exceed the length of the input object, for
instance if the user enters a path for a picture or text file.

@ If you are reading a multiline text (with the option 'Multiline' enabled in the Text tab), make sure this option
is disabled. Otherwise the text will appear as one continuous line without any line breaks.

Auto scroll vertical: This is useful when you are using the input object to load an external text file. In this case
the input object makes the necessary word-wrap adjustment in order to fit the text to the input object as well as
possible.

Scroll bar horizontal - Scroll bar vertical: You may decide to force scroll bars vertically and horizontally. If
you check one of these options, the scroll bars are added to your input object even when they are not needed.

You cannot change the size or color of the scroll bars as you can in a text object.

Important: Checking 'Scroll bar' and 'Auto scroll' not only means that scrolling is enabled, but also that you can
load text files that are larger than the input object.

If you do not check 'Auto scroll’, the input object will simply stop reading the text file once the input object is
full and the rest of the text file will not be loaded.

The List Box object

'—d The List Box object lets you create a list (for instance a list of cars, products, countries, etc.) from which
the end user can select a particular option. Depending on the user choice, you can perform different actions, for
instance display another page or open a web page.

@ The List Box object has certain limitations when exporting to Flash. Please see "Flash restrictions" for more
information. It is not available in documents of type HTML. See the topic "Creating a document™ for more
information on the different document types.

» Choose Insert | Controls | List Box and drag out a frame for the list box on the page.
Q. If you want to include a Contents page, an Index page or a History page in your project, or set up a text search covering

the entire document, you can use one of the ready-made dynamic templates Contents, Index, History or Search. Just choose
the relevant template when creating the page. For more information on these templates, see "Using the dynamic templates".

List Box properties

Once the list box is inserted on the page, its Format tab opens at the right of the ribbon.

n )
. ¥ Background + = el ‘ =
X 387 L iy - ! H [0 Arial = (15 L
. | H | ] - LFrame - - JJ g S S= -E
Y 198 2 4]z - T Iz = B 7 ulA- BringTn Send  Bring  Send  Algn
il - - 7| T Effects ~ Ofl=" Front  To Back Forward Backward
Position & Size Fork Arrange
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The Format tab contains the most common operations that can be performed on list boxes:

e You can use the fields of the Position & Size group to change the position and size of the list box. See
"Moving objects" and "Resizing objects" for more information.

e You can apply different predefined effects by browsing through the style gallery (click the More button at
the bottom right of the gallery to see the full range of choices), checking their effect on your list box as you
go. Once you have found an effect you like, just click it to apply it to the list box.

e You can use the Background, Frame and Effects commands to change the visual aspect of the list box.
e You can change the font and the attributes of the list box with the commands of the Font group.

e You can change its placement or align it differently using the commands of the Arrange group. See
"Arranging objects" and "Aligning objects" for more information.

In addition to the Format tab, the Properties dialog lets you view and fine-tune all the properties applicable to
list boxes. This is where you choose the type of list you want to create and also where you can enter your list
data.

Refer to the topic "Common properties” for a description of the properties that are common to all objects. To
learn more about the particular properties of the List Box object, refer to the next topics.

List Box event

ﬂ?& The On Select event is specific to list boxes. It is triggered every time the user selects an item in the list
box, enabling you to check what has been selected and to execute the appropriate action(s).

The List Box object also has two "invisible™ properties: SelectedIndex and SelectedString.

They are used to read or set what is selected in the list box:
e SelectedIndex holds the entry number of the selection starting with 0 for the first, 1 for the next and so on.

e SelectedString holds the actual contents of the selection.

Example: If you have created a list of car brands in Listbox01 and the third in the list is Aston Martin,
Listbox01.SelectedIndex will have the value 2 (since the list starts with 0, 1, 2) and Listbox01.SelectedString
will have the value "Aston Martin".

You could for instance assign the entry number to a variable named 'Brand' by using an Assign action as follows:

Assign El

" ariable;
Brand L

Azsignmment expression;
Liztbox1. Selectedindes

[ ok [ Cancel

You can also use the Set Property action to set a selection. If for example you want to force the selection of the
item Green in Listbox01 you would fill in the Set Property dialog as follows:

258



Set Property E|
Object:
Listbowi1
Froperty
SelectedShing w

) Constant value Green

)W alue az expression

| 0K |[ Caricel ]

You can also display the contents of an array in a list box, or assign the value of the list box to an array.

For more on variables, arrays and expressions, see "Using project variables" and Using expressions".

List Box properties: List box tab

A click on the List Box tab displays the following dialog.

Properties for Dbject: Listbox »

B EIEEHD ® B

Scrall bar size |14
Datatype | _~ |Datalist
Data

Scroll bar size: Here you set the width of the list box scroll bar, in pixels. A scroll bar is applied automatically
to the list box if necessary.

Data type: This lets you choose the type of list box you require. There are five different types of list boxes:

e Data list: A list containing data that you enter manually in the list box, in the Data field. See the description
of the Data field further down.

e Page list: A list of all the pages contained in the project (except the pages you excluded by disabling 'Use in
Contents' in their Properties dialog). The names displayed in the list box are not the page names, but the
descriptions entered in the Description field of their Properties dialog. See "Page properties: General tab" for
more information.

e Index list: A list containing all the keywords you have added to the project. You can attach keywords to
pages and objects. Refer to "Page properties: General tab" and "Object properties: General tab” for more
information on how to enter keywords.

e Search word list: A list containing all the keywords you have added to the project, as well as all the text
appearing in the project's page descriptions, text objects, headline objects and buttons. The text is only
included if both the object and the page it belongs to have their 'Searchable' property set to True. You can use
the Search Manager (Review | Search | Search Manager) to exclude "noise" words (the, and, it, etc.) from
the search. Refer to "Using the Search Manager" for more information.
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e History list: A list containing all the pages that have been visited. This can be used to allow users to return
to a page visited previously or to retrace their steps in large projects.

5‘5’ Mediator includes ready-made dynamic templates using the last four list box types, respectively called
Contents, Index, Search and History, which you can select when creating a new page. For more information on
how to use these templates, see "Using the dynamic templates".

Data: Use this field to create your own list. You must choose the data type 'Data list' in order to access this field.
Separate each entry in the data list with a semicolon and no space, e.g. Alice;Bill;Lawrence;Dan

Properties for Object: Listbox »
ENE = [
acroll bar size | 14

Datatype | = |Datalist
Data Alice;Bill,Lawrence; Dan;

Q If you have a lot of data to enter, it may be more convenient to create your list in a text editor such as WordPad rather
than typing it directly into this field. Type all your entries in a single line, separating them with semi-colons, then copy the
line and paste it into the Data field. If you need to edit it at a later stage, just copy again the entire contents of the Data field
into WordPad, edit it as required and paste it back into the field.

Possible uses

You can use your own data list to define page names (the real page names, not the descriptions) and go to the
selected page - or define files (e.g. picture files) and assign these to particular objects.

You can also use list boxes to give the user any number of options on how to navigate in the project. This kind of
list box is not as easy to set up as the predefined pages, but it gives you a lot of flexibility.

Every time you wish to present the user with a number of possible choices, a list box is the right solution.

List Box properties: Text tab

A click on the Text tab displays the following dialog.

Properties for Object: Listbox =
ENENE 0 @ &
Fonit: _= | Arial
Text size 12
Text color lo.00 |
Bold [ False
Italic [ False
IInderline [ False
Selected text color [ ]258,255,255 ﬁ
Selected background color |l 73,7373 ﬁ

Font: Select the font you wish to use in the list box.
Text size: Use this field to set the font size.

Text color: Use this field to choose a font color. Click the color box on the left of the field or use the Pipette.
See "Choosing a color" for more information.

Bold - Italic - Underline: Select to format the text as needed.

Selected text color: Use this field to choose the font color of the entry selected by the user in the list box.
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Selected background color: Use this field to choose the background color of the entry selected by the user in
the list box.

Flash device fonts: This property is only available for documents of type Flash. Setting it to True lets you
choose from the three built-in Flash fonts (Arial, Times New Roman, and Courier New). These fonts do not need
to be embedded, which reduces the size of the exported file. It is advisable to always use device fonts when
exporting to Flash.

List Box properties: Color tab

A click on the Color tab displays the following dialog.

Properties for Object: Listbox 4

B E A&ED® R

Background colar [ ]z1z,208,200 A
Frarme calar | [ A
Scroll bar button colar [ ]212, 208, 200 A
scroll bar color [ Je42,242,242 A

Background color: Use this field to choose a background color for the list box. Make sure that this color is in
sharp contrast to that of the text (see List Box properties: Text tab).

Frame color: Use this field to choose a color for the list box frame. If you want an invisible frame select the
same color as the list box background color.

Scroll bar button color - Scroll bar color: Use this field to choose colors for the scroll bar and its buttons.
Remember that a scroll bar is added automatically if needed. The colors should therefore be colors that go well
with the background color.

The ActiveX object

2
The ActiveX object is used to insert ActiveX controls in your project.

An ActiveX object is a program module that can perform a specific task like playing a video, displaying text,
displaying pictures etc. As all Mediator objects, ActiveX objects have properties that can be manipulated. You
can use some of the thousands of ready-made ActiveX objects available. You can also create your own. ActiveX
objects can be made with different programming tools like Visual Basic and C++.

> To insert an ActiveX control in your project, choose Insert | Controls | ActiveX.

The Select ActiveX Control dialog appears.
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Select ActiveX Control

ActivelFlugin Object Customize
Apple QuickTime Contral 2.0

Microzoft Forms 2.0 ComboB ox
Micrazaoft Office Chart 11.0
ticrozoft Qutlook YWiew Control
Microzoft Terminal Services Cantral
PC HelpDezk Contral

5] oo

» (optional) Click Customize to access ActiveX controls that are not listed in the Select ActiveX Control
dialog.

The Available Active Controls dialog appears.

Available ActiveX Controls E'

Thiz iz a lizt of all controlz found an thiz computer. Mat all controls are
intended to be uzed by third party programs like kediator.

Before pou develop vour application it iz vour rezpansibility to check that yau
are allowed to distribute the contral, that the control works as inkended fram
kediator and that wow know in which files [bpically 00 filez] the contral iz
implemented.

IInfartunately there is no standard way of finding the above information,
therefore kMediatar cannat azsist pau with this tagk.

[]:+]WideoSoft Fleméunray Control
[]:+]wideoSoft FlexSting Control
[#] ActivexPlugin Object
[]adbanner Class

[ ]Adobe POF Reader

12

[]Basic IDE Control w6 - Enterprize
[]Basic MalJl Contral +& - Enterprize w

Location
C:AProgram Filez\Auick Time AT OCantral dil

] l [ Cancel

» Choose a control by clicking its checkbox and click OK.

The control is added to the Select ActiveX Control dialog.

» Click OK to validate and drag out a rectangular frame for the ActiveX object.
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@ The Available ActiveX Controls dialog lists all the controls found on your computer. The fact that a control
is listed does not mean that it is intended to work with Mediator or that you are allowed to distribute it. You are
therefore advised to select only ActiveX controls that you are familiar with and are allowed to distribute. It is
your responsibility to make sure that you do not infringe any copyright protecting ActiveX controls.

When you use script and ActiveX controls you also need to make sure that all the necessary files are included in
the exported version of your project.

ActiveX object properties

As all Mediator objects, ActiveX objects have properties that can be manipulated from the standard Mediator
Properties dialog.

Refer to the topic "Common properties” for a description of the properties that are common to all Mediator
objects.

As ActiveX objects are different from each other, their specific properties are also different.

Properties for Dbject: ActiveXx *
B &EE

BackCalor [ ]255,255,255 |
EorderCalar lo.o.0 |
JRL

FileMarne

_MovieHandle 1]

MaovieConkrollervisible [w True

Fullacreen [ False

FullScreenFlags A

FullScreenMaonitarturmber (0
FullScreenEndkeyCode |27

ErrorHandling 1
MewMovieFlags 1025
AutoPlay

BaselRL

Many ActiveX controls also have their own ActiveX Properties dialog.

» Toopen an ActiveX Properties dialog right-click the object and choose ActiveX Properties.

ActiveX object event

E& The ActiveX event is unique to ActiveX objects.

It is a standard interface that returns a string value from the ActiveX control whenever it registers an event.
Different ActiveX controls give different responses.

The return value from the ActiveX event is accessed through the control using the dot notation (e.g.
ActiveX.Event).

In most cases, an If-Then-Else action is used to determine the type of the event.

% (]

A ctives |f
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Events

_{b Events and actions are responsible for all the activity in a Mediator project.

An event is something that can happen to an object or a page. For instance an object may be clicked, the mouse
pointer may be moved inside the object, the object may receive a right click and so on. An action is something
that is triggered by an event. For instance, you may want to display another page or play a sound when a
particular event is triggered.

All the events available for the page or object selected at any given point are listed on the left-hand side of the
Events dialog. Events do nothing on their own, but must be combined with actions in the Events dialog.

For information about how to combine events with actions, see "Using events and actions".

@ The events available depend on the type of the document. Documents of type HTML or Flash do not have as
many events as documents of type Standard. See the topic "Creating a document” for more information on
document types. Please also refer to the "Mediator 9 feature list" for a complete list of all the events available for
each type of document.

Most of the Mediator objects have the same events available to them, although some objects have specific events
that are unique to them.

On the other hand, some events, such as On Page Ready, are only available for pages.
This topic list all the events available, dividing them in four categories:

o Events available on pages and objects

e Events only available on pages

e Events only available on objects

e Events only available on specific objects

Events available on pages and objects
]
Mouse Click o

This event occurs when the left mouse button is clicked.

Mouse Click is the most frequently used event. It lets you detect a click on a button, a hypertext object and so on,
and react to it.

@
Mouse Down

¥
This event occurs when the left mouse button is held down on the object.

You can use the Mouse Down event to execute actions that should only be activated as long as the button is
clicked, e.g. playing a sound, showing a picture, etc.

Gs
Mouse Up =
This event occurs when the left mouse button is released after a Mouse Down event on an object.

It is mostly used to terminate an action started with Mouse Down.

™
Right Click =)

This event occurs when the right mouse button is clicked.

264



This is often combined with the Show action to open a menu, or other items that you would like to display.

! |
Right Down ")
This event occurs when the right mouse button is held down on an object.

You can use the Right Down event to execute actions that should only be activated as long as the right button is
clicked, e.g. play a sound, show a picture, etc.

Be
Right Up =~
This event occurs when the right mouse button is released after a Right Down event on an object.

It is mostly used to terminate an action started with Right Down.

q "
Mouse Double Click 2ol
This event occurs when the left mouse button receives a double click.

You can use it instead of a single click wherever a double click is commonly used to perform a particular action,
for instance to show a picture in higher resolution, start counting or execute a 3rd party program from within
Mediator.

o
Right Double Click 2
This event occurs when the right mouse button receives a double click.

Its use is similar to the Mouse Double Click.

)
On Start %}

This event occurs when an object such as a video or a resource starts or an input object is activated. It also occurs
as soon as Mediator turns to a page. By contrast, the On Page Ready event is triggered later, once all the objects
are fully displayed.

Q. In general, you should use On Page Ready, but On Start can be used when you want to start music or sound while the
page is being built.

@

This event occurs when an object such as a video or resource stops or an input object is left. The Stop event also
occurs when a page is stopped, i.e. when you leave the page.

On Stop

On Stop is often used to show text when a video stops or play a tune when another tune or video stops.

Events only available on pages

On Page Ready \j
This event occurs after a Go to Page action as soon as all visible objects on the new page are displayed.
On Page Ready is often used to start a timeline, activate an input object or play music.
" :.a
On Mouse Move &~ &
This event occurs whenever the mouse is moved.
Example: Your tradeshow presentation plays music to attract customers. When a customer moves the mouse,
your presentation jumps to the introduction page.

265



M
On Key Down
This event occurs the instant a key on the keyboard is pressed.

For more information about how to handle keyboard events, see "Using keyboard events".

*
On Key Up
This event occurs when a key just pressed is released.

Events only available on objects

[,

Move Into .
This event occurs when the mouse is moved into a visible object.

Move Into is often used with the action Set Cursor in order to change the mouse pointer from an arrow to a hand.
It can also be used with the Show action, for instance to show a descriptive label when the mouse is moved into a

picture.
B,

Move Out '«
This event occurs when the mouse is moved out of a visible object.

Move Out is often used to revert changes made with Move Into. It can for instance be used to change the mouse
pointer back from a hand to an arrow, or to remove a descriptive label using the Hide action.

On Show H
This event occurs when a hidden object is shown via the Show action.
Use On Show on an object which is being shown often and perhaps starts a timeline when it is shown.

Let us suppose that several different user actions can show an object, and you would like to play a sound every
time it is shown: using On Show, you only need to place the Sound action on the object being shown instead of
on all the objects that can trigger the showing.

@ Do not confuse the On Show event with the Show action. You cannot place On Show after another event.

On Hide ©
This event occurs when a visible object is hidden via the Hide action.

On Hide has similar uses to On Show. If an object can be hidden by several different user actions, it is often
convenient to set the required action directly on the object using On Hide instead of on all the objects that can
trigger the hiding.

5‘5’ Do not confuse the On Hide event with the Hide action. You cannot place On Hide after another event.

Drop On [_‘STJJ

This event occurs when another object is dropped on the object. Drop On is often followed by an If action that
checks which object was dropped.

Drop On is great for interactive games and CBT material. Create online puzzles. Drop a flag on the
corresponding country. Drop an accounting term in the correct balance sheet item. Build a house with different
building blocks. And so on.
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ool
Collision [

This event occurs when two objects hit each other during an animation. Both objects must have the property
‘Collision detection' checked.

Use this event to play a sound when two objects collide, start another animation, explode the objects, etc.

Events only available on specific objects
Y

Marker Hit IE

This event is unique to the Media Player object. It is triggered when a marker point (in the video or sound played
in the Media Player) is encountered. To insert markers in a file you must use a special program such as the
Media File Editor contained in the Windows Media Encoder. See "The Media Player object" for more
information.

Use this event to show pictures or text at any given point during a piece of music or video. You can also start an
animation, or any other action.

b
Document Complete

This event is unique to the Embedded Document object. It is triggered as soon as the web site, picture, or web-
based document download is complete. See "The Embedded Document object"” for more information.

Use this event to play a sound to inform the user of the completion of the download, start an animation as soon
as download is complete, get perfect control of online timelines, etc.

On Select \ﬁd

This event is unique to the List box object. It is triggered every time the user selects an item in the list box so that
you can check it and execute the appropriate action(s). See "The List Box object" for more information.

On Change S

This event is unique to the Input object. It is triggered every time a character is entered or deleted on the input
object. It gives you complete control of the contents of the input object as you can validate the contents every
time a change happens. See "The Input object” for more information.

Fi
On Ready State Fﬁ!l

This event is unique to the Flash object. It is triggered every time a change occurs in the state of the Flash file.
See "The Flash object" for a list of the possible states.

ActiveX

The ActiveX event is unique to the ActiveX object. See "The ActiveX object" for more information.
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Actions

Standard
Go to Page (Standard tab)

'th The Go to Page dialog lets you go to another page in your project.

As soon as you drop the Go to Page action into the active field, the Go to Page dialog appears.

B Go to Page [Z|

Fage:

a0 Fade | Special | Scroll | £oom | Saft Heveal| Reveal

<:|::|:> | Duration [mz]:
I = ||:| |
Curtain Open
Speed caontral;
I [@ =8 1 0
Curtain Cloze Zoarn Lines o
Center Presig:
Small Center  Medium Center
Tiles Tiles
Cu a0 v
Help Ok, l [ Cancel

Every time you drag a Go to Page action into the active field, a page list opens. This page list contains all the
available pages as well as some special pages described below. In this picture, we only have one normal page
(Pagel).

@Previous
@PFreFage
(@FirgtChild
@Parent
@PreviousParent
(@ extParent

Mew... ][ 1] H Cancel
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» Choose the page you require and close the dialog by clicking OK.

Q Double-clicking the page closes the Page list automatically.
> To select a different page in an existing Go to Page action double-click the action in the active field. The
dialog opens and you can click the Browse button 5 next to the 'Page’ field to open the page list.

You can also drop the Go to Page action in the active field before you have actually created the page you wish to
go to:

> To create a new page simply click New in the Go to Page page list.

[ Mew... ][ ak. ][ Cancel

The new page is inserted in the Page list and selected as the page you wish to go to.

The 'Page' field also accepts variables. This allows you for instance to go to a page previously
selected by the user from a menu of pages and stored in a variable. For more information on variables and
expressions, see "Using expressions".

Using the special @pages
All the pages whose name start with '@" in the Go to Page page list have a special function.
See "Using the Page list" for more information about pages and sub-pages.

@Next: Goes to the next page at the same level in the Page list. If for instance @Next is attached to a head page,
Mediator will turn to the next page placed at the same level as the head page, ignoring any sub-pages. If @Next
is attached to a sub-page, Mediator will go to the next sub-page at the same level in the list, provided both sub-
pages belong to the same parent page.

@Previous: Goes back to the page immediately preceding the current page in the Page list, at the same level
(head page to head page, sub-page to sub-page, etc.). If for instance @Previous is attached to a head page,
Mediator will turn to the previous head page, ignoring all sub-pages. If @Previous is attached to a sub-page,
Mediator will go to the previous sub-page at the same level in the list, provided both sub-pages belong to the
same parent page.

@PrePage: Goes back to the page visited last. Since this function can be used on different pages (head pages,
sub-pages, sub-sub-pages etc.), you can skip through several levels of pages. When called several times, this
function behaves as a history list, allowing you to return to the last pages visited in reverse order. The maximum
number of past pages which can be revisited is 19.

@FirstChild: Goes to the first sub-page of the particular page, i.e. the first of the pages inserted as sub-pages of
the page you are currently on.

@Parent: Goes from any sub-page to its parent page (where parent page means a page at the level immediately
above, e.g. sub-page to head page, sub-sub-page to sub-page, etc.).

@PreviousParent: Goes from any sub-page to its previous parent page in the Page list.
@NextParent: Goes from any sub-page to its next parent page in the Page list.

Selecting a page turn effect

Once you have selected a page you return to the Go to Page dialog. The name of the page now appears in the
'Page’ field. The rest of the fields are used to determine how you want the page turn to look, by selecting an
effect and its settings.
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B Go to Page g|
FPage:
|F'age1
3D Fade | Special | Scroll | Zoom || Soft Reveal | Reveal
‘,:l: :|,‘>_ | Duration [mz]:
Moarmal Curtain Open
Speed control:
[ =1 1 1
Zoom Lines .
Center Presiew:
Smal Center  Mediurm Center
Tiles Tiles
N e L
Help OF. l [ Cancel

Effects are split into several different categories.
» Click one of the tabs to see all the different effects available in that specific category.

» Click an effect to see a preview of the page turn in the Preview window in the bottom right corner. To
display the page without any effect, select Normal in the Reveal tab.

Notes:

e Mediator includes some real 3D effects for use in page transitions. These Direct 3D page transitions work on
any computer with a graphic card that supports Direct 3D 9.0 (standard for most of today's PC's). If a
Mediator project is shown on a computer without Direct 3D 9.0, a normal transition is used.

e HTML and Flash documents do not have as many page transitions available as documents of type Standard.

QI If your project frequently turns to the same page, it is a good idea to use the Random effect. The Random effect uses
effects from all the categories except Reveal. It is located in the Special tab.

Duration: Here you set the exact length of time you wish the effect to last. The time is set in milliseconds to
give you extreme precision (1000 milliseconds = 1 second). Each effect has its own default duration (varying
between 200 and 2000 milliseconds), but you are free to specify the amount of time you wish to allocate for the
effect.

The Duration field accepts variables and expressions. You can for example specify a variable
instead of a fixed value so that when the page turn starts, the current value of the variable is read and used as its
duration. You can change the variable during a page turn. This has no impact on the current page turn, but will
apply to any subsequent page turn using that variable. For more information on variables and expressions, see
"Using expressions".

Speed control: The four icons under 'Speed control' symbolize the acceleration of the effect.

You have four acceleration effects to choose from: None, Accelerate, Decelerate, Combination. Some effects
may look better with one type of acceleration than another. Experiment to find out what kind of acceleration you
prefer for different effects.

J = No acceleration
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J = Acceleration
J = Deceleration

J = Acceleration then deceleration
Creating your own effects

This section is primarily aimed at advanced users. However, the principle of creating your own
effects is very simple.

Imagine a gray-scale picture used to determine how the new page will be revealed: the pixels of the new page
corresponding to black areas of the gray-scale picture will be revealed first, whereas those corresponding to
white areas of the gray-scale picture will be revealed last. The pixels of the new page corresponding to gray
colors in the gray-scale picture will be revealed according to the degree of darkness of these gray colors (i.e.
pixels corresponding to darker areas being revealed before those corresponding to lighter ones). You set the time
duration for the whole effect in the Go to Page dialog.

If for instance you create a gray-scale effect picture containing only black and white areas, the areas of the new
page corresponding to the black areas of the gray-scale picture will be revealed immediately. Once the time you
set in the Duration field (let's say 2000 milliseconds) has elapsed, the areas of the new page corresponding to the
white parts of the gray-scale picture will be revealed.

If your effect picture is graded from black to white (black at the top, white at the bottom) the page turn will start
at the top and progress downwards revealing more and more of the new page.

» To see some demonstration effects made with gray-scaled pictures, click the Reveal tab in the Go to Page
dialog.

The gray-scaled pictures used for the effects can be found in a folder named Picture Effects in the Mediator
installation folder. If you would like to create your own effects, take a look at some of the gray-scaled pictures in
this folder and check the effects in Mediator (a picture has the same name in the folder as the effect it generates).

This way you will get a good idea of how a gray-scaled picture can look so that you can generate the exact effect
you would like to create.

To make your own effect picture to use as a page turn effect in Mediator, follow these next steps:

» Create a new picture in your picture editing program as gray-scale, 8-bit (256 gray colors) or open an
existing 8-bit, gray-scaled picture.

The size and the format are not relevant, as Mediator automatically converts the picture to the appropriate
document size. The recommended format is the standard 4x3 format (320 x 240 or 640 x 480 pixels).

» Save the picture as JPG (e.g. myeffect.jpg) in the Picture Effects folder of the Mediator installation folder.
You should compress the picture so that it is as small as possible. The quality of an effect picture is not what
determines the quality of the effect.

. . e . . . <] .
Next time you start Mediator you will find your effect in the Reveal effect tab with a custom icon I—_"’..-! above it.
Your effect will have the same name as your picture file.

Q You can use alpha channels as effect pictures.

Show/Hide (Standard tab)
Show

E  You use the Show action to make objects that are hidden become visible. This action is only relevant to
hidden (invisible) objects.

When you drop the Show action in the active field the Show dialog appears.
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This dialog is almost identical to the Go to Page dialog, which is described in detail in the topic on the "Go to
Page" action.

M Show Object (%]

Ohject

| |

a0 Fade | Special | Scrall || Zoom Sn:nftF!e'-.feaI| Reveal
<:|::|:> || Duration [rns]:
L] ~ | [s0
MNarmal Curtain Open

The main difference between the Show dialog and the Go to Page dialog is that instead of selecting a new page,
here you select the object you wish to show.

» Click the Browse button @ next to the 'Object’ field to display the object list.

»  Select the object you wish to show.

@Thiz0Object S
[EE Buttan
A Headline
[A] Temt
{J Polygan
@ Ficture

&0 Drawing |
é LniPath

() Flash
W AniGif

| &

[ 1] l [ Cancel

Most of the effects are the same as in the Go to Page dialog.
» Click an effect to see a preview in the Preview window.

» When you have decided on the effect and possibly modified speed and duration settings, click OK.
Hide
2 The Hide action does the opposite of the Show action: it hides currently visible objects. The Hide action is

only relevant to objects that are visible at the start of your project or become visible during it.

When you drop the Hide action in the active field the Hide dialog appears. This dialog is identical to the Show
dialog.

» Click the Browse button @ next to the 'Object’ field to display the object list.
»  Select the object you wish to hide.

You have all the same effects available as in the Show dialog.

» Click an effect to see a preview in the Preview window.

» When you have decided on the effect, click OK.
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9? Do not confuse transparent objects and hidden objects. They are both invisible, but transparent objects
(often used as hotspots) are still able to react to events whereas hidden objects cannot.

Timeline (Standard tab)

g The timeline is ideal for executing actions in a specific sequence or after a given period of time.

As all other actions, the timeline is started by an event such as a mouse click. You can use the timeline to go to
another page after a few seconds (very useful for automatic slideshows), or for more complex tasks such as
showing and hiding objects while playing some music.

When you drop the Timeline action in the active field, the following dialog appears. It is very similar to the
Events dialog.

= Standard | kultimedia | Extemal | Programming | Databasze || Uzer
I O C
% = = =
. Go ko Page Shiow Hide: Timeline Sek Cursar
< >
Time [z] Duration [mz]  Loom [£] Gnid [mz]
|1.un | |5IZIIII | |5 | |1un |
1 1 1 1 1 1 1 1 1 1 1
0ms 1.00 2 2,00 ¢ 300 = 400 ¢ 2,00
| ok [ Cancel

The horizontal bar at the top contains all the same actions as the Events dialog.

& o .
The same clipboard icon N and wastebasket icon — are shown on the left of the actions bar. Under the
actions bar, there are four new time fields which we will describe shortly.

The large white field in the middle is the timeline. It contains several "tracks" to give you a better overview of
the different actions that are placed on it. To see more tracks or expand the timeline, simply pull the edges and
corners of the entire Timeline dialog (or use the scroll bars).

» To place an action on the timeline, drag it from the action field.
Just as in the Events dialog most of the actions open their own dialog.
»  Fill in the dialog and click OK to return to the timeline.

Where applicable (Go to Page, Show/Hide etc.), the timeline track is shaded to represent the time you have
allocated for the action. Some actions do not have a duration.
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When you drag a Sound action on the timeline, a wave form appears to represent the sound. This makes it very
easy to synchronize other actions with the sound. You can for instance record a speech and add visual effects
later, using the wave form as a guide of where to place the actions for perfect synchronization. This technique
works best for sounds that are reasonably short, with easily identifiable gaps and beats.
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» To change any of the settings of the action later, simply double-click its icon to open the action dialog.
The four time fields above the timeline help you place your actions very precisely.

Time [z] Diuration [mz]  Zoom =] Gnid [mz]

1.00 500 5 100
Time (s): This field indicates the delay after which the selected action is executed.

Duration: This field shows the time the selected action should take.

The Duration field accepts variables and expressions. You can for example specify a variable
instead of a fixed value so that when the action starts, the current value of the variable is read and used as its
duration. You can change the variable during the execution of an action. This has no impact on the action
currently running, but will apply to any subsequent action using that variable. For more information on variables
and expressions, see "Using expressions".

Zoom: In this field, you decide how much (or little) you want to see of the timeline (in milliseconds, 1000 ms =
1 second). Increasing the Zoom factor will give you a better overview of the timeline when it contains many
actions. When trying to synchronize actions with a sound on the other hand, lowering the Zoom factor will allow
you to see the wave form in more detail.

Grid: This sets the accuracy of the timeline (in milliseconds).

e Example 1: If Grid is set to 100 (milliseconds) you can place actions on the timeline at intervals of 0.1
second (100 milliseconds = 0.1 second). This means that you can place an action at 1.20 seconds or 1.10
seconds, but not at 1.15 seconds.

e Example 2: If Grid is set to 10 (milliseconds) you can place actions on the timeline at intervals of 0.01
second (10 milliseconds = 0.01 second).

The grid is very useful when you want to start several actions at exactly the same time or place actions one after
the other with exactly the same time interval between them.

When synchronizing actions with a sound, a low grid value will help you position the actions more precisely.

Q When actions are placed at the same time mark, they are executed in random order. Leave a small gap between the
actions if the order of execution is important.

274



Selecting actions

e To select an action on the timeline, click it once.
e To select several actions, press and hold down the Ctrl key while you click each action.

Moving actions

» To move one or more actions on the timeline, click them to select them, then drag them to the desired point
on the timeline (let go of the Ctrl key but hold down the left mouse button while moving the actions).

Changing the duration of an action

>  Select the action on the timeline, then place the mouse pointer over the end of the action's shaded track until
it changes to an arrow.

Rectangle
g L 700ms

Ernimate

‘_
400 g

1.00 5

O  250ms | 500ms 7S0ms | 1.00s  125s 150  175s  2.00:

» Drag the track edge in the required direction.

QI To change the duration of several actions in one go, select them and drag the edge of one of them.

You can also of course double-click the action and change its duration from within its dialog (e.g. Go to Page,
Show/Hide etc.).

If you have used a variable instead of a fixed value in the Duration field of the action, you can also change its
duration by changing the value of that variable.

Cutting, copying or deleting actions

e To cut actions from the timeline and place them on the clipboard, first select the actions you wish to cut as

described above and drag them to the Clipboard icon M in the top left corner of the timeline while
holding the Shift key down. Let go when the pointer is on top of the Clipboard icon.

You can also right-click the selected actions and choose Cut in the local menu.

—- -

e To copy actions, just drag them to the Clipboard icon M (the shape of the mouse pointer changes to a +
sign). The actions remain on the timeline, but are also placed on the clipboard where they will stay until you
replace them with other actions.

You can also right-click and choose Copy in the local menu.

=

e To delete selected actions, press the Delete key or drag them to the wastebasket -
You can also right-click and choose Delete in the local menu.

When you delete actions, they are removed from the timeline and not placed on the clipboard. You can
restore deleted actions by choosing Undo in the Quick Access Toolbar.

Pasting actions

» Move the mouse pointer to the Clipboard icon I[-:}Jl click and drag the actions back onto the timeline (the
shape of the mouse pointer changes to a + sign).

You can also right-click the timeline and choose Paste.
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Saving actions in the User tab

As the Windows clipboard, the Timeline dialog clipboard is only useful as temporary storage. Anything stored
on the clipboard is lost when something else is placed on it or when the computer is shut down.

You can however save actions permanently in the User tab of the Timeline dialog. To do this:
> Open the User tab at the far right of the Timeline dialog.

» Drag the selected actions to the User tab.

To re-use these saved actions:

» Open the Events or Timeline dialog of the page or object you are programming.

» Drag the actions from the User tab into the active field.

Set Cursor (Standard Tab)

7
bt S ;
$ X This action lets you change the shape of the mouse pointer.

When you drop the action in the active field the Set Cursor dialog appears.

Set Cursor §|

ok ol o
0% o+ o

) Irwisible

() Custam cursor file

5] [caea ]

Invisible: The pointer disappears.

Normal: The normal pointer. Use this to restore the original appearance of the pointer.

Help: Turns the pointer into a question mark pointer.

Stop: Turns the pointer into the stop pointer (for instance to highlight areas that do not react to mouse clicks).
Wait: Turns the pointer into the hourglass pointer.

Cross: Turns the pointer into a cross pointer.

Hand: Turns the pointer into the pointing hand pointer.

You can also choose a Custom cursor file (*.cur or *.ani):
. o . .
» Click the Browse button - to access the Open dialog and select your pointer.

@ Only the Normal and Hand pointers are available when working with HTML or Flash projects. In these
exports, the pointer returns to its standard shape after each page turn.

Move Cursor (Standard tab)

R, #
L
PLE" This action lets you move the mouse pointer to any point on the screen.
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When you drop the action in the active field the Move Cursor dialog appears.

Move Cursor, ['5_<|

Mew pozitian

% |0 N

Y [0 |

Diuration [mz]:
| 999 |

o e ]

In the X and Y fields you set the coordinates of the position you wish to move the pointer to. It is however often
easier to use the Pick tool (see below).

Duration: Here you set how long (in milliseconds) you would like the pointer move to last. The speed of the
pointer move depends on how far the pointer has to travel when the action is started.

The Duration field accepts variables and expressions. You can for example specify a variable
instead of a fixed value so that when the action starts, the current value of the variable is read and used as its
duration. For more information on variables and expressions, see "Using expressions".

When you click the Pick button the pointer changes to a cross. Click the position on the screen where you would
like to move the pointer. The X and Y values will be set automatically to that position.

5? Mediator ignores all other events and actions while the pointer is being moved.

Exit (Standard tab)

X

In test mode, you are returned to design mode.

In the exported version of your project, Exit closes (ends) it.

Multimedia

Set Property (Multimedia tab)

hj The Set Property action lets you change one of the properties of any given object at runtime.

When you drop the Set Property action in the Events dialog active field, the following dialog appears:
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X

Set Property

Object:
| |

Froperty

| 4

) Constant value

Duration [mz);

B (&)
] H Cancel ]

Object: Select the object whose property you would like to change.

Property: Select the property required (click the arrow to choose from a list of all the properties applicable to
the object).

Constant value: Most properties are set using numbers, e.g. Width and Height, and you may enter the new value
in this field. If you have selected a color property (color, glow, shadow) a color button appears:

() Corstant value DD

> Double-click the button to open the standard Color dialog and select the preferred color.

Value as expression: You can use this field to enter the new value of the property as a variable or expression.
You can refer to one of the selected object's own properties or to another object's property using the
Object.Property notation, where Object is the name of the object and Property the name of the property.

The Expression button fx helps you create expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".

Example 1: To make the width of one object (Picture) the same as that of another object (Rectangle) fill in the
Set Property dialog as follows:
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Set Property

Object:

| Picture |
Froperty
width v|

) Constant value I:I

(%) Value az expression

| Rectangle.\width |

Duration [mz);

L | (]
| 0K |[ Caricel ]

Example 2: To make the height of one object (Rectangle) the same as the width of another object (Picture) fill in
the Set Property dialog as follows:

| Set Property [Z|
Ohbject:
|F|e-:tangle |
Froperty
|Height v|

) Constant value I:I

) Value as expression

|F'i-:ture.Wi-:Ith |

Diuration [mz]:

° (£
[ OK |[ Cancel ]

Example 3: To change the value of a property repeatedly every time the user clicks a button, enter:
Object.Property + value in the "Value as expression' field (where value can be a fixed value, a variable, or the

content of an input object).

(*) Walue as expression (#) Value as expression (#) Value as expression

| Rectangle. \Width+100 | A ectangle Width+ | Rectangle \Width+ nput. T ext

Duration (ms): Here you set the exact length of time you wish the property change to last. The duration is
specified in milliseconds (1000 milliseconds = 1 second).

The Duration field also accepts variables and expressions. You can for example specify a variable or the content
of an input object instead of a fixed value.
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Diuration [mz]: Dhuration [mz]: Duratian [mz];
2000 Time [rput. Test

When the action starts the current value of the variable or expression is evaluated and used as its duration. You
can change the variable or expression during the execution of the action. This has no impact on the action
currently running, but will apply to any subsequent action using that variable.

Example: If you want to move an object to a different X position (stored in a variable) and want to make sure
that the speed is always the same, regardless of how far the new X position is from the current position, you
could use the difference of the two X values as duration (multiplying it or dividing it by an adequate factor if
necessary).

Changing several properties
Each Set Property action lets you change one property of any object on your page.

If you wish to change more than one property on an object, simply drag in more Set Property actions, and select
the same object, but different properties.

S = = =

hovize Click Rectangle Rectangle Rectangle
Q You may also consider using the Animation Track action. This lets you select all the properties you need in one action.

@ If you execute several Set Property actions with a set duration on an object, and then execute a Set Property
with a zero duration on that same object the Set Property actions in progress are ended. To avoid stopping the
existing actions, set the Duration to 1 millisecond.

Animate (Multimedia tab)

‘EM The Animate action lets you move objects across the screen.

Before the animation can happen, you need to define the animation path that the object must follow. See "The
Animation Path object" for more information.

As soon as you drop the action in the active field the following dialog appears:
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Object to animate: Here you select the object you wish to animate. Click the Browse button 15l and select the
object from the Object list.

R

Animation path: Here you select the animation path the object should follow. Click the Browse button and
select the animation path from the Object list. This assumes that you have already created an animation path for
the object to follow. If you have only created one animation path it will automatically appear in this field.

Duration: Here you set the duration of the entire animation, in milliseconds (1000 milliseconds = 1 second).
The time is independent of the 'Speed control' described below.

The Duration field accepts variables and expressions. This means that you can specify a variable
instead of a fixed value in this field so that then the animation starts, the value of the variable will be read and
used as its duration. Changing the value of the variable during an animation only affects subsequent animations
that use the variable. For more information on variables and expressions, see "Using expressions".

Under the Duration field, you have four radio buttons. Each one selects a different type of animation. The type
you choose determines the starting point for the animation:

e Normal: The path followed by the object is entirely determined by the animation path. When the animation
starts, the object "jumps" from its current position to the first point of the animation path. It then follows the
animation path until it reaches its last point. Since the jump often looks unnatural, this option is normally
used only when the object is initially hidden. You can check 'Auto show object' to automatically show a
hidden object when the animation begins.

e Use object as first animation point: Rather than starting at the first point of the animation path, the
animation starts at the current position of the object. In effect, the first point of the animation path becomes
the second point of the animation. The object starts by going from its current position to the first point of the
animation, then continues along the path. The time set in the Duration field covers the moment when the
object starts moving to the moment when it reaches the final point in the animation path.
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e Fly to object position: Here the position of the animation path is determined by the initial position of the
object. The entire animation path is displaced, so that its end point coincides with the initial position of the
object. You can use this option to make an object "fly" into the screen by following the animation path until
it reaches its initial position. This option is normally used when the object is initially hidden.

e Fly from object position: Here again the animation path is relative to the object's initial position. The entire
animation path is displaced so that its start point coincides with the initial position of the object. This option
is useful to make objects "fly" off the screen. It is most commonly used when the object is visible before the
animation starts.

Reverse: Check this option to make the object follow the animation path from its last point to its first point. This
is convenient if you want to animate an object back and forth along a complex line or curve, or to animate
several objects from both sides of the screen along the same type of path.

Repeat: This option lets you restart the animation as soon as the object reaches the end of the animation path.

Auto show object: If this box is checked, hidden objects are automatically shown when the animation starts.
This is useful when you have several hidden objects that you want to animate one by one, or to animate an object
along an animation path that starts outside the screen.

Follow animation path angle: Check this option to make the animated object rotate automatically in the same
direction (angle) than that of the animation path at any point. The object will therefore orientate itself in the
direction of the animation path as it follows it. In most cases, this makes the animation look more natural.

Speed control: This group of controls let you set the acceleration of the animation. By default, the animation
speed is constant.

Speed contral

— B
R
e

:

L

The speed buttons represent the object's acceleration and deceleration during the animation.
e A horizontal line means that the speed does not change.
e Anupward pointing line means that the object accelerates.

e A downward pointing line means that the object decelerates.

»  Click the speed button that gives you the best appearance for your animation.

Animation Effect (Multimedia tab)

-
AB " The Animation Effect action lets you animate an object across the screen while splitting it up in small
pieces, referred to below as "bricks".

As soon as you drop the Animation Effect action in the active field the Animation Effect dialog appears. Its top
half is shown here:
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Object to animate;

E
Animation path:

AniPath (el

Duration [rz): Help
1000

Brick delay [ms]:

100

Object to animate: Here you select the object you wish to animate. Click the Browse button <l and select the
object from the Object list.

Animation path: Here you select the animation path the object should follow. Click the Browse button and
select the animation path from the Object list. If you have only created one animation path it will automatically
appear in this field.

Duration: Here you set the animation time for each brick. You set the value in milliseconds (1000 milliseconds
= 1 second). The time is independent of the speed control.

The Duration field accepts variables and expressions. This means that you can specify a variable instead of a
fixed value in this field so that then the animation effect starts, the value of the variable will be read and used as
its duration. Changing the value of the variable during an animation effect only affects subsequent animations
effects that use the variable. For more information on variables and expressions, see "Using expressions".

Brick delay: Each brick is animated along the animation path. Here you set the delay between each brick in
milliseconds.

Defining the brick size

The options shown in the 'Brick size' part of the dialog vary depending on the object being animated.

Text-based objects

If you have selected a text-based object (headline or text object), the 'Brick size' part of the dialog will look like
this:

Brick size (¥ Fly to object [Show)]
(*) Line () Fly from object [Hide)
O wiord () Move object

() Character [ Shuffle

Line: Click to animate the selected text object one line at a time (this only works with text objects made up of
several lines as a headline consists of one line only).

Word: Click to animate the selected text-based object one word at a time.

Character: Click to animate the selected text-based object one character at a time.

Q To show one character at a time without animating the characters, create an animation path with just one animation
point. In the Animation Effect dialog select ‘Character’ and 'Fly to object'.

@ Glow and shadow are disabled while the animation effect is running. As soon as the animation effect is
complete glow and shadow are applied.
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Other objects

If you have selected any other type of object or group (not text-based), the 'Brick size' part of the dialog will look
like this:

Brick size (%) Fly ta abject (Show)
Wfidth: | 20 () Fly from obiject [Hide]
Height: [20 () Move object

[ ] Shuile

When the animation effect is executed the selected object or group is divided into bricks and each brick is
animated along the selected animation path. Here you select the size of the bricks that your object or group will
be divided into.

Width: Sets the width of the bricks in pixels.
Height: Sets the height of the bricks in pixels.

Unless you select the Shuffle option, the first brick shown is the top left corner brick, the second brick shown is
the second brick in the top row, then the third in the top row, and so on until the last brick in the top row. Then
the first brick in the second row, second brick etc.

Division of objects into bricks

The number of pixels entered in 'Brick size' is used to divide the object into bricks, going from left to right, top
to bottom. If however the object size values are not exactly divisible by the brick size values (and therefore do

not result in whole number values), the bottom row bricks and/or right-hand side bricks will be larger than the

other bricks.

Animation effects look best when all bricks are the same size. Therefore it is often a good idea to take the time to
calculate a height and width that will work well for the specific object:

e Check the size of the object in its Properties dialog (Height and Width in the General tab).

e Choose an appropriate size for your bricks, by finding a number that your object is divisible by.
e Enter this brick size in the Animation Effect dialog.

Defining the effect

On the right-hand side you define the animation effect.

Fly to object (Show): Check this option when you wish to show an invisible object or animate an object that is
located outside the page. The object is divided into the specified bricks and animated one brick at a time. When
the animation is over the object remains shown.

Fly from object (Hide): Check this option when you wish to hide a visible object or animate an object off the
page. The object is divided into the specified bricks and animated one brick at a time. When each brick
animation is over the brick is hidden.

Move object: Check this option when you wish to move a visible object on the page. The object is divided into
the specified bricks and animated one brick at a time. When the animation is over the object remains shown.

Shuffle: When this option is unchecked the bricks are animated one by one starting from the top left corner or
with the first letter, word, or line. Check it to animate the bricks randomly.

Defining the speed

The bottom of the dialog lets you set the speed of the effect, exactly as with the Animate action. See "Animate"
for details.
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Speed control
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Calculating the overall duration

The total duration of the animation effect can be calculated as follows:

[(number of bricks - 1) x brick delay] + Duration

Animation Track (Multimedia tab)

ﬁj The Animation Track action gives you complete control over object positioning during an animation. It
also lets you change one or more object properties simultaneously, even while animating the object. See
"Appendix 2: Mediator object properties” for more about all the available properties.

When you drop the Animation Track action in the Events dialog active field the Animation Track dialog appears.

The top of the dialog looks like this:

B Animation Track §|

Object: Arnimnation path;

@ @ (%) Marmal
!jﬁ«utu-shnw | !:'Fiepeat | () Fly to object position

() Fly from object position Help

»  Select the object whose properties you would like to change in the Object field
»  Select the animation path you would like the selected object to follow in the Animation Path field.

Selecting an animation path is optional, and you can use the Animation Track action to change properties on the
selected object without animating it.

Auto-show: Shows a hidden object when the animation starts
Repeat: Repeats the animation endlessly

Normal: Normal animation (starts at first animation point)
Fly to...: Animation finishes at current object position

Fly from...: Animation starts at current object position

Using the PathPosition track

When you select an animation path Mediator asks you if you would like to add a "PathPosition track".

The PathPosition track lets you animate an object back and forth on an animation path. You can set the total time
for the animation, and decide when and where on the animation path you want to reverse or pause the animation.

285



e |f you click No the object will be animated along the selected animation path, using the method you select
(Normal, To, From) and the time allocated at the bottom of the Animation Track dialog.

e Ifyou click Yes a PathPosition track is added.

The PathPosition track looks like this:

| 100 |[PathPosition »

.

0ims 500 ms 400 ms B00 ms 800 ms 1000

@ Remember that you can resize most dialogs in Mediator by pulling the sides or bottom of the dialog.

The PathPosition track (and all other tracks added in the Animation Track action) have two fields labeled 0 and
100 on their left-hand side. These are percentage fields indicating the starting and finishing point of the
animation path, 0 representing the first point of the path, 100 the last point of the path.

The bottom right of the dialog shows the allocated time (1000 ms by default). You can change the time by
clicking the field and entering a new value. The timeline shown at the bottom of the dialog indicates the time
used for the animation.

The PathPosition track holds two nodes connected with an upward sloping line. A PathPosition node is a
reference point (not a point on the animation path) that indicates where - as a percentage - the animated object is
on the animation path.

The two nodes are by default always placed at 0 and 100, but you may change this if you like. Placing the nodes
at 0 and 100 means that the object is animated from the first point of the animation path to the last. However,
you can add more nodes to slow, speed up, reverse or pause the animation.

Adding nodes
» Click Add Node to place another node on the track.

The cursor changes to a cross and you can click anywhere on the track to place a new node. A yellow dot (node)
is placed on the track connecting the nodes between which it is placed.

e Anupward sloping line between two nodes indicates that the animation is proceeding along the animation
path.

e A downward sloping line between two nodes indicates that the animation is reversed.

e A straight horizontal line between two nodes indicates that the animation is paused.

@ The steeper the slope is between two nodes, the faster the animation moves in the corresponding time span.

Often it is impossible to place the node exactly where you want to. For complete control over the position, you
may enter the placement values manually in the fields under the track. The values are set in milliseconds (1000
ms = 1 second).

| 454  #| 73

The left field is the time placement of the node (X axis). The right field is the animation path completion
percentage (Y axis).
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Selecting and manipulating nodes

Any new node you place is shown in yellow, indicating that it is the currently selected node.
» To select another node, simply click it so that it becomes yellow.

> Click and hold the left mouse button down to drag it (up, down, right, left) to the desired position on the
track.

You can also change the position of a node manually. When a node is selected, its placement values and curve
settings are displayed at the bottom of the dialog.

F A € BT R S T

You can change the values in the two fields by clicking them and entering a new value manually.

The curve tool lets you set the acceleration and deceleration of the animation.

S

N

» Todo this, select a node, and drag the slider to change the shape of the animation track, thereby changing
the acceleration parameters of the animation.

Deleting nodes

» To delete a node, select it and click Delete Node. You cannot undo a node deletion.

Changing the animation duration

You can change the total time allocated for the animation in the Time field (located in the bottom right corner of
the dialog). Click the field and enter the total time in milliseconds (1000 ms = 1 second).

Node positioning is not fixed, but proportional to the allocated time. When you change the total time the nodes
you have placed on all tracks (PathPosition and Property tracks) are distributed proportionally on the new time
track.

Example:

The total duration of your animation is 1000 ms. You have placed nodes at 250, 500, 750 (e.g. at ¥, ¥, and ¥ of
the total time).

You change the time to 4000 ms. The nodes are redistributed to 1000, 2000 and 3000 (still the same as ¥4, %, and
¥, of the total time).

5‘5’ The total time allocated is not unique to one track, but influences all added tracks (PathPosition and
Property tracks). Changing the Total time therefore affects all the added tracks and their nodes.
Using Property tracks

The Animation Track action also gives you the ability to change one or more object properties at runtime.

With a few exceptions (e.g. string properties such as path names or file names) all the object properties that you
see in the Properties dialog are also available as Property tracks.

You can add as many Property tracks to the Animation Track action as you would like, but you can only change
properties for one object with each Animation Track action. If you wish to change properties on several objects
simultaneously, simply drag another Animation Track action into the active field and select another object.

Q. ] ]
It -Jféz -;é,
Mouse Click @ T hiz0bject Rectangle

» Toadd a Property track, click the Add Track button.
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Depending on the selected object the following dialog appears:

Add Track X

CurveHeight ~
Curvelength
Cureelffset
(2 laB
GlovwColor
GlowD pacity
Glowiafidth
Glo,
Gl
Height
Dpacit

QutlineD azhOffzet

Outlineteight
PathPrsziting

[ Q. ] [ Cancel

» Select a property from the list and click OK to add the Property track to the Animation Track dialog.

5@ You do not have to add a PathPosition track to add Property tracks.

The look and default values of a Property track depends on the selected property:

e If you select any Color property (Color, Color2, FillColor, FillColor2, ShadowColor, GlowColor, etc.) a
color track is added.

[OulieColeni™ [ O

e If you select Height or Width a track is added with a minimum value of 0 and a maximum value of twice the
size of your document, e.g. the maximum size of any object in Mediator.

e The Opacity tracks goes from 0 to 100 (percent).

e The Size track (allowing proportional change of Height and Width) goes from 100 to 0 (percent).
Adding nodes

When you add or select a Property track the button Add Node becomes available.

A node is a time reference point that indicates when and how the selected object property changes.

> Click Add Node to add a new node.

The cursor changes to a cross and you can click anywhere on the track to place a new node.
Working with color tracks

The description below applies to any of the color tracks.

When you place a node on the track the Color dialog appears and you may select the preferred color.

The color track changes, and you can see the fade from one color to another. The further apart you place the
nodes, the longer the fade takes.

Calar2

| &ddMode | [Delete Mode| (<) 500
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Once you have placed the node, you can change the time positioning by selecting the node and dragging it to the
preferred position or enter the value manually in the time field.

O T

» Click Add Node to place another node on the color track.

Colar?

| addMode | [DeleteMode| (<) =00

Working with other tracks
Any node you place on the track is represented by a yellow dot (node).

The placement and property change of the node are displayed in the two fields below the tracks.

(O] 26 #[ 2o

The left field is the node's time placement in milliseconds (X axis). The right field is the property change (Y
axis).

Once you have placed a node, you can change the time and property positioning by selecting the node and
dragging it to the preferred position or enter the values manually in the corresponding fields.

» Click Add Node again to place another node on the track.

| 360 |[Rotate -

| AddNode | |Delete Mode| ;= (O 706 | # [ 274 v

0 mz EDIZi me 4EIEi me EEIEi I BEIEi 1t 1000
e Anupward sloping line between two nodes indicates that the property value increases.
e A downward sloping line between two nodes indicates that the property value decreases.

e A straight horizontal line between two nodes indicates that the property remains unchanged.

@ The steeper the slope is between two nodes, the faster the value changes in the corresponding time span.

The curve tool lets you set the acceleration and deceleration of the property change.
lr,r-' IFREEET] !"'I”_I

» To do this, select a node and drag the slider to change the shape of the property track, thereby changing the
acceleration parameters.
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| 360 |[Rotate »

[ sddNode | [DeleteNode] S (D e | # [ 2 v

0ims 500 ms 400 ms B00 ms 800 ms 1000

Moving and deleting tracks

» To delete a track, select it by clicking it, then click Delete Track. You cannot undo a track deletion.

When you have added more than one track the buttons Move Up and Move Down become available. These
buttons have been provided to let you move a track up or down in the Animation Track dialog for a better
overview.

Sound (Multimedia tab)
d

W
l"‘\ With this action you can start and stop a sound. As soon as you drop the action in the active field the
Sound dialog appears:

Sound E|
Fath:
[ ]Repeat
[ ] Cancel curent midi sound
[ ] Cancel curent wave sound
[ ]Uze streaming [only applies to Flash export]

Buffer [zec]:
4 Fs

w

5] [coes

@ You can also drag sounds directly from the Sounds category of the Multimedia Catalog. A Sound action is

then created automatically and placed in the Events dialog of the page or object you dragged it to. To preview

the sound, just place the mouse pointer over it in the Multimedia Catalog. See "Contents of the Multimedia
Catalog" for more information.

. ik . .
»  Click the Browse button - to choose the sound file you would like to play.

Mediator supports WAV (*.wav), MIDI (*.mid) and MPEG3 (*.mp3) formats. To include a WMA sound in your

project, use the Media Player object instead.

Repeat: If this is checked, the sound is repeated continuously until it is stopped, for instance by another Sound

action.
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Cancel current midi sound: If this is checked, any midi file currently playing will be stopped. Unless your
computer supports multiple midi sounds, Mediator can only play one midi sound at a time.

Cancel current wave sound: If this is checked, any wave file currently playing will be stopped. If you do not
stop existing wave sounds, Mediator mixes all the active sounds together.

@ The *.mp3 format is actually a compressed *.wav. In order to stop the current *.mp3 file, check 'Cancel
current wave sound'.

Use streaming (only applies to Flash export): When this option is unchecked, the sound is downloaded as soon
as the page containing the Sound action is shown. If it is checked, the sound is only downloaded when the Sound
action is triggered. Checking this box may therefore improve the performance of your Flash project if you have
several Sound actions on the page, particularly if it is unlikely that they will all need to be played.

There are however two limitations in the Flash Player that affect this option:
e You can only use this streaming option on MP3 sounds.

e Itis not possible to repeat (by setting the '‘Repeat’ option) a sound that is streamed in this way.

Buffer (sec): The default size of 4 seconds is normally suitable. If however your project uses simultaneously a
sound and a processor-intensive effect lasting more than 3 or 4 seconds, you might want to increase the buffer
size to avoid any gaps in the sound.

Sound Volume (Multimedia tab)

d

Il*faa@ The Sound Volume action lets you control the volume and balance of any sound.

Sound Yolume E|

Sound name;

Yalume
A dB
Ciuration [ms): 0 -
Balance

A S

Help ] [ (] H Cancel

Sound name: Select the sound you wish to adjust. The sound can be a sound file, a video object or a sound
resource.

Sound resources and video objects are straightforward to select, just use the Object list as normal.

With sound files you must enter the file name without the path. If you are playing a sound file, for instance
"c\data\sounds\song.wav", you reference it by entering "song.wav". You can even do this with sound files which
have been started on another page.

@ If only one sound source is present on the page it is automatically selected.

Volume: Use this field to set the new volume level, either entering it or using the slider. The scale goes from 0
to -100, where 0 is unchanged and -100 turns the volume off.
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@ Some music files and sounds are recorded at such a low volume that the sound may disappear long before -
100. Sound volume is measured in decibels, which is a logarithmic scale, not a linear scale. Entering -50 is
therefore not equivalent to turning the volume down by half. To reduce the sound volume by half, you should set
the volume to about -12.

Duration: Use this field to set the fade time to the new sound volume level (in milliseconds).

Balance: Adjusts the balance between the two speakers. This only works with stereo sound.
Possible uses

e Adjusting the sound volume for sound and music.

e Adjusting several sounds to the same volume level.

e Turning background music down when another sound (e.g. speech) is being played and turning it back up
when the other sound is finished.

e Accompanying motion on the screen (an object moves from left to right on the screen and the sound follows
the movement to give true stereo).

5@ The Sound VVolume action can only be used on sounds which have already started playing. If for instance
you want to fade in a sound, you need to use the Sound action first, then the Sound Volume action. When these
actions are placed in the Events dialog, the Sound VVolume action is executed immediately after the Sound action,
giving the required result.

Start/Stop/Pause (Multimedia tab)
Start

%

When you drop the action in the active field, the following dialog appears:

Start §|

Object/Resource:

This action lets you start a video, an animated GIF, a resource or an or input object.

&

Help ] [ k. H Cancel ]

> Click the Browse button % to open the Obiject list. Select the object you wish to start.

Stop

W

Unlike the Pause action, the Stop action rewinds the video or GIF to its first frame.

Use this action to stop a video, an animated GIF, a resource or an input object.

» Click the Browse button to open the Object list. Select the object you wish to stop.

Pause
@

» Click the Browse button to open the Object list. Select the object you wish to pause.

Use Pause to temporarily stop a video, an animated GIF or a resource.
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Wind (Multimedia tab)

# w The Wind action lets you skip back and forth in a video or animated GIF.
When you drop the action in the active field the following dialog appears.

Wind [x]

Dbject/Resource:

lad
kdin Sec bz
0 S ° &7 =
Frame:
0 : []5eek to nearest keyframe

Help ] [ k. l [ Cancel

> Click the Browse button L% next to the 'Object/Resource’ field to open the Object list and select the
required video or animated GIF.

Min - Sec - Ms: In these three fields, you set the time in minutes, seconds and milliseconds. This time value
refers to the exact position in the object that you wish to reach.

Frame: A video often consists of many single pictures, also called "frames". This option lets you wind to a
specific frame. If necessary, you can use one of the freeware tools available on Internet to determine the frame
rate of your video.

Seek to nearest keyframe: If you do not need to wind to a specific frame or an exact time position in your
video, the winding operation will often be faster if you use this option. Although most videos consist of full
frames (also called "keyframes"), they may also contain intermediary frames that only store the changes made
since the last full frame. Since the keyframes may occur only every 10 or 12 frames in the video, their use
reduces the size of the video. When you use this option, the computer can use the keyframe instantly, rather than
having to generate the picture from the intermediary frames.

Drag & Drop (Multimedia tab)

|—£TJJ The Drag & Drop action lets the end user drag and drop objects when running your project. This enables
you to create projects with enhanced interactivity, such as jigsaw puzzles, interactive games, CBT sessions, etc.

QI The Drag&Drop action is often used with the Mouse Down and Mouse Up events and the system variable @ThisObject
to refer to the object. You can find this combination in the User tab of the Events dialog.

Os 5

Maouze Down Drag & Drap
a ]
Jt Iy,

kouze Up Drag & Drop

When you drop the Drag&Drop action in the active field the following dialog appears:
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Drag & Drop E|
Object to drag:

(%) Drag
) Drop
() Toggle

Do not drag outzide window

[ ] Move dragged obiect to front

Help ] [ k. H Cancel ]

Object to drag: Select the object you wish to drag (or drop) by clicking the Browse button = to display the
Obiject list.

@ This action is not applicable to all objects. Only relevant objects are listed in the Object list.

Drag: Check this option to allow the selected object to be dragged as long as the associated event occurs.
Usually the Mouse Down event is used, so that the user is able to move the object as long as he or she holds the
left mouse button down.

Drop: Check this option to drop the object when the associated event occurs. Usually the Mouse Up event is
used (in combination with the Mouse Down event), so that the object is dropped when the user lets go of the left
mouse button.

Toggle: When this option is checked, the object is dragged when an event is triggered and dropped when that
same event is triggered again. Toggle is designed especially for the Mouse Click event, letting the user click the
object to drag it and click it again to drop it.

Do not drag outside window: The object cannot be moved outside the page (the Mediator window). It stops
when it reaches the page boundary. If this option is not checked, the user can drop objects outside the page (and
not drag them back in). Often this is inconvenient, so depending on the nature of your drag & drop, you are
advised to leave this box checked.

Move dragged object to front: As soon as an object is being dragged, it is placed in front of all other objects.
This prevents it from disappearing behind other objects.

@ Usually the object you apply the Drag & Drop action to is the object you select in 'Object to drag' (e.g.
clicking a particular rectangle lets you drag that rectangle). In that case you can use the system variable
@ThisObject to select the object. It is however also possible to click one object and drag another.

Q. If you want your dragged object to snap back to its original position under some circumstances, store its original X and
Y values in variables before dragging it. You will then be able to move it back with the Set Property action.

CD Audio (Multimedia tab)

-

*'-_:;P The CD Audio action lets you play audio tracks from a CD so that you can include high quality sound or
music in your project. This action however requires Mediator to be able to read from the CD drive. It is therefore
not suitable for use with the 'CD-ROM (without installation)' export format.
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CD Audio

) Stop
(%) Play

X)

Track:min: sec Track:min:zec

-]

Stop / Play: The CD Audio action lets you start or stop play back. Select the option required.

From / To: Here you set how many audio tracks you wish to hear by setting the exact start point and the exact
end point in the format "track:minutes:seconds".

Examples:
e From "1.00.00" to "2.00.00" (default setting) means that the first track on the CD should be played.

e From "2.01.22" to "4.03.52" means that the CD should play from track 2 at 1 minute and 22 seconds to track
4 at 3 minutes and 52 seconds.

External

Execute (External tab)
@
When you drop the Execute action in the active field the following dialog appears:

Execute [5_(|

The Execute action lets you start other programs directly from Mediator.

Application [file name]:
™ |

Command line:

E |

Dizable kediator until application ends

5] [cwva ]

Application (filename): Enter the full path and name of the program you wish to open. You can enter the

o .
program name manually or use the Browse button I to access the Open dialog.

For programs that are part of Windows, such as WordPad or Paint you don't need to enter the full path. The
program name is enough.

Note that this field accepts text expressions using a combination of fixed text (which you must place between
guotes), variables, functions etc.
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The Expression button fx helps you create such expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".

If you intend to export your project, you need to make sure that the end users will have access to the program:

» Use Prepare | Additional Program Files prior to exporting to add the main program file (.exe) and any
additional .dll files required to the project. This ensures that Mediator will include the program file(s) in the
export.

» Instead of specifying the full path, use the @ProgramDir system variable to refer to the main program file.
This ensures that Mediator will look for it in the program folder.

See "Adding data and program files" for more information on this.
Command line: Here you set the parameters for the file to be opened, i.e. its path and file name.
This field also accepts text expressions.

For instance, to open the text file MyTextFile.txt using WordPad, the file being located in the same folder as the
md8 file, the dialog should be filled in as shown here:

Execute §|

Application [file name];

"iarite

Command line:

@DocD i "MyT extFie bt

Dizable Mediator until application ends

(] 4 H Cancel ]

where Application = Write (you do not need a path for WordPad, as Mediator automatically recognizes the
program) and Command line = @DocDir+"MyTextFile.txt".

Disable Mediator until application ends: Here you can select to hide Mediator as long as the other application
is running. Mediator reappears as soon as the end user closes the application.

In practice, you should not need to use this option unless you have a particular reason for doing so. If your
application opens up in its maximized state, the Mediator window will disappear underneath it anyway until the
end user closes the application. If the application opens in a smaller window, the Mediator window is placed in
the background.

Web Link (External tab)

©

‘=< The Web Link action lets you display web documents and other data files.

When you drop the Web Link action in the active field the following dialog appears:
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Web Link X

LRL:

(%) Open a new browser window
(") Open the URL in the zame window

Only applicable when the project iz already running in a browser
window, far ingtance in HTL or Flash export.

The URL field must contain a complete LRL, including ‘http: A

-

» To create a link to a web page enter the URL address in the 'URL' field between the quotes. Note that you
need to enter an exact URL, starting with "http://".

The radio buttons are only relevant for HTML and Flash projects which are already running in a browser
window. They let you select if you want to:

e open the selected web page in a new browser window, or

e continue to use the same browser window to display the selected web page.

The URL field accepts text expressions using a combination of fixed text (which you must place
between quotes), variables, functions etc. For more information on variables and expressions, see "Using
expressions”.

You can also use the Web Link action to open a folder or a file located on your computer by entering the
relevant path with forward slashes between the quotes, e.g. "C:/" or "C:/My documents/bird.gif".

If you intend to export your project for distribution to other users, you should just enter the file name and
extension between the quotes, without the path. You will also need to ensure that Mediator includes the file in
the exported version by using the command Prepare | Additional Data Files prior to exporting. See "Adding
data and program files" for more information.

INI File (External tab)

INI
\j The INI File action helps you store information for later use. Here are a couple of examples:

e Storing scores / points / values in games, assignments, training programs etc. on the hard drive, for instance
to let the user resume from where they left the project.

e Saving the contents of your project variables when you switch between two or more Mediator documents.

e Reading data stored in database-like structures using a word processor.

An INI file is a pure text file which can be created and read by any word processor. The easiest way to create an
INI file is to use Notepad, which comes with any standard Windows installation. INI files are saved as ASCII
files. Make sure you give the file the extension 'ini', otherwise it will automatically receive the extension 'txt'.

Structure of an INI file

An INI file consists of one or more sections. Each section header is placed in brackets, e.g. [Section]. Each
section has one or more entries (the number of entries may vary from section to section). Each entry can be
assigned a different value.
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Example:

[First Section]
First entry = valuel
Second entry = valuel

[Second Section]

First entry = value2
Second entry = value2
Third entry = value2

Using the INI Action dialog
The INI Action dialog lets you create, read and write INI files.

The different fields in the dialog let you select the section and entry to read from or write to.

INI File ]

M ethod
%) Fead 0 wirite

File name:

Section;

oy
& [

Entry:

—
&

WalueM aniable:

oy
&

Default value [optional]:

oy
&

) (oot

All fields in the dialog accept text variables and expressions. You can use the Expression button £x to build
these expressions. Be aware that all fixed text strings must be placed between quotes. If you do not use quotes,
the entry is regarded as a variable. You may use a combination of variables, system variables, numbers, object
properties in the Object.Property notation, functions and fixed text between quotes, all linked with operators,
provided that the resulting expression is of text type.

For more on variables and expressions, see "Using project variables" and Using expressions".

Read / Write mode: Check 'Read' to read from an existing INI file or "Write' to write to one. If you try to write
to an INI file that does not exist, Mediator automatically creates it.

File name: Here you enter the name of the INI file and its path. If you do not enter a path Mediator assumes the
INI file is placed in the same folder as the .md8 file. To place the INI file in the user's temporary folder, use the
system variable @TempDir, e.g. @TempDir + "Filename.ini".

If you have created an INI file that you wish to include in the exported version of your project, you must add it
manually with Prepare | Additional Data Files prior to exporting. See "Adding data and program files" for
more information.

Section: Enter the section that you wish to read from or write to, but do not enter the square brackets, only the
section name. If, in Write mode, you enter a section that does not exist in the INI file, Mediator automatically
creates it.
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Entry: Enter the specific entry in the section that you wish to read from or assign a value to. If, in Write mode,
you enter an entry that does not exist in the INI file, Mediator automatically creates it.

Value/Variable:

In Write mode: Here you enter the value to assign to the Entry selected above. The value can be a fixed text
string, the contents of a text variable or a text expression using the notation Object.Property, for instance the
contents of an input object. If the variable is not of type text, you must use the STRING function to convert it to
text.

In Read mode: Here you enter the name of the text variable that the INI file action will fill with the contents of
the specific entry. If you are reading a number from the INI file, you must assign it to a text variable and use the
Assign action to convert it from text to integer or floating point. Note that you cannot use the Object.Property
notation in this field in Read mode. If you want to read the contents of the entry into an input object for instance,
you must first assign the contents to a text variable, and then use the Assign or Set Property action to transfer the
contents of the variable to the input object.

Default value (optional)
This field is only available in Read mode.

If the selected entry in the INI file does not have a value or does not exist, the variable selected in Value will be
set to the default value specified here. This ensures that your variable will always contain a value. You do not
have to enter a value in the 'Default value' field, and may leave the quotes as they are.

5@ The INI files that the INI File action refers to are ordinary INI files that can be found everywhere in a
Windows installation. Therefore the Mediator INI File action is subject to the same specifications as Windows
INI files, i.e. each file may not exceed 32 KB and each entry may not exceed 256 characters.

If data exceeding these figures is written to an INI file, the excess data is simply ignored. The same applies if
you read from an INI file exceeding these limits, so make sure your INI file respects them.

Open Doc (External tab)

Advanced

|

~— The Open Doc action lets you create, open and print external data files.

The standard actions available depend on the program associated with the file extension (e.g. bmp, doc, xls, md8,
etc.) on your computer.

When you drop the Open Doc action in the active field the following dialog appears:

Open Document g|

Diocument:

Action:

OpEmn L

[ ] Disable Mediatar until application ends

[\when erecution takes place through DDE, Mediator will not be able
ko wait until the application ends. Thiz depends on the progranm wuzed.]

[ ]Inchude document file when exporting

5] [cwes

Document: Enter the file name in this field between the quotes. Remember the extension.
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You can also use text expressions using a combination of fixed text (which you must place between quotes),
variables, functions etc., for instance @DocDir + "MyPicture.bmp".

The Expression button fx helps you create such expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".

Action: As soon as you specify the file extension in the Document field, the Action field lists the options
available for that type of file on your computer.

The most common options are Open, New, Print.

As the program associated with the file extension may be different on the end user's computer, you should only
use these common options. You must also make sure that your end users have a program enabling them to open
the file type you have selected. The Open Doc action will only work on files that are associated with a program
on the end user's computer.

Open Document §|

Document:

@Dochir + "MyPicture.brp"*

Achon;

prirto [printto)] v

edit [adit]
open [open n endz

Resize [Resize] rough DDE, Mediator will not be able
fo walk untilthe apphcahion endz. This dependz on the program uszed.]

] l [ Cancel

Select the option you require from the list.

Disable Mediator until application ends: Here you can select to hide Mediator as long as the program
associated with the file extension is running. Mediator reappears as soon as the end user closes the program.

In practice, you should not need to use this option unless you have a particular reason for doing so. If your
application opens up in its maximized state, the Mediator window will disappear underneath it anyway until the
end user closes the application. If the application opens in a smaller window, the Mediator window is placed in
the background.

Include document file when exporting: If you intend to export your project for distribution, checking this box
will ensure that Mediator includes the document in the exported version.

However if you have used an expression to specify the location of the document, you will need to include it
manually by using the command Prepare | Additional Data Files prior to exporting. See "Adding data and
program files" for more information.

Email (External tab)

|—l The Email action lets you create a message in the end user's default e-mail program.

When you drop the Email action in the active field the following dialog appears:
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x]

Send Email

To:

Subject;

File attachment:

| mi |
=1

Show dialog

Text:

) (oot

You can fill in all the fields of this dialog or leave some of them empty.

To: Enter the e-mail address between the quotes. To enter more than one e-mail address place a semicolon
between each address, e.g.myname@me.com ;yourname@you.com.

Subiject: Enter the subject of the message between the quotes.

. . . . =18
File attachment: If you would like to attach a file to the message, enter its path or use the Browse button £ to
locate it.

Show dialog: Disabling this option lets you place a ready-to-send message in the end user's Outbox without
displaying it. The end user can of course open the Outbox to see the mail.

Text: Enter the actual content of the message between the quotes.
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mailto:myname@me.com�
mailto:yourname@you.com�

x]

Send Email

To:

"zalesi@oompany. com'

Subject;

"Pricelizt"

File attachment:

Show dialog
Teut:

"Please send me your latest product brochure and price list,
Sincerely"

+name+"lrln"
+atreet+"lrn"
+zip +city+rin''
+ztate+"iln"
+countn+lrin"

[ ok [ Cancel

All the fields of this action accept text expressions using a combination of fixed text (which you
must place between quotes), variables, functions etc. This allows the contents of the various fields to depend on
input received at runtime. If you use several variables to create a street address or any other content you can use
the control characters ‘|r|n* to force a new line and '+' to combine variables and control characters. For more
information on variables and expressions, see "Using expressions".

If you attach a file and intend to export your project for distribution to other users, you should just enter the file
name and extension between the quotes, without the path. You will also need to ensure that Mediator includes
the file in the exported version by using the command Prepare | Additional Data Files prior to exporting. See
"Adding data and program files" for more information.

Open MD8 Doc (External tab)

@ This action lets you switch to another Mediator document at runtime. If both documents have an identical
layout, the jJump from one to the other is practically unnoticeable.

5@ As soon as you switch to the other document, Mediator closes the current document. This means that all the
values that you may have stored in its variables are deleted. If you want to access them from the new document
or keep them for use at a later date, you must first store them in an external file such as an .INI file, which you
can re-open when needed. See the description of the INI file action for more information.

When you drop the action in the active field the following dialog appears:
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Open Mediator Document EI

Document path:

FPage:

) ool

Document path: Here you enter the name of the Mediator document you wish to open. You can enter the

Ak .
document path manually or use the Browse button = to access the Open dialog.

If you use several Mediator documents in the same project, you must place them all in the same folder, and enter
the name of the document (with its extension but without a path) in the path field. This ensures that Mediator can
find the document you are referring to.

When you export your project to CD-ROM, Mediator does not automatically include other Mediator documents
you may have used. You must copy these Mediator documents and all their data files manually in the folder
containing the main Mediator document, before you proceed to burn the CD-ROM. You can also use the
command Prepare | Additional Data Files to perform this operation, but this is not very practical for large
projects containing many data files. See "Adding data and program files" for more information.

Page: Here you enter the page on which you want the new Mediator document specified above to open. You
must enter the page name manually and make sure that it is accurate. If you do not specify a page, Mediator
opens the new Mediator document on the first page of its Page list.

Q To make the jump from the current document to the new document as smooth as possible, make the page you are opening
identical to the page you are coming from, for instance by using the same menu on both.

5@ This action is only recommended if you have a particular reason to keep your Mediator documents separate
or if you always use the same computer to run your projects, thereby avoiding any difficulties with document
paths. In all other circumstances, it is preferable to merge the separate Mediator documents into a single
document or to build a single Mediator file from scratch in multi-user mode. See the topics "Merging
documents" and "Using multi-user mode" respectively for more information.

Report (External tab)

' The Report action takes input from the end user and uses this to generate an external output file (the
report).

Here are possible uses:
e Letting the end user fill out order forms, interest forms, questionnaires etc.

e Exporting complete text fields and screenshots to a separate document

5@ You will find a ready-made Print Page combination using Report and Open Doc in the User tab of the
Events dialog.

Using the Report action

Imagine that your project prompts the end user to make some choices, which it then saves in different variables.
You would like to let the user print a professional-looking form containing all his or her choices or e-mail it to
you.
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> Using your word processor, you first need to design the form you require, saving it as an RTF file. You can
use your company letterhead, place a picture of yourself or your company logo on the form, type an
introduction, enter a descriptive text, etc. The visual design of the form is completely up to you.

This form is referred to as the Input file.

In the following we will suppose that your project asks the end user for his or her first name and last name,
and stores the names in the two variables FirstName and LastName.

» You then define exactly where in the RTF file you want the user's choices to be inserted, by using special
tags to determine the position of each field.

These tags consist of the variable name with a % sign on either side, e.g. %FirstName%.

For instance, to export the values stored in the variables FirstName and LastName from Mediator into the
Input file, thereby generating the Output file, you must first define in the Input file where you want Mediator
to place the values.

Your Input file (created using your word processor) could look like this:
My name is %FirstName% %L astName%

When Mediator executes the Report action, it inserts the end user choices exactly where you want them in the
RTF file. The Output file is saved as a form, ready for the end user to print it or mail it to you.

In our example, if the end user enters Mark as FirstName and Smith as LastName the Output file will look like
this:

My name is Mark Smith

Q To print the Output file, place an Execute or Open Doc action after the Report action. See the topic "Printing text and
pictures” for more information.

Notes:

e Using variables and % tags lets you export not only values and pictures from Mediator, but also text or other
content from external data files by storing the information temporarily in variables and exporting it to the
RTF file.

e If you wish to place a screenshot of the current Mediator page in the Output file, enter the command
%#ThisPage,80,60% in the Input file at the position where you want the screenshot to be inserted, where 80
and 60 are the width and height of the picture (in millimeters). You can choose different values for the width
and height, as required.

Using the Report dialog

When you drop the Report action in the active field the following dialog appears.

Report §|

[npuat file:

Output file [text expression]:

] oo ]

As you can see there are not many options in the dialog, as most of the work is done outside Mediator in a word
processor.

Input file: Enter the complete path and name of the RTF file that you have prepared or click the Browse button
.‘E to access the Open dialog. This file is the basis of the Output file.
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If you intend to export your project for distribution to other users, you will need to ensure that Mediator includes
the file in the exported version, by using the command Prepare | Additional Data Files prior to exporting. See
"Adding data and program files" for more information.

Output file: Enter the name of the completed form you are going to generate. If you do not enter a path the file
is saved in the same folder as the Input file.

You can use text expressions using a combination of fixed text (which you must place between quotes),
variables, functions etc. in this field, as long as the complete expression creates a valid full path and file name.
You could for instance use a variable to let the user determine the path at runtime, or use the system variable
@TempDir to place the output file in the end user's temporary folder.

The Expression button £ lets you build such expressions. For more on expressions, see "Using expressions".

File actions (External tab)

The File actions let you create, read and write text files.

These actions are useful when you want to store information for later use, have a large chunk of text that you
want to read into an input object, or even create a batch file that you later run with the Execute action.

The File actions are fairly simple and are described below.

Assign File

U 7.9

”_I In the Assign File action you specify whether you want to read from a file or write to a file. When you
drop the action in the active field the following dialog appears:

Assign File &|

File:

kMode Result:
*) Fead v
1 Wiite

%) [ ces

You must always assign a file before you can use the Read or Write actions.

. . . a3 .
File: Enter the path and name of the file or click the Browse button = to access the Open dialog.

You can use text expressions using a combination of fixed text (which you must place between quotes),
variables, functions etc. in this field.

The Expression button fx helps you create such expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions”.

If you intend to export your project for distribution to other users, do not enter a complete path, but only the file
name and an appropriate system variable, e.g. @ TempDir. This way you can be certain that the folder you are
referring to will exist on the destination computer. If you are reading from an existing file, you will also need to
make sure that Mediator includes it in the exported version, by using the command Prepare | Additional Data
Files prior to exporting. See "Adding data and program files" for more information.
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Mode: Select if you wish to Read from an existing file or Write to a file. If you choose to write in a non-existing
file, Mediator automatically creates it.

Result: Here you may enter a boolean variable (True/False) that receives the value True if the File action
completes successfully. This lets you react to any error that may occur.

Read File

dﬁ:ﬂ The Read File action reads the text from the ASCI|I file specified in Assign File and places it in a Mediator
variable.

Read File [x]

String wariable:

| vl

Feszult;

| ¥

Fead

(%) Single line
) Toend of file

[:U Help ] [ k. H Cancel

String variable: Select the text variable into which you want to read the content of the external file. Click the
arrow to select the variable from a list or enter it manually.

9? If you have not yet created a variable you must do so using Page | Programming | Variables.

At the bottom of the dialog you can select to read just one line from the text file (Single line) or the entire text
file (To end of file).

Result: Here you may enter a boolean variable (True/False) that receives the value True if the Read File action
completes successfully. Checking this variable allows you to ensure that all the data has been read before you
use it elsewhere in your project. You can also react to any error that may occur while reading from the file.

Write File

| » ]
\j The Write File action lets you write text to the ASCI| file specified in Assign File. You can write a
specific word or phrase to the selected text file, or the contents of a variable.

Write File x|

E =preszsian ba write;

™ |

Fezult:

| v

[ ] l [ Cancel

Expression to write: Enter the complete text expression in this field. You can use a combination of fixed text
(which you must place between quotes), variables, functions etc.
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Result: Here you may enter a boolean variable (True/False) that receives the value True if the Write File action
completes successfully. This lets you react to any error that may occur while writing to the file.

Delete File

I_E If you don't want to store the text file permanently, but would like to delete it once your project has
finished using it, this action allows you to do so.

Delete File x|

File:

E &)

Rezult:
| vl

] l [ Cancel

File: Enter the path and name of the file you wish to delete. You can use text expressions using a combination of
fixed text (which you must place between quotes), variables, functions etc.

Result: Here you may enter a boolean variable (True/False) that receives the value True if the Delete File action
completes successfully. This lets you react to any error that may occur.

Programming

Assign (Programming tab)

VRN

A=2
{b With the Assign action you can give a variable a new value, combine two text variables, subtract an

integer variable from another, convert a floating point variable to text, switch a boolean from True to False, and
much more.

When you drop the action in the active field the following dialog appears.

Assign [5_<|

W ariable;

| ¥

Agzignment exprezsion:

0

] l [ Cancel

Variable: Select the variable to which you want to assign a new value. You can enter the name of the variable
manually or select it from the list of available variables. Selecting from the list ensures you avoid typing errors.

You can also use the Assign action to set the property of an object dynamically by entering here an expression
using the Object.Property notation as in the Set Property action. Refer to the appendix "Mediator object
properties" for a list of all the properties that can be set for each object.
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Assignment expression: This is where you define the value to be given to the variable selected above.

Depending on the type of the variable you have selected, the expression could be a numeric value, a text value or
a boolean (true/false) value.

If you wish to assign a fixed text string to the variable, you must place this text between quotes ("like this™). Text
that is not placed between quotes will be regarded as a variable which Mediator will expect to be able to find.

You can also use variables in the 'Assignment expression’ field. Any variable you use must be of the same type
as that of the variable selected in the Variable field. In other words you can only assign an integer value to an
integer variable, a text string to a text variable, a boolean value to a boolean variable and so on.

Note that you can change the type of a variable by using assignment functions.

You can for instance convert the value of a text variable to an integer value by placing the INT function in front
of the text variable in brackets, e.g. INT (variable).

The conversion functions available are as follows:
e To convert a Text or Floating point value to Integer: INT (variable)
e To convert a Text or Integer value to Floating point: FLOAT (variable)

e To convert an Integer or Floating point value to Text: STRING (variable)
@ You can assign the value of an integer variable to a text variable. An integer value converted to text can no
longer be used in calculations.

You can also use a combination of variables, system variables, numbers, object properties in the Object.Property
notation, functions and fixed text between quotes, all linked with operators (see the topic "Using operators™).
Text variables are combined using a + sign.

The Expression button £ lets you build such expressions. For more on expressions, see "Using expressions".

Here we combine the variables FirstText and SecondText with the text "Have Fun" and assign the combination
to the variable Full Text.

Assign &l

W ariable;

FullT ext L

Agzignment exprezsion:
FirstT ext + SecondT ext +''Have fun"

| 0K | [ Cancel

If (Programming tab)

&7‘# One of the most important programming features in Mediator is the use of conditions.
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In other words:

IF a condition is true

THEN option 1 is executed,

ELSE option 2 is executed.

When you drop the If action in the active field the following dialog appears:

If-Then-Else X
IF [Condition]

True

Standard | Multimedia | External | Programming | Databaze | User

=1

]
= Ehj C] C) s
i

G0 ko Page Show Hide Timneline =
£ ¥

THEHM [Do if condition iz true]

ELSE (Do if condition is falze]

5] [ ool

IF (Condition): Here you define the condition that executes option 1 or option 2, depending on whether it is
fulfilled (true) or not.

To determine if the condition is fulfilled (true), you must enter an expression, such as MATH = 30 or t+a+d >
36 or name = ""Peter"" etc. (where MATH, t, a, d and name are variables).

This field accepts any combination of variables, system variables, object properties in the Object.Property
notation, functions, fixed text and operators, thereby giving you extreme control on your actions.

The Expression button fx helps you create expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".

5@ Any fixed text that you want to include in an expression must be placed between quotes (“like this"). Text
that is not placed between quotes will be regarded as a variable.

THEN (Do if condition is true): Here you drag the action or series of actions (you can even start a timeline or
resource) which you want to execute if the condition is true.

The condition will be true if the expression in the Condition field is true. If you don't want to execute any
particular actions when the condition is true, simply leave the field empty.

ELSE (Do if condition is false): Here you drag the action or series of actions that you want to execute if the
condition is false. If you do not want anything to happen if the condition is false, simply leave this field empty.
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Loop/Break (Programming tab)

Advanced

Loop

i The Loop action lets you repeat an action or series of actions as fast as possible, until it is stopped by the
Break action.

When you drop the Loop action in the active field the following dialog appears:

Loop §|

Standard | Mulimedia | External | Programming | Databaze || User

= ,;,J C g A—(él

b 4 Go ko Page Show Hide Timeline S

R emember to inzert a Break, action to break, the loop. Otherwize the loop
never ends! Mo uzer input iz proceszsed while the loop iz running.

&) ool

Although you can use all the available actions, the Loop action is only relevant when working with variables in
an If-Then-Else structure, as in classical programming.

Important: As long as the Loop action is running, Mediator will not react to other interactive events. The only
way to stop a Loop action is to use the Break action (see below).

Do not confuse the Loop action with an action that repeats another action a number of times over a given
duration. To repeat an action in this way, you are advised to use a Timeline resource (see "Timeline").

Q You can also use a Loop action if you want to execute several actions one after the other in a resource, with the
guarantee that each action is completed before the next one starts: drag an empty Loop action from the Events dialog into
the Resources dialog, add the required actions to it and place a Break action at the end (without any condition).

Possible uses

o Repeat the same actions with different values, for instance to increase a counter by one. Break the loop when
the counter has reached a given value.

e Automate the same actions for different objects.

e Start the same actions from different places (breaking the loop without conditions). Just drag the loop action
by copy/paste to the Resources dialog.

Break

i}( This action is used to stop the Loop action, meaning that the repetition started by the Loop action is
terminated.
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The Break action does not have any parameters, and therefore no dialog appears when you drop it in the active
field. Since Mediator does not react to any events as long as the Loop action is running, you must always use a
Break action in conjunction with the Loop action.

The Break action is normally used in an If action that determines when the loop is to be broken (or exited) in a
Loop action (for instance when a counter reaches a given value after a certain number of iterations).

Sub Procedure (Programming tab)

; This action allows you to group other actions together for a better overview of the Events dialog if you
have a long list of actions.

It also allows you to define a series of actions that you can copy in the Events dialog clipboard, ready to be
pasted on another object. See "Using events and actions" for how to copy and paste actions in the Events dialog.

Finally the Sub Procedure action can also be used as a resource. This helps you start the same series of actions
from different places on your page, by allocating it to different objects. See "Using resources" for more
information.

When you drop the Sub Procedure action in the active field, the following dialog appears.

Sub Procedure [‘S_<|

Standard |I'v1u|timeu:|ia External | Programming || Databaze | User

fbl
o & & 8
i

Go ko Page Shio Hide Timeline i

&) ool

Just drag the actions you require and click OK.

Script (Programming tab)

P

&
—& The Script action itself is very simple. All it does is to start the script procedure you specify.
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X

Script
Script procedure nanme;

CalcMewPozition

Farameter 1:

CurrentT ime

=
&

Parameter 2
CurrentPozition

=
&

Parameter 3:

oy
&

Parameter 4:

—
)

| ok [ Cancel

You can pass up to 4 parameters to the procedure using the parameter fields. A procedure corresponding to the
above dialog could look like this:

Sub CalcNewPosition(cTime, cPosition)

End Sub

For information about how to write script in Mediator, refer to the topic "Using runtime script".

Set List Box Data (Programming tab)

h__?J The Set List Box Data action only applies to list boxes of Data type 'Page list'. It is used to add or remove
pages dynamically from a list box while the user runs the project.

By contrast, list boxes of Data type 'Index’, ‘Search word' or 'Data’ (i.e. containing respectively keywords, search
words, or your own entries) are filled from the data you enter in design mode and cannot be updated dynamically
during runtime.

You can use the Set List Box Data action to update the page list contained in a list box in different ways:

e You can for instance get the user to select a search word in one list box and use the action to display all the
pages containing the word in another list box.

e You could achieve the same result by getting the user to enter the search word in an input object and use the
action to display all the pages containing the word.

e You could also use the Set List Box Data action to create a complete list of all the pages in your project.

When you drop the Set List Box Data icon in the active field the following dialog appears:
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Set List Box Data E|

Lizt box object;

Ligthow

(%) Clear the list box and add the pages
() &dd the pages [logical OR)
) Bemave the pages not found in this set (logical AMD)
Data
(%) Contents list
) Index search
() Text zearch

fa

-

List box object: Specifies the list box object in which to add or remove pages. Click the Browse button 14 o
select it from the Object list.

Defining the list box update mode

The three options below the object field let you define how you want the page list to be updated.

Clear the list box and add the pages: This setting clears the list box before adding new pages to it.
Add the pages (logical OR): This setting adds new pages to the existing contents of the list box.
Using this option, you can obtain a list of all pages containing only one of two given words, as follows:

» Search all pages containing the first word (the search procedure is explained below) using ‘Clear the list box
and add the pages'. This clears the list box and places all the pages containing the first word in it.

» Then search all pages containing the second word using 'Add the pages (logical OR)'". This adds to the list
box any new pages containing the second word, without removing the first pages.

The list box now contains all the pages found in the first search, as well as all the pages found in the second
search. You can use this approach with more than two search words.

Remove the pages not found in this set (logical AND): This setting removes from the list box any page not
found in the search.

Using this option, you can obtain a list of all pages containing two given words, as follows:

» Search all pages containing the first word using 'Clear the list box and add the pages'. This clears the list box
and places all the pages containing the first word in it.

» Then search all pages containing the second word using 'Remove the pages not found in this set (logical
AND)'. Any page which does not contain the second word is removed from the list box.

The list box now contains all the pages found in the first search that were also found in the second search. You
can use this approach with more than just two search words.

Defining the search function

The Data field at the bottom of the dialog lets you select the Mediator list to be used as a basis for updating the
contents of the list box.

313



e Contents list

This updates the list box with a complete list of all the pages in your project (except pages you excluded by
unchecking the 'Use in Contents' option of their Properties dialog).

When you choose this option the entry field at the bottom of the dialog is not used.

QI If you are using the list box as a table of contents simply place the Set List Box Data action after an On Start event to
update the list immediately.

e Index search

This lists the pages of your project that contain the keyword typed between the quotes or referred to as a variable
in the entry field below.

e Textsearch

This lists the pages in your project that contain the search word typed between the quotes or referred to as a
variable in the entry field below.

QI If you are using the list box to show the result of a search, you could place the Set List Box Data action on a button and
update the page list box when the button is clicked.

Defining the word to be searched

If you are using this action to perform an Index search or a Text search, you use the entry field at the bottom of
the dialog to specify the word to be searched. You can either type the word itself between quotes, enter the name
of a variable containing that word, or refer to the contents of an input object or list box using the Object.Property
notation, e.g. Input.Text or Listbox.SelectedString. This allows you to search for a word entered by the user at
runtime.

e To search for a specific word enter the word between the quotes, e.g. "France".

Drata

(3 Conterts list

(%) Index search
() Text gearch

"France"

e To refer to the contents of an input object, enter the expression Input. Text, where "Input" is the name of your
input object.

Data

() Contents list

) Index zearch
(%) Text search

[rput. T est

The Expression button fx helps you create expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".
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Message Box (Programming tab)

-
k)

Message Box [‘s_<|

This action allows you to display a standard message box as a result of a particular event.

Title:

E |

Texk:

Fesult variable:

| vl
Bukkons Icon
(® 0K {(*) None
(10K, Cancel () Information
(ves, Mo () Exclamation
{1 ¥es, Mo, Cancel ) Cuuestion

{:} Skop

[ QK H Cancel ]

Title: Type here the title of the message box you want to display to the user. This field accepts text expressions
using a combination of fixed text (which you must place between quotes), variables, functions etc.

The Expression button fx helps you create such expressions. It gives you access to all the functions, system
variables and operators that are built into Mediator, as well as all the project variables you may have defined. For
more on expressions, see "Using expressions".

Text: Type here the text of the message box. This field also accepts text expressions.

Result variable: You can use this drop-down box to choose an integer variable in which Mediator will place a
value representing the button clicked by the user to exit from this message box.

The possible values are:

e 1forOK

o 2 for Cancel

e 6 for Yes

e 7 forNo

Buttons: Here you select the buttons which you want the message box to contain.

Icon: Here you choose an icon representing the type of message your message box is intended to convey.
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Database
DB Pointer (Database tab)

]
I%;| The action DB Pointer is used to move the database pointer within a database.

To find out how to connect Mediator to a database, refer to "Using databases".

Database Pointer [‘S__<|

D atabaze resource name:
Ak
=

ke bo

() First recard
) Previous record
() Mext record
) Last record

Help ] [ k. l [ Cancel

There are four options: First, Last, Previous or Next Record.

The DB pointer is always moved to the last search result. When a database is opened all records are included in
the search result. If a database contains 2000 records and a search matches 20 records, the DB pointer is moved
between these 20 records. A search that matches all records can be executed to enable the user to browse the
entire database.

DB SQL (Database tab)

tlﬂ| The DB SQL action can send a SQL expression to a database.

To find out how to connect Mediator to a database, refer to "Using databases".

SQL is a complete database programming language and it is out of the scope of this documentation to teach
SQL. However, you can find examples of the most often used SQL expressions in the "SQL statements™ topic.
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%)

Datahase SOQL

D atabaze name:

| |

SOL statement:

) (oot

SCORM
Set SCORM Variable (SCORM tab)

P T

-
LT The 'Set SCORM Variable' action lets you send data to the Learning Management System (LMS) used
when creating a SCORM compliant e-learning project.

Please refer to the topic "Using SCORM" for a complete description of SCORM and how to create a SCORM
course using Mediator.

If you want to send and save data about the student's progress to the LMS (for example to keep a record of how
well the student performed in a quiz), the 'Set SCORM Variable' action allows you to specify the name of the
SCORM variable that you want to set, and the value it should be set to.

Set SCORM Variable X

(%) Set value and commit immediakely SCORM wvariable name:

() St value but don't commit now | ~ |

Yalue expression:

E |

) Commit previously set valuefs)

o] [Ccme ]

Supposing for instance that you want to set the current score of the student in the course to 93:

» Check Set value and commit immediately.

» Inthe SCORM variable name list, select “cmi.score.raw".
» In the Value expression field, enter 93.

» Click OK.

When setting SCORM array variables (with square brackets) you must specify an array index as described for
'Get SCORM Variable'. When adding new items to the array, you must make sure you fill it sequentially.
Always start with array index 0, before adding an item to array index 1. Empty "slots" in the array are not
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permitted, and an error will result if you try to set an item in index 2 of an array that only contains one item (at
index 0). You will be able to detect such errors with the 'Get last error' functionality of the 'Get SCORM
Variable' action.

If you just want to change the content of an existing item in a SCORM array variable, you must specify the array
index by entering a number that is greater or equal to zero, and less that the number of items in the array.

The current number of elements in a SCORM array variable can be determined with 'Get SCORM Variable' and
the related "_count" SCORM variable, as shown above.

Supposing you wanted to add a new comment from the student to the list of existing comments:

> Drag a Get SCORM Variable action in the Events dialog.

» Check Get value.

» In SCORM variable name, select "cmi.comments_from_learner._count".

» In Mediator variable name, select a Mediator variable that you have previously created, e.g.
CommentCount. If the variable does not exist, Mediator will create it automatically.

» Click OK.

» Now drag a Set SCORM Variable action in the Events dialog.

» Check Set value and commit immediately.

» In SCORM variable name, select "cmi.comments_from_learner.[].comment", and type in

"CommentCount" in the square brackets so the field contains:
cmi .comments_from_learner.[CommentCount].comment

» In Value expression, enter the name of the Mediator string variable that holds the comment just entered by
the user (typically via an input object).

» Click OK.

When these 'Get SCORM Variable' and 'Set SCORM variable' actions are performed, you are guaranteed that the
new comment will be added to the end of the "cmi.comments_from_learner.[].comment" array, leaving no empty
(and disallowed) gaps.

The radio buttons in the 'Set SCORM variable' dialog determine if the new value is sent to the LMS
immediately, or if it should just be cached in the browser to be sent to the LMS later:

o If Set value and commit immediately is checked, the value will be sent and stored on the LMS
immediately, thus eliminating any risk of "losing" the value should the browser crash, or the user navigate
away from the course.

e If Set value but don't commit now is checked, the value will only be cached locally in the browser. This
means that any subsequent 'Get SCORM variable' action referencing the SCORM variable will get the
correct value (from the cache), but the LMS will not get an updated value of the variable until the course is
completed.

If you need to use many 'Set SCORM Variable' actions in a row, it makes sense not to commit each value
immediately, but to check Commit previously set values only on the last action in the row. This will commit all
the previously set values to the LMS in just one communication, thus saving time and network traffic. This is
also likely to make the Mediator project work more smoothly and appear more responsive, since the student will
only notice one delay for the data transfer, rather than many delays for multiple data transfers.

When the course is completed and the learning session ends, all cached data is automatically committed to the
LMS. It is good practice however to commit the data more often to reduce the risk of data loss, should the
browser crash or something else unexpected happen.
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Get SCORM Variable (SCORM tab)

[

Lo The 'Get SCORM Variable' action lets you receive data from the Learning Management System (LMS)
used when creating a SCORM compliant e-learning project.

Please refer to the topic "Using SCORM" for a complete description of SCORM and how to create a SCORM
course using Mediator.

Get SCORM Variable X

(%) Get value SCORM wariable name:

() Get last errar {as error code)
() Get last error (as descriptive bext)

() Get diagnostic

Mediator wariable name (For the return value):

[ (04 l [ Cancel

Supposing for instance that you want to retrieve the name of the current student:

» Check Get value.
» Inthe SCORM variable name list, select "cmi.learner_name".

» In the Mediator variable name list, select a Mediator string variable that you have previously created, or
just type in a new variable name, which Mediator will create automatically.

» Click OK.
You can now use this Mediator variable, for instance to construct a personalized greeting for the student.

The 'Get SCORM Variable' action has a few other uses, which are all related to debugging to project:

e Get last error (as error code) lets you determine if the previous '‘Get SCORM Variable' or 'Set SCORM
Variable' action resulted in an error. Generally the code returned is "0" (zero) if the previous SCORM action
succeeded. If the code returned is not "0", then an error occurred. Please refer to the SCORM specifications
for a complete list of error codes. A typical error is to try to retrieve a variable whose name is not recognized
by the LMS due to a spelling mistake (e.g. "cmi.learner_nae" instead of "cmi.learner_name").

e Get last error (as descriptive text) also lets you determine if the previous 'Get SCORM Variable' or 'Set
SCORM Variable' action resulted in an error. The difference is that the string returned contains a textual
description of the error. This is usually much easier to interpret than an error code.

e Checking Get diagnostic and specifying a parameter in the Diagnostic parameter string text field lets you
retrieve vendor specific error information. The parameter string to be used is defined by the vendor of the
LMS and is outside the scope of this topic.

Some of the variable names listed in the 'SCORM variable name' field contain square brackets, e.g.
"cmi.comments_from_learner.[].comment”. The square brackets are meant to contain an array index, which must
be typed manually.
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The "cmi.comments_from_learner" variable for instance is an array of one or more text strings previously
submitted by the student. To retrieve one of these strings you must specify a number in the brackets, as in the
following examples:

e To get the first comment submitted by the student, you would enter:

cmi .comments_from_learner.[0].comment

e To get the third comment, you would enter:
cmi.comments_from_learner.[2].comment

If you try to retrieve a comment that does not exist, you will receive an empty string. Another '‘Get SCORM
Variable' action with 'Get last error (as descriptive text)' selected would indicate that you specified an invalid
(out of range) array index.

Note that you can also enter expressions or Mediator variable names in the square brackets, as in:
cmi .comments_from_learner.[MyVariable-1].comment

When dealing with SCORM array variables (that is, with square brackets), you can determine how many
elements the array contains by first performing a 'Get SCORM Variable' action with the related "_count”
SCORM variable name.

To determine the current number of student comments for instance, you would use the variable
"cmi.comments_from_learner._count”. If you stored this number in a Mediator variable named
"NumOfComments", you could then use it to retrieve the last comment submitted with
"cmi.comments_from_learner.[NumOfComments-1].comment”.
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Resources

The Database Resource

Fj The Database Resource is used to establish a link between Mediator and a database whose fields you
would like to access from within your Mediator project.

The whole process of establishing the link is described in "Using databases".

Database Resource E|
Database:
C:hky documentshE sampleD B . dzn

ODSM () File [-.dsn]
Initislize when used

Initially select all records intable: | SimpleDE W

Table structure:

= AdvancedDB -
* |D [COUMTER] «2 varRecordID

FirzstM ame [VARCHAR] «» varFirsthame

LastM ame [VARCHAR] «» varLastname

Age [VARCHAR] &= vardage

Location AR CHAR] «» varlocation
* PhoneMumber [MARCHAR] 3 varPhone

=] SimpleDB

D [COUMTER] «# varRecord|D

®  FirzstM ame [VARCHAR] «» warFirstname

® | gztMame [VARCHAR] «» varLastname

® Age [MARCHAR] s vartdge w

o] [cres ]

Database: Enter the name and path of the DSN file or click Browse to select it.

DSN: Make sure this option is unchecked, as Mediator always uses the 'File (*.dsn)" method.
File (*.dsn): Make sure this option is checked.

Initialize when used: Select this option if you want the chosen table to be initialized when starting the
connection.

Initially select all records in table: If this option is checked all the records in the table whose name is shown on
the right are selected. Do not disable this option unless you have a particular reason for doing so.

Q Access databases can contain more than one table. If this is the case for your database, use the 'table’ field to select the
table to display initially.

Table structure: When the connection between Mediator and the database is setup correctly, this field shows all
the tables contained in the database, as well as all the fields contained in these tables.
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e A green dot shown on the left of a field indicates that the field is not connected to a Mediator variable.

e A red dot indicates that the field is connected to a Mediator variable.

If the table structure field remains empty, despite the fact that you have filled in the rest of the dialog, something
in the setup is incorrect (normally the DSN file does not point to the database file).

Link To: Use this button to connect the selected field of the table structure with a Mediator variable.

Remove Link: Use this button to remove a link between a database field and a Mediator variable.

The HTTP Request resource

The HTTP Request resource is used to communicate with web servers via its Post and Get functions.

HIT TP Request E|
LRL:
"hittp: Aenene. mnatchiware, com'
Verh Data:
&
T E
@iet
) Post
Feszponze: Status code; Status test:
Rezponzetar W StatusCodelar » StatusTextar W
Help [ OF. l [ Cancel

In its simplest form you can get an HTML page and load it into a Mediator variable for further processing. In the
above screenshot the resource is set up to load the HTML content of www.matchware.com into the variable
ResponseVar.

You can also communicate with ASP or PHP pages to access data in databases on web servers. This resource
obviously requires that you have access to a web server.

In the field URL you type in the complete URL of the page you want to send data to and/or receive data from.
Examples could be:

"http://www._matchware.com/test/test._asp"
"http://www._matchware.com/product/textinfo.txt"

Note that this field accepts expressions. Any URL typed directly into it must therefore be enclosed in double
quotes.

In Verb you choose whether you want to Get or Post data. Both Get and Post can send and receive data. With
the HTTP protocol Get method, the data to be sent is appended to the URL as in this example:

http://www.matchware.com/test/test.asp?myvariable=20&myname=Bob

Mediator automatically attaches the data to the URL.
By contrast, the Post method inserts the data to be sent in the body of the HTTP request.

Since Get's arguments are appended to the URL, Get should only be used for sending small amounts of data (less
that a few hundred characters), since servers may have a limit on the length of the URL they can handle. If in
doubt, use Post rather than Get.
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Data can be any expression. You can also refer to arrays in this field. See "Using project variables" for more
information about arrays.

In Response you select the variable that will receive the response from the web server. If you asked for an
HTML page it will contain the HTML code. An ASP page will usually respond with a text or a code indicating
for instance whether a database transaction was successful or not.

Status Code and Status Text represent the same message, but Code shows it as a number and Text as
explanatory text. Do not confuse this with the Response field. Although both are often used for OK/Error
messages, they do not come from the same place. The Status message relates to the connection. It will for
instance indicate if the file you specified in the URL does not exist or if your connection has gone down.

HTTP Request events

The reason why the HTTP Request is a resource rather than an action is that it needs to be able to

react to events. The Status message is used together with the HTTP OK and HTTP Error events on the
resource as follows:

e [f the connection is working normally the OK event is triggered. The Status Code and Status Text variables
are not changed since all is fine.

e If an error occurs or if there is no response the Error event on the resource is triggered and you can get the
error code/message from Status Code and Status Text.

The Response reflects "what you are doing™ on the web server containing the URL file. It may well happen that
the connection is fine and that the Status fields show OK, but that you get an error because the server could not
handle or figure out the request you sent.

Sometimes responses from servers can take several minutes. You should take care of this situation by starting a
timeline when you send the request. After 60 seconds (or whatever you find appropriate) you can assume that the
connection is not working and display a message or respond in any other way according to your specific
situation.

Flash export restrictions

The following restrictions apply to the HTTP Request resource when exported to Flash:
e The server you post the request to should be located in the same domain as the Mediator Flash file.

e The data string that you post must be formatted as name-value pairs, e.g.
name=thomas&age=26&o0ccupation=teaching

o |f the data to be posted is not specified as a string, but by setting the DataArray property, the array index
names will be used as names in the name-value pairs, while the array values will be used as the values.

For example, using a data array where myArray[name] = "thomas", myArray[age] = 26 and
myArray[occupation] = "teaching", the data posted to the server will be equivalent to the data string
example above.

See "Using project variables" for more information about arrays.

e The data to be posted must not contain the characters "=" or "&", except as separators between name-value
pairs.

e The data returned from the server to the Flash player should be formatted in the same way as when
specifying a data string to be posted.

o Inthe case of an HTTP error, the Flash player does not provide any error information other than the Status
Code.
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HTML export restrictions

The following restrictions apply to the HTTP Request resource when exported to HTML:

The server you post the request to should be located in the same domain as the Mediator project.

The data to be posted must not contain the characters "=" or "&", except as separators between name-value
pairs.

The HTTP Request returns Status Code 200 if OK, 400 if an error occurred.

If the page you post to redirects you to another URL, the response will be an error.
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System variables

Mediator system variables are very helpful. They can give you information about the end user's computer, the
time and date, location of specific folders, etc. The system variables are particularly useful when you use
Mediator's programming functions.

You can access the list of all the system variables provided by Mediator by clicking the Expression button fx
found in most programming dialogs.

All system variables begin with the character @.

All the Mediator system variables are listed below. The type of variable that the system variable returns is shown
between brackets.

@ColorBits (integer)

Description: Returns the number of colors on the screen in bits. Values are 8, 15, 16, 24 or 32.
Usage: Identical to @Colors, but @ColorBits can also detect 32-bit color resolution.
@cCaolors (integer)

Description: Returns the number of colors on the screen. Typical values are 16, 256, 65536 or 16777216. Screen
drivers with 256 or less colors normally have a palette. Returns 1 for 32-bit color resolution.

Usage: If your project is created for a specific color resolution, you can check the color resolution of the end
user's computer, and perhaps ask the user to change it before continuing. To check for color resolutions higher
than 256 colors, you can use the condition:

IF @colors > 256 OR @colors < 2
This condition will be true for all color resolutions higher than 256 (including 32 bit).
@ComputerName (text)
Description: Returns the NetBIOS name of the local computer.
@CPU (integer)

Description: Returns a number representing the processor type. This is detected by a Windows call. @CPU
returns 586 for unknown CPU's.

Usage: If you have created different versions of your project depending on the computer power of the end user,
you can check the processor type first and run the corresponding project.

@CursorXpos and @CursorYpos (integer)
Description: Returns the X and Y position of the mouse pointer. For more on coordinates, see "Moving objects".

Usage: Determine if the pointer crosses a specific line or point or exits the screen. Then show an object, play a
sound etc.

@Date (text)

Description: Returns a text string indicating today's date. The string format varies according to the Windows
installation of the computer on which Mediator is running. This means that if Windows is using the US standard,
May 10th 2010 will give the text string 5-10-2010.

Usage: You can use the date system variables to show the date, day, month, year etc. in an input object.
@DateDay (integer)
Description: The number of the current day. If the date is May 10th 2010, the content of this variable will be 10.
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Usage: Check the current date using @DateDay, @DateMonth and @DateYear (see below) to see if the
demonstration period for your project has expired.

@DateMonth (integer)

Description: The number of the current month. If the date is May 10th 2010, the content of this variable will be
5, since May is the 5th month.

@DateYear (integer)

Description: Indicates the current year. If the date is May 10th 2010, the content of this variable will be 2010.
@DesktopDir (text)

Description: Returns the path to the desktop folder.

Usage: Gives you the exact path to the desktop of the end user's computer. Use this for instance to place a file on
the desktop during the project.

@DocDir (text)
Description: Returns the path to the folder containing the Mediator project file (.md8).

Usage: If you are planning to export a project containing actions or expressions that refer to external data files,
using @DocDir to specify the location of these external data files will enable Mediator to find them when
running the exported version. For this to work, you also need to copy these external data files in your Mediator
project folder using the command Prepare | Additional Data Files before exporting the project. See "Adding
data and program files" for more information.

If for instance your Mediator project file is stored in the folder "C:\MyProjects", the expression @DocDir +
"MyDocument.doc" will be equivalent to the path name "C:\MyProjects\MyDocument.doc".

@Key (text)

Description: Returns the value of the last key pressed.

Usage: Check which key the user presses. Use an If action to set up actions depending on the key pressed last.
For more information about how to use this function, see "Using keyboard events".

@OS (text)

Description: Returns a text string identifying the operating system used ("Windows 2000", "Windows XP",
"Windows 2003", "Vista", "Unknown").

Usage: Some commands may vary depending on the operating system used. Using @OS you can check the
operating system, and then set up the corresponding commands with the If action.

@PageCount (integer)

Description: Returns the number of pages in the document.

Usage: Gives you an easy way to create a page counter, for instance with;
"You are now on page " + @PageNum +" of " + @PageCount

@PageName (text)

Description: Returns the name of the current page.

Usage: You can save the name of the current page for further use, e.g. if the end user leaves the project and
wants to return to the same page later. Or you can place the value of @PageName in an INI file, and jump to the
page the next time the user opens your project.

@PageNum (integer)
Description: Returns the number of the current page. The first page is number 1.

Usage: See @PageCount.
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@PageRange (integer)
Description: This variable indicates the number of pages in the current chapter (see "Using the Page list").
Usage: Gives you an easy way to create a page counter within the current chapter, for instance with:

"You are now on page " + @PageNum +" of " + @PageRange
@ProgramDir (text)
Description: Returns the path to the folder containing the runtime Mediator Viewer (md8rntm.exe).
Usage: Lets you place additional program files in the same folder as the md8rntm.exe file.

If you are planning to export a project containing actions or expressions that refer to external program files,
using @ProgramDir to specify the location of these external program files will enable Mediator to find them
when running the exported version. For this to work, you also need to copy these external program files in the
same folder as the md8rntm.exe file using the command Prepare | Additional Program Files before exporting
the project. See "Adding data and program files" for more information.

@ScreenXsize and @ScreenYsize (integer)
Description: Returns the width (X) and height (Y) of the screen indicated in the number of physical pixels.

Usage: Check if the end user's screen resolution is high enough for your project. If not ask the end user to change
it, or create a project for each screen resolution.

@SystemDir (text)
Description: Returns the path to the Windows system folder.

Usage: When you create INI files (or other files) you can choose to save them in the Windows system folder,
enabling you to access them later.

WARNING: This is for advanced users only. Do not use if you are uncertain of the consequences.
@TempDir (text)
Description: Returns the path to the user's Temp folder (a folder that stores files temporarily).

Usage: When you create INI files (or other files) you can choose to save them in the user's temporary folder,
enabling you to access them later. However, if the user deletes the temp folder, the files created in it are also
deleted.

@ThisObject
Description: Is used in actions to refer to the object to which the action is applied.

Usage: If you have programmed an object to be hidden when clicked, you can use @ThisObject instead of the
object name. This is especially useful if you copy the same action to many objects that all use this action. Also
useful when creating Drag&Drop functionality.

@Time (text)
Description: Returns a text string holding the computer system time.
Format: "HH:MM:SS", HH=hours, MM=minutes and SS=seconds.
Usage: You can use the time system variables to show the time, hour, minutes etc. in an input object.
@TimeHour (integer)
Description: Returns the specific "hour" number for the computer system time.

Usage: Check the time required by the user to perform a particular action using @ TimeHour, @ TimeMin and
@TimeSec (see below).

@TimeMin (integer)

Description: Returns the specific "minute" number for the computer system time.
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@TimeSec (integer)

Description: Returns the specific "second" number for the computer system time.
@Timer (integer)

Description: The number of seconds since Mediator was started

Usage: Use this for instance to calculate the time spent on a specific task by saving the @Timer value at the start
of the task and subtracting this initial value from the value of @ Timer at the end of the task.

@UserName (text)

Description: Returns the name of the user currently logged on the computer.
@WindowDir (text)

Description: Returns the path to the Windows folder.

Usage: When you create INI files (or other files) you can choose to save them in the Windows folder, enabling
you to access them later.

WARNING: This is for advanced users only. Do not use if you are uncertain of the consequences.
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Functions

r

Mediator provides many different built-in functions that you can use in your expressions.

You can access a list of all these functions by clicking the Expression button £ available in most of the
programming dialogs.

5@ An expression may be a combination of project variables, system variables, numbers, object properties in
the Object.Property notation, functions and fixed text between quotes, all linked with operators. See "Using
expressions" for more information

Syntax

All functions in Mediator have one of the two following formats:

e Function (x), where X is the variable on which the function is performed.
Example:

Here the function COS (Cosine) is applied to the variable Trig, and the result is placed in the variable Input.

Assign f'5_<|

Y anahle:

|In|:|ut v|

Agzignment exprezsion;

COS [Trig)

| oK [ Cancel

e Function (x, p) where x is the variable and p represents one or more parameters, each separated with a
comma.

Example:

Here the function FORMAT is applied to the floating point variable Num. The extra parameter ".2f"
specifies the number of digits after the decimal point (rounding the last digit if necessary). The result is
placed in the variable Input.
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Assign E

" ariable:

|Ir'||:|ut v|

Azzignment expression;
FORMAT [Murm,." 2"

[ ok [ Cancel

List of functions

Each function is described below, with an example of its format and possible use. The following abbreviations
are used for representing the various expression types available:

txt Text variable, expression or fixed value

f Floating point variable, expression or fixed value
n Integer variable, expression or fixed value

b Boolean (True / False) variable

x andy Variables that the function is applied to
The functions available are listed below in alphabetical order.
ABS (n) or ABS (f)

ABS is short for "absolute". Returns the numerical (absolute) value of the variable or expression. Returns an
expression of the same type as the input type.

Examples:
ABS (x) Returns the positive value of x
ABS (-10) = 10
ABS (5) =5
ABS (-10.25) = 10.25
ARCCOS (n) or ARCCOS (f)
ARCCOS is the trigonometric function "arc cosine".
Examples:
ARCCOS (x) Returns the value (in radians) of the arc cosine of x.
ARCCOS (0) = 1.571 (n/2)
ARCCOS (1) =0
ARCCOS (0.5) = 1.047 (n/3)
ARCSIN (n) or ARCSIN (f)
ARCSIN is the trigonometric function "arc sine".
Examples:
ARCSIN (x) Returns the value (in radians) of the arc sine of x.

ARCSIN (0) =0
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ARCSIN (1) = 1.571 (n/2)
ARCSIN (0.5) = 0.524 (n/6)
ARCTAN (n) or ARCTAN (f)
ARCTAN is the trigonometric function "arc tangent".
Examples:
ARCTAN (X) Returns the value (in radians) of the arc tangent of x.
ARCTAN (0) =0
ARCTAN (1) = 0.785 (n/4)
COS (n) or COS (f)

COS is short for the trigonometric function "cosine".

Examples:
COS (x) Returns the value (in radians) of the cosine of x.
Cos(0)=1
COS (n) =-1

COS (n/2) = COS (1.5*1) = 0
COS (x/3) = 0.5
See SIN further down.
FLOAT (n) or FLOAT (txt)
FLOAT is short for "floating point". Converts an integer or text to a floating point number.
Examples:
FLOAT ("10.25") = 10.25
FLOAT (10) = 10

To control the number of digits after the decimal point, use the function FORMAT or set the number in the
Properties dialog of the input object that shows the value of the variable.

FORMAT (n) or FORMAT (txt)

FORMAT converts integer or floating point variables to text. FORMAT is similar to STRING, however
FORMAT lets you add one or more extra (optional) parameters to format the number.

You must enter the extra parameter between quotes, e.g. FORMAT (x, "010.2f")

f The most commonly use parameter is probably f. It allows you to control the number of digits after the
decimal point.

Examples:
FORMAT (10.25,".4f") ="10.2500" Converts 10.25 to text with 4 digits after the decimal point
FORMAT (x,".2f") Converts the variable x to text with 2 digits after the decimal point
FORMAT (x,".0f") Converts the variable x to text with 0 digits after the decimal point

e Returns the value as a decimal number multiplied by the appropriate power of 10.

Examples:
FORMAT (50000, ".e") = 5e + 004, which means 5 x 10 to the power 4
FORMAT (6594, ".3e") = 6.594e + 003, which means 6.594 x 10to the power 3
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FORMAT (6594, ".5e") = 6.59400e + 003, which means 6.594 x 10to the power 3
FORMAT (X, ".e")

E Same as e but using E as the indicator for exponent.

Examples:
FORMAT (50000, ".E") = 5E + 004, which means 5 x 10 to the power 4
FORMAT (6594, ".3E") = 6.594E + 003, which means 6.594 x 10 to the power 3

g Shows the value using the f format if possible, otherwise the e format. The maximum amount of digits
allowed when using the f format is 6. After 6 digits, the e format is used. Decimal point and following zeros are
only included if necessary.

Examples:
FORMAT (50000, "g") = 50000
FORMAT (50000.33, "g") =50000.3 (using 6 significant digits)

FORMAT (5000000, "g") =5E + 006 (as the number has more than 6 significant digits, the e format is
used)

FORMAT (X, "g")
G Same as g but using G as the indicator for exponent.
If an error occurs in the formatting parameter, or if this is left out, the "g" format is used.
Adding leading or trailing zeros or spaces using On1.n2 or n1.n2
You can add leading zeros in front of any given variable by using the parameter On1.n2, where:

e nlis the total number of digits in the number (including the decimal point)

e n2is the number of digits after the decimal point

Similarly, you can add leading spaces in front of any given variable by using the parameter n1.n2, where n1 and
n2 have the same meaning as described above.

Using the minus sign (-) you can specify that trailing spaces should be inserted to the right of the decimal point.
Examples:
FORMAT (x, "010.2f") Returns 2 digits after the decimal point, and up to 7 zeros in front of the variable.
FORMAT (x, "8.4f") Returns 4 digits after the decimal point, and up to 3 spaces in front of the variable.
FORMAT (x, "-8.4f") Returns 4 digits after the decimal point, and up to 3 spaces after the decimal digits.

INT (f) or INT (txt)
INT is short for "integer". Converts floating point or text variables to integers.
Examples:

INT (x) Converts the content of variable x to an integer.

INT ("10") = 10
INT (10.25) = 10
INT (10.7) = 10

Floating point variables are not rounded up. The decimal part is truncated instead. To make sure the value will be
rounded up when necessary, just add 0.5 to the number before performing the INT function, e.g. INT (x + 0.5).
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LEN (txt)
LEN is short for "length". Returns the length of the text, i.e. the number of characters in the text expression.
Examples:
LEN ("Test") = 4
LEN (™) =0
LOG (n) or LOG (f)
LOG is the mathematical function "logarithm".
Examples:
LOG (x) Returns the value of the logarithm (to base e) of x.
LOG (1)=0
LOG (10) = 2.3026...
LOG (100) = 4.6051...
LOWER (txt)
Converts all the characters of a text variable to lower case.
Examples:
LOWER ("HORSE") = "horse™
LOWER ("Horse") = "horse"
LOWER ("HoRsE") = "horse"
See the function UPPER further down.
NOT (n) or NOT (b)

Inverts a True/False expression. Although the inversion is done at the bit level, since a True/False expression has
a value of either 1 or 0, this function returns its inverse.

Objname functions

These functions allow you to get information about an object at runtime. During an animation, you can for
instance check if an object has reached the edge of the screen.

In all the Objname functions below, '‘Objname’ indicates the name of the object.

The parameter is one of the object properties, such as X, Y, Height, Width. Please refer to the appendix
"Mediator object properties" for a list of all the properties available for each object.

Objname.X
Returns the position of the left edge of an object.
Example:
Button.X
Objname.X + Objname.Width
Returns the position of the right edge of an object.

Objname.Width returns the width of the object, so adding this to Objname.X will give you the right edge of the
object.

Example:

Picture.X + Picture.Width
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Objname.Y
Returns the position of the top edge of an object.
Example:
Polygon.Y
Objname.Y + Objname.Height
Returns the position of the bottom edge of an object.

Objname.Height returns the height of the object, so adding this to Objname.Y will give you the bottom edge of
the object.

Example:

Video.Y + Video.Height

Objname.Visible

This function returns True if the object is visible.

Example:

Picture.Visible will return the value TRUE if the picture is currently shown, and FALSE if it is hidden.
RGB (n1,n2,n3)

Combines the RGB (Red, Green and Blue) values in the range 0 to 255 given in the n1, n2 and n3 parameters
and returns a single value that can be used to set the color of a particular object.

Example:

A Set Property action with "Rectangle.FillColor = RGB(128,0,128)" would change the rectangle color to
purple.

RND (n1,n2)

RND is short for "random". Returns a random integer in the interval nl to n2 (both included). The interval
between nl and n2 cannot exceed 65536.

Examples:
RND (1,10) Generates a random number between 1 and 10.
RND (1,x) Generates a random number between 1 and x.
RND (x,y) Generates a random number between x and y.
SIN (n) or SIN (f)

SIN is short for the trigonometric function "sine".

Examples:
SIN (X) Returns the value (in radians) of the sine of x.
SIN (0) =SIN (z) =0
SIN (n/2) =1
SIN (1.5%n) = -1
SIN (n/6) = 0.5
See COS at the top.

STRING (n) or STRING (f)

Converts a number to text.
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Examples:
STRING (10) ="10" Converts an integer to text.
STRING (-5) ="-5" Converts an integer to text.
STRING (10.25) ="10.25"  Converts a floating point number to text.
STRING (x) Converts the variable x to text.
SUBPOS (txt1,txt2)
Returns the position of one piece of text in another (e.g. txt2 in txt1).

Please note that this function is case-sensitive. In other words, it makes a distinction between upper-case and
lower-case characters.

If txt2 is not found in txtl, a zero is returned.

Examples:
SUBPOS ("aaaBBB","aB") = 3 (the combination aB starts from the third letter of the first text)
SUBPOS ("aaaBBB","ab™) =0 (the combination of a lower a and lower b is not present)

SUBPOS ("abCdefghijk", def") = 4

SUBPOS (*"22334455","45") = 6

SUBPOS (x,y) Returns the starting position of the content of variable y in variable x.
SUBSTR (txt,n1,n2)

Returns a part (a sub-string) of the text expression txt. n1 indicates the start position of the sub-string to be
returned and n2 indicates its length (i.e. the number of characters to return).

Please note that this function is case-sensitive. In other words, it makes a distinction between upper-case and
lower-case characters.

Examples:
SUBSTR ("abCDefghijk",4,3) = "Def" (starts at letter 4, 3 letters long)
SUBSTR ("ABCDEFGHIK",2,4) = "BCDE"  (starts at letter 2, 4 letters long)

SUBSTR ("abCD",3,4) ="CD" (starts at letter 3. Only 2 letters long, since the end of the
original string is reached)

SUBSTR (x,3,5) Returns a sub-string of 5 characters long, starting at character 3 in the content of

variable x.
SQR (n) or SQR (f)
SQR is short for "square root". Returns the square root of the variable or expression.
Examples:
SOR (x) Returns the square root of the variable x.
SOR (x +y) Returns the square root of the sum of variable x and variable y.

FORMAT (SQR (x), ".2f")  Returns the square root of the variable x with 2 decimals.
TAN (n) or TAN (f)

TAN is the trigonometric function "tangent".
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Examples:
TAN (X) Returns the value (in radians) of the tangent of x.
TAN (0) =0
TAN (n/4) = 1
UPPER (txt)
Converts all the characters of a text variable to upper case.
Examples:
UPPER ("horse™) = "HORSE"
UPPER ("Horse") = "HORSE"
UPPER ("HoRsE") = "HORSE"
See the function LOWER further up.
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SQL statements

ODBC databases uses SQL (Structured Query Language) for queries. SQL is a very comprehensive language in
which you can create, alter, delete and maintain databases. This section is only a brief description of the SQL
commands used to perform the main tasks from Mediator. If you want go look further into SQL the following
literature could be useful.

Learning SQL by Alain Beaulieu (2005, O'Reilly & Associates, ISBN 0596007272)

Introduction to SQL: Mastering the Relational Database Language by Rick F. Van der Lans (2006, Addison
Wesley Professional, ISBN 0321305965)

SQL Cookbook by Anthony Molinaro (2005, O'Reilly, ISBN 9780596009762)
Understanding SQL by Martin Gruber (1990, SYBEX San Francisco, ISBN 0895886448)
SQL Instant Reference by Martin Gruber (1993, SYBEX San Francisco, ISBN 0782111483)

A Guide to the SQL Standard by C.J. Date and Hugh Darwen (1993, Addison Wesley Boston, ISBN
020155822X)

The SELECT command

SELECT * FROM DemoTable | This is the single most used SQL command in its simplest form. The
. * symbol will select all fields (not records) in the table. In Mediator
SELECT FirstName FROM you normally always use the * instead of specifying individual field
DemoTable names. If Individual fields are selected, all other field links are
SELECT FirstName, LastName frozen and only the selected fields changes when the user browses.

FROM DemoTable

The WHERE clause

SELECT * FROM DemoTable | All records where the field FirstName equals "mike" are selected.
WHERE FirstName = 'mike' After the command is executed, the user can browse in the result
records only. To gain access to the entire table again, execute the
command SELECT * FROM DemoTable

SELECT * FROM DemoTable | All records where the field FirstName equals "mike" or LastName
WHERE FirstName = 'mike’ equals "peters" are selected. For a result where both conditions are
OR LastName = 'peters' met, use AND instead of OR.

The ORDER BY clause
Sorts a query's resulting records on a specified field or fields in ascending or descending order.
Syntax: SELECT field list

FROM table

WHERE select criteria

ORDER BY field1 [ASC | DESC][, field2 [ASC | DESC][, -..]]
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SELECT * FROM DemoTable | Selects all records and sorts them by LastName in ascending order.
ORDER BY LastName

SELECT * FROM DemoTable | Selects all records and sorts them by LastName in Descending
ORDER BY LastName DESC order.

SELECT * FROM DemoTable | Selects the records where LastName matches "peters" records and
WHERE LastName LIKE sorts them by LastName in Descending order and FirstName in
'peters' ascending order.

ORDER BY LastName DESC,
FirstName ASC

Comparison Operators

Operator Comparison

= Equal

== Exactly equal

LIKE SQL LIKE

<> 1= # Not equal

> More than

>= More than or equal to
< Less than

<= Less than or equal to

LIKE Operator

You can use the Like operator to find values in a field that match the pattern you specify. For search patterns,
you can specify the complete value (for example, Like "Smith"), or you can use wildcard characters like those
recognized by the operating system to find a range of values (for example, Like "Sm*").

The following example returns data that begins with the letter P followed by any letter between A and F and
three digits:

SELECT * FROM DemoTable WHERE LastName LIKE 'P[A-F]###

This example returns a list of employees whose names begin with the letters A through D.
SELECT * FROM DemoTable WHERE LastName LIKE '[A-D]*'

Patterns

The following table shows how you can use LIKE to test expressions for different patterns.

Kind of match Pattern Match No Match

Multiple characters 'a*a’ 'aa’, 'aBa’, 'aBBBa' ‘aBC'
*ab*" ‘abc’, "AABB', "Xab' ‘aZb', 'bac’
‘ab*' ‘abCDefg’, 'abc' ‘cab’, 'aab’

Special character ‘a[*]a’ 'a*a’ ‘aaa’

Single character 'a?a’ 'aaa’, 'a3a’, 'aBa’ 'aBBBa'

Single digit ‘atta’ 'a0a’, 'ala’, 'a2a’ ‘aaa’, 'alla’

Range of characters Ta-z]' Y 2','&'
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Outside the range Tla-z]' 9,'&,'% b, a
Not a digit T10-971' ‘Alya, & ‘0,1,'9
Combination ‘a[lb-m]#' 'An9', 'az0', 'a99' ‘abc', 'aj0’

Example SQL Queries

SELECT * FROM Book

Selects all rows and columns from table Book.

SELECT Title, RetailPriceAmount FROM Book
WHERE RetailPriceAmount > 20.0

Selects columns Title and RetailPriceAmount
from table Book, returning only the rows that
match the WHERE clause.

SELECT * FROM Book WHERE CatCode = 'LL'
OR CatCode ='RR’

Selects all columns from table Book, returning
only the rows that match the WHERE clause.

SELECT * FROM Book WHERE CatCode IS
NULL

Selects all columns from table Book, returning
only rows where the CatCode column is NULL.

SELECT * FROM Book ORDER BY Title

Selects all columns from table Book, ordering by
Title, in ascending order. To specify descending
order, add DESC after the ORDER BY Title
clause.

SELECT Title FROM Book WHERE
RetailPriceAmount >= 20.0 AND
RetailPriceAmount <= 35.0

Selects records where RetailPriceAmount
conforms to the WHERE expression.
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Appendix

Appendix 1: Keyboard shortcuts

The table below lists all the keyboard shortcuts provided by Mediator.

Keyboard shortcut | Description

Ctrl +N Create a new document

Ctrl+O Open and browse for an existing document

Ctrl+P Print the active document

Ctrl+Q Export the project using Quick Export

Ctrl+S Save the active document

Ctrl+C Copy the selected data to the clipboard

Ctrl + X Cut the selected data to the clipboard

Ctrl +V Paste the data contained in the clipboard

Ctrl+Zz Undo the last action

Alt + F4 Exit

Insert Create new page

Ctrl + A Select all the objects on the page

Ctrl+B Place the selected objects behind all the other objects
Ctrl+D Duplicate the selected objects

Ctrl+F Place the selected objects in front of all the other objects
Ctrl+ G Group the selected objects

Ctrl+H Define part of a text object as hypertext

Ctrl+U Ungroup a group of objects

Ctrl + drag Resize the selected object freely in both X and Y directions
Shift + drag Resize the selected object symmetrically in all directions
Ctrl + click Select several objects on the page

Shift + click Select a range of objects in the Object list

Ctrl + double-click | Edit the text object on the background color last defined for it
text object

Shift + double-click | Edit the text object on a white background

text object

F1 Help

F2 Rename the selected page in the Page list, Rename the selected object in the Object list
F2 Align the selected objects

F3 Show/Hide the selected objects
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F4 or Ctrl + F10

Show/Hide the Object list

F5

Run the document

F6 or Ctrl + F5

Run the page

Shift + F6 Preview the current HTML or Flash page in your default Internet browser
F7 Spellcheck the document

F8 Show/Hide the Page list

F9 Show the Events dialog for the current page

F11 Check the document for design errors

F12 Show/Hide the Properties dialog

Ctrl + F7 Spelicheck the page

Ctrl + F8 Show the Properties dialog for the current page

Ctrl + F9 Open the Variables dialog

Ctrl + F11 Check the page for design errors

Spacebar + drag

Move the page within the workspace

Altor F10

Show the access keys on the ribbon

Ctrl +F1

Minimize or restore the ribbon
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Appendix 2: Mediator object properties

You can use the Object.Property notation to get or set an object property with the Set Property action, the Assign
action and many actions of the Programming tab in the Events dialog.

See "Using expressions" for more information.

This appendix lists properties and methods for all the Mediator objects which you can use in these actions, as
well as in runtime script and macro script. Note that some are only available from macro script (as shown in the
table).

@ The properties marked as "Read only" in the tables below can be used in programming actions using the
Obiject.Property notation, but do not appear in the list of properties of the Set Property action.

Object (all objects)

Properties
Name Return type Read only | Macro | Runtime
Events Events X
Height Integer X xX*
Keywords String X
Name String X
ObjectType String X
Size Floating X*
Tab Stop Boolean X
Visible Integer X X
Width Integer X X*
X Integer X
Y Integer X
* Only for objects that allow runtime scaling
ActiveX object
Properties
Name Return type Read only | Macro | Runtime
ActiveX IDispatch X X
Event String X X
Events
Name
ActiveX

342



Animated GIF

Properties
Name Return type Read only | Macro | Runtime
AutoStart Boolean
Discardable Boolean X
LoadOnShow Boolean X
Path String X X
Repeat Boolean X
Rotate Integer X
RotateCenterX Integer X
RotateCenterY Integer X

Animation Path

Properties
Name Return type Read only | Macro | Runtime
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
Bump Map

Properties
Name Return type Read only | Macro | Runtime
Discardable Boolean
LoadOnShow Boolean X
NonStretchBottom Integer X
NonStretchL eft Integer X
NonStretchRight Integer X
NonStretchTop Integer X
Opacity Integer X
Path String X X
Tile Boolean X

Button

Properties
Name Return type Read only | Macro | Runtime
Bold Boolean X
Border Integer X
ButtonType Integer (enum) X
DownAlphaPath String X X
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DownPicturePath String X X
FocusAlphaPath String X X
FocusColor Integer X X
FocusPicturePath String X X
Font String X

Italic Boolean X

Margin Integer X
NonStretchBottom Integer X
NonStretchLeft Integer X
NonStretchRight Integer X
NonStretchTop Integer X
NormalAlphaPath String X X
NormalColor Integer X
NormalPicturePath String X
PictureAlignment Integer (enum) X
PictureDiscardable Boolean X
PictureEnableTransparent Boolean X X
PictureLoadOnShow Boolean X
PictureTransparentColor Integer X
PressedColor Integer X

Text String X X
TextAlignment Integer (enum) X

TextColor Integer X X
TextPaddingBottom Integer X
TextPaddingLeft Integer X
TextPaddingRight Integer X
TextPaddingTop Integer X

TextSize Integer X X
Underline Boolean X

Drawing
Properties

Name Return type Read only | Macro | Runtime
GlowBlur Integer X X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
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GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
Opacity Integer X X
Path String X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
ShadowBIur Integer X X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Embedded Document
Properties
Name Return type Read only | Macro | Runtime
IExplorer IDispatch X X
StatusText String X X
URL String X X
Events
Name
DocumentComplete
Flash® object
Properties
Name Return type Read only | Macro | Runtime
BackgroundColor Integer X
Flash IDispatch X X
FrameNum Integer X
Loop Boolean X
Movie String X
Playing Boolean X
Quality Integer X
ReadyState Integer X
TotalFrames Integer X X
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Headline

Properties

Name Return type Read only | Macro | Runtime
Antialiasing Boolean X X
Bold Boolean X X
CurveHeight Integer X X
CurvelLength Integer X X
CurveOffset Integer X X
Font String X X
GlowBlur Integer X X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
Italic Boolean X X
Opacity Integer X X
OutlineColor Integer X X
OutlineDashOffset Integer X X
OutlineStyle Integer (enum) X X
OutlineWeight Integer X X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
ShadowBIur Integer X X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Text String X X
TextFillCenterX Integer X X
TextFillCenterY Integer X X
TextFillColor2 Integer X X
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TextFillGradientAngle Integer X X
TextFillGradientType Integer (enum) X X
TextFillTextureOptions Integer (enum) X X
TextFillTexturePath String X X
TextFillType Integer X X
WarpX Integer X X
WarpY Integer X X
Weight Integer X X
Hypertext
Properties
Name Return type Read only | Macro | Runtime
Color Integer X X
Transparent Boolean X X
Type Integer (enum) X X X
Input Object
Properties
Name Return type Read only | Macro | Runtime
Alignment Integer (enum) X X
AutoScrollHorz Boolean
AutoScrollVert Boolean X
BackgroundColor Integer X
Bold Boolean X X
DecimalPoint String X
EnableFPdecimals Boolean X
FocusSelect Boolean X
Font String X X
FPdecimals Integer X X X
FrameColor Integer X X
FrameWidth Integer X X
GlowBlur Integer X X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
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Italic Boolean X X
Multiline Boolean X

ReadOnly Boolean X X
ScrollbarHorz Boolean X
ScrollbarVert Boolean X
ShadowBIur Integer X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Text String X X
TextArray Array X X
TextColor Integer X X
TextSize Integer X X
Transparent Boolean X

Value Floating X X
VisibleFrame Boolean X

Weight Integer X

List Box
Properties

Name Return type Read only | Macro | Runtime
BackgroundColor Integer X X
Bold Boolean X
ButtonColor Integer X X
Count Integer X X
Data String X X
DataArray Array X X
Font String X
FrameColor Integer X

GlowBlur Integer X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X
GlowWidth Integer X
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GlowX Integer X

GlowY Integer X

Italic Boolean X
ScrollbarColor Integer X X
ScrollbarSize Integer X
ScrollPosition Integer X
SelectedBackgroundColor Integer X X
SelectedIndex String X X
SelectedString String X X
SelectedTextColor Integer X X
ShadowBIur Integer X X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
TextColor Integer X X
TextSize Integer X

Underline String X

Methods
Name Return type Parameters Macro | Runtime
AddString None String X
ClearList None None X
Media Player
Properties

Name Return type Read only | Macro | Runtime
AutoStart Boolean X X
Balance Integer X
CurrentMarkerName String X X
EnableContextMenu Boolean X
FileName String X X
Mplayer IDispatch X X
PlayCount Integer X X
uiMode String X
uiModeEnum Integer X
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Volume Integer X X
Events
Name
MarkerHit
Picture
Properties
Name Return type Read only | Macro | Runtime
AlphaPath String X
Antialiasing Boolean X
AutoScroll Boolean X
Discardable Boolean X
DragScroll Boolean X
EnableScrollbar Boolean X
EnableTransparent Boolean X
GlowBlur Integer X
GlowColor Integer X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
LoadOnShow Boolean X
Opacity Integer X X
Path String X X
PictureHeight Integer X X
PictureWidth Integer X X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
ScrollbarButtonColor Integer X X
ScrollbarColor Integer X X
ScrollbarFrameColor Integer X X
ScrollbarSize Integer X
ScrollPositionX Integer X
ScrollPositionY Integer
ShadowBIur Integer X
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ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Tile Boolean X
TransparentColor Integer X X
XwrapAround Boolean X
Methods
Name Return type Parameters Macro | Runtime
AdjustSize None None X
Polygon
Properties

Name Return type Read only | Macro | Runtime
ArrowSize Integer X
ArrowStyle Integer (enum) X

End Floating X X
EndArrow Boolean X
FillCenterX Integer X X
FillCenterY Integer X X
FillColor Integer X X
FillColor2 Integer X X
FillGradientAngle Integer X X
FillGradientType Integer (enum) X X
FillTextureOptions Integer (enum) X X
FillTexturePath String X X
FillType Integer (enum) X X
GlowBlur Integer X X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
IsClosed Boolean X X
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Opacity Integer X X
OutlineColor Integer X X
OutlineDashOffset Integer X X
OutlineStyle Integer (enum) X X
OutlineWeight Integer X X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
ShadowBIur Integer X X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Start Floating X X
StartArrow Boolean X
Rectangle
Properties

Name Return type Read only | Macro | Runtime
AlphaPath String (path) X X
Antialiasing Boolean X X
FillCenterX Integer X X
FillCenterY Integer X X
FillColor Integer X X
FillColor2 Integer X X
FillGradientAngle Integer X X
FillGradientType Integer (enum) X X
FillTextureOptions Integer (enum) X X
FillTexturePath String X X
FillType Integer (enum) X X
GlowBlur Integer X X
GlowColor Integer X X
GlowExclObjShape Boolean X
GlowOpacity Integer X
GlowWidth Integer X
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GlowX Integer X X
GlowY Integer X X
Opacity Integer X X
OutlineColor Integer X X
OutlineDashOffset Integer X X
OutlineStyle Integer (enum) X X
OutlineWeight Integer X X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
ShadowBIur Integer X X
ShadowColor Integer X X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
Text
Properties
Name Return type Read only | Macro | Runtime
Alignment Integer (enum) X
AutoAdjustHeight Boolean X
BackgroundColor Integer X
ButtonColor Integer X X
EnableScrollbar Boolean X
FrameColor Integer X
GlowBlur Integer X
GlowColor Integer X
GlowExclObjShape Boolean X
GlowOpacity Integer X X
GlowWidth Integer X X
GlowX Integer X X
GlowY Integer X X
Margin Integer X
MaxScrollPosition Integer X
Opacity Integer X
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ScrollbarColor Integer X
ScrollPosition Integer
ScrollbarSize Integer X
ShadowBIur Integer X
ShadowColor Integer X
ShadowExclObjShape Boolean X
ShadowOpacity Integer X X
ShadowWidth Integer X X
ShadowX Integer X X
ShadowY Integer X X
TopLine Integer X
TransparentBackground Boolean X X
UseFlashDeviceFonts Boolean
Video
Properties
Name Return type Read only | Macro | Runtime
AlwaysOnTop Boolean X
AutoStart Boolean X X
Discardable Boolean X
EnableTransparent Boolean X
Frame Integer
LoadOnShow Boolean X
Path String X X
Repeat Boolean X X
Rotate Integer X X
RotateCenterX Integer X X
RotateCenterY Integer X X
TransparentColor Integer X X
Methods
Name Return type Parameters Macro | Runtime
AdjustSize None None X
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Appendix 3: Macro objects

This appendix lists the properties and methods for Mediator script objects that can only be used from macro
script.

@ Mediator script objects are Mediator objects made available to the script. By contrast, script objects are
objects in the script such as the File System object.

Actions
Properties
Name Return type Read only | Macro
Count Integer X X
Methods
Name Return type Parameters Macro
Add Action String (080 path), Integer (index) X
Clear None None X
Item Action String|Integer X
Remove None String|Integer
Application
Properties
Name Return type Read only | Macro
ActiveDocument Document X X
ActiveWindow Window X X
Version Integer (900 for Mediator 9) X X
Methods
Name Return type Parameters Macro
BrowseForFolder String String (title) X
BrowseForPicture String String (title) X
ChooseColor Integer Integer (defaultcolor) X
Quit None None X
Document
Properties
Name Return type Read only | Macro
BorderColor Integer
Height Integer X X
IconPath String X
Pages Pages X X
Title String X
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Width Integer X X
Methods
Name Return type Parameters Macro
AddPage None String (080 path) X
AddVariable Boolean String (name), Integer (type), String (initval) X
Event
Properties
Name Return type Read only | Macro
Actions Actions X X
EventType String X X
Events
Properties
Name Return type Read only | Macro
Count Integer X X
Methods
Name Return type Parameters Macro
Add Event String (080 path) X
Clear None None X
Item Event String|Integer X
Remove None String|Integer
Objects
Properties
Name Return type Read only | Macro
Count Integer X X
Methods
Name Return type Parameters Macro
Item Object String|Integer X
Page
Properties
Name Return type Read only | Macro
Color Integer X
Description String X
Events Events X X
Keywords String X
MasterPageName String X
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Name String X
Objects Obijects X
Resources Actions X
Searchable Boolean X
SizeOfPictures Integer X X
TopMasterPageName String X
UselnContents Boolean X
Methods
Name Return type Parameters Macro
AddObject None String (080 path) X
AddVariable Boolean String (name), Integer (type), String (initval) X
ConvertScale None Double (xfactor), Double (yfactor)
Pages
Properties
Name Return type Read only | Macro
Count Integer X X
Methods
Name Return type Parameters Macro
Item Page String|Integer X
Selected objects
Properties
Name Return type Read only | Macro
Count Integer X X
First Selected Object X X
Methods
Name Return type Parameters Macro
Add None String (object name) X
Item Object String|Integer X
Remove None String (object name) X
Window
Properties
Name Return type Read only | Macro
Page Page X
SelectedObjects SelectedObjects X X
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Methods

Name Return type Parameters Macro
ArrangeBackward None None X
ArrangeForward None None X
ArrangeToBack None None X
ArrangeToFront None None X
ISaveSeIec’[edObjectsAsDropFi Boolean String (080 path), Boolean (hasicon) X

e
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Appendix 4: Mediator action objects

This appendix lists properties and methods for action objects that can be used from macro script.

Action
Properties
Name Return type Read only
Description String
Name String
Animate
Properties
Name Return type Read only
AnimationPathName String
AutoShow Boolean
Duration Integer
ObjectName String
Repeat Boolean
Reverse Boolean
Animation Effect
Properties
Name Return type Read only
AnimationPathName String
BrickDelay Integer
BrickHeight Integer
BrickWidth Integer
Duration Integer
ObjectName String
Shuffle Boolean
Go to Page
Properties
Name Return type Read only
Duration Integer
PageName String
Show/Hide
Properties
Name Return type Read only

359




Duration Integer
ObjectName String
Sound
Properties
Name Return type Read only
SoundPath String
Repeat Boolean
Start/Stop/Pause
Properties
Name Return type Read only
ObjectName String
Timeline
Properties
Name Return type Read only
Count Integer X
Row Integer
Methods
Name Return type Parameters
Add Action String (080 path), Integer (time ms)
Clear None None
GetTerminationTime Integer None
IsTerminated Boolean None
Item Action Integer (index)
Terminate None None
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